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1 DSLR Remote Pro for Windows

Overview

DSLR Remote Pro for Windows allows the Canon EOS digital SLRs to be operated tethered to a PC
using a USB cable or via wifi (some models only). All of the camera's controls remain fully operational
when connected to the PC and pictures can be taken directly using the camera's shutter release or
remotely from the PC.
It is advisable to use a mains DC adaptor when using DSLR Remote Pro for Windows for extended
periods or when using the time lapse features. If the camera is located a long way from the PC or is
not easily accessible it is essential that there is a way of turning the power to the camera on and off.
Then if there is a communication failure between the camera and PC it is possible to turn everything off
and to start again.

Photo Booth Mode

Please see the section on photo booth shooting for help on setting up a photo booth.

Camera notes for photo booth users

Best value camera for photo booth shooting: Canon EOS 1300D/Rebel T6. Suitable for normal
photo booth shooting and boomerang GIFs, but not recommended for video because it cannot use an
external microphone.

Most versatile cameras offering good value for money: Canon EOS R100 and Canon EOS M50
Mark II
These camera models are compact, have good quality face-detect auto focus and can capture for slow
motion video at 120fps.They also have a hotshoe with a center contact for triggering external flash and
microphone inputs allowing an external microphone to be used for better sound quality when recording
video

Best value camera for photo and video booth shooting: Canon EOS 200D/Rebel SL2
This camera has microphone inputs allowing an external microphone to be used for better sound quality
when recording video. It also has Canon's excellent dual pixel AF for improved auto focus in live view.
The Canon EOS 200D/SL2 is slightly more compact than the Canon EOS 750D/Rebel T6i.

Use with caution:
Canon EOS R50: This camera does not have a center contact on the hotshoe. If you wish to use this
camera for a photo booth with external flash you need a Canon AD-E1 Multi-Function Shoe Adapter
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which fits into the hotshoe and provides a hotshoe with a center contact. Please note that this adds to
the height of the camera: please ensure there is enough space in your photo booth housing for it to fit.

Canon EOS 2000D (aka Canon EOS 1500D and Rebel T7) and Canon EOS 250D (aka Canon EOS
200D Mark II and Rebel SL3): These cameras make it tricky to use external flash because they do not
have a central contact on the hotshoe. This limits it to E-TTL compatible flash. A normal hotshoe to PC
sync adaptor will not work with these cameras.
Note: In spring 2020 Canon updated the Canon EOS 2000D (aka Canon EOS 1500D and Rebel T7) to
include a central contact on the hotshoe making this camera suitable for photo booths using flash.
When purchasing this camera please ensure you are getting the updated version with the center
hotshoe contact.

Canon EOS 4000D (aka Canon EOS 3000D and Rebel T100): This is a cut back, budget version of
the Canon EOS 1300D/Rebel T6. It's main limitation over the Canon EOS 1300D/Rebel T6 is that it is
tricky to use an external power adapter to power the camera. This is because it does not have an
access slot for the power lead. This camera also makes it tricky to use external flash because it does
not have a central contact on the hotshoe. This limits it to E-TTL compatible flash. A normal hotshoe to
PC sync adaptor will not work with this camera.

PowerShot cameras:
Recent Canon PowerShot cameras can be used with DSLR Remote Pro. They are smaller than EOS
cameras and have powered zoom lenses which can be controlled remotely. The Canon PowerShot G5
X Mark II and the Canon PowerShot G7 X Mark III support 120fps slow motion video at both 720p and
1080p. However, please note that none of the supported PowerShot models have hotshoes and will
require a suitable optical slave unit triggered from the camera's built-in flash if you want to use an
external flash unit for photos. Unlike EOS models, PowerShot cameras have a power button that has to
be pressed to turn the camera on as opposed to a power switch that can be left on.

Please note: These recommendations are based on the cameras available at the time of writing
(October 2019).

Supported on Windows 11 and Windows 10

DSLR Remote Pro for Windows fully supports Intel versions of Windows 11 and  Windows 10 with the
Canon camera models listed below.

Windows 8.1: Microsoft ended support for Windows 8.1 on January 10, 2023 and therefore we no
longer test or support our software on Windows 8.1.
Windows 8: Microsoft ended support for Windows 8 on January 12, 2016 and therefore we no longer
test or support our software on Windows 8.
Windows 7: Microsoft ended support for Windows 7 on January 14, 2020 and therefore we no longer
test or support our software on Windows 7.
Windows Vista: Microsoft ended support for Windows Vista on April 11, 2017 and therefore we no
longer test or support our software on Windows Vista.
Windows XP: Microsoft ended support for Windows XP on April 8, 2014 and therefore we are no
longer test or support our software on Windows XP

Camera Model Supported
Canon EOS R100 yes
Canon EOS R50 yes
Canon EOS R10 yes
Canon EOS R8 yes
Canon EOS R7 yes
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Canon EOS R5 yes
Canon EOS R6 Mark II yes
Canon EOS R6 yes
Canon EOS R yes
Canon EOS RP yes
Canon EOS-1DX Mark II yes
Canon EOS-1DC yes
Canon EOS-1DX yes
Canon EOS-1Ds Mark III yes
Canon EOS-1Ds Mark II no
Canon EOS-1Ds no
Canon EOS-1D Mark IV yes
Canon EOS-1D Mark III yes
Canon EOS-1D Mark IIN no
Canon EOS-1D Mark II no
Canon EOS-1D no
Canon EOS 5DS R yes
Canon EOS 5DS yes
Canon EOS 5D Mark IV yes
Canon EOS 5D Mark III yes
Canon EOS 5D Mark II yes
Canon EOS 5D no
Canon EOS 6D Mark II yes
Canon EOS 6D yes
Canon EOS 7D Mark II yes
Canon EOS 7D yes
Canon EOS 90D yes
Canon EOS 80D yes
Canon EOS 77D/EOS 9000D yes
Canon EOS 70D yes
Canon EOS 60D yes
Canon EOS 50D yes
Canon EOS 40D yes
Canon EOS 30D no
Canon EOS 20D no
Canon EOS 10D no
Canon EOS 4000D/EOS 3000D/Rebel T100 yes
Canon EOS 2000D/EOS 1500D/Rebel T7/Kiss X90 yes
Canon EOS 1300D/Rebel T6/Kiss X80 yes
Canon EOS 1200D/Rebel T5/Kiss X70 yes
Canon EOS 1100D/Rebel T3/Kiss X50 yes
Canon EOS 1000D/Rebel XS/Kiss F yes
Canon EOS 250D/Rebel SL3/Kiss X10/200D Mark II yes
Canon EOS 200D/Rebel SL2/Kiss X9 yes
Canon EOS 100D/Rebel SL1/Kiss X7 yes
Canon EOS 850D/Rebel T8i/Kiss X10i yes
Canon EOS 800D/Rebel T7i/Kiss X9i yes
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Canon EOS 760D/Rebel T6s/EOS 8000D yes
Canon EOS 750D/Rebel T6i/Kiss X8i yes
Canon EOS 700D/Rebel T5i/Kiss X7i yes
Canon EOS 650D/Rebel T4i/Kiss X6i yes
Canon EOS 600D/Rebel T3i/Kiss X5 yes
Canon EOS 550D/Rebel T2i/Kiss X4 yes
Canon EOS 500D/Rebel T1i/Kiss X3 yes
Canon EOS 450D/Rebel XSi/Kiss X2 yes
Canon EOS 400D/Rebel XTi/Kiss X yes
Canon EOS 350D/Rebel XT/Kiss N no
Canon EOS 300D/Rebel/Kiss Digital no
Canon EOS M6 Mark II yes
Canon EOS M200 yes
Canon EOS M50 Mark II/Kiss M2 yes
Canon EOS M50/Kiss M yes
Canon PowerShot SX70 HS yes
Canon PowerShot G5 X Mark II yes
Canon PowerShot G7 X Mark III yes

Canon R series cameras: Please check raw burst shooting is disabled in the camera's settings
otherwise the camera will not connect to a PC.

Canon PowerShot cameras: It is recommended that the camera aspect ratio is set to 3:2 for
maximum compatibility with Canon EOS cameras when using photo booth mode.

Running DSLR Remote Pro for Windows on high DPI computers

Some modern laptops and tablet computers have very high DPI screens which can cause problems and
confusion when running DSLR Remote Pro in photo booth mode. If an application does not declare
itself as DPI aware Windows will scale its output and make it larger so that it is readable on a high DPI
screen. This can result in text looking blurry and screen images being a different size than expected e.
g. a laptop with 13" screen with a resolution of 1920x1080 pixels may scale the screen to 1280x720
pixels when displaying the output an application that is not high DPI aware.

DSLR Remote Pro defaults to being "DPI aware" to ensure that it uses the full display resolution to
produce sharp images and text. However this may cause problems with screens created using older
versions of DSLR Remote Pro not filling the screen. If this is a problem you can disable "DPI
awareness" in the preferences settings (File->Preferences).

Wireless Tethering (WiFi operation)

DSLR Remote Pro can wirelessly control recent cameras including the Canon EOS R series cameras,
Canon EOS M6 Mark II, Canon EOS 90D, Canon EOS 80D, Canon EOS 77D, Canon EOS 70D,
Canon EOS 6D Mark II, Canon EOS 6D, Canon EOS 800D/Rebel T7i, Canon EOS 200D/Rebel SL2
and mid to high end Canon DSLRs with the appropriate Canon WFT Wireless File Transmitter.
Before running DSLR Remote Pro the connection between the camera and computer needs to be setup
by using the wireless settings on the camera and by running Canon's EOS Utility Launcher software
(which can be downloaded from Canon's website with their EOS Utility software). Click on the "Pairing
over WiFi/LAN" button and then select wifi connection on the camera and "Remote control (EOS Utility)"
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on the camera to establish the connection between the camera and computer. Please see the camera
instruction manual for more information on how to setup the connection.

Older Canon cameras which come with a software CD may require Canon's WFT Pairing Utility to be
run on the PC to setup the connection.

Once the camera and PC have been paired successfully DSLR Remote Pro will connect to the camera
just like a normal wired USB connection. Please make sure no other software (e.g. Canon's EOS
Utility) is running as this may prevent DSLR Remote Pro from connecting to the camera.

In operation the wireless connection should work just the same as a normal wired USB connection and
give full access to the camera's controls, live view etc. The wireless connection may be slower than a
USB connection, particularly as the distance between the camera and computer or wireless access
point increases.

Please note: It is not possible to connect to the Canon EOS 1300D/Rebel T6, Canon EOS 750D/Rebel
T6i or Canon EOS 760D/Rebel T6s wirelessly from a PC. These camera models can only be controlled
wirelessly from a smart phone or tablet.
Older cameras with WiFi built-in to the camera may not support video capture when connected via wifi
or LAN.

Important: The camera's USB port is disabled when WiFi is enabled. Please make sure wifi is disabled
on the camera before attempting to connect via USB.

2 Installing, Registering and Activating DSLR Remote Pro
for Windows

When you install DSLR Remote Pro for Windows you need to activate your license on each PC it is
running on. Activating the software is a quick and simple procedure if the PC has access to the internet,
however, we recommend activating the PC at least 48 hours before an event. You can still activate a
computer which does not have access to the internet, but this involves sending an email to 
sales@breezesys.com and will take longer than activating the software online. Each license can be
activated on one computer.

You must deactivate the software before making any hardware changes, upgrading or repairing
the PC, reinstalling Windows or reformatting a hard disk. The software can then be reactivated after

mailto:sales@breezesys.com
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the work has been done.

Topics covered in this section:
· Installing the software
· Uninstalling the software
· Evaluating the software
· Registering
· Activating
· Deactivating
· Moving the software to a different PC
· Making changes to your PC
· Decommissioning a PC
· Checking for updates
· Activation problems

Installing the software

The latest version of DSLR Remote Pro for Windows can be downloaded from www.breezesys.com.

To install DSLR Remote Pro for Windows simply download and run the setup program then follow the
on-screen instructions.

Uninstalling the software

DSLR Remote Pro can be uninstalled using the standard Windows "Uninstall a program" option in the
Programs section of the Windows Control Panel.
IMPORTANT: Please deactivate DSLR Remote Pro for Windows before uninstalling otherwise you
may not be able to activate the software on another computer. If you forget to deactivate the software
you should be able to reinstall the software, deactivate it and then uninstall.

Evaluation Version

The trial evaluation version of the software is identical to the registered version and is fully functional for
15 days. Each time you run the software it will display the registration dialog allowing you to enter a
registration code or press the "Evaluate" button to continue evaluating the software:

At the end of the 15 day trial period, a watermark will be applied to all images. You must purchase a

http://www.breezesys.com/DSLRRemotePro/index.htm
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license to continue using the software without a watermark.

Registering the software

To purchase a license for DSLR Remote Pro please visit our website: http://www.breezesys.com/
purchase_dslrrempro.htm. You will be sent an email containing your registration details when your
payment has been received.

To register DSLR Remote Pro for Windows run the application enter your registration name and code
exactly as they appear in your registration email. You may find it easier to copy and paste both the
registration name and code directly from your registration email to avoid mistakes when entering it.
Please keep a copy of your registration email safe in case you need to re-enter your registration
details.

Click on the "Register" button after entering your name and registration details. If the details are correct
the message below will be displayed. An error message will be displayed if the name and registration
code are not valid (e.g. they were not entered correctly) or if you need to purchase an upgrade to use
this version of the software.

Click on the "Yes" button to register the software and the following message will be displayed asking
you whether you want to activate the software on this computer:

http://www.breezesys.com/purchase_dslrrempro.htm
http://www.breezesys.com/purchase_dslrrempro.htm
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Click on the "Yes" button to activate the software on this computer (see the section below for details).

Activating the software

The software must be activated on the computer before it can be used. The software can be run
without activating for up to 10 days after the date when the registration code was issued. After that
time a watermark will be applied to all images unless it is activated.. Each license can be activated on
one computer. If you wish to move the software to a different computer you must deactivate it from the
old computer before activating it on the new computer. Once the software has been activated on a
computer you can run it normally.

To activate the software click on the "Activate..." button in the registration dialog

and the activation dialog below will be displayed:

The quickest and simplest way to activate the software is to do it online by pressing the "Activate
Online" button. Please note that the computer must have an internet connection and the program must
be allowed to access the internet in order to activate the software online.
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Please note that it may take up to 30 seconds to activate the software online.

If the computer is not connected to the internet you can activate the software by email by clicking on
"Activate by email" button and the dialog below will be displayed:

It is important that you copy all of the text and email it to sales@breezesys.com. Please do not modify
the text otherwise we may not be able to validate it. The simplest way to copy the text is to press the
"Copy text to clipboard" button and then paste it into the email by typing Ctrl+V. If the computer doesn't
have email you can copy the activation text to a USB memory stick and then read it on a computer
which does have email.

You should normally receive an email containing your activation code within 12 hours of sending the
activation request email. Paste your activation code into the "Activation code" text area at the bottom of
the activation dialog and click on the "Activate" button to activate the software. If you have closed the
activation dialog you can display it again by running the software and then clicking on the "Activate..."
button in the registration dialog followed by the "Activate by email" button.

Deactivating the software

The software can only be activated on one computer at any given time. If you wish to move the
software to a different computer you must deactivate it from the old computer before activating it on
the new computer.

You also need to deactivate the software before making any hardware changes, upgrading or
repairing the PC, reinstalling Windows or reformatting a hard disk. The software can then be
reactivated after the work has been done.

To deactivate the software select "Register..." from the Help menu in the main window to display the
registration dialog:

mailto:sales@breezesys.com.
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Then click on the "Deactivate..." button to display the deactivation dialog:

The quickest and simplest way to deactivate the software is to do it online by pressing the "Deactivate
Online" button. Please note that the computer must have an internet connection and the program must
be allowed to access the internet in order to deactivate the software online.
Please note that it may take up to 30 seconds to deactivate the software online.

If the computer is not connected to the internet you can deactivate the software by email by clicking on
"Deactivate by email" button and the warning dialog below will be displayed:

Click on the "Yes" button if you want to continue and the deactivation dialog below will be displayed:
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It is important that you copy all of the text and email it to sales@breezesys.com. Please do not modify
the text otherwise we may not be able to validate it. The simplest way to copy the text is to press the
"Copy text to clipboard" button and then paste it into the email by typing Ctrl+V. If the computer doesn't
have email you can copy the text to a USB memory stick and then read it on a computer which does
have email.

You should normally receive an email acknowledging the deactivation code within 12 hours of sending
the request email. If you forget to copy the deactivation information and email it to sales@breezesys.
com you can display it again by selecting "Register..." from the Help menu in the main window and
clicking on the "Display" button. Please note that the copy of the deactivation information will be not be
available after another registration code has been entered.

Moving the software to a different PC

The software can be activated on one computer at any given time and so if you are moving the
software to a different PC you should deactivate the software from the old PC first. Then install the
software on the new PC, then register and activate the software.
If you are planning to move the software to a different PC permanently please following the instructions
for decommissioning a PC.

Making changes to your PC

You need to deactivate the software before making changes to your PC such as upgrading the PC
hardware, reformatting a hard disk, reinstalling Windows, upgrading Windows or getting a PC repaired.
Simply deactivate the software online (or by email if the PC doesn't have access to the internet), make
the changes and then re-activate the software. If Windows has been reinstalled or the hard disk has
been replaced or reformatted you may need to re-install DSLR Remote Pro for Windows, re-enter your
name and registration code and then activate the software.
The latest release and previous releases of the software can be downloaded from the upgrades page
on the Breeze Systems website.
IMPORTANT: Please make sure you have a copy of your name and registration code before making
changes to your PC just in case you need to re-enter them later

mailto:sales@breezesys.com.
mailto:sales@breezesys.com
mailto:sales@breezesys.com
http://www.breezesys.com/upgrades.htm#DslrRemotePro
http://www.breezesys.com/upgrades.htm#DslrRemotePro
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Decommissioning a PC

If you are decommissioning a PC and planning to sell it or give it to somebody else you need to 
deactivate the software and remove your registration details. It is very important that you remove your
registration details even if you have uninstalled the software otherwise the new owner may be able to
reinstall the software and gain access to your registration details. If someone obtains your registration
details they will be able to register and activate the software on their computer and could prevent you
from using it on your computer.

After deactivating the software you can remove your registration details by entering the special
registration code below:

Name: Uninstall
Code: 000JJ3-E1GKWH-U8MCMV-VHWHY9-X3EPXQ-B2P3YQ-372MXN

This will install a special old code which replaces your registration details and will cause the software to
display an "Upgrade required" message when it is run.

If you decide to use the computer again you can reinstall the software, enter your registration details
and activate software.

Checking for updates

You can check for updates by selecting "Check for updates online". This will connect to the internet and
display details of the latest version DSLR Remote Pro in your web browser. Alternatively go to the
DSLR Remote Pro for Windows page on our website: http://www.breezesys.com/DSlrRemotePro

Activation problems

If the error message "The server name or address could not be resolved" is displayed when you try to
activate or deactivate the software online it means that the PC is unable to access the internet. Please
check that that the computer is connected to the internet and check your firewall settings to make sure
that DSLRRemote.exe (the DSLR Remote Pro for Windows program) is allowed to access the internet.
If you are still unable to activate the software online you may need to activate it by email instead.

If a different error message is displayed please follow the instructions displayed in the error message.
If you are not sure what to do please email sales@breezesys.com and include your registration name
and code and details of the error message.

Please also see the support page on the Breeze Systems website for help with activation problems.

3 Main Window

The Main Window
The main window shows the main camera controls together with a large preview display and a
histogram for assessing exposure. The main camera settings can be changed using the controls down
the left hand side of the main window. Other settings are available from the menus.

http://www.breezesys.com/DSlrRemotePro
mailto:sales@breezesys.com
http://www.breezesys.com/support_activation.htm
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Screen shot of DSLR Remote Pro for Windows main window showing optional focus point overlay
display

The display can be simplified by hiding the camera controls shown down the left side of the main
window. To do this click on the View menu and deselect "Show camera controls". 

Photo Booth Shortcut Buttons

When DSLR Remote Pro for Windows is run for the first time it will display the photo booth shortcut
buttons at the top of the main window as shown in the screenshot below:

These are convenient shortcuts if you are using the software to run as a photo booth. You can hide the
photo booth shortcut buttons by selecting "Photo Booth Shortcuts" in the View menu. If the buttons are
hidden and you wish to display them by selecting "Photo Booth Shortcuts" in the View menu. You can
also enable or disable different photo booth shortcut buttons and edit the button text by selecting
"Photo Booth Shortcuts Settings..." from the View menu:
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Click on the checkboxes to enable or disable each shortcut. The text displayed in the shortcut button
can be edited if required.
Click on the "Reset" button to reset the settings back to their default values. The settings can be saved
to file by clicking on the "Save..." button. Saved settings can be loaded from file by clicking on the
"Load..." button.

3.1 Release and Preview Buttons

Release Button
Click on the Release button (or press F8) to take a picture. The picture is automatically downloaded to
the PC, displayed in the main window and saved to disk. Images can be stored on the PC's hard disk,
on the camera's memory card or both. When DSLR Remote Pro for Windows is run it always defaults
to saving images to the PC only. Please select the appropriate option from the "Camera" menu if you
wish to use a different setting.

Note: No picture is taken if the camera is set to auto-focus and is unable to focus.

Preview Button
Click on the Preview button (or press F9) to take a picture in preview mode. The picture is taken as a
small JPEG with normal quality so that it is downloaded to the PC quickly. The picture is not stored on
the PC's disk or the camera's CF card.

Shutter Release Button
The shutter release button displayed below the histogram simulates pressing the shutter release on the
camera and is only available with the Canon EOS 50D, Canon EOS 7D, Canon EOS 5D Mark II and
later cameras.

Move the mouse pointer over the shutter release button to simulate half pressing the camera's shutter
release. Normally this will activate the camera's auto focus system (depending on the camera's
settings).

Press the shutter release button to simulate fully pressing the camera's shutter release. This will take a
single picture if the drive mode is set to single shot or a series of pictures if the drive mode is set to
continuous shooting. Pressing the shutter release button can also be used to take photos when mirror
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lockup is selected.

Remote Manual AF Mode
Recent cameras with live view have the option to take pictures without activating the camera's auto
focus. To use this option set the AF mode to "Remote Manual" in the "AF Mode:" dropdown list in the
main window.

3.2 Reviewing and deleting images

Reviewing Previous Images
You may review previous shots by pressing the "<- Prev Image" and "Next Image ->" buttons or by
using the left and right cursor keys. The main and preview images displays are updated to display the
selected image together with the histogram display. You can delete previously taken shots in the
normal way. To help identify which shot is being displayed the status bar shows the filename of the
image and its number in the sequence e.g. [3 of 5].

When a picture is taken the display is updated to show the new shot.

Deleting Images
Press the Delete key to delete the current picture. If the picture was saved to disk it is deleted from the
disk and removed from the display.
Note: Pictures saved to the CF card are not deleted.

3.3 Changing camera settings

Changing Camera Settings
The camera settings can be changed using the controls in the main window or directly using the
camera's controls. When the settings are changed on the camera they are updated and displayed in
the main window. Not all controls can be changed in all camera modes (e.g. the shutter speed can only
be set in Manual and Tv exposure modes) and so some controls are "grayed out" when they are not
applicable.

Operation is more reliable if "Ignore camera updates" is selected from the Camera menu when taking
pictures using the camera's controls. When this is selected the settings shown in the main window
display are not updated to reflect changes in the camera's setting. You can update the settings display
by pressing F5.

Notes
1. The lens can only be zoomed by physically turning the zoom ring on the lens
2. Depending on the camera model the focal length display may not be updated in the main window until

the next picture is taken
3. You can only switch between manual and autofocus using the switch on the lens
4. There is no way to take a exposure reading and display it in the main window without taking a test

shot
5. The exposure mode for the EOS-1D series cameras can be set from the PC. For other camera

models it can only be selected by turning the mode dial on the camera
6. The flash exposure compensation, drive mode and AF mode can only be set using the camera

controls when using a Canon EOS-1D and 1DS (also Kelvin color temperature for the EOS-1D). This
is a limitation of the cameras' firmware and may be adjustable from the PC in a future release if
Canon release new firmware.
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3.4 Full screen mode

Full Screen Mode
Press F11 or select "Full Screen" from the view menu to display images in full screen mode. Press the
Escape key or F11 to exit full screen mode.

In full screen mode the images fill the screen. The following keyboard short cuts are available when in
full screen mode:

F7 View image

F8 Release the shutter and save the image

F9 Take preview shot

F11/Esc Exit full screen mode

Delete Delete current image

Cursor left Display previous image

Cursor right Display next image

Cursor up Increase size of caption text

Cursor down Decrease size of caption text

Ctrl+C Toggle caption display on and off

Ctrl+F Toggle focus point overlay display on and off

Ctrl+G Toggle grid overlay display on and off

Ctrl+W Toggle black and white display mode on and off

3.5 Bulb Mode and Mirror Lockup

Bulb Mode and Mirror Lockup
Timed bulb exposures controlled from the PC are available with cameras from the Canon EOS-1D
Mark III onwards. This includes the Canon EOS 40D, Canon EOS 50D, Canon EOS 60D, Canon EOS
70D, Canon EOS 77D, Canon EOS 80D, Canon EOS 6D Mark II, Canon EOS 6D, Canon EOS 7D, 
Canon EOS 7D Mark II, Canon EOS 800D/Rebel T7i, Canon EOS 760D/Rebel T6s, Canon EOS 750D/
Rebel T6i, Canon EOS 700D/Rebel T5i, Canon EOS 650D/Rebel T4i, Canon EOS 600D/Rebel T3i,
Canon EOS 550D/Rebel T2i, Canon EOS 500D/Rebel T1i, Canon EOS 450D/Rebel XSi, Canon EOS
100D/Rebel SL1, Canon EOS 200D/Rebel SL2, Canon EOS 2000D/Rebel T7, Canon EOS 4000D,
Canon EOS 1300D/Rebel T6, Canon EOS 1200D/Rebel T5, Canon EOS 1100D/Rebel T3, Canon EOS
1000D/Rebel XS, Canon EOS 5DS R, Canon EOS 5DS, Canon EOS 5D Mark IV, Canon EOS 5D
Mark III, Canon EOS 5D Mark II, Canon EOS-1D C, Canon EOS-1D X Mark II, Canon EOS-1D X,
Canon EOS-1D Mark III, Canon EOS-1D Mark IV and Canon EOS-1Ds Mark III). To take a bulb
exposure first set the camera shutter speed to "bulb". Then either press the "Release" button to start
the exposure and again to end it or select the "Time-lapse/bulb shooting..." option from the Camera
menu.

It is not possible to use bulb mode with older cameras when triggering the shutter release from the PC.
This is a limitation of the camera not DSLR Remote Pro for Windows. Pictures can still be taken in bulb
mode by pressing the camera's shutter release button.

Mirror lockup can be used with all cameras that support mirror lockup if the picture is taken by pressing
the camera's shutter release or by using a remote release cable. Some older cameras (e.g. Canon
EOS 10D) can use mirror lockup and be triggered from the PC. With these cameras the mirror will flip
up and the picture will be taken after a 2 second delay.
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Canon EOS 50D, Canon EOS 7D, Canon EOS 5D Mark II and later models:
Pictures can be taken from the PC with mirror lockup enabled by pressing the shutter release button
which is located in the main window below the histogram display.

3.6 Auto Bracketing

Auto Bracketing

DSLR Remote Pro for Windows has flexible settings for auto bracketing (taking a sequence of shots
using different exposure settings) which simplify the taking of shots which are later combined together
to form a single HDR (high dynamic range) image. To enable auto bracketing select the "Auto-bracket"
checkbox and then click on the "Settings..." button to display the auto bracket settings dialog below:

You can set the number of shots in the sequence using the first dropdown list. Then set the number of
exposure stops should separate each shot. This can be 1/3, 2/3, 1, 1 1/3, 1 2/3 or 2 stop per shot
depending on your camera's settings (if your camera is set to use 1/2 stop increments instead of 1/3
stop increments selecting a value of 1/3 or 2/3 stop increments will result in 1/2 stop increments being
used).

The different exposures are set using the camera's exposure compensation control if the one of the
auto exposure modes is selected. If manual exposure mode is selected the exposure will be varied
using either the shutter speed or the aperture according to the settings in this dialog. Normally it is
better to keep the aperture constant (and hence the depth of field) and vary the shutter speed.

DSLR Remote Pro for Windows can optionally run a command at the end of the auto bracket sequence
to combine the shots. To do this click on the "Execute command at end of auto bracket sequence"
checkbox and enter the name of the program or script to run. In the screenshot above the script
"photomatix.bat" has been entered. This will run the Windows batch file "photomatix.bat" which
combines the images using Photomatix Pro (which can be purchased from http://www.hdrsoft.com) and
displays the result in BreezeBrowser Pro (http://www.breezesys.com/BreezeBrowser ). The batch file
can be found in the DSLR Remote Pro for Windows installation folder (usually C:\Program
Files\BreezeSys\DSLR Remote Pro for Windows) and makes use of the command line interface for
Photomatix Pro. Please use photomatix3.bat with Photomatix Pro 3.1 and photomatix2.bat with
Photomatix Pro 2.

Suggested procedure for auto bracketing:
1. Use a tripod and compose the shot as required
2. Switch to manual exposure mode and low ISO setting to maximize the quality
3. Set the required aperture (e.g. use a small aperture like f/16 for good depth of field)

http://www.hdrsoft.com
http://www.breezesys.com/BreezeBrowser
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4. Take a preview shot to determine the correct exposure (this can be judged by looking at the
histogram display). It may be necessary to take a number of test shots to get the correct exposure.
Adjust the exposure by changing the shutter speed

5. Set the lens to manual focus and focus carefully
6. Set the required number of shots and number of stops separating each shot (a 5 shot sequence with

1 stop increments is a good start, more shots may be required if the brightness range in the shot is
very large)

7. Press the "Release" button and DSLR Remote Pro for Windows will automatically take the sequence

Auto exposure bracketing is particularly useful for product shots and for taking pictures of the interiors
of buildings. The photos below compare the results from a single exposure of the interior of a church
with an image which was blended from seven separate exposures taken using DSLR Remote Pro's
auto bracketing feature:

  

Photo of the interior of St Andrews Church, Sherborne St John, Hampshire, England.
(The image on the right was created by blending the auto bracketed images using a separate image
editor which is not part of DSLR Remote Pro for Windows)

The seven shot auto bracket sequence used to create the blended exposure above:

3.7 Grid and focus point overlays

Grid Display
To toggle the grid overlay on the preview image type Ctrl+G or select "Display Grid" from the "View"
menu. Select "Grid Settings..." from the "View" menu to display the "Grid Settings" dialog, shown
below:
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Select the show print area checkbox to show the extent of a particular print size. For example most
digital SLRs shoot images with an aspect ratio of 3:1 which fits perfectly on a 6"x4" print but needs to
be cropped if it is printed on 10"x8" paper. You can display extent of a 10"x8" print by setting the print
aspect ratio to 10 x 8.

NOTE: The grid display is only displayed on the preview image and doesn't affect images saved to
disk.

Focus Point Overlay Display
To toggle the focus point overlay display type Ctrl+F or click on the "Display overlay" checkbox. When
the focus point overlay display is enabled the seven focus point areas and the viewfinder circle are
displayed over the preview image. Active focus points are displayed in red.
Focus points can be selected from the PC for all camera models except the EOS-1D and EOS-1DS.
This is a limitation of the Canon SDK and may change in a future release.

NOTE: The focus point overlay display is only displayed on the preview image and doesn't affect
images saved to disk.

3.8 Flashing highlight and shadow display

Flashing Highlight Display
Select "Flashing Highlights" from the "View" menu to display over-exposed areas by highlighting them
flashing on and off in black. Under exposed areas can also be displayed and these are highlighted in
blue.

The method of calculating the highlight values and the threshold at which to start flashing them can be
specified by selecting "Highlight Settings..." from the "View" menu. When the highlight method is set to
"Luminosity" the luminosity or brightness of the image is used to calculate the highlight values. When it
is set to "RGB value" the largest of the red, green and blue channel values is used.

NOTE: The flashing highlight display is only available for images displayed in the main window. It is not
available in full screen mode or the image preview window.

3.9 Screen blanking

Blanking the Screen
To avoid extraneous light from the computer display affecting the lighting setup the screen can be
blanked when taking a photo. To do this click on the "Camera" menu and select "Blank screen when
taking photo". When this option is selected the screen will be automatically blanked when the shutter is
released from the PC. The screen will be restored after the camera has finished taking the picture. The
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screen may also be restored by clicking the left mouse button.

3.10 Editing Images and Editor Setup

Editing Images and Editor Setup
Right click on the image and select "Edit Image" to open the image in an image editor (or press F3).
For this feature to work you need to tell DSLR Remote Pro for Windows how to run the image editor by
selecting "Setup Image Editor" from the File menu.

Select the "Use the Windows Explorer 'Open' command" option to use the same editor or viewer as
when you open or double-click an image in Windows Explorer.

Select the other option and enter the command line in the edit box to specify a different editor.

Select "Automatically edit image when a photo is taken" to automatically load images into an editor
when they are taken. Please take care not to load too many images into your editor as Windows may
run low on memory causing the editor or DSLR Remote Pro for Windows to fail. You can specify
whether to automatically edit raw and JPEG files, raw files only or JPEG files only using the dropdown
list. 

NOTES:
1. Only images saved to disk can be edited. Preview images cannot be edited.
2. Most image editors cannot open Canon raw files directly and will display an error message if you try

to edit a raw image.

Using Tokens

The command line can use tokens to allow the command to be modified or the command to be made
conditional. If the command line is an empty string the editor command will be ignored.

Example 1: only running a Photoshop droplet in photo booth mode if the photo booth images folder
contains the string "droplet"
The command to run a Photoshop droplet is: droplet.ahk {photoboothimage}
(see Modifying photos before printing for details)

The {photoboothDir} token returns the path of the photo booth images folder.
The {contains,str1,str2} token can be used to test whether the photo booth images folder contains the
string 'droplet' e.g. {contains,{photoboothDir},droplet}.
If {if,test,str1,str2} token can be used to return the droplet command or an empty string by using the
result of the {contains,str1,str2} token e.g. {if,{contains,{photoboothDir},droplet},droplet.ahk
{photoboothimage},}

Breaking this down using two example photo booth images folders:
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1. C:\event\droplet - {photoboothDir} will return C:\event\droplet
{contains,{photoboothDir},droplet} expands to {contains,C:\event\droplet,droplet} and returns 1
{if,{contains,{photoboothDir},droplet},droplet.ahk {photoboothimage},} expands to {if,1,droplet.ahk
{photoboothimage},} and returns droplet.ahk {photoboothimage} and so the command will run

2. C:\event\normal - {photoboothDir} will return C:\event\normal
{contains,{photoboothDir},droplet} expands to {contains,C:\event\normal,droplet} and returns an
empty string
{if,{contains,{photoboothDir},droplet},droplet.ahk {photoboothimage},} expands to {if,,droplet.ahk
{photoboothimage},} and returns an empty string and so the command will not be run

Example 2: only performing AI background removal in photo booth mode if the photo booth images
folder contains the string "aibg"
The command to run the AI background removal utility is: C:\Program Files (x86)\BreezeSys\DSLR
Remote Pro\RemoveBackground.exe

The {photoboothDir} token returns the path of the photo booth images folder.
The {contains,str1,str2} token can be used to test whether the photo booth images folder contains the
string 'aibg' e.g. {contains,{photoboothDir},aibg}.
If {if,test,str1,str2} token can be used to return the AI background removal command or an empty string
by using the result of the {contains,str1,str2} token e.g.
{if,{contains,{photoboothDir},aibg},C:\Program Files (x86)\BreezeSys\DSLR Remote
Pro\RemoveBackground.exe,}

Please note: to use the droplet.ahk AutoHotKey script you need to install AutoHotKey v1.1 on your
computer. This is a free download from https://autohotkey.com

3.11 Displaying Images in BreezeBrowser Pro

BreezeBrowser Pro v1.9.4.4 onwards
BreezeBrowser Pro will automatically monitor a folder and display new images as they are taken. It
can also automatically update a slideshow to display new images. To enable this select "Monitor folder
for chjanges and update display automatically" in BreezeBrowser Pro's preferences (under the General
tab).

BreezeBrowser Pro v1.9.4.3 and earlier releases
Images can be automatically displayed in BreezeBrowser Pro after they have been taken and
downloaded to the PC. To do this select "Setup image editor..." from the File menu and set it up to run
the command BBProDisplay.exe as shown below:
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3.12 Adding comments and IPTC data

Adding Comments
Comments can be automatically added to images as they are taken by entering the comment text in the
edit box located above the histogram.
Comments may be edited in existing images by right clicking on the image and selecting "Edit
comments..." from the menu. Comments can only be edited in images that have been saved to the
computer's disk.

Adding IPTC Data
DSLR Remote Pro for Windows can be setup to automatically store IPTC data in raw and JPEG
images as they are taken (this option is only available when saving images to the PC's hard disk).
Select "Add IPTC data to images" from the "File" menu to enable this function. The IPTC data to be
stored in the image may be edited by selecting "Edit IPTC..." from the "File" menu and the dialog below
will be displayed:

Click on the tabs along the top of the dialog to select the different IPTC data types. Settings may be
saved for future use by pressing the "Save to file..." button and loaded using the "Load from file..."
button.
IPTC data can be entered as normal text or as special tokens which are evaluated when the photo is
taken e.g. %Y for the year. Please see the IPTC tokens page for a list of the available tokens.

3.13 The Image Preview Window

To display an enlarged preview window select View Image from the Image menu (or press F7). The
image preview window can be left on the screen while more pictures are taken to monitor composition
or focus in critical areas e.g. the eyes of a model during a portrait session. The preview window is
automatically updated when the image in the main window changes.

The image can be scrolled by moving the scroll bars or by clicking the left button on the mouse and
dragging the image. If the image preview window is still displayed when a picture is taken it will be
updated to show the same area of the new shot. This is very useful for monitoring important areas of
the image e.g. a model's eyes when taking portraits.

When shooting JPEG images the preview is the same size as the final image. To avoid a lengthy delay
converting raw images the embedded JPEG is displayed (cameras that shoot CRW raw files) or the
associated JPEG when shooting in raw+JPEG mode with the EOS-1D and 1DS. The size of the
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embedded JPEG for Canon EOS 10D raw files is set using the RAW+JPEG custom function (CFn 8).

NOTE: No image is displayed in the Image preview window when shooting in raw mode with an EOS-
1D or 1DS. This is because the raw file only contains a small preview image. Please select Raw+JPEG
mode if you wish to display images in this window.

3.14 Auto Reconnect

When auto reconnect is selected from the "Camera" menu DSLR Remote Pro for Windows will attempt
to reconnect to the camera every 5 secs if it becomes disconnected. DSLR Remote will display a red
screen saying "Not connected" to clearly indicate that the connection has been lost.

The connection to the camera will be lost if the USB cable is removed, the CF card door is opened, the
camera is switched off or the battery becomes flat or is removed.

Warning: Do not disconnect the camera from the computer while images are being downloaded. This
may result in some images being lost and may confuse the USB drivers making it necessary to reboot
the PC before reconnecting.

In full screen photo booth mode auto reconnect will automatically restart the photo booth mode, enable
the live view if required and display the "ready" screen when the camera is connected.

3.15 Suppress Image Display

Select this option from the "View" menu if you do not need the images to be displayed on the PC.
Selecting this option gives a slight improvement in the download speed when shooting multiple pictures.
This is useful if the pictures are being captured to the PC and then forwarded to some other system e.
g. by FTP to a picture desk.

3.16 Color Management

DSLR Remote Pro for Windows supports the color management of images displayed in the main
window and when printing photo booth images. Color management helps produce more accurate and
consistent colors when displaying and printing images. DSLR Remote Pro for Windows uses the
perceptual rendering intent for both the display and printing of images. A detailed explanation of color
management is beyond the scope of this help file.

Select "Color management settings..." from the File menu in the main window to display the color
management settings dialog:
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Color Management of displayed images
Select a suitable color profile for your monitor by clicking on the "..." browse button or clicking on the
"Use default monitor profile" button. Next select a suitable color profile for your camera. Normally this
will be the sRGB Color Space profile unless your camera is set to AdobeRGB in which case it should
be the AdobeRGB 1998 profile. Then select "Enable color management of displayed images" to enable
color management.
Please note: For performance reasons color management is only applied to images displayed in the
main and full screen windows. It is not applied to live images or images displayed in photo booth mode.

Color Management of printed images
First select a suitable color profile for your camera as described above. Next select a suitable color
profile for your printer by clicking on the "..." browse button. Most printer manufacturers provide generic
color profiles for their printers, often with different profiles for different papers. Then select "Enable
color management of printed images" checkbox to color manage the printing of photos for more
accurate colors. 
IMPORTANT: Please disable color management in the printer driver when selecting color management
in DSLR Remote Pro for Windows otherwise the colors may be adjusted twice.

4 Camera Settings

Select "Set date/time and owner string..." from the Camera menu to display the "Camera Settings"
dialog:

This dialog shows information about the camera and allows you to synchronize the camera's internal
clock with your PC's clock and set the Canon camera owner string.

Please note: It may not be possible to sychronize all Canon cameras with the PC's clock to the exact
second but it is possible for it to be no more than one second out of sync.

Select "Automatically synchronize clock when camera is connected" if you would like DSLR Remote Pro
for Windows to automatically synchronize the camera's clock to the PC's time each time it connects to
the camera.
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5 Live View Display

Select "Live View" from the "Camera" menu in the main window or type Ctrl+L to select the live view
and display the live view window.
If the camera is not already in live view mode the mirror will flip up and the camera will enter live view
finder mode. The controls in the main DSLR Remote Pro for Windows window can still be accessed
when the live view window is displayed. If the live view window is covered by other windows it can be
displayed by typing Ctrl+L when the main DSLR Remote Pro for Windows window is displayed. Closing
the live view window will cause the camera to exit live view mode unless the live view image is also
being displayed on the camera's LCD. The window can be resized to display a larger live view image.

With recent cameras the display of live view images on camera's LCD display can be turned on or off
by right clicking on live view display and selecting "Display live view on camera LCD" or by typing
Ctrl+D. Turning on the camera's LCD also enables the camera controls and activates the HDMI video
feed (these are normally disabled when live view is selected from the PC).
If the camera's LCD is accidentally left on after closing the live view window it can be turned off by
typing Ctrl+D.
Note: The camera's LCD cannot be controlled remotely when using older camera models that do not
have HDMI connectors

Live view images can either be displayed full frame as in the screenshot above or zoomed as shown
below. The white rectangle shows the area of the zoomed image. The position of the zoomed area
relative to the rest of the frame is also shown in the navigation window in the bottom left hand corner.
The zoomed area can be moved by clicking on the white rectangle and dragging it using the mouse or
by dragging the rectangle in the navigation window. Double click the left mouse button over the image
or the navigation window to move the zoomed area and switch to the zoomed view.

Click on the "Release" or "Preview" buttons to take a image or a preview shot. The shot will be
displayed in the main DSLR Remote Pro for Windows window.
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The lens can be focused using the arrow buttons or by using the mouse wheel. The "<<<" button shifts
the focus nearer by a large increment, "<<" focuses nearer by a medium increment and "<" can be
used for fine adjustment. Similarly the ">", ">>" and ">>>" focus farther away by small, medium or
large increments.
The mouse wheel provides a very effective way to adjust the focus. When the Shift key is held down
the mouse wheel adjusts the focus in large increments. When the Ctrl key is held down the mouse
wheel adjusts the focus in medium increments and when no keys are held down the mouse wheel can
be used for fine focus adjustments. The lens can also be focused using the cursor left and right keys
with the Ctrl and Shift selecting medium or large increments respectively.
Please note: The lens should normally be set to the auto-focus setting for the focus controls to work.
Some lenses, e.g. Canon EF 17-40mm F/4 L, can also be focused when the lens is set to manual
focus.
Canon PowerShot cameras: the "<<<", "<<", "<", ">", ">>" and ">>>" buttons and the mouse wheel
control the lens zoom when using a Canon PowerShot camera.

Select the "DoF preview" check box to stop the lens down to the currently selected aperture to assess
the depth of field.

Right click on the image to display a menu for selecting AF focus point display, continuous AF in live
view (if supported by the camera model) and to activate auto focus. With recent Canon camera models
the camera is able to auto focus during live view. This can be activated by right clicking and selecting
"Auto focus using live view" or by typing the keyboard shortcut Ctrl+F. The AF status will be shown in
the live view window's title bar as "AF: in progress" followed by "AF: fail" or "AF: sucess" and the active
focus points will be briefly shown in green (to indicate success) or red (to indicate failure) at the end of
the AF sequence.

Right click on the image to display a menu for enabling or adjusting the grid overlay display. The live
view shares the same grid overlay settings as the image display in the main window.

The live view refresh rate can be adjusted by exiting DSLR Remote Pro and then running the Configure.
exe utility (which is in the installation folder) and selecting "EvfIntervalInMS" in the EVF section. The
default setting is 80ms (approximately 12 fps). The minimum interval  (i.e. maximum frame rate) will
depend on the camera model and the computer.

A live histogram can be displayed in the full frame view showing the intensity (or brightness) and the
red, green and blue channels. Right click on the histogram to enable or disable the display of each
channel.
Please note: The histogram display is only available when live view exposure simulation is set in the
camera's custom functions (CFn IV:16 for the Canon EOS-1D Mark III, CFn IV:7 for the Canon EOS
40D) and the full frame live view display is selected.

Electronic level display
An optional electronic level can be displayed in live view for camera models that support it (Canon EOS
7D Mark II, Canon EOS 5DS R, Canon EOS 5DS, Canon EOS 5D Mark IV, Canon EOS 5D Mark III,
Canon EOS-1D C, Canon EOS-1D X, Canon EOS-1D X Mark II, Canon EOS 6D Mark II, Canon EOS
6D, Canon EOS 70D and Canon EOS 80D at the time of writing). To display the electronic level right
click on the live view display and select "Display electronic level".

Focus Peaking (experimental)
Press and hold down the F2 function key to enable live view focus peaking which will highlight areas in
focus in red. The sensitivity of focus peaking can be adjusted by changing the following setting in the
Windows registry (you need to exit DSLR Remote Pro for Windows before changing this setting):
HKEY_CURRENT_USER\Software\BreezeSystems\DSLRRemotePro\100\EvfFocusPeakingThreshold
The default setting is 200. Please note that the focus peaking display is experimental and may change
in future releases.
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Overlay
An optional overlay image can be displayed over the live view images to help composition e.g.
registration marks could be displayed to help align the camera when taking id photos. The overlay
image should be a PNG file with transparency information in the alpha channel. It should be in
landscape orientation with an aspect ratio of 3:2 e.g. 1024x680 pixels in size. Once a suitable overlay
image has been defined it can be displayed by right clicking on the live view image and selecting "Load
overlay image...". An example overlay image called example_overlay.png can be found in the DSLR
Remote Pro for Windows installation folder.

The zoomed area can be moved by clicking the mouse on the image and dragging as required or by by
dragging the white rectangle in the navigation window. It can also be moved by double clicking in the
navigation window.

Double click on the live view image or uncheck the "Zoom" check box to return to the full frame view.

The camera controls are automatically disabled when live view mode is selected but the camera
settings can still be adjusted using the controls in the main DSLR Remote Pro for Windows window.
Press the camera's "Set" button to display the live view image on the camera's rear LCD. In this mode
most of the camera's controls may be used to adjust the camera's settings and the shutter release
button can be used to take pictures.

Auto Focus
Type Ctrl+F to activate auto focus in the full screen or zoomed live view displays. During auto focus the
AF status is shown in the title bar of live view window. It may take several seconds for optimum focus
to be achieved and in some cases (e.g. where the contrast in the image is low or the live view images
are very noisy due to low light levels) it may not be possible to achieve accurate focus.

In main view the area defined by the white rectangle is used to define the auto focus area. The
rectangle can be dragged to a new position to auto focus in a different area of the live view image. In
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the zoomed view the central 1/5 area of the image is used for auto focus. The focus area is highlighted
in red during AF.

Hold down the Shift key when typing Ctrl+F to activate the auto focus using fine adjustments only for
fasting focusing if the image is nearly in focus already.

Limitations: Because it takes several seconds to auto focus in live view it is not suitable for handheld
shots or for moving subjects. Auto focus may fail if the image is very out of focus when AF starts, if the
focus area has poor contrast or if the live view images are very noisy due to low light levels. Lenses
which focus in large steps when using the fine focus settings (the "<" and ">" buttons) and lenses which
focus by different amounts when focusing nearer or farther may cause AF to fail to achieve optimum
focus in live view.

Remote Manual AF Mode and Live View AF Modes
Recent cameras support auto-focus in live view and have a number of different AF modes (e.g. quick
mode, live mode and face detect). These can be selected using the "AF Mode:" dropdown list in the
main window. When the AF mode is set to "Remote Manual" and the camera is triggered remotely from
the PC auto-focus will not be used.

EVF Upscaling
The size of the live view (aka EVF) images depends on the camera model e.g. mid to high end models
like the Canon EOS 50D are 1024x680 pixels, Canon EOS 450D/Rebel XSi images are 848x560 pixels
and Canon EOS 1000D/Rebel XS images are 768x512 pixels. By default the Live View window will
enlarge (or upscale) the images to fit the window. This can produce pixelated images or other display
artefacts depending on the amount of upscaling or the type of subject being photographed. If this is a
problem EVF upscaling can be disabled by right clicking  on the image and deselecting "Allow EVF
upscaling".

Mirroring and rotating the live view display
The live view images can be rotated by selecting one of the orientation settings from the View menu in
the main window. It is not possible for the computer to read the camera's orientation from the built-in
orientation sensor and so the "Use orientation sensor" setting will have the same result as the
"Landscape" setting.
The image can be mirrored by right clicking on the full frame live view image and selecting "Mirror
image" from the popup menu. This will mirror the image horizontally and is applied after the live view
image has been rotated.

Saving a copy of the zoom region
An optional copy of the zoom region can be saved when taking photos when live view is active. When
this option is selected a JPEG showing the full frame is downloaded to the PC as normal and a second
JPEG is created which is cropped to show the zoom region. The second JPEG is saved with suffix
"_cropped" appended to the filename e.g. if the full frame JPEG is saved as IMG_0001.JPG the
second JPEG will be saved as IMG_0001_cropped.JPG.
When the live view is zoomed in the cropped JPEG will show the same area as displayed in the live
view window. When the live view is not zoomed the cropped JPEG will show the same area as white
rectangle representing the zoom area.
To enable or disable this option right click on the live view display and select "Save copy of zoom region
when taking photo".
Please note that this option only works when live view is active and JPEG photos are taken and saved
to the PC. It does not work if the image quality is set to raw only or if live view is not active.

Onion Skinning
Onion skinning is where the current live view image is displayed on top of a previous image help line up
a shot. This is very useful when taking stop motion animations and in other situations where it is
important to accurately line up the camera for consecutive shots.
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Onion skinning is only available when the full frame view image is displayed. To start onion skinning
right click on the view image and select "Onion skinning" from the menu. By default the background
image is updated whenever a photo is taken but this behavior can be disabled if required.

The background image used for onion skinning can be saved and loaded to from the a file. This is
useful when doing stop motion animation and you wish to save the background at the end of the day
and load it again to continue work the next day. It also means you can save the background image, edit
it in an image editor to add reference marks and then load it back into the live view window.

Another use for onion skinning is when taking panoramas. The onion skinning background can be offset
to the left or right for panoramas taken in horizontal format or to the top or bottom for vertical format.
The background is offset by 60% and is used to help align the next shot in the panorama.

Please note: Onion skinning is not currently supported with the "Mirror image" option and will not work
properly if this option is selected.

Motion Detection
The live viewfinder display can be used to feed images to Webcam Zone Trigger motion detection
software which instructs the camera to take a photograph when motion is detected. Applications
include security monitoring and wildlife photography. Webcam Zone Trigger motion detection software
is developed by a company called Omega Unfold and can be purchased from their website.
To use motion detection first connect the camera to your PC and run DSLR Remote Pro for Windows.
When DSLR Remote Pro for Windows is running and connected to your camera  run Webcam Zone
Trigger and select "Connect to Breeze Systems PSRemote software". When live view is active you
should see the live view display from the camera in the Webcam Zone Trigger window. Now select
"Add Trigger" in Webcam Zone Trigger and a circle showing the area being monitored will appear in the
viewfinder window. Use the mouse to drag the circle to the area you wish to monitor. When motion is
detected the circle will turn blue and a picture will be taken. It make take a few seconds for the camera
to take the picture.

Arranging Windows
Type Ctrl+A to automatically arrange the live view and main windows. Repeatedly pressing Ctrl+A will
cycle through the following window layouts:
1. Main window resized to just show the controls and positioned on the left of the screen with the live

view window occupying the rest of the screen. This mode is useful for viewing the live view and
adjusting the camera settings from the computer.

2. Live view window filling the screen - useful for composing and focusing the image
3. Main window filling the screen - useful for viewing images that have been taken

Keyboard Shortcuts
The following keyboard shortcuts can be used when the live view is displayed:
Spacebar or F8 Take a picture
F9 Take a preview image
Ctrl+F Activate contrast detect AF
Shift+Ctrl+F Activate contrast detect AF using fine focus adjustments only
Ctrl+L Close the live view window
Cursor left Focus closer by a small increment
Ctrl+Cursor left Focus closer by a medium increment
Shift+Cursor left Focus closer by a large increment
Cursor right Focus farther by a small increment
Ctrl+Cursor right Focus farther by a medium increment
Shift+Cursor right Focus farther by a large increment
Cursor up Zoom the preview
Cursor down Select full frame display
Ctrl+O Toggle onion skinning on and off

http://www.zonetrigger.com/wzt.html
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Ctrl+B Capture current live view image as onion skinning background
Ctrl+A Arrange the main and live view windows
Ctrl+Z Zoom in/out
Ctrl+Tab Cycle through: Controls+AF area display->AF display but no controls-

>live view images only

6 Power Zoom

DSLR Remote Pro can remote control the lens optical zoom in live view when using the Canon PZ-E1
power zoom and a compatible zoom lens and camera model. The zoom setting can be adjusted when
using the live view dialog or in photo booth mode when live view is active.

The Canon PZ-E1 power zoom is a separate accessory that clips on to the Canon EF-S 18-135mm
1:3.5-5.6 IS USM zoom lens and is powered by four AAA batteries.

Compatible lenses and cameras

The Canon PZ-E1 power zoom lens attachment is only compatible with the Canon EF-S 18-135mm
1:3.5-5.6 IS USM lens. It will work on any camera that accepts EF-S lenses, but only the following
camera models support remote control of zoom when shooting tethered:

Canon EOS 90D
Canon EOS 80D
Canon EOS 77D
Canon EOS 800D/Rebel T7i
Canon EOS 250D/200D Mark II/Rebel SL3
Canon EOS 200D/Rebel SL2

Live View Operation

When the live view window is displayed when using a compatible camera with the Canon PZ-E1 power
zoom a zoom control will appear under the live view image and the zoom status will be displayed in the
window title bar:
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Drag the zoom slider to the left to zoom out (wider focal length) or to the right to zoom in (longer,
telephoto focal length). Move the slider a short distance from its mid setting to zoom slowly or move it
more to increase the zoom speed. When zooming the live view window's title bar will display "Power
Zoom: Driving" followed by one or more chevrons indicating the speed and direction of the zoom.

Status messages displayed in the window title bar:
"Power Zoom: Ready (wide)" - The lens zoom is at its widest setting (18mm) and zoom can be
controlled remotely
"Power Zoom: Ready (tele)" - The lens zoom is at its longest telephoto setting (135mm) and zoom can
be controlled remotely
"Power Zoom: Ready" - The lens zoom is somewhere between its widest and most telephoto settings
and zoom can be controlled remotely
"Power Zoom: Driving >>>" - The lens is zooming in
"Power Zoom: Driving <<<" - The lens is zooming out
"Power Zoom: Manual zoom selected" - The MZ/PZ switch on the PZ-E1 is set to the MZ position and
the zoom cannot be controlled remotely. Move the switch to the PZ position to enable remote control of
zoom.
"Power Zoom: Battery low or missing" - The four AAA batteries in the PZ-E1 unit or low or missing
"Power Zoom: Too hot" - The PZ-E1 unit is too hot and needs to cool down before it can be used

Photo Booth Operation

The PZ-E1 can also be controlled using keyboard shortcuts or touchscreen actions in photo booth
mode when the ready screen is displayed (stills or video) and live view is active.

Keyboard shortcuts (active in ready screen when live enabled):
Ctrl+Alt+cursor up - optical zoom in using PZ-E1
Ctrl+Alt+cursor down - optical zoom out using PZ-E1
Ctrl+Alt+cursor right - digital zoom in
Ctrl+Alt+cursor left - digital zoom out

Touchscreen actions (active in ready screen when live enabled):
"Power zoom in" - optical zoom in using PZ-E1
"Power zoom out" - optical zoom out using PZ-E1
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"Electronic zoom in" - digital zoom in
"Electronic zoom out" - digital zoom out

7 Video Capture

Video capture is available using all recent Canon DSLR, mirrorless and PowerShot cameras.

General Operation

Canon cameras can only capture video to the camera's memory card and with live view enabled. To
capture video with DSLR Remote Pro for Windows first make sure the camera has a memory card with
sufficient free space and the camera is setup for video capture (please see below for information on
how to setup each camera model for video capture). Next, live view should be selected and the "Rec"
button pressed to start and stop video capture. During video capture a small red circle together with
the approximate duration of the video is displayed in the bottom left corner of the live view image. At
the end of video capture a small thumbnail file will be downloaded to DSLR Remote Pro and displayed
in the main window. This thumbnail file has a .THM file extension and is for identification purposes only -
the main .MOV movie file is stored on the camera's memory card.

The main .MOV movie file is stored on the camera's memory card. To download the movie file to the
PC first close the live view window and then either select "Download movies..." from the Camera menu
or right click on the thumbnail image and select "Download movie". After a movie file has been
successfully downloaded it can be automatically deleted from the memory card to free up space (by
selecting the option to delete movie files in Preferences). The memory card can also be formatted by
selecting "Format memory card..." from the Camera menu. Please use this option with care as it will
erase the memory card and any images or movies that have not been downloaded will be lost.

The normal live view focus and histogram options are available during live preview and video capture.
The zoom option is only available during live preview and can be used to zoom into an area to check the
focus. The lens can be focused in small, medium or large steps using the <<<, <<, <, >, >> and >>>
buttons or by using the middle wheel on the mouse.

Canon EOS 5D Mark IV
Please note that 720p 120fps fast video mode is not supported in DSLR Remote Pro. If this setting is
used the camera may lock up and will need to be turned off and the battery removed to reset it. 

Canon EOS 5D Mark II
Please use firmware version 2.0.4 or later for the best results. The latest camera firmware can be
downloaded from Canon's website.

In the camera settings the live view function setting should be set to "Stills+movie" and the screen
settings should be set to "Movie display". The "Movie rec. size" should be set to the required resolution
and frame rate as these cannot be set remotely from the PC.

Select live view in DSLR Remote Pro for Windows (e.g. by typing Ctrl+L) and the live view window will
be displayed. This will show shaded areas defining the frame extent either above and below the image
if 1920x1080 resolution is selected or to the left and right if 640x480 resolution is selected (the
resolution is also displayed in the window title bar). Press on the "Rec" button to start recording a video
clip and a red circle together with the duration of the video will appear in the bottom left corner of the
live view display. Press the "Rec" button again to stop recording - the red circle and video duration will
disappear and a small thumbnail will be automatically downloaded to the PC and displayed in the main
DSLR Remote Pro window.
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The camera's LCD needs to be turned on in order to use the camera's controls to capture video. This
can be done by right clicking on the live view display in DSLR Remote Pro for Windows and selecting
"Display live view on camera LCD" or by pressing the live view button on the camera. The "Set" button
can now be used to start and stop recording.

Canon EOS 1D Mark IV, Canon EOS 5D Mark III, Canon EOS 7D,
Canon EOS 6D and Canon EOS 70D
The EOS 7D and EOS-1D Mark IV have a dedicated movie/camera switch on the back of the camera.
If this switch is in the movie position when the camera is switched on the start/stop button needs to be
pressed in order to be able to use live view. Videos can be captured from the PC with the movie/
camera switch in either position, but can only be controlled using the camera's start/stop button if the
movie/camera switch is in the movie position. The various options are described below:

Movie/camera switch in the movie position when camera turned on: run DSLR Remote Pro for
Windows and press the start/stop button on the camera once it has connected to the camera. Videos
can be started by pressing the start/stop button on the camera and stopped by pressing the start/stop
button again. Videos can also be started and stopped from the PC by selecting live view (e.g. by typing
Ctrl+L) and pressing the "Rec" button.

Movie/camera switch in the camera position when camera turned on: video can be captured from
the PC by selecting live view (e.g. by typing Ctrl+L) and clicking on the "Video" button. The live view
images will display shaded areas defining the video extent and the video resolution and frame rate will
be displayed in the live view window title bar. Press on the "Rec" button to start recording video and
again to stop recording. Alternatively video mode can be selected by moving the movie/camera switch
on the camera to the movie setting - this will allow the camera's start/stop button to be used to start
and stop video capture.

The video resolution and frame rate can be selected from the PC by right clicking on live view display in
DSLR Remote Pro for Windows and selecting the required setting from the menu. Pease note that the
video resolution ad frame rate can't be changed during video capture.

Canon EOS 60D, Canon EOS 550D/Rebel T2i, Canon EOS 600D/
Rebel T3i, Canon EOS 1200D/Rebel T5 and Canon EOS 1100D/
Rebel T3
These cameras have a dedicated movie setting on the camera's exposure mode dial. Videos can be
captured from the PC with the exposure mode dial set to any setting, but can only be controlled using
the camera's record button if the exposure dial is set to the movie position.

If the camera's exposure mode dial is set to the movie position video capture can be started by
pressing the record button on the camera and stopped by pressing the record button again.Videos can
also be started and stopped from the PC by selecting live view (e.g. by typing Ctrl+L) and pressing the
"Rec" button.

If the camera's exposure mode dial is not set to the movie position video capture can only be controlled
from the PC. To do this first select live view (e.g. by typing Ctrl+L) and then press the "Video" button. 
The live view images will display shaded areas defining the video extent and the video resolution and
frame rate will be displayed in the live view window title bar. Press on the "Rec" button to start
recording video and again to stop recording.

The video resolution and frame rate can be selected from the PC by right clicking on live view display in
DSLR Remote Pro for Windows and selecting the required setting from the menu. Pease note that the
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video resolution ad frame rate can't be changed during video capture.

Canon EOS 500D/Rebel T1i
The EOS 500D/Rebel T1i has a dedicated movie setting on the camera's exposure mode dial and this
must be set to the movie position in order to be able to capture video. Please note that the Canon EOS
500D/Rebel T1i cannot be used for video capture from a PC without having access to the camera's
controls. In order to capture videos you must have access the camera to either turn the exposure mode
dial to the movie setting or to press the "Rec" button.

Exposure mode dial is set to the movie position when the camera is turned on: run DSLR
Remote Pro for Windows and press the start/stop button on the camera once it has connected to the
camera. If the "Save to camera only" option is selected in DSLR Remote Pro for Windows videos can
be started by pressing the start/stop button on the camera and stopped by pressing the start/stop
button again. Videos can also be started and stopped from the PC by selecting live view (e.g. by typing
Ctrl+L) and pressing the "Rec" button.

Exposure mode dial not set to the movie position when the camera is turned on: when DSLR
Remote Pro for Windows is run normal live view operation is available but video capture is not possible.
To enable video capture turn the exposure mode dial to the movie position. If the "Save to camera only"
option is selected in DSLR Remote Pro for Windows videos can be started by pressing the start/stop
button on the camera and stopped by pressing the start/stop button again. Videos can also be started
and stopped from the PC by selecting live view (e.g. by typing Ctrl+L) and pressing the "Rec" button.

The video resolution and frame rate is displayed in the live view window's title bar but can only be
changed from the camera.

Trouble shooting
If "busy" is displayed on the camera's LCD when the "Rec" or "Start/Stop" button is pressed it means
that movie mode needs to be selected on the camera (either by turning the exposure mode dial to
movie or by setting the movie/camera switch to movie).

If nothing happens when "Rec" or "Start/Stop" button is pressed on the camera please try selecting the
"Save to camera only" option in DSLR Remote Pro for Windows' Camera menu.

If the live view window does not display live view images you may need to press the "Rec" or "Start/
Stop" button on the camera.

8 Focus Stacking

Focus stacking is a technique for increasing the depth of field by taking a series of photographs with
different focus settings and then combining them together using the areas in focus from each image.
This technique is useful for macro and close-up photography, landscapes, product photography and any
other image where the depth of field is critical and the subject isn't moving.

The live view display in DSLR Remote Pro for Windows makes it very simple to automate the process
of taking a sequence of images with different focus settings by running a script. There is no need to
touch the camera and the mirror stays locked up during the sequence which minimizes the chances of
camera shake or movement. Once the pictures have been taken they can be combined using free
software such as CombineZM or commercial software like Helicon Focus (the example on this page
was combined using CombineZM).

http://www.hadleyweb.pwp.blueyonder.co.uk/CZM/combinezm.htm
http://www.heliconsoft.com/heliconfocus.html
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Image combined using CombineZM from a series of 40 individual shots shot taken with a Canon EOS
40D and Tamron 90mm macro lens set f/5. This is a full frame image which has been resized to fit on
the page and shows the edge effects to the left and right of the image resulting in the text being
reflected and also edge effects at the top and bottom. These can easily be cropped from the final
image but it is worth noting that it is a good idea not to frame the image too tightly when taking the
photos.

Single shot taken with Canon EOS 40D with Tamron 90mm macro lens at f/5. A smaller aperture could
have been used to get greater depth of field but the image quality would be affected due to diffraction
effects if too small an aperture is used. One of the advantages of the focus stacking technique is the
lens can be set at its optimum aperture to give the best possible quality.

How to take the photos using DSLR Remote Pro for Windows

What do you need? 
1. A Canon DSLR which supports live view e.g. Canon EOS 40D or Canon EOS-1D Mark III 
2. A copy of DSLR Remote Pro for Windows (you can use the free trial version for 15-days) and a USB

cable connecting your camera to your computer 
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3. A sturdy tripod to hold the camera steady while taking the sequence 
4. AutoHotKey - a free scripting tool which can be downloaded from http://www.autohotkey.com 
5. focus_stacking.ahk - an AutoHotKey script for taking the photos and adjusting the focus which can

be found in the DSLR Remote Pro for Windows installation folder (usually C:\Program
Files\BreezeSys\DSLR Remote Pro for Windows)

6. CombineZM - a free program for combining the images (download CombineZM) 

First mount the camera on the tripod, select manual exposure mode and compose the shot, roughly
focusing the lens on the subject. Then connect the camera to your PC using the USB cable and run
DSLR Remote Pro for Windows. Activate the live view on the PC by typing Ctrl+L and use the mouse
wheel or cursor keys focus the lens on the nearest part of the subject. Finally, double click on the
focus_stacking.ahk file to run the script to take the photos. DSLR Remote Pro's live view window will
appear and a sequence of shots with different focus settings will be taken. Please don't touch you
computer while the sequence is being taken otherwise it may not work properly. 

By default the focus_stacking.ahk script will take 30 images. This can be changed either by editing the
script using a text editor or by running the script from the Windows Command Prompt and specifying
the number of images on the command line e.g.

C:\> focus_stacking.ahk 15 

Combining the images (or focus stack)

Run CombineZM and select "New" from the "File" menu. Locate the folder containing the images taken
earlier, select all the images in the file open dialog and click "Open". CombineZM will load the images
(this may take a few seconds). Then select "Do Stack" from the "Macro" menu to combine the image
(this may take a few minutes). When it has finished the combined image will be displayed in
CombineZM's main window. The image can be saved by selecting "Save Frame/Picture As" from the
"File" menu. 

9 Time Lapse

Select "Time-lapse..." from the "Camera" menu to take time-lapse shots. With cameras from the Canon
EOS-1D Mark IV, Canon EOS-1D Mark III, Canon EOS-1Ds Mark III, Canon EOS 5DS R, Canon EOS
5DS, Canon EOS 5D Mark IV, Canon EOS 5D Mark III, Canon EOS 5D Mark II, Canon EOS 6D,
Canon EOS 7D, Canon EOS 7D Mark II, Canon EOS 70D, Canon EOS 60D, Canon EOS 50D, Canon
EOS 40D, Canon EOS 600D/Rebel T3i, Canon EOS 550D/Rebel T2i, Canon EOS 500D/Rebel T1i,
Canon EOS 450D/Rebel XSi, Canon EOS 1100D/Rebel T3 and Canon EOS 1000D/Rebel XS onwards
this dialog can also be used to control timed bulb exposures.

The time lapse sequence can be set to start immediately or to start at a particular time and date. You
can either specify an end time and date for the time lapse sequence or the number of frames in the
sequence.
You can specify the interval between shots.

Note: If you set the interval to a time shorter than that required to take and download the picture the
sequence will run as fast as possible.
Press the "Start" button to start the time lapse sequence.

http://www.autohotkey.com
http://www.hadleyweb.pwp.blueyonder.co.uk/CZM/combinezm.htm
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When using a camera that supports timed bulb exposures the "bulb exposure duration" settings will be
displayed in this dialog. These settings will be available if the camera's shutter speed is set to "bulb"
otherwise they will be grayed out as shown in the screenshot above. The bulb exposure duration can
be set to any number of hours, minutes and seconds up to 24 hours and will start when the "Start"
button is pressed.  The bulb exposure can be canceled at any time by pressing the "Cancel" button.

10 Photo Booth Shooting

Start here

The quickest way to get started is to setup your printer and then use the photo booth setup wizard to
set everything else up for you.
You can then change the appearance of the screens by editing the JPEG screen images in an image
editor such as Photoshop or Photoshop Elements.
Then use the print layout editor to edit the print layout or to load a different preset print layout.
The advanced settings can be used to fine tune the settings.

A series of shortcut buttons to provide quick access to key photo booth options can be displayed at the
top of the main window:
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The photo booth shortcut buttons can be turned on or off and button text edited by selecting "Photo
Booth Shortcuts" from the View menu.

The main window display can be simplified by hiding the camera controls that are normally displayed
down the left side of the window. To do this click on the View menu and uncheck "Show Camera
Controls".

Which camera?

Best overall: Canon EOS 200D/Canon Rebel SL2 or Canon EOS M50
The Canon EOS 200D/Canon Rebel SL2 and Canon EOS M50 are currently some of the best all round
cameras for photo booth use. The dual pixel phase detect auto focus in live is excellent and makes it
practical to use auto focus in both stills and video photo booth modes. Both cameras also support the
use of an external microphone making them suitable for video booth use.
The Canon EOS M50 is the most compact camera in the Canon EOS range and is capable of slow
motion video capture (120fps capture with 30fps play back).

Best budget model for stills and video: Canon EOS 200D/Rebel SL2, Canon EOS 800D/Rebel T7i
or Canon EOS 750D/Rebel T6i
These models all have very similar performance in both stills and video.They support a range of
different video resolutions and the use of an external microphone making them suitable for video booth
use as well as stills.
The Canon EOS 200D/Canon Rebel SL2 also has Canon's excellent dual pixel face detect auto focus in
live view.

Best budget model for stills: Canon EOS 2000D/Rebel T7, Canon EOS 1300D/Rebel T6
The Canon EOS Rebel T7 is currently the cheapest model in the Canon DSLR range and is ideal for
use in a stills photo booth. It is not ideal for video booth use because it does not accept an external
microphone.

Which Printer?

You can use any Windows compatible printer, but for a professional photo booth we recommend using
a dye-sublimation printer capable of printing 4"x6" photos and automatically cutting them into two 2"x6"
strips.

More detailed help...

Topics covered in this section:
Photo booth setup wizard
Editing the print layout
External flash mode (see also Camera settings)
Touchscreen settings
Saving settings for future reference and using profiles
Print layout
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Other output options
Images displayed to the user
Inactivity timer
Running external commands
Touchscreen keyboard
Animated GIFs
Keyboard shortcuts
Using external buttons for photo booth shooting
In operation
Reprinting photos after an event
Green screen shooting
Live view overlay
How to create PNG images using Photoshop and Photoshop Elements
Video booth shooting
Uploading to social networking and photo sharing sites

Please also see the series of articles on photo booth shooting on our website.

10.1 Photo Booth Setup Wizard

The photo booth setup wizard provides a fast and simple way of creating the screens and the print
layout for common photo booth configurations.

Running the Photo Booth Setup Wizard

If the photo booth shortcut buttons are displayed at the top of the main window simply click on the
"Photo Booth Setup Wizard" button (if the shortcuts buttons aren't displayed select View->Photo Booth
Shortcuts to display them).
Alternatively click on the File menu and select "Photo Booth Setup Wizard..."

Select the options you wish to use in each of the photo booth wizard screens (described below) and
then press the "Finish" button to create the photo booth settings. The settings are saved to a file named
settings.xml in the photo booth images folder. These settings can be loaded again by pressing the
"Load..." in the photo booth settings dialog.

Step 1: Specify the photo booth images folder
This step allows you to specify the name of the folder where the various screen and layout images
should be stored and looks like this:

http://www.breezesys.com/articles/photobooth.htm
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The optional Event Kite gallery id is used to identify the gallery when using Event Kite online galleries
and micro-sites. The value can be accessed in print captions, emails and QR codes using the
{eventKiteGalleryId} token. 
This field can be left empty if you are not using Event Kite and can be edited using the event info dialog
(select File->Photobooth event info...).

Enter the name of the photo booth images folder. The screens for the photo booth and the optional
layout images will be saved in this folder and can be edited later using an image editor to personalize
the look of your booth.
Press the "Next >" button to go to step 2.

Step 2: Specify user interface options
This step allows you to specify the options available to users of your photo booth and looks like this:

https://www.eventkite.co/
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First select the photo booth modes you wish to use:
"Photos only" - creates a photo booth setup which only offers still photos
"Photos or boomerang GIFs" - creates a photo booth which allows the user the choice of still photos or
boomerang GIFs
"Photos or video" - creates a photo booth which allows the user the choice of still photos or capturing a
short video
"Boomerang GIFs only" - creates a photo booth which only offers boomerang GIFs
"Video only" - creates a photo booth which only offers the option to capture a short video

When "Photos or boomerang GIFs" option is selected the "Single ready screen" option can be used.
When this is selected the ready screen will have a start button for photos and a start button for
boomerang GIFs (the ready.jpg and video_ready.jpg screens will be the same). If this option is not
selected the photo ready screen (ready.jpg) will have a start button and a button to switch to
boomerang GIFs. The boomerang GIF ready screen (video_ready.jpg) will have its own start button
and a button to switch back to stills photo booth mode.

Next select the theme - the default theme is "Tradewind Blue". Different themes can use different
buttons or have different screen backgrounds. Themes can also have different screen captions e.g. to
generate screens in a different language.

The following themes come with DSLR Remote Pro:
"Miami" - a simple black or white interface, with options optimised for various screen configurations
"Pop-o-Matic" - a retro themed interface, with options optimised for various screen configurations
"Tradewind Blue" - a clean modern set of buttons with icons on a blue background
"Tradewind Blue - manual layout" - example of how to manually position buttons and touchscreen
actions on the ready screen
"Tradewind White" - similar to Tradewind Blue but with a white background
"Simple round buttons" - simple round buttons with text
"German" - the simple round buttons theme with captions in German
"Italian" - the simple round buttons theme with captions in Italian
"Polish" - the simple round buttons theme with captions in Polish
"Romanian" - the simple round buttons theme with captions in Romanian
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The "Tradewind Blue" and "Tradewind White" designs were created by The Wilkes Booth Co. Please
visit "The Lab" for more exciting interface designs, filters, actions and GIF overlays from the Wilkes
Booth Co. .
Please see the section on configuring the setup wizard for information on how to create your own
themes.

Select the button placement to specify how the buttons for touchscreen actions are positioned on the
screens.
The "sides" option places the buttons down the left and right sides of the screens.
The "bottom" option places the button along the bottom of the screens.
Note: The button images in the theme folder may include manual sizing and placement information in
which case the button placement option will not affect the layout

Select the live view style:
"normal (3:2)" - this will display the live view images at the camera's normal aspect ratio so that they
occupy about half the screen
"square (1:1)" - this will crop the live view images so that they are square and occupy about half the
screen. The print layout will show square photos and the animated GIFs will also be square
"4:3" - this will crop equal amounts from the sides of the live view images so that they have an aspect
ratio of 4:3 and occupy about half the screen. The photos in the print layout and animated GIFs will
also be cropped to give an aspect ratio of 4:3
"full screen" - this will crop the live view images and resize the it to fill the whole screen. The photos in
the print layout and in the animated GIFs will be cropped to match the aspect ratio of the screen. This
option will also automatically create ready_overlay.png and video_ready_overlay.png screens to show
the start and other buttons.
"disabled" - this option creates a setup with live view disabled e.g. for a magic mirror booth

Notes:
1. The full screen option is only intended to be used with landscape orientation displays. If it is used on

a portrait orientation screen it may result in excessive cropping of the live view images.
2. The square and full screen live view options are not suitable for capturing videos because videos are

saved without modification and won't match the live view display if it is cropped.

Next select the screen background color and the text color to use for screen captions. The default
settings are white text on a black background. Please note that if your selected theme provides a
background image this will be used instead of the screen background color.
The captions used on each screen can be edited by clicking on the "Edit captions..." button. There is no
need to change these settings unless you wish to change the default captions or the language used.
Please see the section on configuring the setup wizard for more information about editing the screen
captions.

"Use touchscreen" - select this option if your booth has a touchscreen. The setup wizard will
automatically add buttons and touchscreen actions to the screens shown to users.
Select the style of buttons to use for the screens. The default setting is for simple round buttons. A
selection of different buttons styles come with DSLR Remote Pro and you can add your own styles.
Please see the section on configuring the setup wizard for more information.

"Allow users to select B&W or color prints" - If the "Use touchscreen" option is selected this option will
add buttons and touchscreen actions to allow users to choose color or B&W prints. If "Use
touchscreen" is not selected this option will do nothing but users will be able to select B&W or color
using the keyboard shortcuts Ctrl+B and Ctrl+C.

"Preview each photo after it is taken" - when this option is selected a full screen preview will be
displayed for 3 secs after each shot is taken.

http://wilkesbooth.co/
http://wilkesbooth.co/the-lab/
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"Display thumbnails of the photos taken so far" - select this option to display a small thumbnail of each
shot taken so far down the right hand of the screen. Each screen will have a series of small gray
rectangles added to show where the thumbnails will be placed. Please see the section on the optional
thumbnail display for more information.

Select "Create slideshow GIF" to create a animated slideshow GIF or MP4 showing the individual
photos captured in photo mode.

Select "Digital only" when one of the photo modes is selected to create and share the print layout
without printing it.

"Display print preview and ask for confirmation before printing" - when this option is selected a full
screen preview of the print layout will be displayed before printing. If the "Use touchscreen" option is
selected buttons and touchscreen actions allowing users to print or reject the photos will be added. If
the "Use touchscreen" option is not selected users need to press A to accept the print or X to reject it.
If the "Use touchscreen" option is selected you can also define the maximum number of copies the user
can select in the confirm printing screen. The photo booth wizard will create buttons and touchscreen
actions for increasing the number of print copies and display these on the right hand side of the screen.
Multiple confirm_printing.jpg screen will be created: confirm_printing_1.jpg which is displayed when 1
copy is selected, confirm_printing_2.jpg for 2 copies, confirm_printing_3.jpg for 3 copies etc.

"Add print option in sharing screen" - select this option to allow users to print photos from the sharing
screen.

The touchscreen keyboard position setting controls where the touchscreen keyboard is displayed when
entering email addresses or mobile phone numbers for texting. It has three options:
1. "top" - displays the keyboard at the top of the screen.
2. "offset from the top" - specifies how from the top of the screen the keyboard should be displayed in

pixels.
3. "bottom" - displays the keyboard at the bottom of the screen. This is the default settings.

"Twitter tweet" - select this option to allow users to post photos their personal Twitter feed direct from
the photo booth (requires an internet connection). Please see the section on uploading photos to social
networks for more information on posting photos to Twitter.

"MMS/SMS" - select this option to allow users to text photos to their cellphone via MMS or SMS
(requires an internet connection and an account with Twilio.com). Please see the section on uploading
photos to social networks for more information texting photos.

"Email photos" - select this option to allow users to email photos direct from the photo booth (requires
an internet connection). Please see the section on uploading photos to social networks for more
information on emailing photos.

"Enable video booth mode (10 sec video capture)" - select this option if you are using a camera which
supports video (e.g. a Rebel T3i/EOS 600D) and wish to offer users the option to record a 10 second
video (the settings can be adjusted later using the "Video Booth Settings" dialog).

Select the "Capture 'boomerang' animated GIFs to capture boomerang style animated GIFs instead of
normal videos. This will set everything up to create a an animated GIF that is approximately 3 secs long
and plays forwards then backwards at approximately double speed.

The inactivity timeout can be set to switch the booth to standby mode and display the welcome.jpg
screen after a preset number of seconds if there is no user input. Set this to 0 to disable the inactivity
timeout. The inactivity timeout is useful if the photo booth is not in continuous use because it disables
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the live view display and puts the booth into standby mode. Disabling live view will allow the camera's
sensor to cool down to avoid possible overheating problems. The booth can be switched back to the
ready screen by pressing F6 or touching the screen (if available).

Click on the "Use default settings" button to load the default settings for the photo booth setup wizard.
This will select photos only using the Tradewind Blue theme with black text on a light gray background. 

If photo mode is selected press the "Next >" button to go to step 3 to setup the printer and select the
print layout. If photo mode is not selected press the finish button to create the photo booth settings and
screens.

Step 3: Printer Settings and Print Layout
This step displays the current printer settings and asks you to select a print layout. The settings for a
Mitsubishi CP70D printer loaded with 6x4 paper are shown below:

First check the printer settings and click on the "Setup printer..." button if they need changing.
Please note: if you printing a double strip of 3 or double strip of 4 photos and are using a dyesub
printer which can cut a 4"x6" sheet into two 2"x6" strips you need to select this option in the printer
driver by clicking on the "Setup printer..." button.

Next select one of the seven print layout options:

"Classic double strip of 4 photos" - This prints two columns of four images side by side as shown
below:
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"Single strip of 4 photos" - This prints a single column of four images as shown below. This option is
useful for printers like the Sony UP-DR200 which can cut 6x2 strips from 6x4 paper and treat these as
6x2 pages.

"Double strip of 3 photos" - Similar to the "Classic double strip of 4 photos" but with only three photos
and more space for logos etc.
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"Single strip of 3 photos" - Similar to the "Single strip of 4 photos" but with only three photos and more
space for logos etc.

"1 large photo with 3 smaller ones below" - This layout gives plenty of space for logos and captions as
shown below:
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"2 rows of 2 photos" - This option fills the page with four equally sized photos arranged in a 2 x 2 grid:

"Single photo" - This option fills the page with a single photo:

When you have selected your preferred layout press the "Finish" button to create the photo booth
settings and screens

What happens next?

Please try running the booth and taking a set of photos to check the print layout. If the photos aren't
correctly centered on the page or the gaps between the photos is too large you can adjust the settings
by clicking on the "Print Layout" shortcut button (or by selecting File->Photo Booth settings... and
clicking on the "Settings..." button to the right of the "Custom layout" checkbox. Please see the section
on the print layout editor for more details.
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Logos and other graphics can be added to the prints by creating a background.jpg image and editing
this in an image editor. The background.jpg image needs to be the same size in pixels as the print
output. The easiest way to create a background.jpg image is to set the output to JPEG only and take a
set of test photos. Then edit the JPEG copy of the print layout in an image editor to add logos etc. and
save this in your photo booth images folder as background.jpg.

The various screens presented to the user are defined using JPEG images saved in the photo booth
images folder. The look of your booth can be customized simply by editing the screen JPEGs using an
image editor such as Photoshop Elements. The screen that is shown when the booth is ready to take
the next set of photos is called ready.jpg. Please see the section on images displayed to the user for
more details.

There are many other settings that can be adjusted. Please see the section on advanced photo booth
settings for more information. There is a series of articles on our website which includes lots of useful
information about photo booth shooting and a section giving answers to frequently asked questions.

Configuring the setup wizard

Themes

Themes provide a way of customizing the appearance of the screens created by the photo booth setup
wizard. A theme can have its own touchscreen button designs, modify the screen background and
change the text used for the captions in the screen images. Themes are defined by creating subfolders
in the "wizard" folder in the DSLR Remote Pro installation folder. The name of the subfolder defines the
theme's name and this is what appears in the theme dropdown list in step 3 of the setup wizard.
For example, the default theme is "Simple round buttons" and is defined by the contents of the folder:
C:\Program Files (x86)\BreezeSys\DSLR Remote Pro\Wizard\Simple round buttons
Please note: You need administrator privileges to modify files in the "Program Files (x86)" folder. This
is because Windows protects the programs folder to prevent the files from being damaged.
The photo booth setup wizard looks for the Wizard folder in your documents first and then looks in the
"Program Files (x86)" folder. Copy the Wizard folder to your documents folder to make it easier to
modify its contents e.g.

 

Button Style

The buttons used for the touchscreen actions in the screens created by setup wizard are defined using
PNG images. The setup wizard looks in the subfolder for the selected theme for PNG files representing
the buttons e.g. Start.PNG for the start button. If the theme's subfolder does not define the button the

http://www.breezesys.com/articles/photobooth.htm
http://www.breezesys.com/articles/photobooth8.htm
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setup wizard will use the default button design in the buttons subfolder.
e.g. If the selected theme is "Simple round buttons" the wizard will look in the folder "C:\Program Files
(x86)\BreezeSys\DSLR Remote Pro\Wizard\Simple round buttons" for a PNG image named Start.PNG
to define the start button. If the folder does not contain a Start.PNG image the setup wizard will use the
default button, "C:\Program Files (x86)\BreezeSys\DSLR Remote Pro\buttons\Start.PNG" instead.

The following PNG button images are used by the setup wizard:

photo_start.png - start button in photo mode (defaults to start.png if there is no photo_start.png image)
boomerang_start.png - start button for boomerang GIFs (defaults to start.png if there is no
boomerang_start.png image)
video_start.png - start button in video booth mode (defaults to start.png if there is no video_start.png
image)
bw.png - select B&W in photo and animated GIF ready screens
color.png - select color in photo and animated GIF ready screens
gif.png - select boomerang GIFs
photo.png - select normal photo booth mode
video.png - select video booth mode
print_confirm.png - accept prints in confirm printing screen (defaults to accept.png if print_confirm.png
not found)
print_cancel.png - reject prints in confirm printing screen (defaults to reject.png if print_cancel.png not
found)
minus.png - reduce the number of copies to print in print confirmation screen
plus.png - increase the number of copies to print in print confirmation screen
email.png - email button in the sharing screen
mms.png - texting button in the sharing screen
print.png - print button in the sharing screen
twitter.png - Twitter button in the sharing screen
cancel.png - button to exit the sharing screen
replay.png - replay video in video playback screen
accept.png - accept animated GIF or video
reject.png - reject animated GIF or video
green_screen_settings.png - display green screen settings dialog (requires <options> for sizing and
placement)
creative_filter_settings.png - display creative filter settings dialog (requires <options> for sizing and
placement)
photo_preview_accept.png - accept the photo that has just been taken (requires <options> for sizing
and placement)
photo_preview_retake.png - retake the photo that has just been taken (requires <options> for sizing
and placement)
photo_preview_abort.png - reject the photo that has just been taken and return to the ready screen
(requires <options> for sizing and placement)
welcome.png - optional button to switch to the ready screen from the standby (welcome.jpg) screen
(requires <options> for sizing and placement)
exit.png - optional button to exit photo booth mode (make this fully transparent to create a hidden
button and use <options> for sizing and placement)

By default the PNG button image will be placed on the screen using the current layout option e.g.
arranged down the sides of the screen or along the bottom. The size and placement of each button can
be specified manually by appending the following modifiers enclosed in curly brackets to the end of the
filename:

T - place the center of the button at the top of the screen
B - place the center of the button at the bottom of the screen
L - place the center of the button at the left of the screen
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R - place the center of the button at the right of the screen
W - width of the button
H - height of the button
Each modifier can be followed by a number (to specify the offset in pixels) or a number followed by %
(to specify the percentage offset wrt the screen size). The number can be an integer (e.g. 10, 20, 30)
or have a decimal point for greater precision (e.g. 10.5%).
Note: the aspect ratio of the button is preserved when resizing. If both the height and width modifiers
are used only the last one to be defined will be used to resize the button.

Examples:
start.png - place the start button in the screen using the selected layout option
start_{T}.png - place the start button at the top of the screen, centered horizontally
start_{T50}.png - place the center of the start button 50 pixels down from the top of the screen,
centered horizontally
start_{T10%}.png - place the center of the start button 10% of the screen height from the top of the
screen, centered horizontally
start_{T10%L}.png - place the center of the start button on the left of the screen and 10% of the
screen height from the top of the screen (the left half of the button will be off the screen)
start_{B100R50}.png - place the center of the start button 50 pixels from the right side of the screen
and 100 pixels from the bottom of the screen
start_{T10%W10%}.png - place the center of the start button 10% of the screen height from the top of
the screen, centered horizontally and resize to 10% of the screen width

It is strongly recommended that either all buttons have size and placement modifiers to override the
automatic placement when creating a theme. If some buttons have size and placement modifiers and
some don't it is likely that buttons will overlap.

The "Tradewind Blue - manual layout" theme gives an example of how buttons can be manually
positioned on the ready screen.

Animated GIFs

Each screen can be animated using an optional animated GIF by placing a GIF with the screen's name
in the subfolder for the selected theme e.g. ready.gif for the ready.jpg screen.
If the GIF should play in a continuous loop the suffix _loop should be added to the filename e.g.
ready_loop.gif.

By default the animated GIF will be centered on the screen. The position can be specified by
appending the following modifiers enclosed in curly brackets to the end of the filename:
T - place the center of the animated GIF at the top of the screen
B - place the center of the animated GIF at the bottom of the screen
L - place the center of the animated GIF at the left of the screen
R - place the center of the animated GIF at the right of the screen
W - width of the animated GIF
H - height of the animated GIF
Each modifier can be followed by a number (to specify the offset in pixels) or a number followed by %
(to specify the percentage offset wrt the screen size).

Examples:
ready.gif - place a GIF that plays once in the ready screen and place it in the center of the screen 
ready_loop.gif - place a GIF that plays in a continuous loop in the ready screen and place it in the
center of the screen 
ready_loop_{T}.gif - place a GIF that plays in a continuous loop in the ready screen and place its
center at the top of the screen (the top half will be off the screen), centered horizontally
ready_loop_{T50}.gif - place a GIF that plays in a continuous loop in the ready screen and place its



 54

© 2024 We Fly Kites Inc.

center 50 pixels down from the top of the screen, centered horizontally
ready_loop_{T10%}.gif - place a GIF that plays in a continuous loop in the ready screen and place its
center 10% of the screen height from the top of the screen, centered horizontally
ready_loop_{T10%L}.gif - place a GIF that plays in a continuous loop in the ready screen and place its
center on the left of the screen and 10% of the screen height from the top of the screen
ready_loop_{B100R50}.gif - place a GIF that plays in a continuous loop in the ready screen and place
its center 50 pixels from the right side of the screen, 100 pixels from the bottom of the screen
ready_loop_{T10%W10%}.gif - place a GIF that plays in a continuous loop in the ready screen and
place its center 10% of the screen height from the top of the screen, centered horizontally and resize to
10% of the screen width

Animated GIFs can also be used for the photo, boomerang GIF or video start buttons by naming them:
start_photo.gif - animated GIF for starting the countdown when in photo mode
start_boomerang.gif - animated GIF for starting the countdown when in video booth mode when the
boomerang GIF option is selected in the setup wizard
start_single_ready.gif - special animated GIF for starting the countdowns when "Photos and
boomerang GIFs" and the "Single ready screen" option are selected (see the "Single Ready Screen"
notes section for more information)
start_video.gif - animated GIF for starting the countdown when in video mode when the video option is
selected in the setup wizard
The "start" animated GIFs can use the same modifiers as other GIFs (_loop and T, B, L, R, W, H in
curly brackets). The setup wizard will create the appropriate touchscreen action "start" action over the
animated GIF.

Please note: If a "start" animated GIF is used the setup wizard will not add the equivalent "start" PNG
button to the screen.
Also, if a start_photo.gif animated GIF is used the ready_loop.gif will be ignored. Similarly if a
start_boomerang.gif or start_video.gif is used the video_ready.gif will be ignored. This is because each
screen can only display one animated GIF.

"Single Ready Screen" Notes

When photo booth mode is set to "Photos and boomerang GIFs" and the "Single ready screen" option
is selected the button PNG images and GIFs for animated GIFs are handled differently.

If the theme folder contains a start_single_ready.gif animated GIF this will be used for both the photo
start and boomerang GIF start touchscreen actions and will be saved as ready.gif and video_ready.gif
in the photo booth images folder.
If the GIF is landscape (wider than it is tall) the left half will be used to start taking photos (using the
touchscreen action "Select photobooth+start") and the right half will be used to start capturing a
boomerang GIF (using the touchscreen action "Select video booth+start").
If the GIF is portrait (taller than it is wide) the top half will be used to start taking photos (using the
touchscreen action "Select photobooth+start") and the bottom half will be used to start capturing a
boomerang GIF (using the touchscreen action "Select video booth+start").

If the theme folder does not contain a start_single_ready.gif animated GIF the PNG button for starting
taking photos will be selected as follows:
start_photo_single_ready_{<options>}.png - used if a matching file is found in the theme folder
start_{<options>}.png - used if a matching file is found in the theme folder (and
start_photo_single_ready_{<options>}.png is not found)
photo.png - used if found in the theme folder otherwise the default photo.png image in the buttons
folder is used
 
If the theme folder does not contain a start_single_ready.gif animated GIF the PNG button for
capturing boomerang GIFs will be selected as follows:
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start_boomerang_single_ready_{<options>}.png - used if a matching file is found in the theme folder
boomerang_start_{<options>}.png - used if a matching file is found in the theme folder (and
start_boomerang_single_ready_{<options>}.png is not found)
gif.png - used if found in the theme folder otherwise the default gif.png image in the buttons folder is
used

Separate button PNG images are also available for color and B&W in the single ready screen:
color_single_ready_{<options>}.png - if this button image is not found in the theme folder the color.png
image is used
bw_single_ready_{<options>}.png - if this button image is not found in the theme folder the bw.png
image is used

Screen Backgrounds

By default screens are created with a solid background color using the color specified in step three of
the setup wizard. An image can be used for the background by placing a JPEG image in the subfolder
for the selected theme. The JPEG image should be named background_tiled.jpg,
background_stretched.jpg or background_cropped.jpg. The filename tells the setup wizard what to do if
the background image is not the same size as the computer's screen:

background_tiled.jpg
The screen background is formed by tiling it with the background image starting from the top left hand
corner. e.g. if the screen is 900x600 pixels and  background_tiled.jpg is 100x100 pixels the screen
backgrounds will be formed by tiling 6 rows of 9 copies of the background image:

background_stretched.jpg
The screen background is formed by stretching the background image so that it fills the screen e.g. if
the screen is 900x600 pixels and background_stretched.jpg is 100x100 pixels the screen backgrounds
will be formed by stretching the background image until it is 900 pixels wide and 600 pixels high. If the
background_stretched.jpg image's aspect ratio is not the same as the screen's aspect ratio it will be
distorted to fit:
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background_cropped.jpg
This is similar to the background_stretched.jpg except that the aspect ratio of the background image is
preserved. The background_cropped.jpg image is resized so that it covers the whole screen and any
overlap is cropped off the right hand or bottom edges e.g. if the screen is 900x600 pixels and
background_stretched.jpg is 100x100 pixels the screen backgrounds will be formed by resizing the
background image until it is 900 pixels wide and 900 pixels high and then the bottom 300 pixels are
cropped off the bottom:

Caption text

The text for the captions added to the screens created by the setup wizard defaults to simple captions
in English. These can be edited to create screens in a different language or if you you prefer different
messages.
To edit the caption text click on the "Edit captions..." button in the "Step 3: Specify user interface
options" screen when running the wizard. This will display the dialog shown below:
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The name of the caption to edited is displayed in the list on the left and a description is displayed on the
right. The current text is displayed in the edit box below the description and can be edited as required.
The default text is displayed below the edit box. Press the "Use default" button to copy the default text
into the edit box.
The settings can be saved to file for future reference by clicking on the "Save..." button. Previously
saved settings can be loaded by clicking on the "Load..." button.

The following tokens can be used in the caption text:
{photoboothSubDir} - This is the same as name of the photo booth images folder specified in step 2 of
the setup wizard
{photoboothNumImages} - The number of photos to be taken in stills photo booth mode
{themeName} - The name of the theme selected in step 3 of the setup wizard
{eventName} - Please see this section for more information on the event name and strings.
{eventString1}
{eventString2}
{eventString3}
{eventString4}
{eventString5}

When the setup wizard is run it will look in the selected theme's subfolder for a file named captions.xml
defining the text to be used for the captions in each screen. The captions.xml file doesn't need to
contain all of the text strings used by the wizard. It can be used to modify a few strings e.g. the
captions.xml file below will remove the "Press the Start button to take a photo..." text displayed in the
ready.jpg screens:

<?xml version="1.0" encoding="UTF-8"?>
<dslr_remote_pro version="3.7.3">
<photobooth_wizard_captions>
  <PhotoStartSingle></PhotoStartSingle>
  <PhotoStartMultiple></PhotoStartMultiple>
</photobooth_wizard_captions>
</dslr_remote_pro>

Filters

Filter files and buttons can be added to the setup wizard by placing the filter JPEG file and associated
PNG button image in the wizard theme folder. This option is only available when manual button sizing
and placement is used for the color and B&W buttons (if color and B&W is selected in the wizard) and
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the filter buttons. An optional button image can be defined to indicate that the color, B&W or filter is not
currently selected by appending _unselected to the filename. The setup wizard will create copies of the
ready screens with suitable suffixes so that they are displayed when color, B&W or one of the filter
options is selected.

Example: to create color, B&W and filter1.jpg options with buttons 100 pixels high placed on the top left
of the screen the following files are required:

color_
{T50L50H100}.png

make color button 100 high wide and place in the top left corner of the screen

color_unselected_
{T50L50H100}.png

optional button image displayed when color mode is not selected

bw_
{T150L50H100}.
png

make B&W button 100 pixels high and place under the color button

bw_unselected_
{T50L50H100}.png

optional button image displayed when B&W mode is not selected

filter1_
{T250L50H100}.
png

 make filter 1 button 100 pixels high and place under the B&W button

filter1_unselected_
{T150L50H100}.
png

optional button image displayed when filter 1 is not selected

filter1.jpg the JPEG lookup table file defining filter 1

Additional Files (keyboard, droplets etc.)

By default the wizard will create keyboard.xml files using the screen background color and text color
defined in the user interface options screen. Place a keyboard.xml file in the theme folder to override
these settings. If the wizard finds a keyboard.xml file (e.g. email_keyboard.xml) it will be copied to the
photo booth images folder without modification.
Note: Please don't use the keyboard.xml file in the theme folder to define the actual keys because their
positions will not work with different screen resolutions.

Any files in the wizard theme folder with a .exe file extension (e.g. Photoshop droplets) or a .dll file
extension (e.g. PhotoboothCreativeFilter.dll) are also copied to the photo booth images folder.

10.2 Print Layout Editor

The print layout editor can be displayed by clicking on the "Print layout" photo booth shortcut button in
the main window or by displaying the "Photo booth settings" dialog (File->Photo booth settings...) and
clicking on the "Edit layout..." button in the output options section of the photo booth settings dialog.
Note: if the photo booth shortcut buttons aren't displayed in the main window you can display them by
selecting View->Photobooth Shortcuts

The print layout editor can be used to create your own print layouts from scratch or to load and edit
print layout templates created earlier.
Please visit the templates page on our website to download a selection of free templates.

http://www.breezesys.com/Photobooth/templates.htm
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The right hand side of the window displays the print layout. Photos and captions can be edited
interactively by clicking on them using a mouse and then dragging to position, resize or rotate them.

The left hand area of the window contains controls to help with the layout and for loading and saving
settings:

A Quick tour of the editor

This section gives a quick overview of some of the ways to edit the layout.

Click on the "Preset layouts..." button, select one of the preset layouts (e.g. "1 large, 3 small") and then
click on the "OK" button. The right hand side of the editor should show the page layout similar to the
screenshot above.
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Left click the mouse on photo 2 to select it:

The photo will be highlighted with a dashed red line to show that it has been selected. It will also have a
resize control in each corner and a dashed line in the center with a control for rotating the image.

Move the mouse over the center of the photo (a hand cursor will be displayed) and then click on hold
down the left mouse button and drag the photo to a new position and then release the left mouse
button. The keyboard cursor keys can also be used to adjust the position of the photo e.g. pressing the
left cursor key will move the photo one pixel to the left. Hold the shift key down and press one of the
cursor keys to move the photo 10 pixels in that direction.

Resize the photo by moving the mouse over one of the corners of the photo (a resize cursor will be
displayed) and then click on hold down the left mouse button and drag the corner to resize the photo
and then release the left mouse button.

Rotate the photo by moving the mouse over the control area at the end of the dashed line in the center
of the photo (a rotate cursor will be displayed) and then click on hold down the left mouse button and
move the mouse to rotate the photo and then release the left mouse button. The keyboard cursor left
and right keys can also be used to rotate the photo when the ctrl key is held down e.g. hold down the
ctrl key and press the left cursor key to rotate the photo 1/2 degree to the counter clockwise. Hold the
ctrl and shift keys down and press cursor left or right to snap the rotation to the nearest 15 degrees
and then rotate in 15 degree steps.

Select all the photos by typing Ctrl+A or by right clicking on a photo as selecting "Select all". The
selected photos will be highlighted with dashed red lines and can be dragged as a group by holding
down the left mouse button.

When a photo is selected it is also highlighted in the image position display in the top left corner of the
edit window. The size, position and rotation of the photo can be entered directly by clicking on the "..."
button for that image. Click on the dropdown list to change the photo number (or select "None" to
remove it or "QR code" set it to a QR code).

Add a caption by clicking on the "Edit captions..." button and the dialog below will be displayed:
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Check the "Enable caption" checkbox if it is not already checked. Caption 1 should now be displayed
highlighted on the print layout (if it isn't visible click on the "Move to center" button). Type in the edit box
to change the caption text or click on the "..." button to the right of the "Font:" label to change the font
or to the right of the "Font color:" display to change the color. Click on the "OK" button and the font
should remain highlighted. You can drag, resize and rotate the text using the mouse just the as with a
photo.

Click on the "Undo" button a few times (or type ctrl+Z) a few times to undo the changes. Then click on
the "Redo" button (or type ctrl+Y) to redo the changes.

Note: The dashed line around the layout shows the full printing extent of the printer including any
overlap over the edges of the paper for borderless printing. The inner solid line represents the area of
the final print.

Printer setup and margins

It is a good idea to check the printer settings and printer margins before designing the layout or running
the photo booth setup wizard. To do this click on the "Printer Setup..." button and the "Printer Setup"
dialog will be displayed:

Select the required printer from the dropdown list. If your printer isn't listed you may need to install the
printer drivers first (please see the Windows help files or printer manuals for information on how to do
this).

Click on the "Setup Printer..." button to select the page size, print orientation, print resolution and other
printer settings.
Note: if you want to print a double strip of three or four images and are using a dyesub printer that can
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cut 4"x6" pages into two 2"x6" strips you need to select the 2x6 cut option in the printer driver.

Click on the "Portrait" or "Landscape" radio buttons to change the printer page orientation.

If the selected printer is setup with a page size of 4"x6" and a print resolution of 300 DPI or 600 DPI
(most professional dyesub printers support this) the "Center page" button will be enabled. You can
press this button to setup the margins to center the page in the printable area. This should produce
correctly centered prints with most printers.

Click on the "Test Print" button to print a page to help setup the printer margins. The test print from a
DNP DS40 printer will look something like this:

In the enlarged view of the top margin shown below the top margin can be read off the ruler as 14
pixels:

And in the enlarged view of the bottom margin shown below the bottom margin can be read off the ruler
as 26 pixels:

Check the top, left, right and bottom margins and enter the values in the printer setup dialog, It is worth
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spending time setting up the print margins accurately as this will save time later.

Preset Layouts

The "Preset layouts..." button can be used to help design a number of different popular layouts using
three or four photos. These include a double strip of three or four photos, a single strip of three or four
photos, one large image with a row of three smaller images below and two rows of two images. Simply
select the layout you want, adjust the page margins and image spacing and then press the OK button
and the software will work out the settings for you:

Select the preset layout from the list of layouts in the top left of the window. The right side of the
window shows a preview of the selected layout. The spacing between photos and the top, left, right
and bottom margins can be adjusted using the edit boxes on the left of the window.
Note: The dashed line around the layout shows the full printing extent of the printer including any
overlap over the edges of the paper for borderless printing. The inner solid line represents the area of
the final print.

Click "OK" to copy the layout to the print layout editor.

Editing Photo Positions

A photo can be added to the layout by selecting the photo number from one of the spare image
dropboxes showing "None" in the top left corner of the editor window. Alternatively a photo can be
hidden by setting its dropdown list to "None".

The size, position and rotation of the photo can be edited by left clicking on the photo to select it and
then using the mouse or keyboard cursor keys:
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Move the photo by moving the mouse to the center of the photo (a hand cursor will be displayed) then
hold down the left mouse button and drag the photo to the new position.
Tip: Hold down the shift key to limit the movement to a horizontal or vertical direction only.
Alternatively use the left, right, up and down cursor keys to move the photo one pixel at a time. Hold
down the shift key and use the cursor keys to move the photo 10 pixels at a time.

Resize the photo by moving the mouse to one of the circular control handles in the corners (the resize
cursor will be displayed) then hold down the left mouse button and drag the corner to resize the photo.
The aspect ratio of the photo will be preserved (i.e. the ratio of the width to the height). Hold down the
shift key if to resize the photo without preserving the aspect ratio (this may result in the photos being
cropped when they are printed).

Rotate the photo by moving the mouse to the circular control handle at the end of the red dashed line in
the center of the photo (the rotate cursor will be displayed) then hold down the left mouse button and
move the mouse to rotate the photo.
Alternatively hold down the ctrl key and use the left and right cursor keys to rotate the photo in 1/2
degree increments. Hold down the ctrl and shift keys and use the cursor left and right keys to rotate the
photo in 15 degree increments.

Photos are printed in the order in which they are defined and so if the second photo's position overlaps
the first photo the second photo will be printed on top of the first photo. You can change the order in
which photos are printed by right clicking on a photo and selecting "Move to back", "Move back", "Move
forward" or "Move to front".

You can also enter the photo position and angle directly by clicking on the "..." button for that photo on
the left side of the editor window and it will display the "Edit image position and effects" dialog:
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You can also edit the position by right clicking on the photo and selecting "Edit image position..." from
the popup menu.

The left and top entries specify the distance in pixels of the photo from the left and top edges of the
page respectively. The layout in the print editor window will be updated automatically as you change
the settings. If the photo isn't visible you can press the "Move to center" button to center it on the page.

The width and height entries specify the width and height of the photo in pixels. To preserve the aspect
ratio of the photo you can enter 0 for the width or height and the software will replace this with the
correct value when you press the "OK" button.
Note: Entering a width and height with a different aspect ratio from the photos taken by the camera
(3:2) will result in the photo being cropped when it is printed.

The angle entry specifies the clockwise rotation of the photo in degrees.

The "Effects" section allows different print compositing effects to be applied when the photo is added
to the print layout. Please see the section on Print Compositing for details of the effects that can be
applied.

Editing QR Codes

A QR code can be added to the layout by selecting "QR code" in one of the spare image dropboxes
showing "None" in the top left corner of the editor window. Alternatively the QR code can be hidden by
setting its dropdown list to "None". The size, position of the QR code can then be edited in exactly the
same way as a photo (described in the section headed "Editing Photo Positions" above).

The text encoded in the QR code can be edited by right clicking on the QR code and selecting "Edit QR
code..." from the popup menu. The "QR Code" dialog shown below will be displayed:
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Type in the text you want to be encoded in the QR code. Normally this is a URL which needs to be
prefixed with http:// or https://
The QR code display will be updated automatically as you type in the text. You can test the QR code
by pressing the "Test URL" button to open it in a web browser. You can also test the QR code by
scanning it with a cell phone.

Tokens can be used in the QR code text to dynamically generate the QR code using information
available when the photo is taken. For example if you have a gallery running on a microsite where the
photos are identified by the photo's UID you can use the {uid} token to generate a QR code that links to
the photos in the gallery by setting the QR code text to something like https://mygallery.com/view/{uid}

The error correction dropdown list specifies amount of error correction encoded in the QR code. A
"Medium" setting should be suitable for most uses. You may wish to use the "Low" setting if the URL is
very long or the QR code is to be printed very small.

Note: The QR code text can also be edited by selecting File->Edit QR code from the main program
window.

Adding Logos and Pictures

Click on "Import logo..." to import a PNG or JPEG image into the print layout. Logos can be moved,
resized and rotated just like photos in the print layout.
When a logo image is imported the PNG or JPEG image is copied into the current photo booth images
folder and its filename is prefixed with "logo_". If the photo booth images folder already contains a file
with the same name you are asked whether to overwrite the file. Any copies of the logo in the print
layout will be removed from the layout and replaced by a single copy of the new logo image in the
center of the layout.
If the photo booth images folder already contains one or more PNG or JPEG images with a logo_
prefix they can be added to the print layout by right clicking on the background of the print layout and
selecting "Add logo...".
Please note: logos are added to the print layout after the optional overlay and will appear on top of the
photos and overlay.

Editing Caption Positions

Add a caption by clicking on the "Edit captions..." button and the dialog below will be displayed:
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You can also edit the caption by right clicking on the caption and selecting "Edit caption..." from the
popup menu.

Select the caption you wish to edit using the dropdown box at the top and then check the "Enable
caption" checkbox if it is not already checked. The caption should now be displayed highlighted on the
print layout (if it isn't visible click on the "Move to center" button). Type in the edit box to change the
caption text. Captions span more than one line and can contain tokens such as such as %d for the date
and %t for the time the sequence started, {comment} for the comments entered in the main screen and
{filename} for the filename used for the JPEG copy of the print layout. Please see the section on
tokens for a list of tokens available.

Click on the "..." button to the right of the "Font:" label to change the font, size and style or to the right
of the "Font color:" display to change the color.

Use the "Left offset" and "Top offset" entries to specify the position of the text. This is specified in
pixels from the top left corner of the page. Use the angle entry to specify the angle of the text. This is
specified as degrees rotation in a clockwise direction.

The "Maximum number of lines" and "Line word wrap length in pixels" settings can be used to control
how long captions are displayed. This is useful when using tokens such as {caption} for Instagram
photos where the caption text could be longer than would fit on a single line. The "Line word wrap
length in pixels" setting specifies the maximum length of a line of text (in pixels) before it is word
wrapped to start a new line of text. The "Maximum number of lines" setting specifies the maximum
number of lines that are displayed. This is useful for preventing very long captions from running off the
bottom of the page or into other elements on the page. When these options are used the maximum
extent of the text is shown by a dashed line.

Normally text is left justified (the "Alignment" dropdown list is set to "Left justified") and its position on
the screen is measured from the top left corner of the text area.
If the "Alignment" dropdown list is set to "Centered" the text will be center justified and the position will
be measured from the top center of the text area.
If the "Alignment" dropdown list is set to "Right justified" the text will be right justified and the position
will be measured from the right side of the text area.

Click on the "OK" button to the save the changes. The caption will be selected in the print layout:



 68

© 2024 We Fly Kites Inc.

The size, position and rotation of the can then be edited using the mouse or keyboard cursor keys
similar to moving and resizing photos.

Move the caption by moving the mouse to the center of the caption (a hand cursor will be displayed)
then hold down the left mouse button and drag the caption to the new position.
Tip: Hold down the shift key to limit the movement to a horizontal or vertical direction only.
Alternatively use the left, right, up and down cursor keys to move the caption one pixel at a time. Hold
down the shift key and use the cursor keys to move the caption 10 pixels at a time.

Resize the caption by moving the mouse to one of the circular control handles in the corners (the resize
cursor will be displayed) then hold down the left mouse button and drag the corner to resize the
caption.
Alternatively hold down the ctrl key and use the up and and down cursor keys to resize the caption.

Rotate the caption by moving the mouse to the circular control handle at the end of the red dashed line
in the center of the caption (the rotate cursor will be displayed) then hold down the left mouse button
and move the mouse to rotate the caption.
Alternatively hold down the ctrl key and use the left and right cursor keys to rotate the caption in 1/2
degree increments. Hold down the ctrl and shift keys and use the cursor left and right keys to rotate the
caption in 15 degree increments.

Aligning, sizing and moving multiple items

All the currently defined photos, captions and QR codes can be selected by typing ctrl+A (or by right
clicking and selecting "Select all"). Alternatively just photos can be selected by typing Ctrl+P (or by right
clicking and selecting "Select all photos"). You can refine the selection by holding down the ctrl key and
clicking on the item to be added or removed from the selection.
Tip: All captions can be selected by typing Ctrl+P to select all photos followed by Ctrl+I to invert the
selection (this will unselect all photos and select all captions).

A group of selected images can be moved by holding down the left mouse button and dragging them to
the new position or by using the keyboard cursor keys.

There are various options for aligning a group of selected items e.g. left align so that a group of images
are arranged in a column. To align the currently selected elements right click the mouse on the
reference element and select the required alignment from the "Alignment" menu of the popup menu.
The selected elements will be moved to align them with the reference element.
Note: If this doesn't produce the required result simply type ctrl+Z to undo the changes.

A group of photos can be spaced evenly by selecting them in order and then right click on any of the
selected images and select "Space photos evenly". The order in which the photos are selected is
important because the middle photos will be spaced evenly between the positions of the first and last
photos in the selection. To select the photos in the right order simply left click on the first photo and
then add the remaining photos to the selection in order by holding down the ctrl key and clicking on
them.

A group of photos can be set to the same size and angle as a reference photo by selecting them and
then right clicking on the reference photo and selecting "Make photos same size and angle".

Background Color and background.jpg

Normally the page background is white but it can be set to any color by clicking on the "..." button next
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to the colored square besides the "Show background color" checkbox.

A JPEG image named background.jpg can also be used as a background. This is useful for adding
logos or fancy captions to the print or to add frames around the photos. Ideally the background.jpg
should be the same size in pixels as the printed output (e.g. 1844 x 1240 pixels for a 6"x4" print from a
DNP DS40 printer).
The background.jpg will be centered on the page. If the background.jpg is larger than the page the
excess will be cropped from the top, left, right and bottom. If the background.jpg is smaller than the
page the edges will be stretched to fill the page to avoid thin white margins if the printer heads aren't
perfectly aligned.

The background.jpg should be saved in your photo booth images folder (this is displayed in the title bar
of the print layout editor window). You can copy a JPEG image into your photo booth images folder by
clicking on the "Import background..." button or by dragging and dropping a JPEG file into the print
layout editor window.

To delete a background.jpg image first press the "OK" button to save the print layout and close the
print layout editor window. Then delete the background.jpg from your photo booth images folder.

Note: If the positions of photos and captions don't quite line up with an imported background.jpg they
can be moved by typing ctrl+A (to select all) and then pressing the cursor keys.

Headers and footers

For backwards compatibility with previous releases the print layout can also display a header image
named header.jpg at the top of the page and a footer image named footer.jpg at the bottom of the
page. It is recommended that you avoid using headers and footers and use the background.jpg instead.
This will make it easier save layouts for future reference without them being specific to a particular
printer model.

Overlay

An option overlay can be placed over the photos by placing an PNG image named overlay.png in your
photo booth images folder. You can copy a  PNG image into your photo booth images folder by clicking
on the "Import overlay..." button or by dragging and dropping a PNG file into the print layout editor
window.

The overlay.png will be centered on the page. If the overlay.png is larger than the page the excess will
be cropped from the top, left, right and bottom. If the overlay.png is smaller than the page the edges
will be stretched to fill the page to avoid thin white margins if the printer heads aren't perfectly aligned.

The overlay.png should be saved as a 24-bit color PNG file with an 8-bit alpha channel containing
transparency information.

To delete an overlay.png image first press the "OK" button to save the print layout and close the print
layout editor window. Then delete the overlay.png from your photo booth images folder.

Please see the section headed "How to create PNG images using Photoshop" for notes on how to
create an overlay.png file.

There is an example PNG file named example_overlay.png in the installation folder which can be used
for testing.
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Tip: The current layout can be saved as a JPEG file by holding down the Shift and Ctrl keys and then
clicking on the "Print Test Page" button. This JPEG image can then be loaded into a photo editor such
as Photoshop to add logos, captions etc. and then saved as a background.jpg or overlay.png image
which can be imported into the layout.

Background/overlay filename suffix

The "Background/overlay filename suffix" setting in the "Output Settings" dialog provides a way to
select different backgrounds and overlays for prints, slideshow GIFs and boomerang GIFs. This setting
can use tokens to provide values that are read at run time e.g. random numbers or data entered in the
survey screens. For example to add a randomly selected overlay to a print layout the "Background/
overlay filename suffix" could be set to random{random,1,3}. The token {random,1,3} evaluates to a
random number between 1 and 3 giving a randomly generated suffix. When preparing the print layout
the software will look for an overlay named overlay_random1.png, overlay_random2.png or
overlay_random3.png depending on the random number. If it can't find an overlay file with the filename
suffix it will use the standard filename, overlay.png, instead.

Hiding and showing elements

Use the various "Show" checkboxes to control what is displayed in the print layout preview. This is
useful if you want to simplify the preview display to make it easier to adjust the photo positions.
Please note: Unchecking the "Show" checkbox for an element only affects the print layout preview and
does not affect the final prints.

Undo and Redo

Most actions can be undone by clicking on the "Undo" button or by typing ctrl+Z and redone by clicking
on the "Redo" button or typing ctrl+Y.
You can't undo the "Printer setup", "Import background...", "Import overlay..." or "Import layout..."
actions.

Exporting and importing layouts

You can save a print layout for future reference by clicking on the "Export layout..." button. This will
save the entire layout including any overlay and background images to a single file with a .pblt file
extension.

A previously saved layout can be imported by clicking on the "Import layout..." button or by dragging
and dropping a print layout template file into the print layout editor window. 
It should be possible to import layouts defined for any similar printer (i.e. one with the same page size
and print resolution) provided the print margins were set accurately.
Please note: If your photo booth images folder contains a background.jpg or overlay.png image they
will be deleted or overwritten when importing a print layout.

Please visit the templates page on our website to download a selection of free templates.

10.3 Print Compositing

Print compositing refers to effects that can be applied to photos when they are added to a print layout.
These include opacity, blur, motion blur, colorizing, blend modes, contrast and saturation. To add or

http://www.breezesys.com/Photobooth/templates.htm
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edit the effects applied to a photo right click on the photo in the print layout editor and select "Edit
image position and effects...":

Most effects work best when used with AI background removal or green screen with the transparent
background option but can also be used with normal photos.

The "Use original unprocessed image" setting to use the original image taken by the camera before any
processing such as green screen, AI background removal and AI special effects. This is useful if you
want to show "before" and "after" images.

Click on the "Crop" button to crop the photo:

The left and width cropping values are expressed as a percentage of the image width e.g. to crop the
image to display the left half set left to 0 and width to 50. Or to crop the image to display the right half
set left to 50 and width to 50.
The top and height cropping values work in a similar way and are expressed as a percentage of the
image height.
When an image is cropped its placement in the print layout editor does not change. Instead, the areas
of the image that are cropped out are made fully transparent.

The opacity setting controls the transparency of the photo. Set this to a value between 0 (fully
transparent) to 1 (fully opaque). 
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Example of a single photo being added to the print layout multiple times with different opacity settings

The contrast setting adjusts the contrast of the photo. Set this to a value between 0 and 2 where 0 is
no contrast (i.e. black), 1 is no adjustment and 2 is high contrast.
Setting the contrast to 0 will produce a silhouette when used with AI background removal or green
screen with the transparent background. This can produce interesting effects when used with the
colorize option e.g.

The saturation setting adjusts the saturation of the photo. Set this to a value between 0 and 2 where 0
is fully desaturated producing a B&W image, 1 is no adjustment and 2 is highly saturated. Faded
effects with subdued colors can be created by setting the saturation to less than 1.

The blur option applies gaussian blur to the photo. Select this option then edit the blur radius to control
the amount the photo is blurred.

The motion blur option blurs the photo in a linear direction to give the impression of motion. Select this
option and then edit the radius to control the length of the motion blur. Edit the motion blur angle to
adjust the angle of the blur (the angle is in degrees).
Placing a photo with motion blur on top of the original photo can produce interesting effects e.g.
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The colorize option provide a simple way to convert a photo into shades of a single color. Enable the
colorize checkbox then click on the "..." button to the right of the color swatch to change the color used
to colorize the photo.

The mirror option simply mirrors the image by flipping it horizontally.

The filter dropdown list allows a color lookup table (or LUT) to be applied the the photo. Please see the
section on filters for information on how to create filters.

The blend mode controls how the photo is blended with the print layout.
The following blend modes are available:
normal, multiply, screen, darken, lighten, dissolve, color burn, linear burn, darker color, lighter color,
color dodge, linear dodge, overlay, soft light, hard light, vivid light, linear light, pin light, hard mix,
difference, exclusion, hue, saturation, color, luminosity, subtract, division
A detailed description of each blend mode is beyond the scope of this help file. Please see this
wikipedia article for more information about blend modes: https://en.wikipedia.org/wiki/Blend_modes.
Alternatively use an image editor such as Photoshop that supports levels and blend modes to see the
effect of different blend modes on overlays applied to photos.

https://en.wikipedia.org/wiki/Blend_modes
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Print layout with trees as the background and one photo taken with AI background removal
which is added to the print layout with darken blend mode.

Photo taken with AI background removal then added to the print layout with contrast set to 0
and colorized to create a gray silhouette. Then added the "hey" overlay using a blend mode. 

10.4 Advanced Photobooth Settings

This section gives detailed information about the various photo booth settings. If you want to get
started as quickly as possible you can use the photo booth setup wizard to set everything up and then
come back to this page later to find out more about tweaking the various settings. 
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Setting up the page layout

To setup photo booth operation select "Photobooth Settings..." from the File menu and the dialog below
will be displayed:

First select the number of images to be taken and how they are arranged. This could be a single image
on one sheet of paper (1 image, 1 row, 1 column), a passport style strip of images (e.g. 4 images, 4
rows, 1 column), 2x2 grid of 4 images as shown above or any other arrangement of up to 20 images
arranged in a grid. Alternatively select "Custom layout" and click on the "Settings..." button next to the
checkbox to position each image manually on the page (this is described in more detail later).

Using live view for long periods of time drains battery power and can cause the camera's sensor to
heat up. Most camera models will automatically cancel live view after 30 minutes to prevent
overheating. Full screen photo booth mode has an inactivity timer which will automatically cancel and
restart live view after 25 minutes to prevent the camera from canceling it. Alternatively full screen photo
booth mode can automatically cancel live view and display the welcome.jpg screen image if the photo
booth is not used for a preset time. Live view can also be canceled manually by pressing the F6
function key. Press the F6 function key to reactivate live view and return to ready.jpg screen when the
welcome.jpg screen is displayed. The inactivity timeout can be enabled by setting the "Inactivity in
secs" value to the required number of seconds e.g. 120.

Next select the delay before taking each photo and how long the shot just taken is displayed on screen
when shooting in full screen photo booth mode (this can be disabled by setting the time to 0). After
taking each photo a preview can be displayed on the screen for a specified number of seconds (set this
to 0 to disable the preview). The delay before taking the first photo can be set to a different value than
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that for the remaining photos. This is useful when using a touchscreen as it means a longer delay can
be set before the first photo to give people time to move back from the touchscreen.

When the "Minimum duration in seconds before closing 'processing' screen is set to 0 the 'processing'
screen will be close as soon as the data has been sent to the printer. The 'processing' screen can be
displayed for longer by adjusting this value. This is useful if you want to keep displaying a message
such as "Thank you! Your photos are being printed, please leave the booth now" for longer than it takes
to print the images.

The countdown text is displayed before shooting each image and is updated every second. The
following tokens can be used:
@imageNumber@ - the shot number in the photo booth sequence
@numberOfImages@ - the number of images in the photo booth seconds
@secsToNextPhoto@ - the number of seconds until the next photo in the sequence is taken

Select "Enable live view for full screen photo booth shooting" to display live view images in the full
screen photo booth shooting mode.
The live view image can be mirrored so that the user sees the image the same way round as when
looking in a mirror. By default preview images displayed after taking each photo are displayed the
correct way round (i.e. not mirrored). 
Use the height setting to resize the live view images. The live view image can be displayed in portrait
orientation by selecting one of the portrait orientations from the View menu in the main window.
Select "Only display live view in ready screen" if you only want the live view to be displayed in the ready
screen and hidden during the countdown.

A preview can be shown after taking each photo. To enable this set the "Image preview time" to the
time in seconds the preview should be displayed.
Retaking photos: When previews are enabled the following touchscreen actions can be defined to
allow the user the option to retake the photo:
"Preview: accept" - accept the photo (this is the default action if the user does nothing)
"Preview: retake" - reject the photo and take another photo
"Preview: abort" - cancel the shooting sequence

Some users can be confused if the previews don't match the live view images (i.e. they are not
mirrored when the live view display is mirrored). Unselect the "Don't mirror preview images" option if
this a problem (the photos added to prints will still be the correct way round i.e. not mirrored).

By default photos added to prints and animated GIFs are displayed the normal way round but
sometimes it is useful to be able to mirror them e.g. if the camera is mounted so that images are
reflected in a mirror or when taking "painting with light" photos when users are writing words which
would appear the wrong way round if the images weren't mirrored.
Select the "Mirror output images" option to mirror photos before they are printed or added to animated
GIFs. 

Select the "Auto standby" option to have the booth automatically switch to standby mode at startup and
after each set of photos. This option is useful because it automatically disables live view when the
booth is not in use which will avoid problems with the camera's sensor overheating. In standby mode
the booth displays the welcome.jpg screen image. You can switch back to ready mode by typing F6
(toggle between standby and ready modes) or Ctrl+Alt+F6 (switch from standby to ready mode) or by
using the "Toggle standby mode" or "Switch from standby to ready" touchscreen actions.

Select "Scan QR codes for strings" and/or "Scan QR codes for commands" to enable the scanning of
QR codes from the camera's live view to control the photo booth.
Please see the section on QR Codes and Contactless Operation for more details.
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By default the live view images are displayed centered at the top of the screen with the count down text
beneath. The position of the live view images can be adjusted using the "Left offset" and "Top offset"
settings. These specify the offset in pixels from the left and top of the screen respectively. If the left
offset is set to -1 the live view display will be centered horizontally on the screen.
If the count down text offset is set to 0 the count down text is automatically displayed centered in the
spare space above or below the live view images (depending on whether there is more space above or
below the live view images). Please make sure there is enough space for the count down text when
setting the live view size and position.
Alternatively the countdown text can be manually positioned on the screen by setting the offset to a
non-zero value. This value is the number of pixels the text is offset from the top of the screen. If
required, the countdown text can be positioned so that it overlays the live view images.

The live view display can be cropped if required by selecting full screen photo booth mode and holding
down the Shift key and using the cursor left and right keys to increase or decrease the cropping.
Cropping removes equal amounts from the left and right of the live view image when displaying live view
images in landscape orientation and from the top and bottom when using portrait orientation. When
adjusting the live view cropping a status message showing the amount of cropping is shown briefly in
the bottom right hand corner of the screen. Please see this section for more information on cropping
live view and photos in the print layout.

Normally the live view display, if enabled, is shown before each image in the sequence is taken. When
the "Only display Live View images for the first shot in the sequence" option is selected live view
images are only displayed to the user before taking the first shot of the sequence and are hidden during
the rest of the sequence.  If the "Only display live view in ready screen" option is selected the live view
is shown in the ready screen and is hidden when the user starts the shooting sequence.
Alternatively select the "Only display live view in ready screen" to disable live view for the entire
shooting sequence.

The live view display can be disabled during printing by selecting the "Disable live view when printing"
checkbox. Disabling the live view during printing and displaying a suitable message in the 'processing'
screen is a good way of encouraging people to leave the booth after the photos have been taken. For
example you could disable live view during printing, set the minimum duration before closing the
'processing' screen to 15 secs and display the message "Thank you! Your photos are being printed and
will be ready outside shortly, please leave the booth now" by editing the 'processing screen
(processing.jpg).

The "Disable live view when taking photo" option is useful when auto focus is required, particularly when
using older models of Canon DSLR. When "Disable live view when taking photo" is selected the it will
disable live view immediately before taking each photo allowing the camera to auto focus as normal
and then re-enable live after taking the photo. Please note that if the camera's auto focus system is
unable to focus properly the camera will not take the photo and the photo booth shooting sequence will
fail.
Please see the "Camera Settings" section for more information on camera settings and using auto
focus.

External flash mode and camera settings
Most photo booth use studio flash units connected via the camera's hotshoe using a hotshoe to PC
sync adaptor. If you are using a Rebel series camera (e.g. Canon Rebel T6/EOS 1300D) with a studio
strobe and live view is activated in photo booth mode you need to select the "External flash mode"
setting otherwise the flash won't be triggered when taking photos.

For simple photo only photo booth set ups the "Camera settings mode:" should be set to "Simple". This
will ensure that the live view images are bright and will select a shutter speed of 1/125 sec when taking
the photos. For more complicated setups requiring more control over the camera settings (e.g. a photo
booth that offers both photos and video using a mid-range Rebel series camera) the "Camera settings
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mode:" should be be set to "Bank 1" or "Bank 2" and the "Camera Settings" dialog should be used to
configure the settings.

The exposure mode dial on the camera should be set to M (manual exposure) when using the "External
flash mode" setting.

Most photo booths use flash when taking photos and have separate lighting to illuminate the booth. For
optimal color balance when taking the photos the white balance on the camera should be set to flash
but this may result in poor white balance in the live view display because the modeling light has a
different color temperature from the flash. When the "Camera settings mode:" is set to "Simple" the
white balance used in live view can be adjusted by checking the "Live view white balance" checkbox
and selecting the white balance. Select "Auto (ambience)" or "Auto (white)" to use auto white balance
(older camera models which don't have separate ambience and white auto settings will use "Auto").
Alternatively select a preset white balance setting such as tungsten to give more consistent white
balance in live view.
Please see the "Camera Settings" section for information on how to adjust the live view white balance
setting when the "Camera settings mode:" is set to "Bank 1" or "Bank 2".

If a Canon E-TTL compatible flash or the camera's built-in flash is used the "External flash mode"
setting does not need to be selected. It is recommended that the exposure mode dial on the camera is
set to M with a shutter speed of 1/125 sec, an aperture of f/5.6 or f/8 and an ISO setting between 400
to 1600 when using on camera or E-TTL compatible flash.

Please see the "Camera Settings" section for more information on camera settings.

Clicker mode allows users or a photographer to choose when to take each photo rather than the
standard operation where the software automatically takes the photos at preset intervals. When clicker
mode is selected the software will wait until each photo is taken either by a photographer pressing the
shutter release on the camera or by users pressing a remote release (the "clicker"). The clicker could
be a wireless shutter release which plugs in to the camera's remote shutter release socket or a
wireless remote (e.g. a wireless presenter) connected to the PC. The wireless remote should be set up
to send Ctrl+Z. The shooting sequence in clicker mode is:
1. The ready.jpg screen and live view displayed as normal until the start button is pressed (e.g. by

pressing F4)
2. When the start button is pressed the 1.jpg screen will be displayed with no countdown text and the

software will wait until a photo is taken from the camera by pressing the shutter release or using a
remote release or by typing Ctrl+Z on the computer. The LCD screen on the rear of the camera is
turned on when the software is waiting for a photo to be taken and turned off the rest of the time.
Photos can only be taken when the LCD screen is on.

3. After each photo is taken a preview is displayed on the screen if enabled in the photo booth settings
and then the screen for the next photo is displayed e.g. 2.jpg

4. After the last photo has been taken the processing.jpg screen will be displayed and the photos
printed as normal

Please note: You can't use a remote release connected to the camera when using external flash mode
and clicker mode because the external flash won't be triggered when live view is active. You either
need to take each photo via the computer (e.g. by using a wireless presenter or arcade style button
which sends Ctrl+Z) or use a mid-range DSLR such as the Canon EOS 80D, Canon EOS 70D or
Canon EOS 60D and disable external flash mode then disable live view exposure simulation and silent
shooting mode in the camera's live view settings.

Output Settings



Photo Booth Shooting 79

© 2024 We Fly Kites Inc.

Click on the "Settings..." button to the right of the output options to display the output settings dialog
which allows you to configure the print preview and how JPEG copies of the printed output are handled
and to configure the sharing of photos by Twitter, text or email:

The "Output:" drop down list allows you to specify whether photos are printed only, printed with a
JPEG copy of the layout saved in "prints" sub folder, a JPEG copy of the layout is saved in the "prints"
sub folder without printing or no output action is taken. (This is the same as the "Output:" drop down list
displayed in the main photo booth settings dialog).

Select "Postprocess photos" to allow photos to post processed by an external web site before they are
added to the print layout. The post processing can be used to add AI image processing or to perform
other actions such as running a Photoshop droplet on the photo. Click on the "Settings..." button to edit
the settings (see Postprocessing Photos for details).

Select "Save copy of processed photos" to save a copy of each photo taken by the camera after it has
been processed e.g. rotated, cropped, digitally zoomed, chroma-keyed, converted to B&W, toned or
the Instagram style filter applied. The original unmodified image from the camera is saved in the
download folder (specified in File->Preferences) and the copy of the processed image is saved in the
"processed" subfolder.
The processed image can be optionally resized, sharpened and an overlay added. To do this click on
the "Processed photo settings..." to display the "Processed photos settings" dialog:
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Select "Resize, sharpen and add optional overlay" checkbox to modify the processed image.
The image width and height settings specify the size of the saved image. If these are set to zero the
size of resized photo will be used.
The photo width and photo height settings define the size of the resized photo. If one of the values is 0
the aspect ratio of photo will be used to calculate the value e.g. in the screenshot above the width is
set to 600 and the height is set to 0 which will give a height of 400 for an uncropped photo in landscape
orientation. The photo is only resized if the new size is smaller than the original.
The left and top offset values are used to place the photo within the image. This is useful if you want to
add a border to the saved photo e.g. to add a 20 pixel border set the left and top offsets to 20 and set
the image width to 640 and the image height to 440.
If the photo is offset within the image or the photo is resized so that it is smaller than the image the
image background will be visible. This defaults to a white background but it can be replaced with an
optional background image named processed_image_background.jpg.
When using green screen or AI background removal with the transparent background option the
background of the photo will use the greenscreen_background.jpg image if available.

An optional overlay can be added to the processed image by placing a PNG image named
processed_photo_overlay.png in the photo booth images folder. If the overlay is larger than the
processed photo it is resized to fit. If it is smaller than the photo it is placed in the center of the photo.

The photo can be sharpened before it is added to the image. The default sharpening is 85, set this to 0
if you do not require sharpening.

Select "Display thumbnails" to display a small thumbnail of each photo. The thumbnails can be arranged
vertically down one side of the screen or horizontally across the top or bottom of the screen. Click on
the "Settings..." button to 
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The left offset specifies the distance in pixels of the first thumbnail from the left edge of the screen. If a
negative value is specified the distance will be measured from the right edge of the screen e.g. and
value of -1 will place the first thumbnail on the right of the screen. The top offset specifies the distance
in pixels of the first thumbnail from the top edge of the screen. If a negative value is specified the
distance will be measured from the bottom edge of the screen e.g. and value of -1 will place the first
thumbnail on the bottom of the screen.
The thumbnail width specifies the width of the thumbnail in pixels (the height of the image will be
calculated automatically using the aspect ratio of the photo).
The horizontal and vertical spacings specify the positions of the remaining thumbnails relative to the first
thumbnail. The settings in the screenshot above will place four thumbnails 240 pixels wide across the
bottom of the screen and will be centered horizontally if the screen resolution is 1366 x 768.
The default setting is to only display thumbnails during the photo booth countdowns when taking the
photos and not to show them at the end of the shooting sequence on the processing or printing
confirmed screens. Select the "Display thumbnails on processing and printing confirmed screens" if you
also want the thumbnails to be displayed at the end of the shooting sequence when the processing or
printing confirmed screens are displayed.

The "Delay before creating print layout (secs):" setting is normally set to 0 so that photos are printed
as soon as possible. This setting is useful if the photos need to be modified by another program (e.g.
by running a Photoshop droplet to edit the photos or using a green screen program to create high
quality green screen photos) before they are printed by DSLR Remote Pro. Please see the section on "
Modifying Photos Before Printing" for information on how to use this option.

The "Background/overlay filename suffix" setting provides a way to select different backgrounds and
overlays for prints, slideshow GIFs and boomerang GIFs. This setting can use tokens to provide values
that are read at run time e.g. random numbers or data entered in the survey screens. For example to
add a randomly selected overlay to a print layout the "Background/overlay filename suffix" could be set
to random{random,1,3}. The token {random,1,3} evaluates to a random number between 1 and 3 giving
a randomly generated suffix. When preparing the print layout the software will look for an overlay
named overlay_random1.png, overlay_random2.png or overlay_random3.png depending on the random
number. If it can't find an overlay file with the filename suffix it will use the standard filename, overlay.
png, instead.

Select the "Sign or draw on photos before printing" option if you want to allow users to draw on the
print layout before it is printed. This option is useful for letting users sign their photos when running a
magic mirror photo booth with a touchscreen. Please see the section on "Signing or Drawing on the
Prints" for more information on using this setting.

Select "Confirm before printing" in the "Output Settings" dialog if you want to be able to decide whether
to print the images or not (this is the same as the "Confirm before printing" checkbox displayed in the
main photo booth settings dialog). When this option is selected the print layout will be displayed on the
screen with "Print" and "Cancel" buttons in the top left hand corner. Users should click on the "Print"
button (or press the Enter key or A key) to print the images or click on the "Cancel" button (or press
the Esc or key or X key) to reject the prints and return to the ready screen. Users can also press the P
key (or tap on the "Confirm printing (no JPEG copy)" touchscreen action) to print without copying the
JPEG copy of the printed output to a separate folder. This is useful if you want to offer users the
choice of printing only or printing and copying the output to a separate folder (e.g. copying to a folder
on another computer running Breeze Kiosk).

Select the "Delete photos if not printed" checkbox to delete the original photos downloaded from the
camera if the user chooses not to print.
 
The "Maximum number of copies" setting limits the maximum number of print copies the user is allowed



 82

© 2024 We Fly Kites Inc.

to select.
If the touchscreen input mode is selected and touchscreen actions for confirm or cancel printing are
defined the "Print" and "Cancel" buttons will not be displayed. The touchscreen sensitive areas can be
displayed using the confirm_printing.jpg screen image.

If a confirm_printing.jpg screen image is in the photo booth images folder this will be used for the
background to the print confirmation window to allow instructions or touchscreen buttons to be
displayed. 
If a printing_confirmed.jpg screen image is in the photo booth images folder this will be displayed if the
user selects printing. This allows the processing.jpg screen to show a message like "Processing,
please wait..." and the printing_confirmed.jpg to display a message like "Thank you, please leave the
booth now. Your photos are being printed outside."
Please note that if the "Sign or draw on photos before printing" option is selected the drawing screen
can be used to accept or reject the photos and to select the number of copies to print. In most cases
the print confirmation screen is not required if the "Sign or draw on photos before printing" option is
used.

Click on the "Preview size and position..." to specify how the print preview image should be displayed:

The print preview can be cropped by enabling "Crop print preview" and specifying the top left corner
and the width and height of the cropped area (these settings are in pixels). This is useful when printing
double strips where two 2"x6" strips are printed on a single sheet of 4"x6" paper and automatically cut
into two 2"x6" strips by the printer. The print preview would normally show the whole 4"x6" print with
the two strips side by side, but by cropping the print preview just one strip can be displayed. For
example a typical dyesub printer prints at 300 dpi giving a print size of 1200x1800 pixels when printing
4"x6" media in portrait orientation. This can be cropped so that only the left half of the strip is displayed
in the print preview by setting left=0, top=0, width=600, height=1800.

The print preview can be rotated by 90 degrees CW, 90 degrees CCW or 180 degrees using the
rotation setting. Normally this can be set to "None". If the print preview is displayed on its side it
probably means that the page orientation is set incorrectly in the printer settings. The rotation setting
can be used to compensate for this, but it would be better to change the page orientation setting in the
printer settings and update the print layout.

The size and position of the print preview can be set print preview offset, width and height settings. The
print preview can be moved on the screen, e.g. to make space for the print confirmation buttons, using
the left and top offset settings. For example to leave a space 200 pixels wide on the left of the screen
set the print preview left offset to 200. If the print preview width and height settings are set to 0 the
print preview will be resized to fill the rest of the screen. Set the print preview width and height settings
to values other than 0 to specify the size of the print preview image. The print preview will be sized and
centered to fit within the preview area.
The print preview area can also be edited using the touchscreen editor.

Use the "Timeout (secs):" to specify a timeout for how long the print preview should be displayed (the
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default timeout is 300 secs). Set the timeout action dropdown list to the action that should be
performed when the timeout occurs (the default setting is to cancel the print).

Use the sharing options to enable the sharing of photos by Tweeting, texting (MMS or SMS) or by
sending photos by email. Please see the section on uploading to social networks for information on how
to set this up.
Select the "Share animated GIFs" to enable the sharing of animated GIFs by email, Twitter or texting.
Please note: When sharing animated GIFs please note that the files can be large and so it is best to
keep the image size small to avoid excessively large files for sharing. This can result in the animated
GIF appearing very small in the sharing screen. The preview can be made large by increasing the "Max
percentage upscaling setting" e.g. set this to 200 to display the animated GIF 2x normal size or 300 for
3x normal size.
Select the "Share videos" option to share videos captured in video booth mode.

Select the "Printing" option to give users the option to print photos in the sharing screen with the option
of adding a payment screen. Users can print the photos by typing P or by using the "Sharing: Print
photos" touchscreen action. Photos can be printed if the output is set to "Print and save JPEG copy" or
"JPEG copy only". The share_printing.jpg screen is displayed for a minimum of 5 seconds each time
the user selects printing from the sharing screen.
Click on the "Settings..." button to edit the options for printing from the sharing screen:

Select "Payment mode" to enable the payment screens when printing from the sharing screen. When
payment mode is enabled and the user selects print from the sharing screen a payment screen named
share_print_payment.jpg is displayed until a timeout occurs or a payment accepted or payment
cancelled command is received. If the payment is accepted the photos are printed and the
share_printing.jpg screen is displayed. If the timeout occurs or the payment is cancelled the
share_print_payment_cancelled.jpg screen is displayed for a few seconds before returning to the share
screen. Please see the Payment Options section for more information.

Set the "Number of prints allowed" to the maximum number of prints allowed or to 0 if there is not limit.
Then enter the message that is displayed if the user tries to print more copies than is allowed.

If the user prints the photos one or more times from the sharing screen the photos additional copies
won't be printed if the output is set to "Print and save JPEG copy". If the user doesn't print the photos
from the sharing screen and the output is set to "Print and save JPEG copy" the photos will be printed
when the sharing screen is closed using the currently selected number of print copies.

By default the sharing screen shows a print preview image centered on the screen with a height of no
more than 2/3 the height of the screen. This setting can be overridden by setting the preview left, top,
right and bottom settings to non-zero values. The left value is the offset in pixels from the left edge of
the screen. The top value is the offset in pixels from the top edge of the screen. The width and height
values specify the maximum width of the preview image in pixels.

Select the "Create animated GIF of photos" option to created an animated GIF of the photos taken
with an optional overlay and title page.



 84

© 2024 We Fly Kites Inc.

Please see the Animated GIF section for details on how to set up animated GIFs in stills photo booth
mode and in video mode.

Select "Display QR code in sharing screen" to display a QR code in the sharing screen. The size and
position of the QR code in the share.jpg screen can be edited using the touchscreen editor and the QR
code text can be edited by selecting "Edit QR code..." from the File menu in the main window. The QR
text can be generated dynamically by using tokens. This can be used to provide a link to a guest's
photos in an online gallery or microsite.
Select "Display live view in sharing screen" to display live view images from the camera in the sharing
screen. This is useful when scanning QR codes from guests' phones to email photos without having to
touch the photo booth. The size and position of the live view display in the share.jpg screen can be
edited using the touchscreen editor.
Please see the section on QR Codes and Contactless Operation for more information.

When the output option is set to "Print and save JPEG copy" or "JPEG copy only" the filename of the
JPEG copy of the printed output can be specified using the "Filename for JPEG copy of output:" edit
box. This value can use tokens to specify values which are determined at run time e.g. %d represents
the date and %t the time. Please see the section on tokens for a list of available tokens. The JPEG
copy of the printed output is an exact copy of what is sent to the printer and can be used for reprints
after an event.
An optional second copy of the printed output can be saved in a different folder by selecting the
"Create processed copy of print output" option. Click on the "Settings..." button to display the
"Processed Copy of Print Output Settings" dialog:

You can specify the folder where the additional JPEG copy of the printed output is saved using the
"Folder:" edit box. If this is left empty the JPEG will be saved in a sub folder named "copy". You can
also enter the full pathname of the folder where the images should be copied to (e.g. "C:\Print copies")
or the name of a different sub folder (e.g. "Backup").  The folder name can also use tokens to specify
values which are determined at run time. The second copy of the print output can also be cropped,
resized and rotated before it is saved.

The quality when saving JPEG copies of the layout defaults to 90 (out of 100). This setting can be
adjusted by exiting the software and modifying the following setting in the Windows registry:
HKEY_CURRENT_USER\Software\BreezeSystems\DSLRRemotePro\100\PhotoboothJpegSaveQuality
This setting can also be changed exiting DSLR Remote Pro and then running the Configure.exe utility in
the installation folder.

Photo Booth Start options

The following start options are available:

"Keyboard only (ignore This is the default setting where the photo booth sequence can be started
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mouse or touchscreen
clicks)"

using the normal keyboard shortcuts e.g. F4

"Left click anywhere to
start"

This setting allows a mouse or a touchscreen to start the photo booth
sequence. The user simply needs to click the left mouse button or press
anywhere on the display if using a touchscreen

"Left click to start, right
click to toggle B&W
mode"

This setting allows a standard mouse to be used to start the sequence (left
click) or to toggle between B&W and color modes (right click)

"Left click top left to
start"

This setting is designed for touchscreens and requires the user to click in
the top left fifth of the screen to start the sequence. The ready.jpg image
should be edited to show the user where to touch the screen to start the
sequence.

"Left click top left to
start color sequence,
bottom left for B&W"

This setting is designed for touchscreens and requires the user to click in
the top left fifth of the screen to start the sequence in color and the bottom
left fifth to start it in black and white. The ready.jpg image should be edited
to show the user which areas to touch to start the sequence.

"Touchscreen" This setting allows up to 18 areas on a touchscreen to be given different
actions (described in more detail below)

Touchscreen Settings

Up to 45 areas can be defined on a touchscreen to control different photo booth settings such as
starting the sequence, switching between color and B&W, selecting the number of print copies etc.
First select the "Touchscreen" option in the "Start options" dropdown list and then click on the
"Settings..." button to display the touchscreen settings dialog:

Select the action using the dropdown lists on the left and the area on the touchscreen that activates the
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action using the corresponding "Left", "Top", "Right" and "Bottom" edit boxes. The values entered in the
edit boxes are the screen coordinates in pixels with the origin in the top left corner. The example in the
screenshot above defines eight touch sensitive areas on the touchscreen.
The first action defines a square area 191x191 pixels in the top left corner of the screen which starts
the photo booth sequence (action is set to "Start photo booth").
The second and third actions provide a way to select color or B&W photos. 

Touchscreen actions can also be viewed or edited interactively using a mouse by clicking on the "Show/
edit touchscreen areas..." button. When the touchscreen action editor is first opened it will display the
ready.jpg screen and the touchscreen actions for as boxes with white outlines and green text indicating
the action. The action can be moved by clicking in the box and moving the mouse with the left button
held down. The size of the box can be adjusted by dragging the corners with the left mouse button held
down. Touchscreen actions can be deleted by right clicking on the action and selecting "Delete action"
from the menu. New actions added by right clicking the mouse and selecting the "Add action...".
Different screens can be displayed by right clicking the mouse and selecting the required screen.
Exit the touchscreen action editor by pressing the escape key or by right clicking the mouse and
selecting "Exit" from the menu. If the touchscreen actions have been modified a confirmation dialog will
be displayed asking you if you want to save the changes.
Please note: the touchscreen action editor only edits the positions of the touchscreen actions. It
doesn't edit the JPEG screen images which display the graphics for the touchscreen buttons - to do
this you need to use an image editor such as Photoshop Elements.

Normally an error message will be displayed if different touchscreen actions overlap because selecting
two actions could produce strange results. Sometimes it is useful to be able to overlap touchscreen
actions so that one touch can be used to perform multiple actions. To enable overlapping touchscreen
actions first exit DSLR Remote Pro and then run the Configure.exe utility (which is in the installation
folder) and select "AllowOverlappingTouchscreenAreas" in the Photo Booth section. Run DSLR Remote
Pro again and it will allow touchscreen areas to overlap. When touchscreen actions overlap the actions
will be executed in the order in which they are defined in the "Touchscreen Settings" dialog.
Important: If you decide to use overlapping touchscreen actions please test it very carefully as some
combinations of actions could cause unexpected results.

An optional password can be used to protect the "Exit full screen photo booth" action by entering the
password in the "Photo booth exit action password" field. Many photo booth operators define a secret
touchscreen action on the screen to exit photo booth mode which can cause problems if users find it
because it will allow them to break out of full screen photo booth mode. Using a password to protect
this should prevent problems if users manage to find the secret exit photo booth mode touchscreen
action.

An optional touchscreen keyboard can be displayed at the start or end of the photo booth shooting
sequence to allow users to enter information such as their email address. This information is stored in
the XML file saved after each shooting sequence. Use the dropdown list to select when the
touchscreen keyboard should be displayed and the "Test keyboard..." button to test it. The "Timeout
(secs):" value allows a timeout for the keyboard to be specified. If the user does not touch the
touchscreen before the timeout the touchscreen keyboard will be automatically closed.
Please see the section describing the touchscreen keyboard for more details.

Survey screens can be added by clicking on "Test keyboard..." and selecting "Add survey keyboard...".
Please see the section on User Surveys for more information.

Select the "Show mouse cursor" option to display a mouse cursor in screens that accept touchscreen
input to allow a mouse to be used to control the photo booth. This can be convenient for testing when a
touchscreen is not available or for allowing a mouse to have full control over a photo booth that does
not have a touchscreen. Note: this setting is not saved in the XML settings files and is ignored when
loading profiles.
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"Run script" Touchscreen Actions
The "Run script" and "Run script (password)" touchscreen actions can be used to run an AutoHotKey
script (ahk file extension), Windows batch file (bat or cmd file extension) or an executable file (exe file
extension). These touchscreen actions are only active in the ready and standby screens, and when
pressed, will look for a script or executable file in the current photo booth images folder with a filename
starting with script_ e.g. script_shutdown.ahk.
The "Run script (password)" touchscreen action works in exactly the same way except that it asks for a
password before running the script. The password is the same password as the "Photo booth exit
action password".

Print Layout

Click on the "Edit layout..." button in the output options section to edit the print layout. Please see print
layout editor for details.

Other output options

The images can be sharpened by selecting the "Sharpen images" checkbox and specifying a
sharpening amount in the range 0 to 100. The amount of sharpening required depends on personal
taste, the camera and the printer. A value of around 75 is a good starting point.

If the "Crop image if required to fit the printable area" checkbox is selected the image will be cropped
to fill the printable area within the grid. e.g. if the printable area within the grid is square equal portions
of the left and right of the image will be cropped to make it square.

Photos can be printed in color, pure black and white, toned black and white (e.g. sepia) or "Instagram"
style filters (filters 1 to 6) by selecting the appropriate option from the dropdown list headed "Print
photos:". You can also switch between these options when the software is running in full screen photo
booth mode by using the following keyboard shortcuts:
Ctrl+C to select color
Ctrl+B to select black and white
Ctrl+T to select toning
Ctrl+F to select filter 1
Ctrl+G to select filter 2
Ctrl+H to select filter 3
Ctrl+I to select filter 4
Ctrl+J to select filter 5
Ctrl+K to select filter 6
Ctrl+W to toggle between color and B&W
W to cycle through color, B&W, toning and filters 1 to 6
.
When the "toned" option is selected the hue and saturation settings can be adjusted when the software
is running in full screen photo booth mode by using the following keyboard shortcuts: Ctrl+cursor left/
Ctrl+right to adjust the hue and Ctrl+cursor up/Ctrl+down to adjust the saturation. A status message
showing the current settings is briefly displayed in the bottom right hand corner of the display when
adjusting the hue and saturation in full screen photo booth mode. Setting the B&W toning hue to 200
and the saturation to 40 is a good starting point for sepia toned prints.

Please see the "Additional Filters" section for information on "Instagram" style filters and the use of
creative filters.
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Applying effects to images before printing

You can use the editor command to run a command or script on each image after it has been
downloaded. This could be used to run a Photoshop droplet to modify the image.
Please see the "Modifying Photos Before Printing" section for more information.

Fast Resize Mode
Fast resize mode uses a fast interpolation method to resize photos when preparing the images for
printing. This may result in a slight reduction in image quality but will reduce the time it takes to prepare
images for printing by up to 30%. Fast resize mode can be disabled by exiting DSLR Remote Pro and
setting the following value in the Windows registry to 0 (the default setting of 1 enables fast resize
mode):
HKEY_CURRENT_USER\Software\BreezeSystems\DSLRRemotePro\100\PhotoboothFastResize
This setting can also be changed exiting DSLR Remote Pro and then running the Configure.exe utility in
the installation folder.

Running External Commands
External commands can be used to customize the way the photo booth works e.g. by emailing images
or turning lights on and off. There are three different ways external commands can be run when
shooting in full screen photo booth mode:
1. After each photo is downloaded
2. When the photo booth screen changes during the photo booth shooting sequence
3. When the XML summary file is written after the photo booth output has been printed or saved

Running commands after downloading each photo
This is useful if the photos need to be modified using an external program or Photoshop droplet before
they are printed. To do this use the edit images option and select the command line option.
Please see the section headed "Modifying Photos Before Printing" for more information.

Running commands when the photo booth screen changes
This allows a command to be run each time the photo booth screen changes during the photo booth
shooting sequence. The full pathname of the screen image is passed as a command line argument to
the command e.g. C:\Program Files\BreezeSys\DSLR Remote Pro\PhotoboothImages\ready.jpg. To
enable this two values need to be stored in the Windows registry:  PhotoboothStatusCmdEnable and
PhotoboothStatusCmd (see below for details).

Running a command when the XML summary file is written
This allows a command to be run after the photo booth output has been saved or printed and the XML
summary file has been written. The full pathname of the XML summary file is passed as a command
line argument to the command. To enable this two values need to be stored in the Windows registry: 
PhotoboothStatusCmdEnable and PhotoboothStatusCmdXML (see below for details).

Windows registry settings
To enable the photo booth screen change or XML summary file commands the following REG_DWORD
value in the Windows registry should be set to 1:
HKEY_CURRENT_USER\Software\BreezeSystems\DSLRRemotePro\100
\PhotoboothStatusCmdEnable

The photo booth screen change command is defined using the following REG_SZ value:
HKEY_CURRENT_USER\Software\BreezeSystems\DSLRRemotePro\100\PhotoboothStatusCmd

The XML summary file command is defined using the following REG_SZ value:
HKEY_CURRENT_USER\Software\BreezeSystems\DSLRRemotePro\100\PhotoboothStatusCmdXML
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Enter an empty string or delete the registry value for PhotoboothStatusCmd or
PhotoboothStatusCmdXML if you want to run one command but not the other. These settings can be
edited using the Windows regedit utility.
These settings can also be changed exiting DSLR Remote Pro and then running the Configure.exe utility
in the installation folder.

Monitoring the photo booth state

The state of the photo booth can be monitored by reading the title of the full screen photo booth
window. For example when photo booth is in the ready state waiting for the next session the ready.jpg
screen is displayed and the title of the window will be something like this:
Breeze Systems Photobooth - C:\Users\photobooth\Documents\PhotoboothImages\event\ready.jpg

Additional information is also available as hidden text in the full screen photo booth window e.g.
PhotoboothStatus: prints=1; printCounter=111, output=2, color=0, numPhotos=1, profile=,
uid=OEH25911, uid2=IWOKU463
PhotoboothText: 
Power Zoom: not connected
QR:

The "PhotoboothStatus:" line contains the number of print copies (prints) and the print counter
(PrintCounter). The output value shows whether the output is set to print only, print and JPEG copy,
JPEG copy only or none. The color value shows whether color, B&W, toned or one of the filter settings
is selected. The numPhotos value shows the number of photos that will be taken in stills photo booth
mode. The profile value shows the pathname of the most recently loaded profile. The uid and uid2
values show the values of the {uid} and {uid2} tokens.

The "PhotoboothText:" line shows the value of the text displayed during the countdown before taking
each photo.

The "Power Zoom:" line shows the status of the power zoom if the camera has a powered zoom lens

The "QR:" line shows the URL of the most recently scanned QR code. This is reset to an empty string
when the ready screen is displayed.

Controlling the photo booth

Scripts can control the photo booth by sending key presses to the photo booth window (please see 
Keyboard Shortcuts for a list of shortcuts that can be used) or by sending WM_COPYDATA
messages. The following WM_COPYDATA messages are available:

1. Data=100 and the pathname of the photo
This message tells the app that any post processing being applied to a photo has completed. It has
the same effect as sending Ctrl+Z when running the droplet.ahk script to process Photoshop
droplets (see Modifying Photos Before Printing).

2. Data=200 and a URL containing commands and/or strings
This message provides a way of processing QR code URLs to control the photo booth e.g. start the
shooting sequence, read info such as the user's name and to email photos. Please see QR Codes
and Contactless Operation for more information about the format of the URL.

3. Data=300 and the text for a touchscreen command
This message allows any touchscreen command to be run provided the touchscreen command has
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been defined using the touchscreen editor.
The app ignores upper and lower case, spaces and punctuation when comparing the command string
with the touchscreen actions e.g. the following strings will all match the touchscreen action "Select
photobooth+start":
Select photobooth+start
select photobooth+start
selectphotobooth+start
selectphotoboothstart

4. Data=301 and the text for a touchscreen command
This is the same as the data=300 message described above except that the touchscreen action
does not need to be defined. One example of this message is executing a "payment accepted"
touchscreen action when a payment has been received. This allows the action to be executed
without having to define it in the payment screen. If the a touchscreen action for "payment accepted"
was defined in the payment screen users would be able tap the screen without having to make a
payment.

Exporting the program settings to file

All the program settings can be saved to a Windows registry file either for backup purposes or when
copying the settings from one PC to another. Select Tools->Export settings to file... to save the
program settings to file. This will save the settings to a Windows .reg registry settings file. The settings
can be copied back into DSLR Remote Pro by exiting DSLR Remote Pro and then double clicking on
the .reg file in Windows File Explorer.

Important:
· The .reg file contains sensitive information such as email passwords and Twilio account settings and

should be kept secure.
· Doubling clicking on the .reg file to copy the settings back to the Windows registry will overwrite the

current settings and cannot be undone.
· The program settings saved in the .reg file do not include the software licensing information or

activation status. If you are moving DSLR Remote Pro to another computer you need to deactivate it
on the current computer before activating it on the new computer. Please see the section on moving
the software to a different PC for more information.

· The program settings saved in the .reg file do not include the screen images and other files in the
photo booth images folder. If you are moving the software to another PC and wish to keep your
existing events you need to copy the contents of the photo booth images folders manually.

10.5 Postprocessing of Photos

Photo postprocessing provides two methods of modifying photos before they are added to print layouts
or used in slideshow GIFs:

1. Using a web based service such as Breeze Fx to apply affects such as AI image processing
2. Running local commands such as Photoshop droplets to modify images

Please note: Breeze Fx and third party AI image processing services may require additional fees. To
run Photoshop droplets a registered copy of Photoshop needs to be installed on the photo booth
computer.

To enable the postprocessing of photos select "Postprocess photos" in the "Output Settings" dialog and
then click on the "Settings..." button to adjust the settings:

https://www.breezesys.com/solutions/breeze-fx/
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Select "Save copy of original photo in 'originals' folder" to keep a copy of the original unmodified photo.
This is useful if you want to display "before" and "after" images.
Then select either "Web based (HTTP POST)" or "Local command" to choose how the photos are
processed.

Web Based Postprocessing

Choose this option to use web based services such as Breeze Fx to modify photos. This option
requires an internet connection and works by uploading the photo to a web based service which applies
some processing to the image and returns the modified photo.
Enter a timeout to allow the web based service enough time to process the image and to provide a
fallback if there are problems with the internet connection. If the postprocessing times out the original
unmodified photo will be used in the print layout.

Some AI image processing services only accept images up to a certain size. If this is the case set the
"Max image size (pixels)" to the maximum size of the image that is uploaded. The image will be resized
so that the height and width do not exceed the max image size setting before uploading the image. Set
the max image size to 0 to disable the resizing of the image.

Enter the URL of the web service and the optional password or API key. The URL can contain tokens
which allows the URL to be modified e.g. using the results of surveys.

Some examples of AI face swapping using Breeze Fx:

https://www.breezesys.com/solutions/breeze-fx/
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Technical Details

The photo is sent to the URL together with the any survey inputs and other data as a multi-part form
using an HTTP POST. The image will be sent as JPEG data unless AI background removal with a
transparent background is selected in which case it will be sent as a PNG image. The image data
returned from the web server can be accepted as either and JPEG image or a PNG image.

Local Postprocessing

Select "Local command" to run a local command or a Photoshop droplet to modify the photos:

Enter a timeout to allow the command enough time to process the image and to provide a fallback if
there are problems running the command. If the postprocessing times out the original unmodified photo
will be used in the print layout.

The image can be resized before running the command by setting the "Max image size (pixels)"
alternatively set this to 0 to disable the resizing of the image.

Enter the command to be run to process the image. This can be a .exe. file such as a Photoshop
droplet, an AutoHotKey script with a .ahk file extension or a batch file with a .bat or .cmd file extension.
The command can contain tokens which allows the URL to be modified e.g. using the results of
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surveys.

The source image will be a JPEG image unless AI background removal with a transparent background
is selected in which case it will be a PNG image. The command can save the images as a JPEG image
which overwrites the source image or as a PNG image with the same filename as the source image but
with a .png file extension.

10.6 Screens displayed to the user

Screens displayed to the user

If full screen mode is selected (by pressing Ctrl+F4 to enter full screen mode and display the ready
image) a series of images can be displayed to the user to show them what's happening and to
advertise the photo booth. These images are held in the same folder as the background, header and
footer images and are as follows:

ready.jpg - image displayed when DSLR Remote Pro for Windows is ready to take the next set of
photos
ready_overlay.png - optional screen overlay displayed over the ready.jpg screen and live view display
(see below for more information)
ready_overlay_qr.png - optional screen to provide visual feedback when a QR code is scanned in the
ready screen
live_view_overlay.png - optional overlay displayed over the live view display in photo mode (see Live
view overlay)
1.jpg, 2.jpg etc. - countdown screen images displayed during the countdown before taking each photo
(1,jpg for the first photo, 2.jpg for the second photo etc.)
taking.jpg - image displayed for approximately 1 sec before taking each photo
release.jpg - optional image displayed as the photo is taken (live view is hidden when this screen is
displayed)
preview.jpg - optional background image displayed with the preview photo
processing.jpg - image displayed after taking the photos while DSLR Remote Pro for Windows formats
and sends the page to the printer
reprint.jpg - optional image displayed at the bottom of the reprint selection dialog
reprinting.jpg - optional image displayed when reprinting photos (processing.jpg will be displayed if
reprinting.jpg isn't found)
camera_not_connected.jpg - image displayed when the camera is turned off or disconnected
welcome.jpg - image displayed when the inactivity timer has canceled live view or standby mode has
been selected by pressing F6
confirm_printing.jpg - optional background image when displaying print confirmation screen
printing_confirmed.jpg - image displayed if user selects printing from the print confirmation screen
printing_confirmed_no_copies.jpg - image displayed if user selects "Confirm printing (no prints)" from
the print confirmation screen. If this screen image can't be found it displays printing_confirmed.jpg 
keyboard_input_ok.jpg - image displayed if user selects 'ok' from the on screen keyboard after the
photos have been taken
keyboard_input_cancel.jpg - image displayed if user selects 'cancel' from the on screen keyboard after
the photos have been taken
share.jpg - displayed after taking the photo and after the print confirmation screen (if enabled) when the
email sharing options are selected
share_printing.jpg - displayed for at least 5 seconds when the user selects printing from the sharing
screen
share_print_payment.jpg - displayed while waiting for payment when share print payment mode is
selected
share_print_payment_cancelled.jpg - displayed if payment fails or is cancelled when share print
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payment mode is selected
email_photo.jpg - displayed while emailing photos
email_offline.jpg - displayed after user has entered the email address and email offline mode is
selected
email_success.jpg - displayed for a few seconds after the photos have been successfully emailed
email_payment.jpg - displayed while waiting for payment when email payment mode is selected
email_payment_cancelled.jpg - displayed if payment fails or is cancelled when email payment mode is
selected
email_error.jpg - displayed if there was an error emailing the photos
twitter_login.jpg - screen displayed when logging in to Twitter
twitter_login_failure.jpg - screen displayed if there is an error logging in to the user's Twitter account
twitter_upload.jpg - screen displayed while the photo is being uploaded to the user's Twitter feed
twitter_success.jpg - screen displayed after a successful post to Twitter
twitter_cancel.jpg - screen displayed if the user cancels a post to Twitter
twitter_error.jpg - screen displayed if there is an error posting the photo to Twitter
twitter_timeout - screen displayed if the user does nothing and the Twitter timeout occurs
mms.jpg - screen displayed when sending an MMS
mms_success.jpg - screen displayed after an MMS has been sent successfully
mms_as_sms.jpg - screen displayed in if MMS isn't supported and SMS is being used instead
mms_offline.jpg - screen displayed in offline mode after the user has entered their cellphone number to
send an MMS
mms_payment.jpg - displayed while waiting for payment when text payment mode is selected
mms_payment_cancelled.jpg - displayed if payment fails or is cancelled when text payment mode is
selected
mms_error.jpg - screen displayed if there is an error when sending an MMS
video_ready.jpg - displayed when the video booth is ready to capture the next clip
video_ready_overlay.png - optional screen overlay displayed over the video_ready.jpg screen and live
view display (see below for more information)
video_ready_overlay_qr.png - optional screen to provide visual feedback when a QR code is scanned
in the video ready screen
video_live_view_overlay.png - optional overlay displayed over the live view idisplay in video booth mode
(see Live view overlay)
video_countdown.jpg - displayed together with the countdown text during the countdown before
capturing the clip
video_capture.jpg - displayed together with a progress bar while the video clip is being captured
video_processing.jpg - displayed after video capture while the movie file is being transferred to the PC
video_playback.jpg - displayed when playing back the video that has just been captured
video_playback_finished.jpg - optional screen image displayed after playback or after downloading the
video if auto playback is not enabled
GIF_processing.jpg - optional screen displayed when creating animated GIFs in video mode
video_confirmed.jpg - optional screen displayed after accepting a video or closing the sharing screen
ready_info1.jpg, ready_info2.jpg etc. - optional information screens available from the stills photo booth
ready screen
video_info1.jpg, video_info2.jpg etc. - optional information screens available from the video booth ready
screen
before_session.jpg - screen displayed before a timed photo booth session starts
after_session.jpg - screen displayed after a timed photo booth session ends

A typical photo booth shooting sequence will display screens in the following order:
ready.jpg - the photo booth is ready to take the next set of photos
1.jpg - displayed during the countdown for the first photo in the sequence
taking.jpg - displayed approximately 1 sec before taking the photo
release.jpg - displayed when the command to take the photo is sent to the camera
2.jpg, taking.jpg, release.jpg - screens displayed during the countdown for the second photo
repeated for the remaining photos in the sequence...
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processing.jpg - displayed after taking the photos while preparing them for printing
confirm_printing.jpg - screen asking the user to confirm or reject the prints
share.jpg - screen displayed asking the user to share the photos by email, text etc.
printing_confirmed - displayed after user has accepted the prints and has exited the share.jpg screen

ready_overlay.png - this is an optional overlay file that is displayed over the ready.jpg screen and the
live view display. This screen image should be the same size as the ready.jpg screen and should
contain transparent areas so that the live view screen may be seen. The ready_overlay.png screen
makes it simple to add buttons, text or graphics that appear over the live view display when the ready
screen is displayed. The ready screen overlay is only displayed with the ready screen and is hidden
when the countdown starts.
video_ready_overlay.png - this is an optional overlay file that is displayed over the video_ready.jpg
screen and the live view display. This screen image should be the same size as the video_ready.jpg
screen and should contain transparent areas so that the live view screen may be seen. The
video_ready_overlay.png screen makes it simple to add buttons, text or graphics that appear over the
live view display when the video ready screen is displayed. The video ready screen overlay is only
displayed with the video ready screen and is hidden when the countdown starts.
Please note that areas of the ready_overlay.png and video_ready_overlay.png screens must be either
fully opaque or fully transparent. You can't use an alpha channel to provide semi-transparent areas.
 
A different screen for the taking.jpg, release.jpg and preview.jpg screens can be displayed for each
photo in the sequence for by appending the photo number to the end of the filename. e.g. taking1.jpg,
release1.jpg, preview1.jpg for the first photo; taking2.jpg, release2.jpg, preview2.jpg for the second
photo etc.

Please note that it is not always necessary to define all the screen images e.g. share.jpg and the email
screens are not required if the email options are not used. The simplest way to get started is to run
the photo booth setup wizard which will automatically create all the screens for you. You can then edit
the screens in an image editor to customize the look of your photo booth.

These images can be JPEGs containing any information you like and are displayed centered on the
display with a black background. The images 1.jpg, 2.jpg etc are displayed together with the text
defined in the settings dialog which can be used to give a count down timer before each picture. The
text is displayed centered on the screen below the live view display, if applicable, as white text on a
transparent background. The following tokens can be used in the text:

@imageNumber@ - the number of the image in the sequence starting from 1
@numberOfImages@ - the number of images in the sequence
@secsToNextPhoto@ - the number of seconds until the next photo is taken

The images displayed to the user should be the same size or bigger than the computer's display. If the
images are too small they will be expanded to fit with a black border and a small warning message will
be displayed in the bottom left corner showing the image size and the display size.

When using live view in photo booth mode the live view images will not be updated while the camera is
actually taking each picture. This will cause the live view display to freeze for a couple of seconds and
can confuse some users as it shows the live view just before the picture is taken and this will be slightly
different from the actual photo. To avoid this problem the live view display will be blanked out when the
photo is taken if you define a release.jpg image.

It is also possible to display different screens depending on whether color, black and white or
monochrome toned mode is selected and the number of print copies.  This provides a way of giving
feedback to the user when different settings have been selected.

The way it works is to check for a suffix after the filename for the appropriate screen image in the form
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<screen>_<b|c|t><1..9>.jpg where <screen> is the name of the screen image e.g. "ready", <b|c|t> is
the color mode: "b" for black and white, "c" for color, "t" for monochrome toned or f, g, h, i, j, k for
filters 1 to 6 and <1..9> is the number of print copies e.g. "1" is one copy is selected.

For example when the ready.jpg image is to be displayed, the color mode is set to black and white and
the number of print copies is set to 2 the software will look for a suitable screen image in the following
order:
ready_b2.jpg - i.e. "ready" + black and white + 2 copies selected or if this isn't found it looks for: 
ready_b.jpg - i.e. "ready" + black and white or if this isn't found it looks for:
ready_2.jpg - i.e. "ready" + 2 copies selected or if this isn't found it looks for:
ready.jpg

So to have screens to indicate the color mode and the number of print copies from 1 to 3 you need the
following "ready" screens: ready_c1.jpg, ready_c2.jpg, ready_c3.jpg, ready_b1.jpg, ready_b2.jpg,
ready_b3.jpg.

When a setting is changed, e.g. the color mode is set to black and white, the screen image is updated
automatically to show the user the current status.

This technique can also be used for the confirm_printing.jpg screens when displaying the print
confirmation screen e.g. confirm_printing_1.jpg is used for 1 copy, confirm_printing_2.jpg is used for 2
copies etc. The touchscreen actions "Confirm printing (+ # prints)" and "Confirm printing (- # prints)" can
be used to increase or decrease the number of copies to print and the screen will be updated to show
the confirm_printing.jpg background to provide the user with visual feedback of the selected number of
copies. The maximum number of copies that can be selected in the "Output Settings" dialog.

Optional info screens
One or more information screens can be displayed from the stills photo ready or video ready screens.
Touchscreen actions are available to display the information screens from the ready screens, to display
the next or previous page, to close the information screen and to start the photo booth shooting
sequence.

To display information screens from the stills photo booth ready screen (ready.jpg) create screen
images named ready_info1.jpg, ready_info2.jpg, ready_info3.jpg etc. and place them in the photo booth
images folder. Then add the following touchscreen actions to control the display of the information
screens:
Photo info open - display the first information screen (ready_info1.jpg) from the stills photo ready
screen (ready.jpg)
Photo info next - display the next information screen if available e.g. switch from ready_info1.jpg to
ready_info2.jpg
Photo info previous - display the previous information screen if available e.g. switch from ready_info3.
jpg to ready_info2.jpg
Photo info close - close the information screen and return to the ready screen (ready.jpg)
Photo info start - close the information screen and start the photo booth shooting sequence

To display information screens from the video booth ready screen (video_ready.jpg) create screen
images named video_info1.jpg, video_info2.jpg, video_info3.jpg etc. and place them in the photo booth
images folder. Then create add the following touchscreen actions to control the display of the
information screens:
Video info open - display the first information screen (video_info1.jpg) from the video ready screen
(video_ready.jpg)
Video info next - display the next information screen if available e.g. switch from video_info1.jpg to
video_info2.jpg
Video info previous - display the previous information screen if available e.g. switch from video_info3.
jpg to video_info2.jpg
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Video info close - close the information screen and return to the ready screen (video_ready.jpg)
Video info start - close the information screen and start the video booth shooting sequence

The information screens can be animated using GIF or MP4 images (see below for details).
The information screens will be automatically closed after 30 seconds of inactivity. This timeout can be
changed by editing the InfoInactivityTimeout setting using the Configure utility.

Using animated GIF files to animate screens
Animated GIF files can be displayed on the screens by placing an animated GIF in the photo booth
images folder and giving it the same name as the screen image. For example, to play an animated GIF
when the ready.jpg screen is displayed the file should be named ready.gif. Animated GIFs can be
displayed over the live view images and the live view will be visible behind transparent areas of the
animated GIF.
Append "_loop" to the filename , e.g. ready_loop.gif, if you want the animated GIF to play in a
continuous loop.

By default animated GIFs are displayed in the center of the screen. Animated GIFs can also be
positioned manually by appending the offsets from the left and top of the screen to the filename in the
form _{LeftOffset}+{TopOffset} e.g. to position ready.gif 200 pixels from the left of the screen and 100
pixels from the top the file should be named ready_200+100.gif (or ready_loop_200+100.gif if you want
it to play continuously).
The size and position of the animated GIF can also be specified as a percentage of the screen size e.
g. ready_{w50%}_loop.gif will display an animated GIF that is half the width of the screen and plays in
a continuous loop in the ready screen. Please see this page for more information

When an animated GIF is displayed on the countdown screen (e.g. by naming it 1.gif) it replaces the
normal countdown text and is only played once. Approximately 1 second before the end of the GIF the
taking.jpg screen is displayed and then the photo is taken when the GIF reaches the end.
Important: The delay before taking each photo must be set to 2 secs or more otherwise the
countdown movie will not be displayed.

Example animated GIFs (in the installation folder):
start.gif - displays a pulsating "Start" button. To test this copy start.gif to your photobooth images
folder and rename it ready_loop.gif. This will display an animated button in the center of the screen. It
can be moved by appending the left and top offsets to the filename e.g. change the filename to ready_
{l200t100}_loop.gif (or ready_loop_200+100.gif using the older naming scheme) to place it 200 pixels
from the left of the screen and 100 pixels from the top.

1.gif - displays a 5, 4, 3, 2, 1 countdown with a progress ring. To test this copy countdown.gif to your
photobooth images folder and rename it 1.gif. This will display the countdown in the center of the
screen during the countdown for the first photo. It can be moved by appending the left and top offsets
to the filename e.g. change the filename to 1_{l200t100}.gif (or 1_200+100.gif using the older naming
scheme) to place it 200 pixels from the left of the screen and 100 pixels from the top. Alternatively
change the filename to 1_{t25%}.gif to place it 1/4 of the way down the screen.
Make copies of the file and rename them 2.gif, 3.gif etc. to provide animated countdowns for photos 2,
3, etc.

Using movie files to animate screens
Movie files can be displayed on the screens by placing a movie file in MP4 or QuickTime MOV format
in the photo booth images folder and giving it the same name as the screen image. For example, to
play an MP4 movie file when the ready.jpg screen is displayed the movie file should be named ready.
mp4. Movie files can't overlap the live view display and so if live view is active the movie will be
displayed in the area below the live view.
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Append "_loop" to the filename , e.g. ready_loop.mp4, if you want the movie to automatically restart
from the beginning and play continuously.

By default movie files are displayed centered on the screen unless live view is active in which case they
are displayed below the live view. Movie files can also be positioned manually by appending the offsets
from the left and top of the screen to the filename in the form _{LeftOffset}+{TopOffset} e.g. to position
the ready.mp4 movie 200 pixels from the left of the screen and 100 pixels from the top the file should
be named ready_200+100.mp4 (or ready_loop_200+100.mp4 if you want it to play continuously). If the
movie is larger than the screen it will be automatically scaled to fit the screen.

The size and position of the movie can also be specified as a percentage of the screen size e.g. ready_
{w50%}_loop.mp4 will resize the movie so that is half the width of the screen and plays in a continuous
loop in the ready screen.
Please see this page for more information about sizing and positioning movie files

When a movie is displayed on the countdown screen (e.g. by naming it 1.mp4) it replaces the normal
countdown text and is only played once. Approximately 1 second before the end of the movie the
taking.jpg screen is displayed and then the photo is taken when the movie reaches the end. There is a
sample movie file called countdown.mp4 in the folder where DSLR Remote Pro is installed. To use this
simply copy it to your photo booth images folder and rename it to 1.mp4, 2.mp4 etc.
Important: The delay before taking each photo must be set to 2 secs or more otherwise the
countdown movie will not be displayed
Please note: If an animated GIF has been defined for the countdown the countdown movie file will be
ignored.

Troubleshooting
If a video does not play properly it could be a video CODEC problem. Please try downloading and
installing the K-Lite CODEC pack which should fix the problem.
The K-Lite CODEC pack can be download it from: http://www.codecguide.com/download_kl.htm

Audio Prompts
Audio prompts can be added by placing a WAV sound file in the photo booth images folder and giving it
the same name as prompt screen. For example to play a sound when the photo booth is ready copy a
WAV file named ready.wav into the photo booth images folder and it will be played when the ready.jpg
image is displayed. You can also play an audio file when the touchscreen keyboard is displayed by
naming it keyboard.wav and placing it in the photo booth images folder.
Note: There is no need to use a WAV file if you are already using a movie file (see above) because
movie files can contain both pictures and sound.

The easiest way to see how this works is to try it out. To do this run DSLR Remote Pro for Windows
then press Ctrl+F4 to display the ready screen. Then press Shift+F4 to take a test sequence or F4 to
take the pictures and print them.

A typical 4 picture sequence would be:

At startup: "ready.jpg" image displayed on screen and "ready.wav" played once (if present)

Sequence started: "1.jpg" image displayed on screen together with countdown text and "1.wav"
played once (if present)

Approx 1 sec before taking picture #1:  "taking.jpg" image displayed on screen and "taking.wav"
played once (if present)

http://www.codecguide.com/download_kl.htm
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After taking picture #1: preview image displayed for the required number of seconds (if enabled in the
settings) then "2.jpg" image displayed on screen together with countdown text and "2.wav" played once
(if present)

Approx 1 sec before taking picture #2:  "taking.jpg" image displayed on screen and "taking.wav"
played once (if present)

After taking picture #2: preview image displayed for the required number of seconds (if enabled in the
settings) then "3.jpg" image displayed on screen together with countdown text and "3.wav" played once
(if present)

Approx 1 sec before taking picture #3:  "taking.jpg" image displayed on screen and "taking.wav"
played once (if present)

After taking picture #3: preview image displayed for the required number of seconds (if enabled in the
settings) then "4.jpg" image displayed on screen together with countdown text and "4.wav" played once
(if present)

Approx 1 sec before taking picture #4:  "taking.jpg" image displayed on screen and "taking.wav"
played once (if present)

After taking picture #4: preview image displayed for the required number of seconds (if enabled in the
settings) then "processing.jpg" image displayed on screen and "processing.wav" played once (if
present). During this time the images are formatted ready for output and either saved to file or sent to
the printer queue. When this has finished the screen goes back to the "ready.jpg" image and the ready.
wav sound file is played ready for the next sequence.

It is also possible to display different screens depending on whether color, black and white or
monochrome toned mode is selected and the number of print copies. This makes it possible to show
the user which settings have been selected and could be used as part of a touchscreen menu system.
The way it works is to check for a suffix after the filename for the appropriate screen image in the form
<screen>_<b|c|t><1..9>.jpg where <screen> is the name of the screen image e.g. "ready", <b|c|t> is
the color mode: "b" for black and white, "c" for color or "t" for monochrome toned and <1..9> is the
number of print copies e.g. "1" is one copy is selected.

For example when the ready.jpg image is to be displayed, the color mode is set to black and white and
the number of print copies is set to 2 the software will look for a suitable screen image in the following
order:
ready_b2.jpg - i.e. "ready" + black and white + 2 copies selected or if this isn't found it looks for: 
ready_b.jpg - i.e. "ready" + black and white or if this isn't found it looks for:
ready_2.jpg - i.e. "ready" + 2 copies selected or if this isn't found it looks for:
ready.jpg

So to have screens to indicate the color mode and the number of print copies from 1 to 3 you need the
following "ready" screens: ready_c1.jpg, ready_c2.jpg, ready_c3.jpg, ready_b1.jpg, ready_b2.jpg,
ready_b3.jpg.
When a setting is changed, e.g. the color mode is set to black and white, the screen image is updated
automatically to show the user the current status.

Adding a watermark to prints
A watermark can be added to prints displayed in the confirm printing and sharing screens by placing a
PNG file named print_watermark.png in the photo booth images folder. The PNG file should contain
transparency information in an alpha channel so that the print is visible when the PNG is overlaid on top
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of it.

10.7 Camera Settings

Overview

The "Camera settings mode:" dropdown in the "Photobooth Settings" dialog has three options: simple,
bank 1, bank 2

For photo booths only offering photos the simple setting can be used. This will use the current camera
settings for the shutter speed, aperture, ISO and white balance when taking photos. The color balance
of the live view images can be improved by enabling "Live view white balance" and selecting a suitable
white balance e.g. "Auto (ambience)".
If "External flash mode" is selected the simple camera setting mode will automatically set the shutter
speed to bulb when live view is displayed and 1/125 sec when taking photos.

If more control over the camera settings is required (e.g. for a photo booth that offers both photos and
videos) the camera settings mode should be set to "Bank 1" or "Bank 2". When bank 1 or bank 2 is
selected the live view white balance checkbox is replaced with a "Camera settings..." button. Click on
this button to adjust the camera settings:



Photo Booth Shooting 101

© 2024 We Fly Kites Inc.

The top half of the "Camera Settings" dialog is shows the settings for bank 1 and the bottom half
shows the settings for bank 2. Which bank of settings to use when the photo booth is running is
specified by the "Camera settings mode" in the "Photobooth Settings dialog". Please note that only the
camera settings mode is saved to file and loaded using when profiles. This allows profiles to be used to
select different camera settings. The individual camera settings for each bank are not saved in profiles
because these will depend on the lighting conditions when setting up the photo booth at the venue.

The exposure mode dial on the camera should be set to M (manual exposure) in order for the settings
to work.

Click on the "Test Photo: Bank 1" button to set the camera to the bank 1 settings and take a preview
photo to test the exposure. Click on the "Test Photo: Bank 2" button to test the exposure settings for
bank 2. 

Please note: It may not be possible for all the specified settings to be applied if the camera does not
support them e.g. basic Rebel series cameras only support fully automatic exposure and white balance
in video mode and so any settings specified in the "Camera settings for live view and capture when in
video booth mode" will be ignored. Selecting a value that is out of range will result in the nearest
available setting being used e.g. selecting an aperture of f/1.8 will result with a lens that has a
maximum aperture of f/4 will result in f/4 being used.

Camera Settings for Photo Booths with Studio Strobes, E-TTL
Flash or the Camera's Flash

Camera settings for all camera models: Set the camera exposure mode to manual (by turning the
exposure mode dial on the camera to M), shutter speed to 1/125 sec, aperture to f/8, ISO to 400 and
white balance to Flash:
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DSLR Remote Pro main window showing suggested camera settings for all camera models when using flash

Additional camera settings for mid to high end cameras
Disable live view exposure simulation and "Silent LV shoot" in the camera settings and disable "External
flash mode" in the "Photo booth Settings" dialog.

Additional camera settings for Canon EOS M50
Ensure the rear LCD is facing outwards (otherwise live view may freeze after a few seconds).
Disable live view exposure simulation in the camera settings and disable "External flash mode" in the
"Photo Booth Settings" dialog.
Set the camera to manual exposure by turning the exposure mode dial on the camera to 'M'.
Set the camera settings in the "Photo Booth Settings" dialog to "Bank 1" or "Bank 2" and in the
"Camera setting when taking photos" set the shutter speed to 1/100, the aperture to 8.0 and the ISO to
400.
IMPORTANT: Do not select a shutter speed faster than 1/100 sec when triggering external flashes or
studio strobes via the camera's hotshoe. There is a bug in the camera's firmware which makes flash
triggering unreliable if the shutter speed is set higher than 1/100 sec.
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Suggested 'Bank 1' camera settings for a Canon EOS M50 taking photos and videos

Take a test photo by pressing the "Preview (F9)" button in the main window. If the photo is too dark it
can be made brighter by increasing the power setting on the flash, by increasing the ISO setting on the
camera or by using a larger aperture (by reducing the Av setting). If the photo is too light it can be
darker brighter by decreasing the ISO setting on the camera or by using a smaller aperture (by
increasing the Av setting) or by reducing the power setting on the flash.
Try to keep the ISO setting below 1600 to give the best image quality.

Photo Booth Settings for "Photo only" Photo Booths

Rebel series cameras using studio strobes In the "Photobooth Settings" dialog enable "External
flash mode", set the "Camera settings mode" to simple, enable "Live view white balance" and select
"Auto (ambience)":
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Suggested settings in the "Photobooth Settings" dialog for Rebel series cameras when using studio strobes

Rebel series cameras using the camera's flash or an E-TTL flashgun and mid to high end
cameras using all types of flash: These should use the same settings as above except "External
flash mode" should be disabled.

Settings for "Video only" Photo Booths

All camera models: Set the camera exposure mode to manual (by turning the exposure mode dial on
the camera to M), shutter speed to 1/30 sec, aperture to f/5.6, ISO to 1600 and white balance to "Auto
(ambience)" or "Tungsten" depending on the lighting being used:

Please note that basic Rebel series cameras use fully automatic exposure and white balance for video
and so changing the camera settings will have no effect.
If the lighting is likely to vary the ISO can be set to auto so that the camera can adjust the ISO to
adjust the exposure.
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In the "Photobooth Settings" dialog set the "Camera settings mode" to simple and disable "Live view
white balance". Flash is not used when capturing video and so it doesn't matter whether "External flash
mode" is selected or not.

To set the correct exposure and white balance in video mode type Ctrl+L in the main DSLR Remote
Pro window to display the live view window. Then click on the "Video" button to select video mode. If
the live view is too dark adjust the exposure by reducing the shutter speed, selecting a wider aperture
(by reducing the Av setting), selecting a higher ISO setting or by increasing the power of the lights. If
the live view is too light adjust the exposure by by selecting a lower ISO setting, selecting a smaller
aperture (by increasing the Av setting), selecting a higher shutter speed or by reducing the power of
the lights.
If the ISO is set to auto and the live view is too dark it means that there is not enough light for correct
exposure event with the highest ISO setting selected by the camera. To correct this reduce the shutter
speed, select a wider aperture (by reducing the Av setting) or increase the power of the lights.

Settings for Photo Booths using both Photo and Video Modes

Set the camera settings for taking photos using flash using the settings above i.e. manual exposure,
Tv=1/125 sec, Av=8.0, ISO=400.

Rebel series cameras need the "External flash mode" setting to be selected  in the "Photobooth
Settings" dialog when using flash. Mid to high end cameras do not need the "External flash mode"
setting to be selected.

Basic Rebel series cameras use fully automatic exposure and white balance in video mode the camera
and so the settings in the "Photobooth Settings" dialog can be the same as for taking photos i.e.
"Camera settings mode" set to simple and live view white balance set to "Auto (ambience)".

Other cameras allow manual control over exposure and white balance in video mode. Photo booths
using flash for photos and continuous lighting for video will have different lighting conditions for photos
and videos and will therefore require different camera settings. To do this set the "Camera settings
mode" to "Bank 1" and press the "Camera settings..." button to display the "Camera settings" dialog:

Two banks of camera settings are available for advanced setups, but for a simple video and photo
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setup only bank 1 is required. Each bank allows different settings to be used for the camera exposure
and white balance when taking photos, displaying live view and for capturing video. Settings can be set
to specific values, e.g. Tv: 1/125, or to "camera". The "camera" setting will use the same setting that
was set on the camera before entering full screen photo booth mode.

The first row of settings, headed "Camera settings when taking photos", is used to specify the camera
settings to use when taking photos. The suggested settings are Tv: 1/125 sec (so that the camera
syncs with the flash - NB use 1/100 sec with the Canon EOS M50). Av: "camera", ISO: "camera" and
white balance "camera". Using "camera" for most of the settings allows the exposure when taking
photos to be adjusted by taking test photos and changing the camera settings in the main window.

The second row of settings, headed "Camera settings for live view in stills photo booth mode", is used
to specify the camera settings for the live view display when in photo booth mode (i.e. when the ready
and countdown screens are displayed). For Rebel series cameras Tv needs to be set to "bulb" to
ensure that the live view images are correctly exposed. For mid to high end cameras the Tv setting
should be set to "camera". The aperture (Av) and ISO settings don't have much effect the live view and
should be set to "camera". The white balance setting should be set to "Auto (ambience)", "Tungsten" or
one of the other preset white balance settings to give good color balance in live view. The camera
white balance when taking the photos will be set to "Flash", but this setting will give excessively yellow
colors if used for live view in the ready and countdown screens.

The third row of settings, "Camera settings for live view and capture when in video booth mode", is
used to specify the camera settings when in video booth mode. Video capture requires continuous
lighting and same lighting will be used for live view in the ready and countdown screens as is used when
capturing the video. The lighting is likely to be less bright than the flash used for taking photos and so
the shutter speed and ISO need to be lower and the ISO higher to compensate. Suggested settings
are Tv: 1/30 (the slowest available shutter speed in video mode), Av: 5.6 (to give some depth of field
while still letting in plenty of light) and ISO 1600.

Tip: When using manual exposure mode and bank 1 or bank 2 camera settings the live view brightness
can be adjusted in photo booth mode using the cursor up and cursor down keys. Press cursor up to
lighten live view by selecting a slower shutter speed or press cursor down to darken live view by
selecting a faster shutter speed. Note: pressing cursor up when the shutter speed is set to 30 sec on a
Rebel series camera will select bulb which will use auto exposure for live view.

Advanced Usage of Camera Settings

Sometimes different settings are required for different photo booth activities e.g. a photo booth that
allows users to choose between standard photos with flash and "painting with light" photos. Standard
photos with flash normally require a shutter speed close to the camera's flash sync speed (e.g. 1/125)
with a medium aperture (e.g. f/5.6) and ISO (e.g. 400). Painting with light photos may also use flash to
illuminate the subject, but require a longer shutter speed to record light trails from torches etc. They
also need to minimize the effects of ambient lighting by using a very small aperture (e.g. f/22) and a low
ISO (e.g. 100). The ability to switch between these settings using profiles can be achieved by using
bank 1 for the standard photos with flash camera settings and bank 2 for the painting with light camera
settings. The profile used to select standard photos with flash should be saved with the "Camera
settings mode" set to "Bank 1" and the profile used to select painting with light should be set to "Bank
2".  

Camera Types

Basic Rebel series cameras: e.g. Canon Rebel T7/EOS 2000D, , Canon Rebel T6/EOS 1300D,
Canon Rebel T5/EOS 1200D, Canon Rebel T3/EOS 1100D, Canon EOS 4000D
· Cost-effective cameras for normal photo booth shooting.
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· Require the use of "external flash mode" when using external studio flash.
· Not so good for video because they have limited video resolutions and are unable to use an external

microphone. The camera's built-in microphone may give poor sound recording at noisy venues.
· Unable to use continuous AF in live view

Enthusiast Rebel series cameras: e.g. Canon Rebel T6s/EOS 760D, Canon Rebel T6i/EOS 750D,
Canon Rebel T5i/EOS 700D,, Canon Rebel SL1/EOS 100D
· Suitable for normal photo booths and video capture.
· Require the use of "external flash mode" when using external studio flash.
· Good support for video capture including full control over exposure, ISO and white balance and the

ability to use an external microphone for improved sound recording
· Most models support continuous AF in live view but this is slow except for the Rebel T6s/EOS 760D

and Rebel T6i/EOS 750D

Enthusiast Rebel cameras with dual pixel AF in live view: e.g. Canon EOS 77D, Canon EOS 800D/
Rebel T7i, Canon EOS 250D/200D Mark II/Rebel SL3, Canon EOS 200D/Rebel SL2
· Suitable for normal photo booths and video capture.
· Require the use of "external flash mode" when using external studio flash.
· Good support for video capture including full control over exposure, ISO and white balance and the

ability to use an external microphone for improved sound recording.
· Excellent continuous AF in live view with face tracking. The use of an STM lens is recommended

when capturing video with continuous AF 

Mid to high end cameras: e.g. Canon EOS 60D, Canon EOS 50D, Canon EOS 7D, Canon EOS 6D,
Canon EOS 5D Mark III, Canon EOS 5D Mark II
· Suitable for normal photo booths and video capture.
· Do not require the use of "external flash mode" when using external studio flash if the live view

settings in the camera are set to disable live view exposure simulation and disable silent shooting
mode.

· Good support for video capture including full control over exposure, ISO and white balance and the
ability to use an external microphone for improved sound recording

· Support continuous AF in live view but this is slow

Mid to high end cameras with dual pixel AF in live view: e.g. Canon EOS 90D, Canon EOS 80D,
Canon EOS 70D, Canon EOS 7D Mark II, Canon EOS 6D Mark II, Canon EOS 5D Mark IV
· Suitable for normal photo booths and video capture.
· Do not require the use of "external flash mode" when using external studio flash if the live view

settings in the camera are set to disable live view exposure simulation and disable silent shooting
mode.

· Good support for video capture including full control over exposure, ISO and white balance and the
ability to use an external microphone for improved sound recording.

· Excellent continuous AF in live view with face tracking. The use of an STM lens is recommended
when capturing video with continuous AF 

Mirrorless cameras: Canon EOS M50, Canon EOS M6 Mark II, Canon EOS M200
· Suitable for normal photo booths and video capture.
· Does not require the use of "external flash mode" when using external studio flash if "Expo simulation"

is disabled in the camera (in the SHOOT3 menu of the camera settings)
· Good support for video capture including full control over exposure, ISO and white balance and the

ability to use an external microphone for improved sound recording.
· Excellent continuous AF in live view with face tracking. The use of an STM lens is recommended

when capturing video with continuous AF
· Slow motion video capability when 120fps video capture is selected. Play back is at 1/4 normal



 108

© 2024 We Fly Kites Inc.

speed (30fps) and does not include sound
· Very compact, particularly when used with the EF-M 22mm lens

Recommendations:
1. Canon Rebel T6/EOS 1300D or Canon Rebel T7/EOS 2000D with standard 18-55mm kit lens

These cameras are excellent value for money and are suitable for all photo booths which do not
need to capture video. They can be used for video capture, but the inability to use an external
microphone may give poor sound recordings at noisy venues.

2. Canon Rebel T7i/EOS 800D or Canon Rebel SL2/EOS 200D with 18-55mm STM kit lens
These camera models are more expensive than the Rebel T6/EOS 1300D, but have a microphone
socket and can therefore use an external microphone to give better sound recordings when capturing
video.
The Canon Rebel T7i/EOS 800D and Rebel SL2/EOS 200D also have Canon's excellent dual pixel
live view AF system which can provide continuous auto focus with face detect when used in photo
booth mode.

3. Canon EOS M50 with EF-M 22mm STM lens or EF-M 15-45mm STM lens
This camera is very compact, has a microphone socket, excellent dual pixel auto focus and 120fps
slow motion video capability. This is probably the best value all round camera currently available for
photo booth use.

Lighting

Most photo booths either use a studio strobe or an E-TTL compatible flash (e.g. the camera's built-in
flash or a Canon E-TTL compatible flash in the camera's hotshoe) to light the subject when taking
photos. Additional lighting is required for the live view display between photos and this is normally
provided by the modeling light on studio strobes, additional lights (e.g. an LED lighting panel) or the
ambient lighting at the venue. Normally it is best not to rely on the ambient lighting at the venue because
you have little or no control over it and it may change during the course of the event.

When using flash the exposure is determined by the amount of light, the camera ISO setting and the
lens aperture. It is recommended that the exposure mode dial on the camera is set to M to give
complete control over the camera settings. The exposure mode must be set to M when using external
flash mode.
The shutter speed does not affect the exposure and should be set to a value that is the same as or
lower than the camera's flash sync speed and fast enough that ambient light is unlikely to affect the
exposure e.g. 1/125 sec.
The lens aperture affects the exposure and the depth of field: a small aperture like f/22 will give a wide
depth of field but does not let much light in and therefore will require a more powerful flash or higher
ISO setting to get the correct exposure. An aperture of f/8 is a good starting value.
The ISO setting affects the exposure by setting the gain or amplification of the image from the sensor.
A higher ISO setting will give lighter images than a lower ISO setting but may reduce image quality by
introducing noise. Normally an ISO value of between 100 and 1600 will give excellent results. An ISO
setting of 400 is a good starting point.
The power of the flash also affects the exposure. Most studio flash units have variable power settings
to control their output. Direct flash can produce harsh lighting and so it is usually fired through a diffuser
or bounced off a reflector or umbrella to give softer lighting but this will reduce its output. Moving the
flash closer to the subject will increase the lighting and moving it away from the subject will reduce it.
Normally it is best to adjust the exposure by adjusting the flash power and only changing the ISO and
aperture if the flash is not powerful enough.

Flash can't be used when capturing video and so some form of continuous lighting is required e.g. LED
lighting panels. It is recommended that the exposure mode dial on the camera is set to M to give
complete control over the camera settings. However, if you are using a basic Rebel series camera to
capture video the exposure will be set automatically by the camera and the only adjustments you can
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make are the exposure compensation setting on the camera and the lighting. With most other camera
models the shutter speed, aperture and ISO can be set when capturing video.
The shutter speed affects the exposure and the amount of motion blur. A slower shutter speed will give
lighter images than a faster shutter speed. The slowest available shutter speed, 1/30 sec, will give
good results for most setups. A faster shutter speed nromally is only needed if fast moving subjects are
to be captured and played back in slow motion.
The lens aperture affects the exposure and the depth of field: a small aperture like f/22 will give a wide
depth of field but does not let much light in and therefore will require a more powerful lighting or higher
ISO setting to get the correct exposure. An aperture of f/5.6 is a good starting value.
The ISO setting affects the exposure by setting the gain or amplification of the image from the sensor.
A higher ISO setting will give lighter images than a lower ISO setting but may reduce image quality by
introducing noise. Normally an ISO value of between 100 and 3200 will give good results when
capturing video. An ISO setting of 1600 is a good starting point.
The power of the lighting also affects the exposure. Normally it is best to adjust the exposure by
adjusting the power of the lights or changing the ISO setting.

White Balance

The camera's white balance setting affects the color balance of the photos, video and the live view
display. The color balance is also affected by the color temperature of the lighting.

When taking photos using studio strobes or flash guns setting the camera's white balance to "flash"
should give pleasing results. However, the lighting used for the live view will almost certainly be different
and will require a different white balance setting to give good results .e.g a studio strobe with a
tungsten modeling light will give live view images that are too yellow if the live view white balance is set
to "flash". Setting the live view white balance to "tungsten" or "auto" will give better looking live view
images.

When capturing video the white balance setting will depend on the type of lighting and you may need to
try different white balance settings to get the best results. It's normally better to use one of the preset
white balance settings as this is likely to give more consistent results than auto white balance.
The camera's white balance setting and live view white balance settings need to be set to the same
value.

If having accurate colors is important a custom white balance setting can be used. This normally
involves taking a test photo of a neutral gray target and telling the camera to use the settings from this
photo as the custom white balance setting (please see the camera manual for details on how to do
this). Once the white balance setting has been stored in the camera it can be selected by setting the
camera's white balance to "custom".

Auto Focus

Cameras without dual pixel AF in live view
It is recommended that auto focus is not used for most photo booths. This is because it can take
several seconds for the camera to focus at the end of the countdown and this makes it difficult to know
exactly when the photo is going to be taken. Also, if the camera is unable to auto focus it won't take the
photo. DSLR Remote Pro handles this by displaying an error message indicated that it is unable to
focus and will tri to take the photo again after a few seconds.

The simplest way to disable auto focus is to set the AF/MF switch on the camera lens to the MF
position. When setting up the booth you can focus by turning the focus ring on the lens and checking the
focus on the live view display on the PC screen.
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An alternative method of using manual focus is to set the custom function "C.Fn IV: Operations/Others -
Shutter/AE lock button" to "1:AE lock/AF" (please see the camera manual for information on how to set
this). This setting has the advantage that focus can still be adjusted remotely from the PC but auto
focus won't be used when taking a photo. With this setting the lens can be focused in full screen photo
booth mode by typing Ctrl+A. For more precise control of focus exit photo booth mode and type Ctrl+L
to display the live view window. Then use the <<<, <<, <, >, >>, >> buttons or the mouse wheel to
manually adjust the focus.

Cameras with dual pixel AF in live view
Auto focus can be used very effectively in live view when using recent cameras that have Canon's dual
pixel auto focus e.g. Canon EOS M50, Canon EOS 800D/Rebel T7i, Canon EOS 200D/Rebel SL2,
Canon EOS 70D, Canon EOS 77D, Canon EOS 80D, Canon EOS 7D Mark II, Canon EOS 6D Mark II,
Canon EOS 5D Mark IV.

To use auto focus in live view (for all models except the Canon EOS 77D, Canon EOS 800D/Rebel T7i,
and Canon EOS 200D/Rebel SL2) select "Continuous AF" in the camera's settings and set the AF
method to face detect.
Continuous AF can also be selected using DSLR Remote Pro by typing Ctrl+L in the main window to
open the live view window and then right clicking on the live view display and selecting the "Continuous
auto focus" menu option. Then, with the live view window still open, select "Face detect" from the "AF
mode:" dropdown list in the main window.

Note: the AF/MF switch on the camera's lens needs to be set to the AF position

When continuous AF with face detect is enabled the camera will automatically detect faces and focus
on them when live view is active in photo booth mode. When the camera takes each photo it will use
the current focus setting and won't attempt to refocus or cause additional delays before taking the
photo.
This technique can also be used with recent Rebel series cameras (e.g Rebel T6i/EOS 750D and
Rebel T6s/EOS 760D) that have improved AF in live view. Other recent camera models also support
continuous AF in live view but this can be slow.

Some cameras (e.g. Canon EOS 6D Mark II, Canon EOS 77D, Canon EOS 800D/Rebel T7i and
Canon EOS 200D/Rebel SL2) have dual pixel AF in live view but don't support continuous AF. To use
face detect AF in live view with this type of camera they need to be set up as described below.

Press the live view button on the back of the camera to select live view and then press the 'Q' button to
adjust the settings:
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Set the AF Method to face detect AF with tracking by tapping the "AF method" icon in the top left
corner of the camera's touchscreen and then tap the face detect with tracking icon (the first icon on the
left at the bottom of the screen):

Set the AF Operation to Servo AF by tapping on the "AF Operation" icon in the top left corner of the
screen, below the AF Method icon. Then tap on "SERVO" at the bottom of the screen:
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Then press the live view button again to disable live view and also check that the AF/MF switch on the
camera's lens is in the AF position.

Shutter lag

Shutter lag is the time it takes from pressing the shutter release button to when the camera actually
takes the photo. Most cameras have a shutter lag of around 1/10 sec when taking normal photos. The
shutter lag is longer if live view is used and longer still if external flash mode is used. The shutter lag for
some basic Rebel series cameras can be over 1/2 sec when using live view and external flash mode. A
typical shooting sequence with a Rebel series camera using live view and external flash mode is:

User presses the start button to start a 5 second countdown
t=0 sec: countdown screen (e.g. 1.jpg) displayed with "5"
t=1 sec: countdown screen (e.g. 1.jpg) displayed with "4"
t=2 sec: countdown screen (e.g. 1.jpg) displayed with "3"
t=3 sec: countdown screen (e.g. 1.jpg) displayed with "2"
t=4 sec: taking.jpg screen displayed with "1"
t=5 sec: release.jpg screen displayed, live view display hidden and commands to take the photo sent to
the camera
t=5.5 sec: flash fires and camera takes the photo

The extra delay due to shutter lag can confuse some users by taking the photo slightly later than
expected. The delay due to shutter lag can be compensated for by exiting DSLR Remote Pro and
setting the following value in the Windows registry to the delay in milliseconds:
HKEY_CURRENT_USER\Software\BreezeSystems\DSLRRemotePro\100\PhotoboothShutterLag
This setting can also be changed exiting DSLR Remote Pro and then running the Configure.exe utility in
the installation folder.

For example setting this registry value to 500 will tell DSLR Remote Pro to send the command to take
the photo 500ms (1/2 second) before reaching the end of the countdown:

User presses the start button to start a 5 second countdown
t=0 sec: countdown screen (e.g. 1.jpg) displayed with "5"
t=1 sec: countdown screen (e.g. 1.jpg) displayed with "4"
t=2 sec: countdown screen (e.g. 1.jpg) displayed with "3"
t=3 sec: countdown screen (e.g. 1.jpg) displayed with "2"
t=4 sec: taking.jpg screen displayed with "1"
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t=4.5 sec: release.jpg screen displayed, live view display hidden and commands to take the photo sent
to the camera
t=5 sec: flash fires and camera takes the photo

10.8 Saving Settings for Future Reference and using Profiles

Saving settings for future reference and using profiles

Settings can be saved to file for future reference by pressing the "Save..." button and reloaded by
pressing the "Load..." button in the "Photobooth Settings" dialog. This is makes it possible to define a
number of different layouts which can be selected before entering full screen photo booth mode.  When
saving the settings to file you have the option to include a copy of the current printer settings and when
you load these settings the printer settings will also be loaded. This makes it possible to use profiles to
select different printers or printer settings e.g. profile one could print single photos on 6x4 paper, profile
2 could select a double strip of 4 printed on the same printer but using the 6x2 cut strip option and
profile three could select a different printer to print jumbo 6x9 photos.
Please note that layout depends on the size of the page which is affected by the printer settings. The
values saved for one setup may not produce the same results if a different printer is used or the page
or resolution settings have changed. Also the printer settings saved to file are specific to that printer
model and you may get strange results if the printer is no longer available or the settings are copied to
a different computer.

The image download directory specified in preferences is not saved with the photo booth settings, but
you can use the tokens {photoboothDir} and {photoboothSubdir} to specify a different output directory
for each profile.
{photoboothDir} gives the full path of the photo booth images folder e.g. C:
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\Photobooth\Layouts\MyLayout
{photoboothSubdir} gives the name of the photo booth subfolder e.g. if the photo booth images folder is
C:\Photobooth\Layouts\MyLayout then {photoboothSubdir} would become MyLayout

For example:
strips_profile: outputs standard photo booth strips to the default printer and uses C:
\Photobooth\Layouts\strips as its photo booth images dir
cubes_profile: takes four photos with the output set to 'none' and uses C:\Photobooth\Layouts\cubes as
its photo booth images dir. Its output directory is then monitored by the Hot Folder Prints utility which
formats the images as a photo cube and sends them to a different printer.
To make this work the download directory in preferences could be set to C:
\Photobooth\Output\{photoboothSubdir}. This would save images from the strips_profile to C:
\Photobooth\Output\strips and the cubes_profile to C:\Photobooth\Output\cubes. The Hot Folder Prints
utility could then be setup to monitor the C:\Photobooth\Output\cubes folder for images and print them
out automatically when the required number of images are available.

Profiles allow you to use a keyboard shortcut (or touchscreen action) to automatically switch between
different sets of saved settings. To assign a profile to a keyboard shortcut click on the "Profiles..."
button at the bottom of the photo booth settings dialog to display the following dialog:

Then click on "..." button for the appropriate profile and select a previously saved set of photo booth
settings. In the screenshot above profile 1 (keyboard shortcut SHIFT+CTRL+1) loads the settings file
photobooth_settings1.xml and profile 2 (keyboard shortcut SHIFT+CTRL+2) loads the settings file
photobooth_settings2.xml. Profiles can be used to allow users to selects different sets of photo booth
settings e.g. profile 1 might be a traditional layout of two columns of four images and profile 2 might be
a custom layout with one large image and several smaller ones. Profiles can be selected using the
touchscreen actions (described above) allowing a user to easily switch between different settings.

The tokens {photoboothDir}, {photoboothSubDir} and {documents} can be used to specify the pathname
of the profile file to be loaded.
{photoboothDir} is replaced with the value of current photo booth images folder and provides a way to
use more than 18 profiles by allowing profiles to be loaded from the current photo booth images folder
{photoboothSubDir} is replaced with the parent folder of the current photo booth images folder

http://www.breezesys.com/Hotfolder
http://www.breezesys.com/Hotfolder/
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{documents} is replaced with the path of the current user's Documents folder

The default profile setting can be used to ensure the photo booth starts up in a known state and is
reset to a known state at the end of each photo booth shooting sequence e.g. setting the photo booth
to stills mode, color photos and one set of prints.

Select "Load default profile when launching DSLR Remote Pro" to automatically read the settings from
the default profile when running DSLR Remote Pro.

You can also load a profile file by dragging and dropping the settings file onto the DSLR Remote Pro
main window or you can launch DSLR Remote Pro and load a profile by dragging and dropping the
settings file onto the DSLR Remote Pro desktop shortcut. Alternatively right click on the DSLR Remote
Pro desktop shortcut, select properties and add the pathname to settings file to the "Target" (or
command line).
Please note: The settings from when DSLR Remote Pro was last run will be replaced with the settings
read from the profile file loaded at startup.

Tip: To create a setup which uses a different profile when the print quota has been used set the default
profile to something like this:
C:\Profiles\{if,{printQuotaUsed},share_only.xml,print_and_share.xml}
Please see the section on Event Info for more information about the print quota settings.

Loading Random Profiles

There are two different methods of selecting random profiles:

Method 1: Load a randomly selected profile at startup and after each shooting sequence
Set the "Default profile loaded at startup and after each shooting sequence" to "Random", "Random
1..10" or "Random 10..18". The "Random" setting will randomly choose a profile to use from the full set
of 18 profiles, "Random 1..10" chooses a random profile from profiles 1 to 10 and "Random 10..18"
chooses a random profile from profiles 10 to 18.

Method 2: Using touchscreen actions to load a randomly selected profile
Touchscreen actions can be defined to "Select random profile 3-10", "Select random profile 11-18",
"Random profile 3-10 + start" or "Random profile 11-18 + start". When the user touches the "Select
random profile 3-10" touchscreen action a profile in the range 3 to 10 when be randomly selected and
loaded.When the user touches the "Select random profile 11-18" touchscreen action a profile in the
range 11 to 18 when be randomly selected and loaded.
The "Random profile 3-10 + start" and "Random profile 11-18 + start" work in a similar way except that
they also automatically start the shooting sequence after loading the profile.

The random profile options will only choose a profile from profiles that reference a settings file that
exists e.g. using the "Random" option with the profiles set up in the screenshot above will randomly
select profile 1, profile 2 or profile 3.

Saving All Photo Booth Related Settings to File

All photo booth related settings can be saved to an XML file by selecting File->Save Photobooth
Settings...
This is useful if you want to save the current settings before making changes such as loading screen
designs from a third party. You can restore the saved settings by dragging and dropping the XML file
into the main DSLR Remote Pro window or by clicking on the  "Load..." button in the "Photobooth
Settings" dialog.
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The settings saved when selecting File->Save Photobooth Settings... are:
· All the normal photo booth settings that are saved when you click on the "Save..." button in the

"Photobooth Settings" dialog
· The current printer settings
· The profile settings and the default profile
· The photo booth shortcut button settings
· The download folder for photos together with the filename prefix and the year, month and day

subfolder settings
· The image editor settings (File->Setup image editor...)

 

Using Profiles to Set Up a Photo Booth

This section describes how to edit the XML settings files to make them easier to transfer to other photo
booths and to create a settings file which can be dragged and dropped onto the main DSLR Remote
Pro window to install the settings.

The problem
A complete photo booth set up normally includes several photo booth images folders and settings files
for different configurations which are loaded using profiles. There needs to be a way for the settings
files to specify the photo booth images folders in a relative way (so that each photo booth doesn't have
to use exactly the same folders for each configuration) and for the loading the profile definitions and
other settings.

Specifying the photo booth images folder as a relative path 
When the settings are saved to file the <photoboothImageDir> tag specifies the location of the photo
booth images folder as an absolute pathname e.g. C:
\users\Chris\Documents\PhotoboothImages\MyBooth. In DSLR Remote Pro v3.7 onwards the
pathname will be replaced with {documents} if the photo booth images folder is in the current user's
documents folder e.g. C:\users\Chris\Documents\PhotoboothImages\MyBooth will be saved as
{documents}\PhotoboothImages\MyBooth if the current user login is Chris. The files can be copied to
the Documents folder of another user, e.g. John, and when the settings are loaded the {documents}
token will be replaced with path of the current user's Documents folder e.g. C:
\users\John\Documents\PhotoboothImages\MyBooth.

A more flexible method which allows the folders to be copied to any location is to edit the settings file in
a text editor and replace the <photoboothImageDir> tag with '.' e.g. <photoboothImageDir>.</
photoboothImageDir>
When the settings file is loaded the '.' is replaced with the pathname of the settings file and so as long
as the settings file is in the same folder as the screen images the photo booth images folder will be set
correctly.
Please note: if the settings file is saved again using the "Save..." button in the "Photobooth Settings"
dialog the <photoboothImageDir> value will be saved as an absolute pathname and you will need to
edit it again in a text edit to set it back to '.'.

Specifying profile paths and other settings
There are some additional tags that can be added to settings files to define profiles, photo booth
shortcut buttons, the download folder, file uploader settings and image filenames. These tags are read
when the settings file is loaded but are not saved with the other settings when the "Save..." button is
pressed.

The easiest way to explain this is to use an example of a simple three profile set up which consists of
three photo booth images folders:
C:\Photobooth\simple\menu - this contains screens for the initial menu screen
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C:\Photobooth\simple\single - this contains the files for a single photo print layout
C:\Photobooth\simple\2x2 - this contains the files for a print layout with two rows of two photos

The settings files for each folder are:
C:\Photobooth\simple\menu\settings.xml - set this as profile 10 and make it the default profile so that it
is displayed at startup and after each set of photos. Include touchscreen actions to load profile 11 for
single photos and profile 12 for the 2x2 layout
C:\Photobooth\simple\single\settings.xml - set this as profile 11 and include a touchscreen action to
load profile 10 to go back to the main menu
C:\Photobooth\simple\2x2\settings.xml - set this as profile 12 and include a touchscreen action to load
profile 10 to go back to the main menu

Each of the settings.xml files needs to be edited to set the <photoboothImagesDir> to '.' so that the
photo booth images folder is set to the same folder as the settings.xml file.

The final step is to create an XML settings file that can be used to install the profile definitions and
other settings required. This file will be saved in the C:\Photobooth\simple folder and named install_me.
xml. Dragging and dropping this file onto the DSLR Remote Pro main window will load the settings
required to use the simple three profile set up. The install_me.xml file will look something like this:

<?xml version="1.0" encoding="UTF-8"?>
<dslr_remote_pro build_date="Feb 21 2017" version="3.7">

<photobooth_settings>
<!-- Profiles -->
<defaultProfile>10</defaultProfile>
<profile10>.\menu\settings.xml</profile10>
<profile11>.\single\settings.xml</profile11>
<profile12>.\2x2\settings.xml</profile12>

<!-- Folders and filenames -->
<photoboothImageDir>.</photoboothImageDir>
<downloadFolder flattenDate="1" day="1" month="1" year="1">{documents}\PhotoboothImages</downloadFolder>
<filenamePrefix numDigits="0">{uid}_</filenamePrefix>

<!-- Disable the image editor command -->
<editorCommand></editorCommand>

<!-- Event info -->
<eventInfo>

<eventName>The Event Name</eventName>
<eventString1>String one</eventString1>
<eventString2>String two</eventString2>
<eventString3>String three</eventString3>
<eventString4></eventString4>
<eventString5></eventString5>

</eventInfo>

<!-- Set the QR code string -->

<QRcode>https://breezesys.com</QRcode>

<!-- Enable or disable user survey screens -->

<enableUserSurvey>1</enableUserSurvey>

<!-- Enable and label the photo booth shortcut buttons -->
<shortcutButton1 displayOrder="1" enable="1">Printer Setup</shortcutButton1>
<shortcutButton2 displayOrder="2" enable="0"></shortcutButton2>
<shortcutButton3 displayOrder="3" enable="0"></shortcutButton3>
<shortcutButton4 displayOrder="4" enable="0"></shortcutButton4>
<shortcutButton5 displayOrder="5" enable="0"></shortcutButton5>
<shortcutButton6 displayOrder="6" enable="0"></shortcutButton6>
<shortcutButton7 displayOrder="7" enable="1">Reprint Photobooth Photos</shortcutButton7>
<shortcutButton8 displayOrder="8" enable="1">Start Photobooth</shortcutButton8>
<shortcutButton9 displayOrder="9" enable="1">Take Test Photo</shortcutButton9>
<shortcutButton10 displayOrder="10" enable="0"></shortcutButton10>
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<shortcutButton11 displayOrder="11" enable="0"></shortcutButton11>
<shortcutButton12 displayOrder="12" enable="0"></shortcutButton12>
<shortcutButton13 displayOrder="13" enable="0"></shortcutButton13>
<shortcutButton14 displayOrder="14" enable="0"></shortcutButton14>
<shortcutButton15 displayOrder="15" enable="0"></shortcutButton15>
<shortcutButton16 displayOrder="16" enable="0"></shortcutButton16>
<shortcutButton17 displayOrder="17" enable="0"></shortcutButton17>
<shortcutButton18 displayOrder="18" enable="0"></shortcutButton18>
<shortcutButton19 displayOrder="19" enable="0"></shortcutButton19>
<shortcutButton20 displayOrder="20" enable="0"></shortcutButton20>
<shortcutButton21 displayOrder="21" enable="1">Camera Settings...</shortcutButton21>
<shortcutButton22 displayOrder="22" enable="0">Event info...</shortcutButton22>

</photobooth_settings>
</dslr_remote_pro>

What each tag does:

Tag: defaultProfile
Description: defines the default profile that is loaded at startup and after each set of photos (from 1 to
18)
Example: <defaultProfile>10</defaultProfile>

Tag: profile1 to profile18
Description: defines the settings file loaded by each profile. The path can be an absolute path or start
with {documents}, '.' or '..'
Example: <profile10>./menu/settings.xml</profile10>

Tag: photoboothImageDir
Description: defines the path of the photo booth images folder. The path can be an absolute path or
start with {documents}, '.' or '..'
Example: <photoboothImageDir>.</photoboothImageDir>

Tag: downloadFolder
Description:  defines the folder where photos taken by the camera are saved. The path can be an
absolute path or start with {documents}, '.' or '..'. The optional attributes for flattenDate, day, month
and year can be used to specify how date based folders are created
Example: <downloadFolder flattenDate="1" day="1" month="1" year="1">{documents}
\PhotoboothImages</downloadFolder>

Tag: filenamePrefix
Description: defines the prefix added to the filenames of downloaded files. The optional numDigits
attribute specifies how many digits should be used to number the filesshortcutButton1: Printer Setup
Example: <filenamePrefix numDigits="4">IMG_</filenamePrefix>

Tag: editorCommand
Description: defines the pathname of the command that is run on each JPEG image after it has been
downloaded from the camera. The path can be an absolute path or start with {documents}, '.' or '..'. An
empty string will disable the editor command
Example: <editorCommand><editorCommand>

Tag: eventInfo
Description: defines the event name and event strings used to identify an event (more details)

Tag: QRcode
Description: defines the QR code string for QR codes added to print layouts or displayed in the
sharing screen (more details)
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Tag: enableUserSurvey
Description: enables or disables the user survey screens (more details)
Example: <enableUserSurvey>0</enableUserSurvey>

Tag: shortcutButton1 to shortcutButton22
Description: defines the photo booth shortcut buttons displayed in the main window. The optional
enable attribute enables or disables the button. The displayOrder attribute defines the order in which
the buttons should be displayed. This must be a number between 1 and 21 and each button must have
a different value otherwise it may not be displayed. If the button text is empty the current value will be
used. 
Example: <shortcutButton1 enable="1" displayOrder="1">Printer...</shortcutButton1>

The tags for each shortcut button are:
shortcutButton1: Printer setup
shortcutButton2: Edit QR Code
shortcutButton3: Photobooth Setup Wizard
shortcutButton4: Print Layout
shortcutButton5: Advanced Settings
shortcutButton6: Videobooth Settings
shortcutButton7: Reprint Photobooth Photos
shortcutButton8: Start Photobooth
shortcutButton9: Take Test Photo
shortcutButton10: Load Profile...
shortcutButton11: Load Profile 1
shortcutButton12: Load Profile 2
shortcutButton13: Load Profile 3
shortcutButton14: Load Profile 4
shortcutButton15: Load Default Profile
shortcutButton16: Save Default Profile
shortcutButton17: Load Profile 5
shortcutButton18: Load Profile 6
shortcutButton19: Load Profile 7
shortcutButton20: Load Profile 8
shortcutButton21: Camera Settings...
shortcutButton22: Event info...

Uploader Tags: uploadFiles, uploadUrl, uploadPassword, uploadXmlSummary etc.
Description: define the settings for the file uploader
Example: <uploadFiles>0</uploadFiles>

The tags for the uploader settings are:
uploadFiles: enable or disable the uploading of files
uploadUrl: the upload URL
uploadPassword: the encrypted upload password (this can be copied from the following Windows
registry setting:
HKEY_CURRENT_USER\SOFTWARE\BreezeSystems\DSLRRemotePro\100\UploadPassword)
uploadPrintLayout: upload the JPEG copy of the printed output
uploadProcessedPrintLayout: uploaded the processed copy of the printed layout
uploadXmlSummary: upload the photo booth XML summary file
uploadOriginalPhotos: upload the original photos
uploadProcessedPhotos: upload the processed copy of the original photos
uploadSharingXml: upload the XML sharing files when sending emails and texts
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10.9 Modifying Photos Before Printing

Sometimes it is necessary to modify the photos using another application before they are printed by
DSLR Remote Pro. This could be to use AI to modify an image or to run a Photoshop droplet to apply
a special effect or to produce a specific "look" to the photos.
Please see the Postprocessing of Photos section for information on how to apply AI to photos and
alternative method of running local commands or using Photoshop droplets to modify photos.

This section explains how run Photoshop droplets using the editor command when running DSLR
Remote Pro v3.19 or earlier.

Please note that to run Photoshop droplets a registered copy of Photoshop needs to be installed on the
photo booth computer. You also need to download and install AutoHotKey. AutoHotKey is a free
Windows scripting tool which can be downloaded from https://www.autohotkey.com
IMPORTANT: Please download AutoHotKey v1.1. The droplet script is only compatible with
AutoHotKey v1.1 and will not work with AutoHotKey 2.0.

Photoshop Droplets step 1 - Run a command on each photo after it
has been downloaded

The Photoshop droplet or other command can be automatically run after downloading each photo using
the edit images option by selecting "Setup Image Editor..." from the File menu:

Select the "Use command line below" option and enter the pathname of the command or script that
should be run on each photo after it has been downloaded. Set the command line to "droplet.ahk
{photoboothImage}" to run a Photoshop droplet on each photo taken in photo booth mode. This will run
an AutoHotKey script called droplet.ahk each time a photo is taken. The script saves a copy of the
photo in a subfolder named Originals and then runs the Photoshop droplet on the downloaded photo. 
The {photoboothImage} token is set to the number of the photo in the sequence (1, 2, 3, 4 etc.) or 0 if
DSLR Remote Pro is not running in photo booth mode. Please see the section on tokens for more
information about tokens like {photoboothImage}.

Select "Automatically edit the image when a photo is taken" option and select "Edit JPEG files only".
This will run the command on every time a photo is taken and a JPEG image is downloaded to the
computer. This can be disabled by unchecking "Automatically edit the image when a photo is taken".

Photoshop Droplets step 2 - Delay the printing of the photos to
allow time for the photo to be processed

Normally DSLR Remote Pro will start preparing the print layout immediately after downloading the last
photo in the shooting sequence and this can result in the last photo not being modified before it is

https://www.autohotkey.com
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placed in the print layout if the command takes too long to process the photo. This problem can be
avoided by setting a delay before printing in the "Output Settings" dialog:

Set the delay before printing to sufficient time to allow the command to modify the photo. After taking
the last photo DSLR Remote Pro will wait for the specified number of seconds before it starts to create
the print layout. The delay can be cut short by sending the key sequence Ctrl+Z to DSLR Remote Pro.
This is done automatically by the droplet.ahk script after the droplet has been run on the last photo in
the sequence.
Set the delays to a time that is guaranteed to always be long enough (e.g. 30 secs) and the script will
send Ctrl+Z to DSLR Remote Pro when droplet has finished, thus minimizing the time DSLR Remote
Pro waits before printing the photos.

Photoshop Droplets step 3 - Copy the Photoshop Droplet to the
Photobooth Images folder

Photoshop droplets are executable files that have a .exe file extension. The droplet should be saved in
the current photobooth images folder and be given a name that starts with droplet e.g. droplet.exe or
droplet_artistic_effect.exe.

Running Different Photoshop Droplets on each Photo

If there is only one droplet file in the photobooth images folder it will be applied to each photo in the
shooting sequence. A different droplet can be run on each photo in the shooting sequence by setting
the command line to droplet.ahk {photoboothImage}
The {photoboothImage} token is set to the number of the photo in the sequence (1, 2, 3, 4 etc.) or 0 if
DSLR Remote Pro is not running in photo booth mode.
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The droplet.ahk will list all .exe files starting with droplet found in the photo booth images folder, sort
them into alphabetical order and then use the photo number to decide which one to run.
e.g.
droplet_effect_1.exe - run on photo 1
droplet_effect_2.exe - run on photo 2
droplet_effect_3.exe - run on photo 3
droplet_effect_4.exe - run on photo 4

Running Different Photoshop Droplets using Profiles

Different droplets can be used for different profiles by placing the droplet in the photobooth images
folder selected by the profile and running the droplet.ahk from the editor command. If the script cannot
find the droplet in the current photobooth images folder it will look for it in the same folder as the script.

Hiding the Photoshop Window

When a Photoshop droplet is run it will launch Photoshop if it is not already running and the Photoshop
window will appear on the photo booth screen. To avoid this happening run the "Hide Window Taskbar"
utility. This can be run by double clicking on HideWindowsTaskbar.exe in the DSLR Remote Pro
installation folder (usually C:\Program Files (x86)\BreezeSys\DSLR Remote Pro):

Select the option to "Hide Photoshop window when photo booth is running". The Hide Windows Taskbar
utility will monitor DSLR Remote Pro and when it is running in full screen photo booth mode the utility
will hide the Windows task bar and the Photoshop window if Photoshop is running. When you exit full
screen photo booth mode the utility will automatically restore the Windows taskbar and show the
Photoshop window again.
Please make sure no tool windows are open in Photoshop otherwise these may appear on the photo
booth screen when running the droplet.

The Hide Windows Taskbar hides the Windows task bar when full screen photo booth mode is selected
to avoid problems with the taskbar appearing on screen during photo booth shooting on some
computers. This function is deliberately not built into the main DSLR Remote Pro program because if
DSLR Remote Pro exits prematurely (e.g. due to problems with the camera connection) it won't be
able to restore the Windows taskbar which then makes it very difficult to control the computer. This
problem is avoided by using a separate utility which is simple and very reliable.

The droplet.ahk script will also help to hide the Photoshop window.

Notes for creating and running Photoshop droplets

The Photoshop droplet needs to save the edited image so that it overwrites the original photo. Note:
Don't worry about overwriting the original photo: the droplet.ahk script will save a copy of the original
photo in a subfolder named "originals" before running the droplet.
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Try to avoid droplets that cause Photoshop to display progress windows when processing certain
commands as these can be difficult to hide and could be visible on the photo booth's screen.

Make sure there is enough time between photos to run the droplet. If the countdown interval for the
second photo in the shooting is shorter than the time it takes to run the Photoshop droplet there won't
be enough time to process the last photo before the next one is ready and the droplets won't work
properly. 

Please note: to use the droplet.ahk AutoHotKey script you need to install AutoHotKey v1.1 on your
computer. This is a free download from https://autohotkey.com

10.10 Signing or Drawing on the Prints

After taking the photos a screen allowing users to sign the prints or draw on them can be displayed by
selecting the "Sign or draw on photos before printing" option in the "Output Settings" dialog.

The print layout is displayed full screen with a menubar down the left hand side. The current line width
and pen color is displayed in the top left hand corner. Users can sign their print or draw on it using a
touchscreen or mouse. Tapping the color palette icon in the menubar will display a panel of colors
allowing users to choose the pen color:

When the user taps on a color in the panel it is highlighted and the pen width and color indicator in the
top left corner is updated to show the color. The color panel can be dismissed by tapping anywhere in
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the menubar or by drawing on the print.
Tapping the line width icon in the menu bar will display a slider allowing users to adjust the line width: 

The pen width can be adjusted by moving the slider left or right and the pen width and color indicator in
the top left corner is updated to show the new pen width. The pen width slider can be dismissed by
tapping anywhere in the menubar or by drawing on the print.

Users can add emojis/stickers/virtual props by clicking on the emoji icon in the menu and then selecting
the required image. The image is placed in the center of the print preview and can be moved by
dragging the center and resized or rotated the image by dragging the corners. Tap outside the image
to fix it. The emoji can be removed by tapping the undo button.

If the user makes a mistake they can undo the last action by tapping the "Undo" icon (the red arrow in
the menubar). Alternatively they can start again by tapping the trashcan icon. Actions that have been
undone by tapping on the undo or trashcan icons can be re-done by tapping the "Redo" icon (the blue
arrow in the menubar).

The number of copies to print can be increased by tapping the + symbol to the right of the number of
copies display in the menubar and decreased by tapping the - symbol.

Tapping the printer icon accepts the photos together with any drawing added by the user and prints the
selected number of copies.

Tapping on the cancel icon (the cross in the menubar) will reject photos and the photo booth will return
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to the ready screen without printing the photos.

Modifying the appearance of the screen

The default screen appearance is a black background with a white menubar area. The icons for the
actions in the menubar a defined using PNG files in the icons subfolder of in the installation folder:
color.png - image used for the color palette icon
width.png - image used for the pen width icon
emoji.png - image used for the emoji icon
frames.png - image used for the frames icon
redo.png - image used for "Redo" icon
undo.png - image used for the "Undo" icon
clear.png - image used for the clear/trashcan icon
print.png - image used for the print icon
cancel.png - image used for the cancel icon

The appearance of the icons can be changed by replacing the PNG images in the icons subfolder with
new images or by placing PNG images in the current photobooth images folder.

The appearance of the whole screen can be modified by creating a JPEG screen image named
usermodifyprint.jpg and placing it in the current photobooth images folder. The screen image should be
the same size in pixels as the screen on which the photo booth will be displayed.

An optional overlay can be placed on top of the background and print layout by creating a PNG screen
image named usermodifyprint_overlay.png and placing it in the current photobooth images folder. The
overlay image should be the same size in pixels as the screen on which the photo booth will be
displayed and should contain transparency information in the alpha channel. The overlay can be used to
display instructions to the user and will appear on screen but not in the final prints.

A set of color icons is available in the "color icons" subfolder of the installation folder:

These can be used by renaming the "icons" subfolder to "b&w icons" and renaming the "color icons"
subfolder to "icons" in the installation folder. Alternatively the icon PNG files can be copied into the
current photo booth images folder. 

Editing the settings

Hold down the shift and ctrl keys and left click the mouse to display the settings dialog:
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Use the checkboxes in the "Menu Items" area to select which actions should be made available to the
user in the menubar area.

Select "Enable line drawing" if you want users to be able to draw on the print. Disable "Enable line
drawing" if you only want users to be able to add emojis or frames.

The initial color setting specifies the pen color that is selected when the screen is displayed. Click on
the "..." button to choose a different color.
The initial line width specifies the line width in pixels of the pen when the screen is first displayed. The
min line width and max line width settings specify the range of line widths the user can select if the "Line
width selector" menu option is enabled.
Select "Automatically close color selector when user selects color" to close the color selector menu
when a color is selected.

By default the emoji and frame menus have a white background. Select "Use gray background for emoji
and frame menus" to use a mid-gray background instead. This is useful if the emojis or frames have
light colors which don't show up well against a white background.

Select "Automatically close frame selector when user selects a frame" to close the frame selector
menu when a frame is selected. If this option is not selected the frame selector menu will continue to
be displayed when a frame is selected and the print preview is updated to show the selected frame.

Select "Default to first frame" to add the first frame to the print layout when opening the drawing/signing
screen.

The "Inactivity timeout (secs):" setting allows a timeout to be set. If the user does not touch the screen
for a period longer than the timeout value the screen will be closed and the photos either printed or
canceled depending on the timeout action setting. Setting the timeout to 0 will disable the timeout.

Select "Emojis" to add the option to add emojis/stickers/virtual props to prints and specify the folder
where the emoji images are stored in "Emoji folder:". The images should be PNG images with an
optional alpha channel for transparency information. The recommended image size for the emoji images
is between 128x128 pixels and 1024x1024 pixels.
The folder name can be a relative path (e.g. "emoji") to use images in a subfolder or an absolute path
(e.g. C:\emoji_images) if they are stored elsewhere. If it is set to a relative path it looks for the
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subfolder in the current photo booth images folder first and then looks in the installation folder. This
allows different sets of emojis to be made available for each profile if required.
Emoji icons supplied by EmojiOne

The max copies setting specifies the maximum number of print copies the user can select by tapping
the + symbol in the menubar.

The position of the print preview can be adjusted using the "Preview position:" dropdown. The default
setting is to center it vertically. Select the "Top" option to place the preview at the top of the screen or
"Bottom" to place it at the bottom of the screen.

By default users can draw anywhere on the print, but this can be limited by enabling the clipping and
exclusion clipping regions. The clipping region is used to specify a region where the user is allowed to
draw. The exclusion region allows an area within the drawing area to be protected e.g. to stop people
drawing on corporate logos. The clipping and exclusion clipping regions can be edited by clicking on the
"OK" button. The clipping region will be displayed by a green rectangle and the exclusion clipping region
by a red rectangle. Click on one of the rectangles to select it and then adjust its size and position by
dragging it corners. Click in the menubar area to save the settings and return to drawing mode.

Select the "Show mouse cursor" to display the mouse cursor to allow users to draw on the prints using
a mouse.

Frames

The frames option allows users to choose a frame to apply to the print layout. The frames are defined
by overlay PNG images in the current photo booth images folder with filenames starting with frame_ e.
g. frame_1.png, frame_2.png etc. The frame overlays are sorted into alphabetical order when they are
displayed in the frame selector menu.
The frames menu icon will only be displayed if the "Frames" option is selected in the settings and one
or more frame overlay images are found in the current photo booth images folder.

The frame overlay images should be the same size in pixels as the print layout and have transparent
areas where the photos are positioned so that the photos can be seen underneath the frame overlay.
Please note: The frame overlay is added to the print layout after captions, logos etc. have been added
and may obscure them. If you wish to add a logo or caption to the prints and use the frames option in
the drawing/signing screen you either need to leave transparent areas in frames or to add the logos or
captions to each of the frame overlay images.

Implementation notes

The signing and drawing screen is implemented using a dynamic library named UserModifyPrint.dll and
saves its settings in the Windows registry using the following registry key:
HKEY_CURRENT_USER\SOFTWARE\BreezeSystems\DSLRRemotePro\100\UserModifyPrint
If different drawing and signing functionality is required it can be implemented by creating a new
dynamic library to replace the default UserModifyPrint.dll library without requiring a custom build of
DSLR Remote Pro.

Copyright information for icons used by UserModifyPrint.dll:
Undo/Redo/Cancel/Frames icons: These icons are provided by icons8 as Creative Commons
Attribution-NoDerivs 3.0. You can copy, use and distribute this icon, even for commercial purposes, all
without asking permission provided you link to icons8.com website from any page you use this icon.
You may not alter, transform, or build upon this work. https://icons8.com
Color Palette/Trashcan icons from http://downloadicons.net
Printer icon: royalty free icon purchased from http://artistsvalley.com. This icon may only be used with

https://www.emojione.com
https://icons8.com
http://downloadicons.net
http://artistsvalley.com
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Breeze Systems' products unless a separate license is purchased from Artists Valey. 
Line width: Copyright Breeze Systems Limited. This icon may only be used with Breeze Systems'
products.

10.11 Touchscreen Keyboard

An optional touchscreen keyboard can be displayed at the start or end of the photo booth shooting
sequence to allow users to enter information such as their email address. To enable the keyboard set
the photo booth start options in the photo booth settings dialog to "Touchscreen" and click on the
"Settings..." button. The touchscreen settings dialog will be displayed:

Then select the required touchscreen keyboard option from the dropdown list:
"Not displayed" - the touchscreen keyboard is not displayed
"Email input at start of sequence" - the email input touchscreen keyboard is displayed when the user
presses the start button before any of the photos are taken
"Email input at end of sequence" - the email input  touchscreen keyboard is displayed after the photos
have been taken and the optional print confirmation screen has been displayed (it isn't displayed if the
user chooses not to print the photos)
"Email input after taking photos".- the email input touchscreen keyboard is displayed immediately after
taking the photos before the optional print confirmation screen
"Message input at end of sequence" - the message input  touchscreen keyboard is displayed after the
photos have been taken and the optional print confirmation screen has been displayed (it isn't displayed
if the user chooses not to print the photos)

The "Timeout (secs):" setting allows an inactivity timeout to be specified. If the user does not tap the
touchscreen for a while the timeout will automatically close the touchscreen keyboard. This is useful if
the user leaves the photo booth without using the touchscreen keyboard as it allows the booth to
automatically close the touchscreen keyboard and display the ready screen ready for the next user.
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Select the "Show mouse cursor" option to display a mouse cursor in the ready screen and other
screens requiring user input. This setting allows a photo booth to operating using a mouse if a
touchscreen display is not available.

Select "Enable user survey screens" to enable the display of user survey screens (see the User Survey
section for more information).

The touchscreen keyboard can be tested by pressing the "Test keyboard..." button and selecting the
keyboard type to test from the menu. The default keyboard layout will fill the screen and look similar to
the screenshot below:

The text entered by the user is saved in the <user_data> tag (and the <user2_data> tag if two text
fields are defined) in the XML file written at the end of the photo booth shooting sequence. If any
checkboxes are defined (see below) their status will be saved in <chkbox1>, <chkbox2> etc. tags e.g.
if the user selects the first checkbox the XML will contain <chkbox1>1</chkbox1>. The XML file is
saved in the same folder as the photos downloaded from the camera (see preferences) e.g.

<?xml version="1.0" ?>
<breeze_systems_photobooth version="1.0">
<photo_information>
  <date>2011/01/26</date>
  <time>16:37:19</time>
  <user_data>sales@breezesys.com</user_data>
  <photobooth_images_folder>C:\Photobooth\PhotoboothImages</photobooth_images_folder>
  <photos>
    <photo image="1">20110126_163719_1.JPG</photo>
    <photo image="2">20110126_163719_2.JPG</photo>
    <photo image="3">20110126_163719_3.JPG</photo>
    <photo image="4">20110126_163719_4.JPG</photo>
    <output>prints\20110126_163719.jpg</output>
  </photos>
</photo_information>
</breeze_systems_photobooth>

There is a default timeout of 300 secs after which time the touchscreen keyboard will be automatically
canceled. This timeout is stored in the Windows registry key:
HKEY_CURRENT_USER\Software\BreezeSystems\DSLRRemotePro\100
\PhotoboothKeyboardTimeout

When the "Message input at end of sequence" touchscreen option is used the data entered by the user
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is also stored in the {message} token which can be used in the captions in the print layout or in email
messages when using the sharing options.

Customizing the keyboard
The layout of the keyboard can be customized by creating an XML settings file called keyboard.xml and
putting this in the photo booth images folder. This gives control over the size and position of the keys,
the background color etc. A series of keyboard images can also be used if you need more control of
the appearance of the keyboard.

The easiest way to customize the keyboard is to save a copy of the XML file and TIFF screen images
used to define the default keyboard layout and then edit them as required. The files can be saved by
first displaying the keyboard by pressing the "Test keyboard..." button and then holding down both the
Shift and Ctrl keys and pressing the left mouse button. The keyboard.xml file will look something like:

<?xml version="1.0" ?>
<breeze_systems_photobooth version="2.2">
<photobooth_settings>
  <keyboard>
    <text_point_size>480</text_point_size>
    <prompt1 rows="1">Please enter your email address:</prompt1>
    <text1_y>411</text1_y>
    <text1_x>50</text1_x>
    <text1_r>300</text1_r>
    <background_color>0x000080</background_color>
    <transparent_color>0x000080</transparent_color>
    <text_color>0xFFFFFF</text_color>
    <show_cursor>0</show_cursor>
    <show_mouse_cursor>0</show_mouse_cursor>
    <key>
      <left>58</left>
      <top>630</top>
      <width>112</width>
      <height>89</height>
      <legend>q</legend>
      <shifted_legend>Q</shifted_legend>
      <code>q</code>
      <shifted_code>Q</shifted_code>
    </key>
    <key>
      <left>186</left>
      <top>630</top>
      <width>112</width>
      <height>89</height>
      <legend>w</legend>
      <shifted_legend>W</shifted_legend>
      <code>w</code>
    </key>
    ...
    <key>
      <left>1296</left>
      <top>840</top>
      <width>160</width>
      <height>89</height>
      <legend>Shift</legend>
      <shifted_legend>Shift</shifted_legend>
      <code>Shift</code>
      <shifted_code>Shift</shifted_code>
    </key>
    <key>
      <left>400</left>
      <top>945</top>
      <width>368</width>
      <height>89</height>
      <legend>Send email</legend>
      <shifted_legend>Send email</shifted_legend>
      <code>OK</code>
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      <shifted_code>OK</shifted_code>
    </key>
    <key>
      <left>784</left>
      <top>945</top>
      <width>368</width>
      <height>89</height>
      <legend>No thanks!</legend>
      <shifted_legend>No thanks!</shifted_legend>
      <code>Cancel</code>
      <shifted_code>Cancel</shifted_code>
    </key>
  </keyboard>
</photobooth_settings>
</breeze_systems_photobooth>

Text input
The <prompt1> tag defines the text that is displayed above the user input area and defaults to "Please
enter your email address:". The <text1_x> and <text1_y> tags specify the position of the user input
area. This is specified as the number of pixels down from the top, left corner of the screen. The right
hand side of the user input area can be specified using the <text1_r> tag or you can specify the width
using the <text1_w> tag.
Additional prompts can be added by including <prompt2>, <text2_x>, <text2_y>, <text2_r> etc. tags up
to a maximum of 10 user input areas.

The prompt tags can have an optional password attribute which if set to "1" will display the text in the
user input area as * characters e.g. <prompt1 password="1">Please enter your password:</prompt1>.
The prompt tags can have an optional mandatory attribute which if set to "1" means that the prompt
must contain text e.g. <prompt1 mandatory="1">Please enter your name:</prompt1>.
The prompt tags can have an optional email_address attribute which if set to "1" will check that the text
looks like an email address in the form name@domain.com e.g. <prompt1 email_address="1">Please
enter your email address:</prompt1>. If the text does not appear to be an email address an error
message saying "Please enter a valid email address in the form name@domain.com" will be displayed.
The text of this error message can be changed in the email settings dialog.
The prompt tags can have an optional value attribute to define an initial value. This value can include 
tokens which are evaluated when the keyboard is displayed e.g. <prompt1
value="{eventString1}">Email address:</prompt1>
The prompt tags can include an optional id attribute which can be used to help identify input fields for 
user survey data e.g. <prompt1 id="name">Please enter your name:</prompt1>
Prompt tags in survey data can also be used to collect an email address and automatically send the
email when the sharing screen is displayed by setting the id to "autoEmail" e.g. <prompt1
id="autoEmail" email_address="1">Please enter your email address:</prompt1>.

The input text area is normally on a single line. Multiple lines can be used by setting the prompt tag's
rows attribute to 2 or more e.g. <prompt1 rows="3">Please enter a message:</prompt1>.
When more than one user input area is defined users can switch between the input areas by touching
them. The currently selected input area is highlighted in red.

The optional <text_point_size> tag defines the size of the text font used in the user input area. This is
specified in tenths of a point and defaults to 480 (a point size of 48).
The text entered by the user is stored in the <user_data>, <user2_data> etc. fields in the XML file
saved with the photos.

You can use attributes instead of tags to define a text input area more concisely e.g.

<prompt1 id="email" email_address="1" mandatory="1" x="20" y="172" w="1496">Please enter your
name</prompt1>
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is the same as

<prompt1 id="email" email_address="1" mandatory="1>Please enter your name</prompt1>
<text1_x>20</text1_x>
<text1_y>172</text1_y>
<text1_w>1496</text1_w>

Checkboxes
Up to 10 checkboxes can be added using the <chkbox1_prompt>, <chkbox1_x>, <chkbox1_y>,
<chkbox2_prompt>, <chkbox2_x>, <chkbox2_y> etc. tags. The <chkbox1_prompt> tag specifies the
text displayed to the right of the text box and can include a value attribute to specify whether the
checkbox is initially checked or not e.g. <chkbox1_prompt value="0">Checkbox prompt (default off)</
chkbox1_prompt> or <chkbox1_prompt value="1">Checkbox prompt (default on)</chkbox1_prompt>. A
checkbox can also be made mandatory (i.e. the user has to check the checkbox before pressing the
"OK" button) by adding the mandatory attribute to the <chkbox1_prompt> tag e.g. <chkbox1_prompt
mandatory="1">I agree to the terms and conditions</chkbox1_prompt>. The optional point_size
attribute can be used to specify the point size of the legend and also the size of the checkbox box e.g.
<chkbox1_prompt point-size="240">Checkbox</chkbox1_prompt> adds a checkbox with the legend
displayed using 24 point text.
The chkbox_prompt tags can include an optional id attribute which can be used to help identify input
fields for user survey data e.g. <chkbox1_prompt id="over18"> I am over 18 years of age</
chkbox1_prompt>
The <chkbox1_x> and <chkbox1_y> tags specify the position of the checkbox. These can be specified
as separate tags or as attributes of the chkbox tag.

Example: this creates a checkbox which is initially set, has the caption "Checkbox prompt" with a point
size of 24 and is placed 100 pixels from the left of the screen and 200 pixels from the top of the
screen:
<chkbox1_prompt point_size="240" value="1" x="100" y="200">Checkbox prompt</chkbox1_prompt>

and is equivalent to this:
<chkbox1_prompt point_size="240">Checkbox</chkbox1_prompt>
<chkbox1_x>100</chkbox1_x>
<chkbox1_y>200</chkbox1_y>

The checkbox status is stored in the <chkbox1>, <chkbox2> etc. fields in the XML summary file saved
with the photos.

Adding an Information Page
An optional information page can be displayed to provide more information to the user e.g. a privacy
policy or help information.
To add an information page create a JPEG or TIFF screen image with the same name as the
keyboard.xml file e.g. email_keyboard_info.jpg. This can be displayed by defining a key with the code
"info". The info screen will close automatically after a timeout of 30 secs. It can be closed manually by
defining a key with the code "info close" and tapping on it. Please see the "User Survey" section for an
example.

Color and Other Settings
The <background_color> tag specifies the background color of the window and the <key_text_color>
specifies the color for the prompt text and key legends.
The optional <text_foreground_color> tag specifies the foreground color for text displayed in the user
input areas. The default value if this tag is omitted is black (0x000000).
The optional <text_background_color> tag specifies the background color for the user input areas. The
default value if this tag is omitted is white (0xFFFFFF).
The optional <text_box_outline_color> tag specifies the color for outline of text input areas. The default
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value if this tag is omitted is black (0x000000).
The optional <text_box_outline_highlight_color> tag specifies the color for outline of the active text input
area when more than one text input is defined. The default value if this tag is omitted is red
(0xFF0000).
The optional <transparent_color> tag specifies a color which will be made transparent when the
keyboard is displayed.
All colors should be hexadecimal RGB values e.g. 0x000000 for black, 0xFF0000 for red, 0x00FF00 for
green, 0x0000FF for blue, 0xFFFFFF for white.

The <show_cursor> tag specifies whether a gray cursor is shown in the user input area. Set this to 1 to
display the cursor or 0 to hide it. The cursor display is useful if the keyboard allows the entry of
spaces.
The <show_mouse_cursor> tag specifies whether a the mouse cursor is displayed, The default setting
is for the mouse cursor not to be displayed.

The <vertical_position> tag specifies the default position of the keyboard if no keys are defined in the
XML file. Set this to "top" to place the keyboard at the top of the screen, "bottom" to place it at the
bottom of the screen or set it to the number of pixels measured from the top of the screen.

The <key> tag specifies the size and position of each key, its legends and what should be typed when
it is pressed. The top left corner of the key is defined using the <left> and <top> tags and the width
and height are specified using the <width> and <height> tags (all values are in pixels). The
<shifted_legend> tag specifies what is displayed on the key when the shift key is pressed and the
<legend> specifies the key legend when shift is not pressed. 
The <shifted_code> tag specifies what is typed when the key is pressed when shift is pressed and the
<code> tag specifies what is typed when the shift key is not pressed. The following codes have special
values:
"Shift" - puts the keyboard into shifted mode (i.e. upper case) when pressed
"Delete" - delete a character from the text input field
"Clear" - clear all text input fields
"Newline" - start a new line in a multi-line text input field
"Left" - move the cursor left in a text input field
"Right" - move the cursor right in a text input field
"info" - display the optional info screen if defined
"info close" - close the optional info screen and return to the touchscreen keyboard
"OK" - closes the keyboard window and returns the user input if at least one text input field contains
text and all inputs marked as mandatory have been entered
"OK all" - closes the keyboard window and returns the user input if all the input fields contain some text
"OK none" - closes the keyboard window and returns the user input even if none of the input fields
contain text provided all inputs marked as mandatory have been entered
"Cancel" - closes the keyboard window and cancels the user input
"Close" - closes the keyboard and returns to the ready screen when the "Email input at start of
sequence" touchscreen keyboard option is used

International and special characters need to be added in UTF-8 unicode format e.g. the Euro symbol,
€, is defined in UTF-8 as 0x20AC. This needs to added to the XML file as &#x20ac; e.g.
    <key>
      <left>58</left>
      <top>630</top>
      <width>112</width>
      <height>89</height>
      <legend>&#&x20ac;</legend>
      <shifted_legend>&#&x20ac;</shifted_legend>
      <code>&#&x20ac;</code>
      <shifted_code>&#&x20ac;</shifted_code>
    </key>
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The keyboard.xml can just include additional settings and the touchscreen keyboard will use the default
layout (shown above) if it doesn't contain any <key> tags. For example you could use the default
keyboard layout and add a checkbox to ask users whether they consent to their photos being uploaded
to a website using the keyboard.xml file below:

<?xml version="1.0" ?>
<breeze_systems_photobooth version="2.3">
<photobooth_settings>
  <keyboard>
    <chkbox1_prompt value="0">I agree to my photos being posted on a web site</
chkbox1_prompt>
    <chkbox1_x>38</chkbox1_x>
    <chkbox1_y>70</chkbox1_y>
  </keyboard>
</photobooth_settings>
</breeze_systems_photobooth>

Or you could use it to place the keyboard at the top of the screen e.g. for a mirror booth:

<?xml version="1.0" ?>
<breeze_systems_photobooth version="2.3">
<photobooth_settings>
  <keyboard>
    <vertical_position>top</vertical_position>
  </keyboard>
</photobooth_settings>
</breeze_systems_photobooth>

Example 1: Adding a CC line to the email keyboard
To do this we need to add a second prompt of type email_address to the email keyboard. Start with
the default email_keyboard.xml file by opening the touchscreen editor, clicking on "Test keyboard..."
and selecting "Email keyboard". Then hold down the Shift and Ctrl keys and left click the mouse to save
the XML file and the keyboard images. Next delete the four keyboard image files (otherwise we won't
see any any changes we make to the text prompts). Open the email_keyboard.xml file in a text editor.
It will look something like this:

<?xml version="1.0" encoding="UTF-8"?>
<breeze_systems_photobooth version="3.12" build_date="Nov 20 2018">
<photobooth_settings>
  <keyboard>
    <prompt1 email_address="1">Please enter your email address:</prompt1>
    <text1_x>38</text1_x>
    <text1_y>356</text1_y>
    <text1_r>1882</text1_r>
    <chkbox1_prompt x="-1" y="-1"></chkbox1_prompt>
    <background_color>0xEBEBEB</background_color>

...
  </keyboard>
</photobooth_settings>

Duplicate the four lines defining the text prompt (the lines starting with <prompt1, <text1_x, <text1_y
and <text1_r) and change the tags from 1 to 2. Then change the text for prompt2 from "Please enter
your email address:" to "CC:". Finally add the mandatory="1" attribute to prompt1 to ensure that the
user enters an email address in the first text area. The CC email address is optional and so prompt2
does not need the mandator attribute.
The email_keyboard.xml file should now look something like this:

<?xml version="1.0" encoding="UTF-8"?>
<breeze_systems_photobooth version="3.12" build_date="Nov 20 2018">
<photobooth_settings>
  <keyboard>
    <prompt1 email_address="1" mandatory="1">Please enter your email address:</prompt1>
    <text1_x>38</text1_x>
    <text1_y>170</text1_y>
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    <text1_r>1882</text1_r>
    <prompt2 email_address="1">CC:</prompt2>
    <text2_x>38</text2_x>
    <text2_y>356</text2_y>
    <text2_r>1882</text2_r>
    <chkbox1_prompt x="-1" y="-1"></chkbox1_prompt>
    <background_color>0xEBEBEB</background_color>

...
  </keyboard>
</photobooth_settings>

Example 2: Adding a terms and conditions page
The "Email input at start of sequence" touchscreen keyboard option and the "Close" <key> code can be
used to create a simple terms and conditions page that the user must accept in order to use the photo
booth. To do this first create a keyboard.xml file with two keys defined: one to accept the terms and
conditions and one to reject them. If the user presses the reject key they will be returned to the ready
screen. The following keyboard.xml file defines an accept key and a reject key suitable for a terms and
conditions page:

<?xml version="1.0" encoding="UTF-8"?>
<breeze_systems_photobooth version="3.4" build_date="Apr 25 2016">
<photobooth_settings>
  <keyboard>
    <background_color>0x000080</background_color>
    <key_text_color>0xFFFFFF</key_text_color>
    <text_foreground_color>0x000000</text_foreground_color>
    <text_background_color>0xFFFFFF</text_background_color>
    <text_point_size>180</text_point_size>
    <text_font_name>Arial</text_font_name>
    <show_cursor>0</show_cursor>
    <show_mouse_cursor>0</show_mouse_cursor>
    <prompt1 email_address="0"></prompt1>
    <text1_y>2000</text1_y>
    <key>
      <left>457</left>
      <top>20</top>
      <width>419</width>
      <height>101</height>
      <legend>Accept</legend>
      <shifted_legend>Accept</shifted_legend>
      <code>OK none</code>
      <shifted_code>OK none</shifted_code>
    </key>
    <key>
      <left>895</left>
      <top>20</top>
      <width>419</width>
      <height>101</height>
      <legend>Reject</legend>
      <shifted_legend>Reject</shifted_legend>
      <code>Close</code>
      <shifted_code>Close</shifted_code>
    </key>
  </keyboard>
</photobooth_settings>
</breeze_systems_photobooth>

The text can then be added by defining keyboard images and editing them in Photoshop.

Example 3: Entering the user's name and adding it to the prints
The "Email input at start of sequence" or "Email input after taking photos" touchscreen keyboard
options can be used to capture other information such as the user's name so that it can be displayed on
the prints.

Creating the keyboard
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The default touchscreen keyboard for email input could be used as the template for the keyboard, but
this does not include a space key and so it makes more sense to use the message keyboard as the
template.
Step 1: In the "Touchscreen Settings" dialog click on the "Test keyboard..." button and select the
"Message keyboard..." option
Step 2: Save the keyboard XML file and keyboard images by holding down the shift and ctrl keys and
left clicking the mouse. This will save the following five files to the current photo booth images folder:
message_keyboard.xml, message_keyboard_lowercase.tif, message_keyboard_lowercase_pressed.
tif, message_keyboard_uppercase.tif, message_keyboard_uppercase_pressed.tif
Step 3: Delete the keyboard image files (message_keyboard_lowercase.tif,
message_keyboard_lowercase_pressed.tif, message_keyboard_uppercase.tif  and
message_keyboard_uppercase_pressed.tif) and rename message_keyboard.xml to keyboard.xml
Step 4: Edit the keyboard.xml file in a text editor (e.g. Notepad) and change the line starting
<prompt1> to:
<prompt1>Please enter your name:</prompt1>
Step 5: In the "Touchscreen Settings" dialog set "Touchscreen keyboard:" to "Email input at start of
sequence" or "Email input after taking photos"

Adding the user's name to the prints
Step 1: Display the print layout editor by clicking on the "Print Layout" button
Step 2:  Add a caption by right clicking on the print background and selecting "Add caption"
Step 3: Right click on the caption and select "Edit caption..." to display the "Edit Captions" dialog
Step 4: Add the token {user1_data} to the caption text (this will be replaced by the text entered by the
user when the photos are printed):

Keyboard images
Separate keyboard screen images can be defined if you need more control over the appearance of the
keyboard. These images should be TIFF images the same size as the resolution of the screen and
should be placed in the photo booth images folder. The keyboard images should be named as follows:

keyboard_uppercase.tif - keyboard image showing upper case key legends
keyboard_uppercase_pressed.tif - keyboard image showing upper case key legends with the keys
pressed
keyboard_lowercase.tif - keyboard image showing lower case key legends
keyboard_lowercase_pressed.tif - keyboard image showing lower case key legends with the keys
pressed

If TIFF keyboard images aren't found the software will attempt to load JPEG images instead
(keyboard_uppercase.jpg, keyboard_uppercase_pressed.jpg, keyboard_lowercase.jpg and
keyboard_lowercase_pressed.jpg).
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When the email option is used (see Uploading to social networks...) the touchscreen keyboard will look
for the following keyboard xml definition file and keyboard images:
email_keyboard.xml - XML file defining the keyboard layout
email_keyboard_uppercase.tif - keyboard image showing upper case key legends
email_keyboard_uppercase_pressed.tif - keyboard image showing upper case key legends with the
keys pressed
email_keyboard_lowercase.tif - keyboard image showing lower case key legends
email_keyboard_lowercase_pressed.tif - keyboard image showing lower case key legends with the
keys pressed
Please note that for compatibility with previous releases the email option will use the standard XML
definition file and keyboard images if versions with an email_ prefix aren't found.

When the Twitter upload option is used (see Uploading to social networks...) the touchscreen keyboard
will look for the following keyboard xml definition file and keyboard images:
twitter_keyboard.xml - XML file defining the keyboard layout
twitter_keyboard_uppercase.tif - keyboard image showing upper case key legends
twitter_keyboard_uppercase_pressed.tif - keyboard image showing upper case key legends with the
keys pressed
twitter_keyboard_lowercase.tif - keyboard image showing lower case key legends
twitter_keyboard_lowercase_pressed.tif - keyboard image showing lower case key legends with the
keys pressed

When the send SMS/MMS option is used (see Uploading to social networks...) the touchscreen
keyboard will look for the following keyboard xml definition file and keyboard images:
mms_keyboard.xml - XML file defining the keyboard layout
mms_keyboard_uppercase.tif - keyboard image showing upper case key legends
mms_keyboard_uppercase_pressed.tif - keyboard image showing upper case key legends with the
keys pressed
mms_keyboard_lowercase.tif - keyboard image showing lower case key legends
mms_keyboard_lowercase_pressed.tif - keyboard image showing lower case key legends with the
keys pressed

When the "Message input at end of sequence" option is used the touchscreen keyboard will look for the
following keyboard xml definition file and keyboard images:
message_keyboard.xml - XML file defining the keyboard layout
message_keyboard_uppercase.tif - keyboard image showing upper case key legends
message_keyboard_uppercase_pressed.tif - keyboard image showing upper case key legends with
the keys pressed
message_keyboard_lowercase.tif - keyboard image showing lower case key legends
message_keyboard_lowercase_pressed.tif - keyboard image showing lower case key legends with the
keys pressed

Please take care that the keys are in the same positions in each of the keyboard images and that these
also correspond to the values in the keyboard.xml file. The <background_color>, <text_color>,
<prompt>, <legend> and <shifted_legend> tags in the keyboard.xml file are ignored when keyboard
images are used to define the appearance of the keyboard.

Note: If you only need to change the keyboard layout and are happy with the default keyboard display
you only need to create a keyboard.xml file in the photo booth images folder and can delete the
keyboard screen images (keyboard_uppercase.tif, keyboard_uppercase_pressed.tif,
keyboard_lowercase.tif and keyboard_lowercase_pressed.tif). If keyboard images are defined the
<prompt> tags in the keyboard.xml file will be ignored.
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10.12 User Survey

Up to 10 screens can be displayed to gather information from users before starting the photo booth
shooting sequence. The survey screens are defined in the same way as the touchscreen keyboard and
can include checkboxes, text entry areas and keys. Information entered by the user is stored in the 
XML photobooth summary file which is saved after each shooting sequence.

The survey screens are shown at the start of the photo booth shooting sequence before taking the
photos. To enable a survey first make sure user survey screens are enabled in the "Touchscreen
Settings" dialog then create the files defining the touchscreen keyboard to be used for the survey.
An email can be sent automatically using the email address entered in the survey data by setting the id
of the input prompt to "autoEmail" (see touchscreen keyboard text input for details).

Adding a simple survey screen

A simple survey screen with a checkbox, text entry field and optional information screen can created
using the "Add Survey Keyboard" dialog. This can be displayed by going to the "Touchscreen Settings"
dialog and clicking on the "Test keyboard..." button and selecting "Add survey keyboard...":

Select "Add checkbox" to display a checkbox in the survey. Set the id to identify the input and edit the
caption to be displayed beside the checkbox e.g. set the caption to "Display your photo in the online
gallery" and the id to "gallery". Select "Mandatory (checkbox must be selected)" if the user must select
the checkbox before continuing e.g. if the checkbox is asking whether they accept the terms and
conditions of using the photo booth they must accept them before continuing.

Set the "Text entry:" dropdown to the type of text entry field to display a text entry box in the survey
screen and a keyboard to enter the text. The following text entry options are available:
none - do not display a text entry field or keyboard
normal - add a text entry field that allows free text entry
email - add a text entry field that allows an email address to be entered. An error message will be
displayed if the user enters an invalid email address and tries to continue
autoemail - the same as "email" above plus the output from the photo booth will be automatically
emailed to the guest.

Set the id to identify the input and the caption to be displayed above the text entry field e.g. set the
caption to "Please enter your name" and the id to "name". Select "Mandatory (text field must not be
empty)" if the user must enter some text before continuing
Please note: when autoemail is selected the id is automatically set to autoemail and cannot be
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changed.

Select "Add info screen" to add a button to display an information screen and set the key legend e.g.
"T&C" to display a terms a conditions screen. This will create a screen named survey1_keyboard_info.
jpg. This screen can be edited using an image editor such as Photoshop to display the required
information.

The tokens that can be used to access information entered in the survey are displayed in the dialog e.
g. if the id of the text entry field is set to "name" the the token to access this information would be
{survey1_text_name}. This can be used in print captions to print the user's name on the photos or it can
be included in an email. 

Click on the "..." button to the right of the keyboard background color to select a background color for
the keyboard.

The survey keyboard can be previewed by pressing the keyboard button. The settings shown above
produce a survey keyboard like the one below:

Press the OK button to create the survey keyboard. For the first survey scree, survey1, this will create
a file named survey1_keyboard.xml which contains the information to display the survey keyboard. It
will also create a JPEG screen imaged named survey1_keyboard_info.jpg if the info checkbox was
selected.
Additional survey screens can be created by selecting "Add survey keyboard..." again in the
"Touchscreen Settings" dialog.

The rest of this page provides more information on how to customize survey screens and some
examples.

Files used to define survey screens

The user survey screens are defined using XML touchscreen keyboard definition files and optional TIFF
or JPEG image files stored in the photo booth images folder e.g. the first survey screen can be defined
using the following files:
survey1_keyboard.xml - touchscreen keyboard definition file for survey screen 1
survey1_keyboard_lowercase.tif - optional TIFF keyboard image showing lower case keys
survey1_keyboard_lowercase_pressed.tif - optional TIFF keyboard image showing lower case keys
when a key is pressed
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survey1_keyboard_uppercase.tif - optional TIFF keyboard image showing upper case keys
survey1_keyboard_uppercase_pressed.tif - optional TIFF keyboard image showing upper case keys
when a key is pressed

Multiple survey screens can be defined by incrementing the screen number e.g.
survey1_keyboard.xml - touchscreen keyboard definition file for survey screen 1
survey2_keyboard.xml - touchscreen keyboard definition file for survey screen 2
survey3_keyboard.xml - touchscreen keyboard definition file for survey screen 3
...
survey10_keyboard.xml - touchscreen keyboard definition file for survey screen 10

survey1_keyboard_info.jpg or survey1_keyboard_info.tif - optional information page for survey screen 1
survey2_keyboard_info.jpg or survey2_keyboard_info.tif - optional information page for survey screen 2
survey3_keyboard_info.jpg or survey3_keyboard_info.tif - optional information page for survey screen 3
...
survey10_keyboard_info.jpg or survey10_keyboard_info.tif - optional information page for survey
screen 10
 
Note: the number can be omitted from the first survey screen e.g. survey_keyboard.xml

The user survey screens can be enabled or disabled in the "Touchscreen Settings" dialog or read from
a settings file.

Options for closing the survey screens

Define a key with the action "OK" to accept the input from the survey screen. If the survey screen
includes any mandatory input fields it will only close if these have been completed. When the screen
closes the next survey screen in the sequence will be displayed or, if this is not defined, the photo
booth will start the shooting sequence.

Define a key with the action "Cancel" to close the survey screen without saving the user input. When
the screen closes the next survey screen in the sequence will be displayed or, if this is not defined, the
photo booth will start the shooting sequence.

Define a key with the action "Close" to close the survey screen without saving the user input and return
to the ready screen

Format of saved survey data

The information entered by the user is saved in the XML summary file stored in the same folder as the
photos downloaded from the camera. The information is stored within the <survey_data> tags using
tags which define the survey screen number, the input field and the optional id field to help identify the
data. An example XML summary file created from two survey screens is shown below:

<?xml version="1.0" encoding="UTF-8"?>
<breeze_systems_photobooth version="3.7.1">
  <photo_information>
    <date>2017/06/07</date>
    <time>17:09:05</time>
    <user_data/>
    <survey_data>
      <survey1_chkbox1 id="over21">1</survey1_chkbox1>
      <survey1_chkbox2 id="agree">1</survey1_chkbox2>
      <survey1_chkbox3 id="share">0</survey1_chkbox3>
      <survey2_text1 id="name">Chris Breeze</survey2_text1>
      <survey2_chkbox1 id="test">0</survey2_chkbox1>
    </survey_data>
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    <prints>1</prints>
    <photobooth_images_folder>C:\Users\chris\Documents\PhotoboothImages\survey_example</photobooth_images_folder>
    <digital_zoom>100</digital_zoom>
    <mirror_output>0</mirror_output>
    <camera_orientation>0</camera_orientation>
    <bw_mode>0</bw_mode>
    <photos>
      <photo image="1">IMG_0001.JPG</photo>
      <photo image="2">IMG_0002.JPG</photo>
      <photo image="3">IMG_0003.JPG</photo>
      <output>prints\170607_170905.jpg</output>
    </photos>
  </photo_information>
</breeze_systems_photobooth>

Survey screen 1 contained three checkboxes with ids "over18" (set by the user), "agree" (set by the
user) and "share" (not set by the user). Survey screen 2 contained a text entry area with id "name" (set
to "Chris Breeze") and a checkbox with id "test" (not set by the user).

      <survey2_text1 id="name">Chris Breeze</survey2_text1>

Displaying user survey data on the prints

User survey data can be displayed on the prints by using tokens in the caption text. The tokens should
be enclosed with curly brackets and given the same names as the tags used to store the information in
the XML summary file e.g. {survey2_text1} will display the name entered by the user in survey screen 2
in the example above.
You can also use the id to access the survey data using a token with the survey screen and input type
followed by the id e.g. {survey2_text_name}

Information from checkboxes can also be included in the caption text e.g. {survey1_chkbox1} will
display the user's response to the "over 21" checkbox in the first survey screen. This will display 1 if the
checkbox was selected or 0 if it was not selected. 
You can also use the id to access the survey data using a token with the survey screen and input type
followed by the id e.g. {survey1_chkbox_over21}

The {survey1_chkbox1} token can be combined with other tokens to provide a more meaningful
response e.g. suppose the photo booth print is to be used as a drinks voucher and you only want to
offer alcoholic drinks to people over 21 you could set the caption text to {if,{survey1_chkbox1},Voucher
for alcoholic cocktail, Voucher for soda}.

The five survey results in the example above can be accessed using the following tokens:
{survey1_chkbox1} or {survey1_chkbox_over21}
{survey1_chkbox2} or {survey1_chkbox_agree}
{survey1_chkbox3} or {survey1_chkbox_share}
{survey2_text1} or {survey2_text_name}
{survey2_chkbox1} or {survey2_chkbox_test}

Example 1: Simple terms and conditions screen

Create a survey_keyboard.xml like the one below in the photobooth images folder:

<?xml version="1.0" encoding="UTF-8"?>
<breeze_systems_photobooth>
<photobooth_settings>
  <keyboard>
    <key>
      <left>20</left>
      <top>20</top>
      <width>320</width>
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      <height>120</height>
      <legend>Agree</legend>
      <shifted_legend>Agree</shifted_legend>
      <code>OK</code>
      <shifted_code>OK</shifted_code>
    </key>
    <key>
      <left>360</left>
      <top>20</top>
      <width>320</width>
      <height>120</height>
      <legend>Decline</legend>
      <shifted_legend>Decline</shifted_legend>
      <code>Close</code>
      <shifted_code>Close</shifted_code>
    </key>
  </keyboard>
</photobooth_settings>
</breeze_systems_photobooth>

Then create TIFF keyboard image files (survey_keyboard_lowercase.tif,
survey_keyboard_lowercase_pressed.tif, survey1_keyboard_uppercase.tif and
survey1_keyboard_uppercase_pressed.tif) and edit these in an image editor to add the terms and
conditions text.
A quick way to create the TIFF keyboard images is to open the "Touchscreen Settings" dialog and click
on the "Test keyboard..." button and select "Survey keyboard..." to display the survey keyboard. Then
hold down the Shift and Ctrl keys and left click the mouse to save the keyboard images to file.

Note: The action for the "Agree" button is "OK" which accepts the user's input and displays the next
survey screen if defined, or starts the photo booth shooting sequence. The action for the "Decline"
button is "Close" which closes the survey screen and returns to the ready screen without taking any
photos.

Example 2: Terms and conditions screen with mandatory email
input and checkbox

Create a survey_keyboard.xml like the one below in the photobooth images folder:

<?xml version="1.0" encoding="UTF-8"?>
<breeze_systems_photobooth>
<photobooth_settings>
  <keyboard>
    <chkbox1_prompt id="terms" mandatory="1">I accept the terms and conditions</chkbox1_prompt>
    <chkbox1_x>20</chkbox1_x>
    <chkbox1_y>20</chkbox1_y>
    <prompt1 id="email" email_address="1" mandatory="1">Please enter your email address:</prompt1>
    <text1_x>20</text1_x>
    <text1_y>200</text1_y>
    <text1_r>1880</text1_r>
  </keyboard>
</photobooth_settings>
</breeze_systems_photobooth>

After taking the photos the XML summary file will look something like this:

<?xml version="1.0" encoding="UTF-8"?>
<breeze_systems_photobooth version="3.7.1">
<photo_information>
  <date>2017/06/07</date>
  <time>18:13:53</time>
  <user_data></user_data>
  <survey_data>
    <survey1_text1 id="email">sales@breezesys.com</survey1_text1>
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    <survey1_chkbox1 id="terms">1</survey1_chkbox1>
  </survey_data>
  <prints>1</prints>
  <photobooth_images_folder>C:\Users\chris\Documents\PhotoboothImages\survey_example</photobooth_images_folder>
  <digital_zoom>100</digital_zoom>
  <mirror_output>0</mirror_output>
  <camera_orientation>0</camera_orientation>
  <bw_mode>0</bw_mode>
  <photos>
    <photo image="1">img_0006.JPG</photo>
    <output>prints\170607_181353.jpg</output>
  </photos>
</photo_information>
</breeze_systems_photobooth>

Example 3: Terms and conditions screen with 3 checkboxes

The first checkbox asks the user whether they are over 21 years of age.
The second checkbox asks the user to agree to the terms and conditions and is mandatory i.e. it must
be selected in order to continue and take the photos.
The third checkbox asks the user whether they agree to their photos being shared on the internet.

Create a survey_keyboard.xml like the one below in the photobooth images folder:

<?xml version="1.0" encoding="UTF-8"?>
<breeze_systems_photobooth>
<photobooth_settings>
  <keyboard>
    <chkbox1_prompt id="over21">I am over 21 years of age</chkbox1_prompt>
    <chkbox1_x>20</chkbox1_x>
    <chkbox1_y>160</chkbox1_y>
    <chkbox2_prompt mandatory="1" id="agree">I agree to the terms and conditions</chkbox2_prompt>
    <chkbox2_x>20</chkbox2_x>
    <chkbox2_y>280</chkbox2_y>
    <chkbox3_prompt id="share">I agree to my photos being shared on the internet</chkbox3_prompt>
    <chkbox3_x>20</chkbox3_x>
    <chkbox3_y>400</chkbox3_y>
    <key>
      <left>20</left>
      <top>20</top>
      <width>320</width>
      <height>120</height>
      <legend>Agree</legend>
      <shifted_legend>Agree</shifted_legend>
      <code>OK</code>
      <shifted_code>OK</shifted_code>
    </key>
    <key>
      <left>360</left>
      <top>20</top>
      <width>320</width>
      <height>120</height>
      <legend>Decline</legend>
      <shifted_legend>Decline</shifted_legend>
      <code>Close</code>
      <shifted_code>Close</shifted_code>
    </key>
  </keyboard>
</photobooth_settings>
</breeze_systems_photobooth>

You can use the results of the survey in the captions appearing on the prints by placing the appropriate
token in the caption text. For example if the caption text is set to "Over 21: {survey1_chkbox1}" it will
print "Over 21: 0" or "Over 21: 1" depending on whether the user checked the first checkbox or not.
Tokens can be combined e.g. if you want to print a free drinks voucher and only allow soft drinks for
guests who are younger than 21 years old you could set the caption text to:
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{if,{survey1_chkbox1},Free alcoholic drinks voucher,Free soft drinks voucher}

The results of the user survey can also be used to specify the download folder. For example, the
download folder could be set to "public" or "private" depending on whether the user checked the third
checkbox or not by setting the download folder path (in File->Preferences) to:
C:\Photos\{if,{survey1_chkbox3},public,private}

After taking the photos the XML summary file will look something like this:

<?xml version="1.0" encoding="UTF-8"?>
<breeze_systems_photobooth version="3.7.1">
<photo_information>
  <date>2017/06/07</date>
  <time>18:15:43</time>
  <user_data></user_data>
  <survey_data>
    <survey1_chkbox1 id="over21">0</survey1_chkbox1>
    <survey1_chkbox2 id="agree">1</survey1_chkbox2>
    <survey1_chkbox3 id="share">0</survey1_chkbox3>
  </survey_data>
  <prints>1</prints>
  <photobooth_images_folder>C:\Users\chris\Documents\PhotoboothImages\survey_example</photobooth_images_folder>
  <digital_zoom>100</digital_zoom>
  <mirror_output>0</mirror_output>
  <camera_orientation>0</camera_orientation>
  <bw_mode>0</bw_mode>
  <photos>
    <photo image="1">IMG_0007.JPG</photo>
    <output>prints\170607_181543.jpg</output>
  </photos>
</photo_information>
</breeze_systems_photobooth>

Example 4: Asking for user consent and displaying a privacy
statement

This example shows how to create a simple screen asking for the user's consent to share files on a
website and to display a page giving details of the event's privacy policy.

Create a file named survey_keyboard.xml containing the following text in your photo booth images
folder:

<?xml version="1.0" encoding="UTF-8"?>
<breeze_systems_photobooth>
<photobooth_settings>
  <keyboard>
    <chkbox1_prompt id="agree to post on website">I agree to my photos being posted on a web site</chkbox1_prompt>
    <chkbox1_x>30</chkbox1_x>
    <chkbox1_y>30</chkbox1_y>
    <key>
      <left>20</left>
      <top>120</top>
      <width>320</width>
      <height>120</height>
      <legend>Continue</legend>
      <shifted_legend>Continue</shifted_legend>
      <code>OK</code>
      <shifted_code>OK</shifted_code>
    </key>
    <key>
      <left>360</left>
      <top>120</top>
      <width>320</width>
      <height>120</height>
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      <legend>Cancel</legend>
      <shifted_legend>Cancel</shifted_legend>
      <code>Close</code>
      <shifted_code>Close</shifted_code>
    </key>
    <key>
      <left>900</left>
      <top>120</top>
      <width>320</width>
      <height>120</height>
      <legend>Privacy info...</legend>
      <shifted_legend>Info</shifted_legend>
      <code>Info</code>
      <shifted_code>Privacy info...</shifted_code>
    </key>
    <key>
      <left>20</left>
      <top>120</top>
      <width>320</width>
      <height>120</height>
      <legend>Info close</legend>
      <shifted_legend>Info close</shifted_legend>
      <code>Info close</code>
      <shifted_code>Info close</shifted_code>
    </key>
  </keyboard>
</photobooth_settings>
</breeze_systems_photobooth>

Then create a JPEG screen image the same size as the computer's display and save it in your photo
booth images folder as survey_keyboard_info.jpg. Edit the survey_keyboard_info.jpg image to show
the required information (e.g. the event's privacy policy) and the graphics for a close button to line up
with the "info close" key in the XML file i.e. 320 pixels wide by 120 pixels high, placed 20 pixels from
the left and 120 pixels from the top of the screen.

Explanation:
The lines starting <chkbox1 define the position of the checkbox and the text prompt displayed to the
user.
The first <key> defines the position of the OK key which has the legend "Continue". When this is
tapped the survey screen closes and the photo booth shooting sequence continues.
The second <key> defines the position of the close key which has the legend "Cancel". When this is
tapped the survey screen closes and the booth returns to the ready screen without taking any photos.
The third <key> defines the position of the info key with the legend "Privacy info...". When this is tapped
the survey_keyboard_info.jpg image is displayed. This is displayed until the 30 second timeout occurs
or the user taps the info close button.
The fourth <key> defines the size and position of the info close button. When this is tapped the info
screen is closed and control is returned to the survey keyboard. Please note that this key is not
displayed in the keyboard or the info screen. All it does is define the position of the area the user
should tap to close the info screen. If you wish to show this key in the info screen you need to edit the
survey_keyboard_info.jpg screen image.

The user's response is stored in the photo booth XML summary file. It can also be used in captions that
appear on prints or in the filenames and folder path of downloaded images using the token
{survey1_chkbox1}. This returns 1 if the checkbox is selected or 0 if it is not selected.
For example the photos could be automatically saved to a folder named "website" if the users checks
the checkbox and to a folder named "no website" by setting the download folder in File->Preferences
to:
{documents}\PhotoboothImages\{dateLess8h} {if,{survey1_chkbox1},website,no website}

Making survey data available to other applications
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The survey data is recorded in the photo booth summary XML file but it can also be written to the
Windows registry when the survey keyboard closes to make it available to other applications.
To enable this set the following Windows registry value to 1:
HKEY_CURRENT_USER\SOFTWARE\BreezeSystems\DSLRRemotePro\100
\WriteSurveyDataToRegistry

When the user has completed the survey their responses are saved as a JSON string in the following
Windows registry value:
HKEY_CURRENT_USER\SOFTWARE\BreezeSystems\Event Info\SurveyData

e.g. a survey screen which has a checkbox asking for their email address and whether the they give
consent for the photos to be added to a gallery would result in the following JSON string being written
to the registry: 
{"dateTime":"20221028_114152","surveyData":
[{"id":"email","key":"survey1_text1","value":"sales@breezesys.com"},
{"id":"agree","key":"survey1_chkbox1","value":"1"}]}

dateTime is the date and time the survey was displayed in the for YYYYMMDD_hhmmss
surveyData is an array of responses in the form id, key and value. id is the identifier assigned to the
input, key contains the survey screen and input type and value is the user's response.

10.13 Animated GIFs

Animated GIFs provide a way of displaying a short sequence of images that are displayed in a
continuous loop. DSLR Remote Pro has two options for creating animated GIFs:

1. As a simple slideshow showing the photos taken during the shooting sequence with an optional
overlay and title page

2. As a short video clip captured in video booth mode. Please note that animated GIFs don't include
sound (but the MP4 video copy can contain a soundtrack)

The animated GIFs can be viewed using our Breeze Kiosk software and then shared by email, text
(MMS in USA and Canada, SMS elsewhere) or uploaded to Twitter.

An MP4 movie file can also be created from the animated GIFs. The MP4 files can be shared can be
sent as an email attachment by selecting the "Use MP4 copy of animated GIF if available" setting in the
"Email Settings" dialog.

Creating Animated GIFs in Photo Booth Mode

Select "Create animated GIF of photos" on the "Output Settings" dialog and then click on the "Animated
GIF settings..." button to configure the settings:

http://breezesys.com/BreezeKiosk/index.htm
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The animated GIFs will show the photos in the same orientation as the live view display. If the live view
display is cropped or digitally zoomed the photos added to the animated GIF will be cropped and
zoomed by the same amounts.
If green screening is enabled the green screened copy of the photos will be added to the GIF. If the
transparent background option is selected in the green screen settings the photo placed in the GIF will
also have a transparent background.
If B&W mode, monochrome toning (e.g. sepia) or creative filters are used the photos will be added to
the animated GIF with these effects applied.

Use the "Photo width (pixels):" setting to specify the width photos added to the animated GIF. The
height of the photos will be calculated automatically in proportion to the width e.g. setting the width to
600 pixels will give a height of 400 pixels when the camera is horizontal or a height of 900 pixels if the
camera in in portrait orientation.

The "Photo left offset:" and "Photo top offset:" settings specify the position the photos are added to the
GIF. The offsets are measured in pixels from the left and top edges of the GIF.

The "GIF width" and "GIF height" settings specify the size of the animated GIF in pixels. If these
settings are 0 the GIF will created the same size as the photos. 

An optional overlay can be displayed over each photo by placing a PNG file named GIF_overlay.png in
the photo booth images folder. A different overlay can be used for each photo by naming the overlays
GIF_overlay_1.png for photo 1, GIF_overlay_2.png for photo 2 etc.

An optional background can also be used for each photo by placing a JPEG image named
GIF_background.jpg in the photo booth images folder. A different background can be used for each
photo by naming it GIF_background_1.jpg, GIF_background_2.jpg etc.
Background images can be used as a simple way to provide a background to the GIF when the GIF is
larger than the photo. Background images can also be used to provide the green screen background
when using the transparent background option when shooting green screen. More interesting
animations can be created by having multiple backgrounds per photo when shooting green screen with
a transparent background.

Multiple overlays and/or backgrounds can be added to each photo by setting "Backgrounds/overlays
per photo" to more than 1 e.g. to display two overlays per photo set "Overlays per photo" to 2 and
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name the files as follows: GIF_overlay_1.png for the first half of photo 1's display time, GIF_overlay_2.
png for the second half of photo 1's display time, GIF_overlay_3.png for the first half of photo 2's
display time, GIF_overlay_4.png for the second half of photo 2's display time etc.
An additional optional overlay can be added to the frames by placing a PNG image named
GIF_logo_overlay.png in the photo booth images folder. As its name implies, the GIF_logo_overlay.png
image is useful for adding logos or branding to the animated GIFs. This makes it easier to have a
standard set of overlays which can be used for different events and to add branding or a logo.

Setting the number of loops to more than 1 allows different overlays and/or backgrounds to be added
to each loop in the animation.
 
The PNG overlay images can be made transparent or semi-transparent by adding an alpha channel. 
If overlay images are larger than the GIF width setting they will be resized to the same width. If an
overlay is smaller than the GIF it will be displayed bottom right justified i.e. in the bottom right hand
corner.

The image interval setting specifies how long each photo should be displayed and is in units of 1/100
sec. A value of 75 (3/4 sec) to 100 (1 sec) is probably a good starting point.

One or more optional title pages can be displayed at the beginning or end of the photo sequence. To
add a single title page place a JPEG image named GIF_title.jpg in the photo booth images folder. To
add multiple title pages to create a short animation place JPEG images named GIF_title_1.jpg,
GIF_title_2.jpg, GIF_title_3.jpg etc. in the photo booth images folder
If the title page image is larger than the GIF width setting it will be resized to the same width. Use the
"Title display time" to specify how long each title page should be displayed.
The title page or pages can be displayed before or after the photos. It probably makes more sense to
display titles after the photos because browsers that display animated GIFs will normally show a
thumbnail generated from the start of the animation. Putting the title at the end will mean that the
thumbnail will show the first photo whereas if the title is at the start of the animation the thumbnail will
show the title page.

Select "Play GIF in a continuous loop" if you want the GIF to loop indefinitely. If this option is not
selected the GIF will loop once i.e. it will play the animation twice by running through it once and then
looping a single time to play it again.

Select the "Ping-pong" option to play the photo sequence forwards and then backwards e.g.
4 photos with no title and the ping-pong option selected will display photo 1, photo 2, photo 3, photo 4,
photo 3, photo 2, photo 1, photo 2 etc.
4 photos with no title and the ping-pong option not selected will display photo 1, photo 2, photo 3, photo
4, photo 1, photo 2, photo 3, photo 4 etc.
4 photos with a title at the end and the ping-pong option selected will display photo 1, photo 2, photo 3,
photo 4, photo 3, photo 2, photo 1, title, photo 1, photo 2 etc.

When using overlays with the "ping-pong" option the overlay files should be named as follows:
Overlay files for 3 photos with no title, the ping-pong option selected and overlays per photo set to 1:
GIF_overlay_1.png for photo 1, GIF_overlay_2.png for photo 2, GIF_overlay_3.png for photo 3,
GIF_overlay_4.png for photo 2

Overlay files for 3 photos with a title, the ping-pong option selected and overlays per photo set to 2:
GIF_overlay_1.png/GIF_overlay_2.png for photo 1, GIF_overlay_3.png/GIF_overlay_4.png for photo
2, GIF_overlay_5.png/GIF_overlay_6.png for photo 3, GIF_overlay_7.png/GIF_overlay_8.png for
photo 2, GIF_overlay_9.png/GIF_overlay_10.png for photo 1

Background/overlay filename suffix
The "Background/overlay filename suffix" setting in the "Output Settings" dialog provides a way to
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select different backgrounds and overlays for prints, slideshow GIFs and boomerang GIFs. This setting
can use tokens to provide values that are read at run time e.g. random numbers or data entered in the
survey screens. For example to add a randomly selected overlays to slideshow GIFs created in photo
booth mode the "Background/overlay filename suffix" could be set to random{random,1,3}. The token
{random,1,3} evaluates to a random number between 1 and 3 giving a randomly generated suffix. When
preparing the animated GIF the software will look for an overlay with a filename suffix of random1,
random2 or random3 depending on the random number.
e.g. The overlay for frame 1 of the animated GIF is normally named GIF_overlay_1.png. If the filename
suffix is random1 the software will look for an overlay named GIF_overlay_random1_1.png first. If it
can't find an overlay file with the filename suffix it will use the standard filename, GIF_overlay_1.png,
instead. The background/overlay filename suffix is also used when selecting the GIF background image
and title frames.

Select the "Create PNG copies of GIF frames in 'GIF_frames' subfolder" option to create PNG copies
of all the frames that make up the animated GIF. This is useful if the frames are to be processed by
other software.
Please note: It is not necessary to select this option to create MP4 copies of the GIFs.
Warning: The PNG files created when this option is selected can be quite large and may fill up the
computer's hard disk.

By default the animated GIF will be created in a subfolder named GIF in the download folder. If you
are using our Breeze Kiosk software to display the animated GIFs you need to set it up to monitor the
GIF folder.
Select the "Save GIF in 'prints' subfolder" option to save the GIF in the prints subfolder with the JPEG
copies of the printed output. This is useful if you are using kiosk software and wish to display the GIFs
and the prints.

MP4 copy
Select the "Create MP4 copy of the animated GIF" option to automatically create an MP4 movie file of
the animated GIF. Set the minimum duration of the movie in secs or set this to 0 to make the movie as
short as possible. This option is useful if the movie file is to be uploaded to a site which has a minimum
length requirement (e.g. videos posted to Instagram must be at least 3 seconds long). If the movie file
will be shorter than the minimum length the GIF frames, but not the title frames, will be repeated until
the movie is long enough.

An optional soundtrack can be added to the MP4 copy of the animated GIF by placing a MP3 file
named GIF_soundtrack.mp3 or a WAV file named GIF_soundtrack.wav in the photo booth images
folder. Please make sure the soundtrack is at least as long duration of the MP4 file otherwise the MP4
may be truncated.

Use the "Save MP4 in" dropdown list to specify where the MP4 files should be saved:
"same folder as GIF" will save the MP4 file in the same folder as the GIF (either the GIFs subfolder or
the prints subfolder depending on the "Save GIF in 'prints' subfolder" setting)
"'MP4' subfolder" will save the MP4 file in a subfolder named MP4
"prints' subfolder" will save the MP4 file the prints subfolder (where the JPEG copies of the prints are
also saved)

Please note: The output setting must be set to "Print only", "Print and save JPEG copy" or "JPEG
copy only" in order to create the animated GIF. The GIF will not be created if the output is set to
"None". You also need to create a print layout which includes all the photos taken otherwise an error
will be displayed when the software tries to create the animated GIF.

Dithered vs Indexed Color

http://breezesys.com/BreezeKiosk/index.htm
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Animated GIFs can only display 256 different colors per frame which causes a problem when trying to
display photos which typically have many more colors. There are two ways to handle this limitation:
1) Dithered color where the color of each pixel is represented by several pixels
2) Indexed color where the 256 most common colors in the photo are used

Dithered images can give a better representation of the colors in the original photo but will provide less
detail for a given image size. Indexed colors give better detail and usually give adequate colors but may
show some contouring or shimmering with some photos, particularly if there are areas of graduated
color in the original photo.

Indexed color is recommended for most applications for animated GIFs and so the "Dither GIFs to give
better color" option should normally be left unchecked. 

Creating Animated burst GIFs in Video Booth Mode

Select "Capture clip as a series of still frames" and "Create animated GIF" in the "Video Booth
Settings" dialog to create animated GIFs of short video clips:

Please see "Video Booth Shooting" section for details on how to set the video clip capture settings.

Animated GIFs captured in video booth mode can be captured with the camera set to normal photo
mode or video mode. Which setting is best to use depends on a number of factors such as live view
image size, depth of field and motion blur. This is explained in more detail at the end of this section.

Select the "Create animated GIF" option and click on the "Animated GIF settings..." button to adjust the
animated GIF settings:
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Use the "Photo width (pixels):" setting to specify the width photos added to the animated GIF. The
height of the photos will be calculated automatically in proportion to the width e.g. setting the width to
600 pixels will give a height of 400 pixels when the camera is horizontal or a height of 900 pixels if the
camera in in portrait orientation. Please note that the aspect ratio of the live view images used to
create the animated GIF may vary depending on the camera and whether it is set to video or photo
mode. The aspect ratio will also change if the live view is cropped.

The "Photo left offset:" and "Photo top offset:" settings specify the position the photos are added to the
GIF. The offsets are measured in pixels from the left and top edges of the GIF.

The "GIF width" and "GIF height" settings specify the size of the animated GIF in pixels. If these
settings are 0 the GIF will created the same size as the photos. 
The diagram below shows how the various settings work:
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Please note: The images grabbed from the camera's live view feed are typically only 960 x 640 pixels
in size and ideally the photo width should not exceed this otherwise the final result may appear
pixellated.

The image interval setting specifies how long each frame should be displayed and is in units of 1/100
sec. In order to play back smoothly the frame rate needs to be at least 10 frames/sec which
corresponds to an image interval of 10 1/00ths sec. Increasing the play back rate above 20 frames/sec
(an image interval of 5) will have little visual improvement over GIFs played at lower frame rates and
will result in larger file sizes.

The capture rate in frames/capture specifies how frequently frames for the animated GIF are grabbed
from the camera's live view feed. Live view frames are downloaded from the camera at a rate of
approximately 12.5 frames/sec. The speed of play back is defined by the live view frame rate, the
capture rate and the image interval of the animated GIF. For a slow motion effect set the capture rate
to 1 and the image interval to a value between 10 and 20. To play back the animated GIF at
approximately normal speed set the capture rate to 1 and the image interval to 8. For high speed play
back set the capture rate to 2 or more and the image interval to 8 or 10 (for smooth play back).

One or more optional title pages can be displayed at the beginning or end of the video clip. To add a
single title page place a JPEG image named video_stills_title.jpg in the photo booth images folder. To
add multiple title pages to create a short animation place JPEG images named video_stills_title_1.jpg,
video_stills_title_2.jpg, video_stills_title_3.jpg etc. in the photo booth images folder
If the title page image is larger than the GIF width setting it will be resized to the same width. Use the
"Title display time" to specify how long each title page should be displayed.
The title page or pages can be displayed before or after the video clip. It probably makes more sense
to display titles after the clip because browsers that display animated GIFs will normally show a
thumbnail generated from the start of the animation. Putting the title at the end will mean that the
thumbnail will show the first frame of the video clip whereas if the title is at the start of the animation
the thumbnail will show the title page.

The "Ping-pong forward/backwards display" option specifies whether the animated GIF should display
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the clip forwards then backwards (e.g. frame 1, 2, 3, 4, 5, 4, 3, 2, 1, 2, 3) or forwards only (frame 1,
2, 3, 4, 5, 1, 2, 3, 4, 5, 1).

An optional background can be defined by placing a JPEG file named video_stills_background.jpg in the
photo booth images folder. A different background can be used for each captured frame by naming the
files video_stills_background_1.jpg, video_stills_background_2.jpg, video_stills_background_3.jpg etc.
When shooting green screen choose the "Transparent background" option in the green screen settings
if you want to animate the background behind the guests. Use the background files
(video_stills_background_1.jpg, video_stills_background_2.jpg, video_stills_background_3.jpg etc.) to
animate the background. Areas in the photos where the green background has been removed will be
transparent and the background images will be visible.

An optional overlay can be displayed over each photo by placing a PNG file named video_stills_overlay.
png in the photo booth images folder. A different overlay can be used for each captured frame by
naming the overlays video_stills_overlay_1.png, video_stills_overlay_2.png, video_stills_overlay_3.png
etc.
An additional optional overlay can be added to the frames by placing a PNG image named
video_stills_logo_overlay.png in the photo booth images folder. As its name implies, the
video_stills_logo_overlay.png image is useful for adding logos or branding to the animated GIFs. This
makes it easier to have a standard set of overlays which can be used for different events and to add
branding or a logo.

The PNG overlay image can be made transparent or semi-transparent by adding an alpha channel.
If the overlay image is larger than the GIF width setting it will be resized to the same width. If the
overlay is smaller than the GIF it will be displayed bottom right justified i.e. in the bottom right hand
corner.

Background/overlay filename suffix
The "Background/overlay filename suffix" setting in the "Output Settings" dialog provides a way to
select different backgrounds and overlays for prints, slideshow GIFs and boomerang GIFs. This setting
can use tokens to provide values that are read at run time e.g. random numbers or data entered in the
survey screens. For example to add a randomly selected overlays to boomerang GIFs created in video
booth mode the "Background/overlay filename suffix" could be set to random{random,1,3}. The token
{random,1,3} evaluates to a random number between 1 and 3 giving a randomly generated suffix. When
preparing the animated GIF the software will look for an overlay with a filename suffix of random1,
random2 or random3 depending on the random number.
e.g. The overlay for frame 1 of the animated GIF is normally named video_stills_overlay_1.png. If the
filename suffix is random1 the software will look for an overlay named video_stills_overlay_random1_1.
png first. If it can't find an overlay file with the filename suffix it will use the standard filename,
video_stills_overlay_1.png, instead. The background/overlay filename suffix is also used when selecting
the GIF background image and title frames.

Select the "Create PNG copies of GIF frames in 'GIF_frames' subfolder" option to create PNG copies
of all the frames that make up the animated GIF. This is useful if the frames are to be processed by
other software.
Please note: It is not necessary to select this option to create MP4 copies of the GIFs.
Warning: The PNG files created when this option is selected can be quite large and may fill up the
computer's hard disk.

By default the animated GIF will be created in a subfolder named GIF in the download folder. If you
are using our Breeze Kiosk software to display the animated GIFs you need to set it up to monitor the
GIF folder.
Select the "Save GIF in 'prints' subfolder" option to save the GIF in the prints subfolder with the JPEG
copies of the printed output. This is useful if you are using kiosk software and wish to display the GIFs
and the prints.

http://breezesys.com/BreezeKiosk/index.htm
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MP4 copy
Select the "Create MP4 copy of the animated GIF" option to automatically create an MP4 movie file of
the animated GIF. Set the minimum duration of the movie in secs or set this to 0 to make the movie as
short as possible. This option is useful if the movie file is to be uploaded to a site which has a minimum
length requirement (e.g. videos posted to Instagram must be at least 3 seconds long). If the movie file
will be shorter than the minimum length the GIF frames, but not the title frames, will be repeated until
the movie is long enough.

An optional soundtrack can be added to the MP4 copy of the animated GIF by placing a MP3 file
named video_stills_soundtrack.mp3 or a WAV file named video_stills_soundtrack.wav in the photo
booth images folder. Please make sure the soundtrack is at least as long duration of the MP4 file
otherwise the MP4 may be truncated.

Use the "Save MP4 in" dropdown list to specify where the MP4 files should be saved:
"same folder as GIF" will save the MP4 file in the same folder as the GIF (either the GIFs subfolder or
the prints subfolder depending on the "Save GIF in 'prints' subfolder" setting)
"'MP4' subfolder" will save the MP4 file in a subfolder named MP4
"prints' subfolder" will save the MP4 file the prints subfolder (where the JPEG copies of the prints are
also saved)

Select "Dither GIFs to give better color (but reduced detail)" to used dithered colors in the GIFs.
Normally this setting is unchecked (see above for more information).

Explanation of capturing video GIFs using the camera's photo or video modes

Setting the camera to to photo mode or video mode may affect the size of the live view images and the
exposure settings (shutter speed and aperture) when capturing animated GIFs in video booth mode.

Live View When the camera is in photo mode the live view images will have an aspect ratio of 3:2 and
will be 960x640 pixels for most recent camera models
When the camera is in video mode the size of the live view images may depend on the
camera model and the selected video resolution e.g. the live view images from a Rebel T6i
(aka EOS 750D) are 960x640 pixels in photo mode and 1024x576 pixels in video mode
when the video resolution is set to 1080p or 720p. Live view images from a Rebel T6 (aka
EOS 1300D) are 960x640 pixels in both photo mode and video mode.

Motion blur In photo mode the camera captures live view images with an effective shutter speed of 1/20
sec irrespective of the shutter speed set on the camera. Changing the shutter speed on the
camera will affect the brightness of the live view display if live view exposure simulation is
enabled in the camera, but it won't affect the way the live view frames are captured. This
means that fast moving objects may appear blurred in the captured frames.
In video mode the exposure mode can be set to manual and adjusting the shutter speed will
affect the way live view frames are captured. A faster shutter speed will reduce the
chances of motion blur but it will also reduce the amount of light reaching the sensor and
therefore require more light or a higher ISO setting to get correctly exposed images. In
video mode the slowest shutter speed that can be used is 1/30 sec (this is because the
video frame rate is normally 30 fps).
Please note: motion blur is not necessarily a problem if the animated GIF is played back at
10 frames/sec or more and may provide more pleasing results than frames captured
without motion blur. However, it may be a problem if individual frames from the captured
sequence are printed out.

Depth of
field

In photo mode the lens aperture is always wide open when live view is active in order to let
in the maximum amount of light. This means that the depth of field will be relatively shallow.
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In video mode when the exposure mode is set to manual the lens will be stopped down to
whatever aperture is set in the camera. This means that the depth of field can be increased
by selecting a smaller aperture (e.g. f/22). However, selecting a small aperture will reduce
the amount of light that reaches the sensor and will require brighter lights, a higher ISO
setting or a slower shutter speed to get correctly exposed images.

Modifying the ffmpeg command line used to create MP4 file

MP4 files are created using the ffmpeg.exe command line utility (https://ffmpeg.org/) with the following
parameters:
-vf "scale=trunc(iw/2)*2:trunc(ih/2)*2,fps=25,format=yuv420p" -c:v libx264 -preset veryslow

Advanced users may use different settings by exiting DSLR Remote Pro and editing the following
Windows registry setting:
HKEY_CURRENT_USER\SOFTWARE\BreezeSystems\DSLRRemotePro\100\ffmpegCmdLine

10.14 Keyboard Shortcuts

The photo booth mode in DSLR Remote Pro for Windows can accept the following key presses: 

Esc - exit full screen photo booth or video booth mode and return to the main DSLR Remote Pro for
Windows screen
F2 - switch to B&W mode and start the photo booth sequence
F3 - switch to color mode and start the photo booth sequence
T - switch to B&W (toned) mode and start the photo booth sequence
F4 - start the photo booth sequence using the current B&W or color setting
F5 - same as F4
F6 - reactivate live view and display ready.jpg screen if previously canceled due to inactivity or cancel
live view and display welcome.jpg screen if live view currently active
Ctrl+Alt+F6 - switch from standby to ready mode
Ctrl+Alt+S - switch from ready mode to standby
F9 - switch to stills photo booth mode and start the photo booth sequence
Ctrl+F1 - select the camera's user 1 picture style
Ctrl+F2 - select the camera's user 2 picture style
Ctrl+F3 - select the camera's user 3 picture style
Ctrl+F4 - select the camera's standard picture style
Ctrl+F5 - select the camera's portrait picture style
Ctrl+F6 - select the camera's landscape picture style
Ctrl+F7 - select the camera's neutral picture style
Ctrl+F8 - select the camera's faithful picture style
Ctrl+F9 - select the camera's monochrome picture style
S - cycle through available picture styles
Ctrl+A - auto focus (only available for camera models that support live view AF) when ready screen is
displayed OR accept the photo when displaying photo preview
Ctrl+B - switch to B&W mode but don't start the photo booth sequence
Ctrl+C - switch to color mode but don't start the photo booth sequence
Shift+Ctrl+F - select "Instagram" style filter 1
Shift+Ctrl+G - select "Instagram" style filter 2
Shift+Ctrl+H - select "Instagram" style filter 3
Shift+Ctrl+I - select "Instagram" style filter 4
Shift+Ctrl+J - select "Instagram" style filter 5
Shift+Ctrl+K - select "Instagram" style filter 6
Ctrl+K - switch to color mode but don't start the photo booth sequence (alternative for Ctrl+C)

https://ffmpeg.org/
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Ctrl+Alt+P - display the reprint selection dialog
Ctrl+R - reprint the last set of photos without displaying the touchscreen keyboard or print confirmation
screens OR preview retake when displaying photo preview
Ctrl+Alt+R - reprint the last set of photos with touchscreen keyboard and print confirmation screens if
enabled
Shift+Ctrl+R - fast reprint of the last set of photos (if output option is set to "Print and save JPEG
copy")
Ctrl+T - switch to B&W (toned) mode but don't start the photo booth sequence
Ctrl+W - toggle between B&W and color modes
Ctrl+X - Aborts the shooting sequence when pressed during the photo preview
Ctrl+Z - take photo when the booth is running in clicker mode
A - Accept print when print confirmation window is displayed or in the reprint selection dialog
P - Accept print when print confirmation window is displayed but don't copy JPEG copy
W - cycle through color, B&W, B&W (toned), filter 1, filter 2, filter 3, filter 4, filter 5, filter 6
X - Reject print when print confirmation window is displayed or cancel the reprint selection dialog
Ctrl+1 - select one copy of prints (and start printing when in print confirmation screen)
Ctrl+2 - select two copies of prints (and start printing when in print confirmation screen)
Ctrl+3 - select three copies of prints (and start printing when in print confirmation screen)
Ctrl+4 - select four copies of prints (and start printing when in print confirmation screen)
Ctrl+5 - select five copies of prints (and start printing when in print confirmation screen)
Ctrl+6 - select six copies of prints (and start printing when in print confirmation screen)
Ctrl+7 - select seven copies of prints (and start printing when in print confirmation screen)
Ctrl+8 - select eight copies of prints (and start printing when in print confirmation screen)
Ctrl+9 - select nine copies of prints (and start printing when in print confirmation screen)
Ctrl+Alt+1 - select profile 1 and start shooting sequence
Ctrl+Alt+2 - select profile 2 and start shooting sequence
Ctrl+Alt+3 - select profile 3 and start shooting sequence
Ctrl+Alt+4 - select profile 4 and start shooting sequence
Ctrl+Alt+5 - select profile 5 and start shooting sequence
Ctrl+Alt+6 - select profile 6 and start shooting sequence
Ctrl+Alt+7 - select profile 7 and start shooting sequence
Ctrl+Alt+8 - select profile 8 and start shooting sequence
Shift+Ctrl+1 - select profile 1 when in ready screen or select number of copies when in print
confirmation screen
Shift+Ctrl+2 - select profile 2 when in ready screen or select number of copies when in print
confirmation screen
Shift+Ctrl+3 - select profile 3 when in ready screen or select number of copies when in print
confirmation screen
Shift+Ctrl+4 - select profile 4 when in ready screen or select number of copies when in print
confirmation screen
Shift+Ctrl+5 - select profile 5 when in ready screen or select number of copies when in print
confirmation screen
Shift+Ctrl+6 - select profile 6 when in ready screen or select number of copies when in print
confirmation screen
Shift+Ctrl+7 - select profile 7 when in ready screen or select number of copies when in print
confirmation screen
Shift+Ctrl+8 - select profile 8 when in ready screen or select number of copies when in print
confirmation screen
Shift+Ctrl+9 - select profile 9 when in ready screen or select number of copies when in print
confirmation screen
Shift+Ctrl+F1 - select profile 10
Shift+Ctrl+F2 - select profile 11
Shift+Ctrl+F3 - select profile 12
Shift+Ctrl+F4 - select profile 13
Shift+Ctrl+F5 - select profile 14
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Shift+Ctrl+F6 - select profile 15
Shift+Ctrl+F7 - select profile 16
Shift+Ctrl+F8 - select profile 17
Shift+Ctrl+F9 - select profile 18
Shift+Ctrl+N - select next profile
Shift+Ctrl+P - select previous profile
Ctrl+Alt+CursorLeft - digital zoom out
Ctrl+Alt+CursorRight - digital zoom in
Ctrl+Alt+CursorUp - optical zoom in when using a PowerShot camera or the PZ-E1 power zoom
adapter with an EOS camera
Ctrl+Alt+CursorDown - optical zoom out when using a PowerShot camera or the PZ-E1 power zoom
adapter with an EOS camera
Shift+CursorLeft - crop live view display: decrease horizontal cropping/increase vertical cropping
Shift+CursorRight - crop live view display: increase horizontal cropping/decrease vertical cropping
Shift+rotate mouse wheel - adjust live view display cropping
Ctrl+Home - cancel digital zoom and live view cropping
Ctrl+rotate mouse wheel - adjust focus
Number pad '+' - increase the number copies of prints (up to a maximum of 9 copies)
Number pad '-' - decrease the number copies of prints (down to a minimum of 1 copy)
Ctrl+Page Up - decrease exposure using exposure compensation in auto exposure modes or ISO in
manual exposure
Ctrl+Page Down - increase exposure using exposure compensation in auto exposure modes or ISO in
manual exposure
CursorUp - brighten live view by decreasing the shutter speed when using manual exposure and bank 1
or bank 2 camera settings
CursorDown - darken live view by increasing the shutter speed when using manual exposure and bank
1 or bank 2 camera settings
b - cycle through number of copies of prints: 1,2,3,4,5,6,7,8,9,1,2,3...

Photo preview keyboard shortcut notes
When using the photo preview shortcuts (Ctrl+A to accept, Ctrl+R to retake, Ctrl+X to abort) it is
important that at least one of the touchscreen actions ("Preview: accept", "Preview: retake", "Preview:
abort") is also defined otherwise the software may crash if the shortcuts are used when the final photo
in the sequence is displayed.
Please note that the shortcuts Ctrl+A, Ctrl+R have different actions when the ready screen is
displayed: Ctrl+A=auto focus, Ctrl+R=reprint

Sharing photos by email or text
E - select email photos from the sharing screen
S - select text photos from the sharing screen
X - exit the sharing screen
Shift+Ctrl+S - display the sharing screen (only available when the ready screen is displayed)

Video booth keyboard shortcuts:
Ctrl+A - auto focus (only available for camera models that support live view AF)
Ctrl+V - switch from stills photo booth mode to video booth mode
Ctrl+P - switch from video booth mode to stills photo booth mode
Ctrl+S - toggle between video and stills photo booth mode and back again
F4 - start video booth capture sequence in video booth mode or photo booth shooting sequence in stills
mode
F7 - start video booth capture sequence
F8 - switch to video booth mode and start the video booth capture sequence
End - end the video recording now rather than wait for the full duration
Ctrl+F1 - select the camera's user 1 picture style
Ctrl+F2 - select the camera's user 2 picture style
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Ctrl+F3 - select the camera's user 3 picture style
Ctrl+F4 - select the camera's standard picture style
Ctrl+F5 - select the camera's portrait picture style
Ctrl+F6 - select the camera's landscape picture style
Ctrl+F7 - select the camera's neutral picture style
Ctrl+F8 - select the camera's faithful picture style
Ctrl+F9 - select the camera's monochrome picture style
Ctrl+rotate mouse wheel - adjust focus
S - cycle through available picture styles
A - accept the video and switch from the playback screen to the ready screen
P - play video from the start when in displaying the playback screen
X - reject the video, delete it from the computer and switch from the playback screen to the ready
screen

10.15 Using External Buttons for Photo Booth Shooting

 and start shooting sequence
This page describes a number of different options for connecting one or more pushbuttons to a PC and
use them to control the photo booth mode shooting mode.

Note: For a simple setup you can use the PC's mouse to control the photo booth by selecting the "Use
mouse left button to start and right button to toggle between B&W and color" option in the photo booth
settings.

StealthSwitch

The StealthSwitch is a robust foot switch which plugs straight into a USB port and makes an ideal
switch for photo booth operation. It is very simple to use: just plug it in to any spare USB port, wait a
few seconds for Windows to recognize it and you're ready to go. In full screen photo booth mode
pressing the StealthSwitch button will start the photo booth sequence - that's all there is to it.
Note: If you have already installed the "desktop cloaking" software that comes with the StealthSwitch
you need to disable it otherwise every time you press the button the photo booth display will be hidden.

Arcade Style Buttons

There are several ways arcade style buttons can be connected to a PC and used to control the photo
booth including the StealthSwitch 3 and the serial port method. The StealthSwitch 3 is simpler to setup
than the serial port method but is a little more expensive. Both the StealthSwitch 3 and the serial port
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methods are described in detail below.

StealthSwitch 3

The StealthSwitch 3 is similar to the original StealthSwitch described above but has two important
differences:
1) You can connect external buttons which simply plug into standard 3.5mm sockets (the same as used
by most MP3 players)
2) Each button is programmable allowing it to send any key press or sequence of key presses you like

StealthSwitch 3 showing the five 3.5mm sockets for connecting external buttons on the front and the
USB port on the side
Please note: The StealthSwitch 3 is functionally identical to the StealthSwitch II which it replaces.

Instructions to add an arcade style button using the StealthSwitch 3:
These are the components required to add an arcade style button: the button, stereo cable with 3.5mm
jacks and two female spade connectors

1) Cut off the jack plug from one end of the stereo cable and bare the wires
2) Plug the USB cable from the StealthSwitch II and plug the remaining 3.5mm jack from the stereo
cable into one of the StealthSwitch sockets
3) Run StealthSwitch Configuration Utility and select "Keyboard test mode". When you press the each
button you should see something like this:
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4) Release the switch and identify the correct wires to use from the stereo cable by shorting two of
them together. When the correct pair of wires are shorted together the keyboard test window will show
A, B, C, D or E
5) Attach the spade connectors to each of the two wires identified in step 4. Use a crimp tool or solder
them to ensure they are firmly attached
6) Connect the wire to the arcade switch using the spade connectors and press the button to check
that the keyboard test window shows A, B, C, D or E

You should now have an arcade button attached to a cable with a 3.5mm jack plug which looks
something like this:

Finally use the StealthSwitch Configuration Utility to program each of the buttons to send the required
key strokes. The best way to do this is to right click on the required button in the main Configurator
window and select "Macro 1", click on "1st KEY" and type the first key in the macro e.g. function key
F4 to start the photo booth sequence. If the macro has more than one key, e.g. Ctrl+B to select black
and white mode, click on "1st KEY" and press (and release) the Ctrl key then click on "2nd KEY" and
press C. When you've finished press the Program button to program the StealthSwitch 3 (you only
need to do this once - the StealthSwitch 3 will remember the settings and can be used on any
computer). The StealthSwitch 3 is now ready to be used to control the photo booth. 

Kensington Wireless Presenter

This provides a simple and effective way for the operator to wirelessly control the photo booth. The
following keyboard shortcuts can be accessed using the Kensington Wireless Presenter:
laser pointer button (F5) - start the photo booth sequence
left arrow (Page Up) - decrease exposure using exposure compensation in auto exposure modes or
ISO in manual exposure
right arrow (Page Down) - increase exposure using exposure compensation in auto exposure modes or
ISO in manual exposure
stop button (b) - cycle through number of copies of prints: 1,2,3,4,5,6,7,8,9,1,2,3...
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Serial Port Method

What you need 

1. Unless the PC has a serial port you will need a USB to RS-232 adaptor such as the StarTech.com
USB to RS-232 Serial DB9 Adaptor. This is not the cheapest adaptor available, but it does work on
Windows XP and Windows Vista.

2. DB9 socket and wires or an old RS-232 cable with a DB9 socket
3. A suitable "push to make" button. The arcade style button below was purchased from Gremlin

Solutions in the UK. This site in the US has a good selection of buttons: www.happcontrols.com
4. Photobooth Pushbutton Utility, PhotoboothBtn_DSLR.exe, which can be found in the DSLR Remote

Pro for Windows installation folder

http://www.gremlinsolutions.co.uk
http://www.gremlinsolutions.co.uk
http://www.happcontrols.com
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Connecting it up 

First install the driver software that comes with the USB to serial to RS-232 adaptor and connect it to a
USB port on your PC. Then run the Photobooth Pushbutton utility (PhotoboothBtn_DSLR.exe): 

Next identify the correct COM port for the serial port. This can be done by using a small piece of wire
and connecting pins 1 and 4 on the DB9 connector (shown below). If the correct COM port is selected
the "Pin 1" checkbox in the Photobooth Pushbutton utility should be checked when pins 1 and 4 are
connected. If nothing happens try selecting a different COM port from the drop down list. 



Photo Booth Shooting 163

© 2024 We Fly Kites Inc.

Now wire up the button or buttons to the appropriate pins on the DB9 socket e.g. if you're using two
buttons pin 4 should be connected to the "common" connections of the two buttons and pin 1 should be
connected to the "push to make" connection of one button and pin 6 to the "push to make" connection
of the other button. Normally the connections would be made by soldering the wires to the DB9
connector but if you're not happy with soldering you can use an RS-232 cable instead and simply cut off
one end, identify which wires to use and then connect them to the spade connections on the buttons
using crimp connectors. 

Once the buttons are connected they can be tested by observing whether the appropriate checkboxes
are checked in the pushbutton utility app when each button is pressed. 

Finally, select the required action for each button using the drop down lists in the pushbutton utility e.g.
for a two button setup with DSLR Remote Pro for Windows where the user can select B&W or color
prints you would use settings similar to those below: 

In operation 

Connect the USB to RS-232 adaptor to a USB port on the PC and, making sure no buttons are
pressed, run the Photobooth Pushbutton utility. Before running DSLR Remote Pro for Windows check
that the buttons are working properly by pressing them and making sure the correct checkbox in the
pushbutton utility is checked. It may be necessary to select a different COM port if the buttons don't
work. Normally the same COM port is assigned provided the USB to RS-232 adaptor is connected to
the same USB port each time. 

Next run DSLR Remote Pro for Windows, select full screen photo booth mode and you should be able
to use the buttons to trigger the photo booth sequence. The Photobooth Button utility needs to running
at all times during photo booth operation so that it can detect the button presses and forward them to
DSLR Remote Pro for Windows. 
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10.16 Additional Filters

"Instagram" Style Filters

In addition to the color, B&W and monochrome toned filters there are 6 different Instagram style filters
that can be applied to images. The effects of these filters are shown in the live view images and are
applied to photos in print layouts and in animated GIFs. The standard filters can be replaced with user
defined filters if different effects are required.
The filters can be selected using the touchscreen actions "Select filter 1" through  "Select filter 2" or the
using keyboard shortcuts below:
Shift+Ctrl+F - select filter 1
Shift+Ctrl+G - select filter 2
Shift+Ctrl+H - select filter 3
Shift+Ctrl+I - select filter 4
Shift+Ctrl+J - select filter 5
Shift+Ctrl+K - select filter 6
W - cycle through color, B&W, B&W (toned), filter 1, filter 2, filter 3, filter 4, filter 5, filter 6

User defined filters
The filters use a color lookup table to map each color in the photo to a new color and optionally darken
the corners to create a vignetting effect. The lookup table is read from a JPEG image 2048x1024
pixels in size with the same name as the filter e.g. filter1.jpg, filter2.jpg, filter3.jpg etc. Vignetting is
applied if the filename ends with _vignette e.g. filter1_vignette.jpg.
The rest of the filename is ignored and can be used to identify the filter e.g. the following are valid
names for filter 1:
filter1.jpg - filter 1 with no vignetting applied
filter1_my_sketch_filder.jpg - filter 1 with no vignetting applied
filter1_vignette.jpg - filter 1 with vignetting applied
filter1_vignette_popart.jpg - filter 1 with vignetting applied

DSLR Remote Pro will look for a filter file in the current photo booth images folder first. If a filter file is
not found in the current photo booth images folder it will use the default filter in the installation folder.

The simplest way to create a new JPEG color lookup file is to download the following Photoshop PSD
file and edit it in Photoshop: https://breezesys.com/downloads/filter_setup.psd

https://breezesys.com/downloads/filter_setup.psd
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Then either use the test image in the "Your test photo here" layer or replace it with your own test
photo. Add adjustment layers to modify the output as required. The adjustment layers can apply any
adjustment that is applied to single pixels (e.g. level, curves, contrast, brightness, color fill, color
balance etc.). Adjustments that apply to groups of pixels (e.g. sharpening, masking, blur, noise filters
etc.) can't be used.
When you are happy with the changes, turn the visibility of the "Pattern" layer on:

Then save the file as a JPEG named filter1.jpg, filter2.jpg, filter3.jpg, filter4.jpg, filter5.jpg or filter1.jpg
and save it in the current photo booth images folder. Append _vignette to the filename to darken the
corners of the images.
Do not resize the filter_setup.psd image as this will prevent the filter from working.

The JPEG filter file should be 2048x1024 pixels in size and look something like this:

Creative Filters

The photo booth creative filters give the option of applying a variety of special effects to photo booth
photos and to the live view images displayed before taking the photos. The default filters include color
and monochrome negative images, color and monochrome posterization effects, desaturation and over
saturation effects and selective saturation. The filters are applied using a DLL which means that
experienced C or C++ programmers can write their own filters if required. A sample VC++ 2005 project
can be downloaded from http://www.breezesys.com/downloads/SampleCreativeFilter.zip

Please note that some filters may produce different results in the live view and final photos if flash is
used. This is because flash will probably give different highlight and shadow areas which will affect how

http://www.breezesys.com/downloads/SampleCreativeFilter.zip
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the posterization effects are applied. This is less of a problem if continuous lighting is used.
Creative filters that affect the colors may not work properly with green screen shooting.

To use creative filters you need put a copy of the PhotoboothCreativeFilter.dll file in your photo booth
images folder. The PhotoboothCreativeFilter.dll file can be found in the installation folder (from the
installation folder (normally C:\Program Files (x86)\BreezeSys\DSLR Remote Pro). The creative filter
DLL can be given any name ending with Filter.dll e.g. glitch_filter.dll.
When you enter full screen photo booth mode the software will automatically load the filter DLL and the
live view images will display the default filter which is color negative. Type Ctrl+Shift+C to display the
setup page to select a different effect or to configure the settings. The following settings dialog will be
displayed:

The processing of the filters in real time for the live view display can put quite a load on the computer
which may cause the live view refresh rate to slow down. On a dual or quad core computer the load
can be shared between the processor cores by setting the number of threads to more than 1.

The filter type can be selected from the drop down list. The various filter types that are available with
the PhotoboothCreativeFilter.dll that comes with the software are described below.

Color negative
This filter creates a negative color image e.g. yellow items will appear as blue and blue items will
appear as red. There are no controls for adjusting how this filter behaves.

Original image
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Image with color negative filter applied

Monochrome negative
This filter converts the image to grayscale and displays the negative e.g. dark items will appear light
and light items will appear dark. There are no controls for adjusting how this filter behaves.

Image with the monochrome negative filter effect applied

Posterize
This filter produces a thresholding/posterization effect with an adjustable number of levels. The strength
slider controls the size of each threshold with 0 having no effect and 255 producing an image just made
up of fully saturated colors. The recommended range of settings is 10 to 100.
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Image with the posterize filter applied with the strength set to 70.

Monochrome posterize
This is a highly configurable filter which converts the images to monochrome then posterizes it and
colorizes with one or two colors. It's probably simpler to experiment with the different settings below
and see their effect than to try explain how this filter works. The settings are shown below:

Strength - this controls the size of each threshold from 0, which has no effect, to 255 which gives only a
few solid colors.
White highlights - this controls whether bright highlights appear as one of the colors (top or bottom
color) or as white
Hue - this controls hue of the color displayed in the image
Saturation - this controls how strongly saturated the color is
Top Hue - this controls hue of the color displayed at the top of the image which randomly fades to the
main color at the bottom of the image. If this is set to 0 only the main color is used.
Top Saturation - this controls how strongly saturated the bottom color is

Image with the monochrome posterize filter applied: strength=53, base level=54, hue=8, saturation=40,
top hue=195, top saturation=100, white highlights=on
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Image with the monochrome posterize filter applied: strength=53, base level=54, hue=193,
saturation=40, top hue=0, top saturation=100, white highlights=on

Saturation
This filter allows the image saturation to be boosted to produce an over saturated image or reduced to
produce a more subtle desaturated image. Setting the strength to 100 will leave the saturation
unchanged.

Image with the saturation filter applied: strength=200 (strongly increasing the saturation of the colors)
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Image with the saturation filter applied: strength=10 (almost desaturating to grayscale)

Pop Art
This filter produces a three color "pop art" effect reminiscent of some of the work by Andy Warhol. The
photo is reduced to three colors: the background, dark areas of the subject and light areas.
This filter requires a green or a blue background and works best with continuous lighting rather than
flash. Set the threshold to a middle value (e.g. 140) and the sensitivity to a low value (e.g. 6) and then
adjust the background hue slider until the background is replaced with the background color for the first
photo (the default setting is red). A background hue setting of around 80 should be suitable with a
green background.
Then adjust the threshold and sensitivity sliders to get the desired result. The background, low light and
highlight colors used for each photo can be changed by clicking on them in the setup dialog.



Photo Booth Shooting 171

© 2024 We Fly Kites Inc.

Set of 4 photos shot using the pop art filter

Mirror Filters
The mirror filters mirror different parts of the photo to give fun effects when taking photos or capturing
animated GIFs. These filters are designed to be used with the camera in landscape orientation. They
can also be used with the camera in portrait orientation but the swap top halves may not give the
expected results.

Original photo without mirroring
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Mirror left/right
Please note: this option will mirror the top and bottom of the photo when the camera is in portrait
orientation. Please use the "Mirror top/bottom" option to mirror the left and right halves when the
camera is in portrait orientation.

Mirror top/bottom
Please note: this option will mirror the left and right halves of the photo when the camera is in portrait
orientation. Please use the "Mirror left/right" option to mirror the top and bottom when the camera is in
portrait orientation.
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Mirror 2x2 mosaic

Mirror swap top halves
Please note this option is only designed to work when the camera is in landscape orientation.

User selection of different filter effects
The settings for the filter are saved using the name of the photo booth images folder which means that
different effects can be applied in by using profiles to switch to different folders. For example users
could be given the choice between normal, over saturated and under saturated colors by creating three
photo booth images folders:
C:\PhotoboothImages\normal
C:\PhotoboothImages\over
C:\PhotoboothImages\under

Then save the photo booth settings to three different settings files:
C:\PhotoboothImages\normal\settings.xml - with the photo booth images folder set to C:
\PhotoboothImages\normal
C:\PhotoboothImages\over\settings.xml - with the photo booth images folder set to C:
\PhotoboothImages\over
C:\PhotoboothImages\underl\settings.xml - with the photo booth images folder set to C:
\PhotoboothImages\under
Please note: if you are using a touchscreen you need to create touchscreen actions to load profiles 1
to 3 before saving the settings.

Next create three profiles:
Profile 1 loads C:\PhotoboothImages\normal\settings.xml
Profile 2 loads C:\PhotoboothImages\over\settings.xml
Profile 3 loads C:\PhotoboothImages\saturation\settings.xml

Then copy the PhotoboothCreativeFilter.dll to the "over" and "under" folders (don't copy it to the normal
folder). Now run the booth in full screen photo booth mode and select profile 2 to switch to the "over"
photo booth images folder. Type Shift+Ctrl+C to display the settings and select "Saturation" from the
filter type combo, set the strength to 200 and click on OK to save the settings. Next select profile 3 to
switch to the "under" photo booth images folder. Type Shift+Ctrl+C to display the settings and select
"Saturation" from the filter type combo, set the strength to 10 and click on OK to save the settings.
Check everything is working by selecting profile 1 which should display normal live view images, profile
2 which should display over saturated live view images and profile 3 which should display under
saturated images.

Please see the section on Saving settings for future reference and using profiles for more information
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on using profiles.

Saving a copy of each filtered photo
Select "Save copy of processed photos" in the "Output Settings" dialog to save a copy of each photo
after the creative filter effect has been applied.

10.17 Payment Options

DSLR Remote Pro v3.16 onwards supports payments using standard payment systems such as the
Nayak VPOS Touch contactless credit card reader (shown below). To use this you need to run our free
MDB Payment utility software and to buy the necessary hardware (a Qibixx MDB-USB Interface, PSU
and cables and a suitable MDB payment system such as the Nayax VPOS Touch).

The MDB Payment utility monitors the state of the photo booth by reading the pathname of the screen
being displayed and communicates with any suitable MDB payment system via the Qibixx MDB-USB
interface.
MDB is a standard interface used by the vending machine industry to connect a wide range of payment
systems to vending machines (or in this case a photo booth). A typical payment system for a Windows
based photo booth is shown below:

For more information please see the help file for the MDB Payment Utility.
The MDB Payment Utility can be downloaded from the Downloads & Support page on our website.

https://breezesys.com/MDBPayment/help/
https://www.breezesys.com/support/
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Alternative Payment Systems

BKSoft in Germany have developed a photo booth cash payment system and associated hardware that
works with DSLR Remote Pro. Please visit their website for more information.

10.18 In Operation

In Operation

Once everything is setup simply run DSLR Remote Pro for Windows and press Ctrl+F4 to enter full
screen mode and display the ready screen. You probably don't want to have a keyboard on show
otherwise users will be able to exit the photo booth mode and access your computer. There are a
number of methods that can be used to start the photo booth shooting sequence:

1. The simplest option is to use a mouse and set the start option to "Left click to start, right click to
toggle B&W mode" or one of the other left click options. Provided the keyboard is hidden away the
users won't be able to access your computer but use the left mouse button to start the sequence
and the right mouse button to toggle between B&W and color photos.

2. Alternatively you could use a programmable USB input device which can be setup to send an F4 key
press to DSLR Remote Pro for Windows:
a) The Powermate from Griffin Technology (http://www.griffintechnology.com/products/powermate/)
is an inexpensive and nicely made device which works very well.
b) The StealthSwitch (http://www.stealthswitch.com) is a very robust foot switch which simply needs
to be plugged in to be used in full screen photo booth mode. No additional drivers need to be
installed. The desktop hiding software that comes with the StealthSwitch should be disabled
otherwise the photo booth screen will be hidden when the switch is pressed.

3. For a more professional setup you could use external panel mounted buttons.
4. Use a touchscreen and one of the left click start options

If "auto reconnect" is selected from the "Camera" menu the camera can be turned off when not in use
and then turned it back on again to automatically restart photo booth operation. When the camera is
turned off the camera_not_connected.jpg screen is displayed and when it is turned back on again the
ready.jpg screen is displayed.

The keyboard shortcuts Ctrl+1, Ctrl+2, Ctrl+3, Ctrl+4, Ctrl+5, Ctrl+6, Ctrl+7, Ctrl+8 or Ctrl+9 can be
used to specify the number of copies of prints when running in full screen photo booth mode. The
number pad "add" and "subtract" keys can also be used to increase or decrease the number of copies.
A small confirmation message is displayed for approximately 2 seconds in the bottom right corner of
the display when the number of copies is changed.

A default profile can be used to reset the photo booth to a known state after each shooting sequence.

If there is no internet connection available at an event you can use the offline email mode to record
users' email addresses and send the emails later. Please see this section of the help file for details.

To exit full screen photo booth mode either press the Esc key or hold down the SHIFT key and press
the left mouse button.

Lockdown Mode

Lockdown mode protects the photo booth settings with a password and can be used to prevent
untrained photo booth attendants from changing the settings.
To enable lockdown mode select "Lockdown mode..." from the View menu:

https://www.casino-software.de/photo_booth_cash_control_system_e.htm
http://www.griffintechnology.com/products/powermate/
http://www.stealthswitch.com
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Enter the password and click on the "Lockdown" button. Check it is working by clicking on the
"Advanced Settings" button and a password prompt will be displayed.

To disable the lockdown password select "Lockdown mode..." from the View menu and enter the
password. If you have forgotten the password it can be reset by exiting DSLR Remote Pro and
deleting the following value from the Windows registry:

HKEY_CURRENT_USER\Software\BreezeSystems\DSLRRemotePro\100\PhotoboothLockdown

Alternatively copy the text below into a text file named disable_lockdown.reg and then double click on
the file to copy the reset setting to the registry:

Windows Registry Editor Version 5.00

[HKEY_CURRENT_USER\Software\BreezeSystems\DSLRRemotePro\100]
"PhotoboothLockdown"=dword:00000000

If you have forgotten your lockdown password it can be removed by exiting DSLR Remote Pro and
deleting the following value from the Windows registry:
 
HKEY_CURRENT_USER\Software\BreezeSystems\DSLRRemotePro\100
\PhotoboothLockdownPassword

Digital Zoom

The live view can be digitally zoomed in full screen photo booth mode holding down the Ctrl and Alt
keys and then pressing cursor left and cursor right keys. It can also be adjusted using touchscreen
actions.
The digital zoom range is from 1x to 4x magnification. Digital zoom works by taking a small portion of
the photo and magnifying it and is an alternative to zooming the image by turning the zoom ring on the
lens. Digital zoom may result in a reduction in image quality and pixellated live view images. It will also
increase the time it takes to generate preview images and to prepare the photos for printing. Green
screen processing will take considerably longer if digital zoom is used and isn't recommended unless
you have a fast computer. The photos taken by the camera are not affected by digital zoom and are
always saved showing the full frame. Digital zoom is only applied to the live view images presented to
the user and to the printed photos.
Digital zoom can be reset to 1x magnification using the keyboard shortcut Ctrl+Home when in full
screen photo booth mode or by running the photo booth setup wizard. Typing Ctrl+Home will also reset
live view cropping. 
Please note that digital zoom is only available in stills photo booth mode and can't be used for video.

Cropping Photos

Photos can be cropped in the live view display and the final prints when using stills photo booth mode
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(but not when using video booth mode). The photos can be cropped horizontally - removing equal
amounts from the left and right of the photo - or vertically - removing equal amounts from the top and
bottom of the photo. Horizontal cropping can be used to create square photos or to create a portrait
aspect ratio when the camera is in landscape orientation. Vertical cropping can be used to create a
"letter box" style crop where the photo is short and wide.
There are separate controls for cropping the live view and the photos placed in the print layout:

Cropping live view: Hold the shift key down and adjust the live view cropping using the cursor left and
right keys when in full screen photo booth mode. Type Ctrl+Home to disable live view cropping (this will
also reset digital zoom). The amount of cropping is displayed in the bottom right corner of the screen
together with size of the cropped live view images in pixels. A crop size of 0 means no cropping, a
positive crop size indicates horizontal cropping (removing equal amounts from the left and right) and a
negative crop size indicates vertical cropping (remove equal amounts from the top and bottom). Use the
live view size information to help select the correct amount of cropping e.g. to get a square crop adjust
the settings until the width and height are the same. It's worth noting down the live view width and
height as this can be used to set the cropping in the print layout.

Cropping photos in the print layout: In the print layout editor the aspect ratio (and hence the
cropping) of a photo can be adjusted by holding down the Shift key and dragging the photo's corners.
When a photo is selected it will be highlighted in green in the layout panel in the top left corner of the
print layout editor window. The size and position of the photo is updated as the corners are dragged
and the width and height displays can be used to check the exact cropping. Alternatively click on the
"..." button to the right of the setting for the currently selected photo to display a dialog where the width
and height can be typed in. To get a square crop simply enter the same setting for the width and the
height. To match the live view cropping enter the live view width and height settings.
Once the correct amount of cropping has been applied the photo can be resized keeping the same
aspect ratio by releasing the Shift key and dragging its corners.
Repeat the process for each photo on the layout. Alternatively type Ctrl+P to select all the photos then
right click on the cropped photo and select "Make photos same size and angle" to crop the remaining
photos by the same amount.

Manual Focus vs Auto Focus

For most cameras (except cameras with dual pixel live view AF (e.g. Canon EOS 70D, Canon EOS
77D, Canon EOS 80D, Canon EOS 800D/Rebel T7i, Canon EOS 200D/Rebel SL2, Canon EOS 7D
Mark II) it is better to use manual focus than auto focus. This is because if the camera is set to auto
focus and is unable to lock focus it will not take the photo. We recommend using manual focus to avoid
this problem.

The simplest way to set the camera to manual focus is to set the AF/MF switch on the lens to the MF
position. When setting up the booth you can focus by turning the focus ring on the lens and checking the
focus on the live view display on the PC screen.

Recent Canon DSLRs (mid range and above) and mirrorless models have dual pixel phase detect auto
focus with face detect in live view. This makes it practical to use continuous auto focus in live view and
get reliable, accurate autofocus. 

Please see the section on photo photo booth camera settings for more information on using auto focus.

Testing without a camera

If no camera is connected photo booth can be tested using a simulated camera with a simulated live
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view display. When testing in normal photo booth mode or in video booth mode the software will display
the normal countdown and then use the sample photos that are in the "Samples" subfolder of the main
installation folder (normally C:\Program Files (x86)\BreezeSys\DSLR Remote Pro\Samples). If you
would prefer to use your own sample images simply create a folder named "Photobooth Samples" in
your Documents folder and copy sample JPEG photos and MP4 movies there.

The simulated live view display shows green land (to allow green screen testing) with a blue sky (to
allow blue screen testing) with a stylized figure in front and the sun and a cloud moving in the
background to show that live view is active:

The stylized figure can be replaced with the image of your choice by creating a PNG file named
simulated_evf_landscape.png (for when the camera is in landscape orientation) and a PNG file named
simulated_evf_portrait.png (for when the camera is in portrait orientation). The
simulated_evf_landscape.png file should be 960 x 640 pixels in size and the simulated_evf_portrait.png
file should be 640 x 960 pixels. The PNG files should contain an alpha channel containing transparency
if you want the land, sky etc. to be visible in the background. The simulated_evf_landscape.png and
simulated_evf_portrait.png files should be saved in the installation folder (normally C:\Program Files
(x86)\BreezeSys\DSLR Remote Pro).

Reprints

The last print layout can be reprinted by typing Ctrl+R in full screen photo booth mode. Alternatively
select the output option to also save a JPEG copy and then use a browser or image editor to select
and print the required layout.

Reprint Selection Screen

A reprint selection screen is available from the ready screen which allows users (or the photo booth
operator) to quickly select a set of photos to be reprinted. The reprint selection screen can be
displayed by typing Ctrl+Alt+P or by using the "Display reprint screen" touchscreen action. This will
display a screen showing thumbnails of the JPEG copies of prints stored in the prints subfolder. The
user can select one or more photos and the number of copies to be reprinted using the touchscreen or
by using the cursor keys or mouse if no touchscreen is available. After selecting the photos they can be
printed by pressing the Enter key or typing A or by clicking on the printer icon in the center bottom of
the screen. The user can also cancel the reprint selection screen and return to the ready screen by
typing Esc or X or by clicking on the cancel icon at the right bottom of the screen. The reprint selection
screen will also cancel automatically if a timeout occurs. Clicking in the bottom left corner of the screen
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deselects all selected photos when using the ReprintMultiSelect option.

The reprint selection screen can be customized by clicking on the "Reprint screen settings..." button in
the "Photobooth Settings" dialog and the "Reprint Selection Screen Settings" dialog will be displayed:

The bottom area of the reprint selection screen defaults to the Windows default background color with
a printer icon and a red cross to cancel the screen. The icons can be replaced by putting PNG images
named Printer-icon.png and Cancel-icon.png in your photo booth images folder. Alternatively you can
use create screen image named reprint.jpg in your photo booth images folder (please note that only the
bottom portion of the reprint.jpg screen will be visible).

The "Thumbnail size" setting specifies the width and height of the thumbnails and the "Thumbnail
spacing" setting specifies the spacing between the thumbnails. These settings are in pixels.

The "Caption text size" specifies the size of the text used for the caption beneath each thumbnail.

The "Timeout" settings specifies how long it takes the screen to timeout and close when there is no
user input.

The "Maximum number of copies" specifies the maximum number of copies the user is allowed to
select. If this is set to more than 1 the currently selected number of copies will be displayed together
with a - and a + sign for decreasing or increasing the number of copies to print. If a reprint.jpg screen
is in the current photo booth images folder this will be displayed instead of the - and + signs.

When "Display newest prints first" is selected the thumbnails will be sorted by their file creation
timestamp with the most recently created thumbnails displayed first. When this option is not selected
the order will be reversed and the oldest thumbnails will be displayed first.
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By default the print icons appear at the bottom of the screen. Select "Top" in the "Icon placement"
dropdown list to place the icons at the top of the screen.

Select "Allow multiple prints to be selected" if you want users to be able to select more than one print.
When this is selected users can select a thumbnail by tapping on it and deselect it by tapping on it a
second time.
When "Allow multiple prints to be selected" is not selected only one thumbnail can be selected at a
time. If another thumbnail is tapped it will be selected and the original thumbnail deselected.

Select the "Show mouse cursor" option to display the mouse cursor to make it easier to select reprints
when using a mouse.

Use the "Caption text color" and "Caption color when selected" settings to set the color used to display
the captions. Click on the "..." buttons to change the colors.

The thumbnails are displayed on a white background and if the thumbnails themselves have a white
background it can be difficult to see them properly. By default a thin black outline is displayed around
the thumbnails to make them easier to see. Use the "Outline color" setting to change the color. A
different color can be used for the outline when a thumbnail is selected to help highlight it.

Use the "Background color when selected" setting to specify the color of the background used to
highlight thumbnails that have been selected.

Enter a password in the password field to protect access to the reprint selection screen. Leave the
password field empty if password protection is not required.

Reprinting after an Event

If the output option was set to "Print and save JPEG copy" or "JPEG copy only" when the photos were
taken a JPEG copy of the printed output will be saved in the prints subfolder. The JPEG copies of the
printed output can be reprinted after an event by selecting "Print selected photo booth photos..." from
the File menu and then selecting one or more JPEGs for printing.

If a JPEG copy of the printed output is not available or you want to reprint the photos using a different
layout you can do it as follows:
1. Setup the printer and photo booth print layout as required
2. Use Windows Explorer to drag and drop the first set of photos into the DSLR Remote Pro main

window
3. Type Shift+Ctrl+R or select "Reprint photos" from the File menu and the photos will be printed
4. Repeat steps 2 and 3 to as required

Where Photos, Videos and GIFs are Saved

Photos and videos taken by the camera are downloaded to the PC and saved in the download folder.
The location of the download folder is set in File->Preferences:
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The settings shown above will save photos and videos in a separate subfolder of C:
\Users\chris\Documents\PhotoboothImages for each date.
e.g. photos and videos captured on July 6, 2017 are saved in:C:
\Users\chris\Documents\PhotoboothImages\2017-07-06
The XML shooting information file (see below) is also saved in the download folder.

If the output is set to "Print and Save JPEG copy" or "Jpeg copy only" the JPEG copy of the printed
output will be saved in a subfolder of the download folder named "prints"
e.g. the JPEG copy of prints from photos taken on July 6, 2017 are saved in:
C:\Users\chris\Documents\PhotoboothImages\2017-07-06\prints

If one of the GIF animation options is selected the animated GIFs are saved in a subfolder of the
download folder named "GIF"
e.g. GIFs created on July 6, 2017 are saved in:
C:\Users\chris\Documents\PhotoboothImages\2017-07-06\GIF

A quick method of showing where the photos are being saved is to exit full screen photo booth mode
and take a photo by pressing the shutter release on the camera or by pressing the "Release (F8)"
button in the main DSLR Remote Pro window. When the photo is taken it is automatically downloaded
to the PC and saved on the hard disk in the download folder. The full pathname (i.e. download folder
name and image filename) will be displayed in the status line at the bottom of the main DSLR Remote
Pro window:

XML Shooting Information
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After each set of shots an XML file containing information about the set of photos is written to the
folder where the photos are downloaded from the camera. The XML file has the same filename as the
first shot in the sequence (but with a .XML file extension). An example XML shooting information file is
shown below:

<?xml version="1.0" ?>
<breeze_systems_photobooth version="3.5">
<photo_information>
  <date>2016/01/26</date>
  <time>16:37:19</time>
  <user_data>sales@breezesys.com</user_data>
  <survey_data>
    <survey1_chkbox1 id="over18">1</survey1_chkbox1>
    <survey1_chkbox2 id="agree">1</survey1_chkbox2>
    <survey1_chkbox3 id="share">0</survey1_chkbox3>
    <survey2_text1 id="name">Chris Breeze</survey2_text1>
    <survey2_chkbox1 id="test">0</survey2_chkbox1>
  </survey_data>
  <prints>1</prints>
  <photobooth_images_folder>C:\Photobooth\PhotoboothImages</photobooth_images_folder>
  <digital_zoom>100</digital_zoom>
  <camera_orientation>0</camera_orientation>
  <bw_mode>0</bw_mode>
  <photos>
    <photo image="1">20160126_163719_1.JPG</photo>
    <photo image="2">20160126_163719_2.JPG</photo>
    <photo image="3">20160126_163719_3.JPG</photo>
    <photo image="4">20160126_163719_4.JPG</photo>
    <output>prints\20160126_163719.jpg</output>
    <gif_file>GIF\20160126_163719.GIF</gif_file>
  </photos>
</photo_information>
</breeze_systems_photobooth>

The <date> and <time> tags contain the date and time of the first shot in the sequence. Please note
that the date and time will only be correct if the camera's clock is set correctly. The camera's clock can
be automatically synchronized with the PC's time when it connects to the PC by selecting the automatic
synchronization option in the camera settings dialog.
The <user_data> tag contains the text entered by the user if the touchscreen keyboard option is used.
The <survey_data> tag contains information entered by the user if optional user survey screens are
defined.
The <prints> tag contains the number of prints requested (this is 0 if the user rejects the photos in the
print confirmation window)
The <photobooth_images_folder> tag contains the full pathname of the photo booth images folder.
The <digital_zoom> tag contains the amount of digital zoom expressed as a percentage of the frame i.
e. 100 means no digital zoom
the <camera_orientation> tag contains the camera orientation expressed in degrees measured
clockwise from the horizontal
the <bw_mode> tag contains color/B&W/monochrome tinting information, 0=color, 1=B&W,
2=monochrome tinting 
The <photo> tags contain the filenames of the photos taken in the shooting sequence.
The <output> tag contains the relative pathname of the JPEG copy of the printed output (if selected).
The <gif_file> tag contains the relative pathname of the animated GIF (if selected).

The writing of the XML shooting information file can be suppressed by setting the following value in the
Windows registry to 1:
HKEY_CURRENT_USER\Software\BreezeSystems\DSLRRemotePro\100\PhotoboothSuppressXml
Please note: if PhotoboothSuppressXml is set any information entered using the optional user survey
screens will not be saved and will be lost.

This setting can be changed exiting DSLR Remote Pro and then running the Configure.exe utility in the
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installation folder.

Print Counter

Each time photos are sent to the printer the photo booth print counted is decremented by the number of
copies being printed until it reaches 0. The value of the print counter is saved in the Windows registry
as the following DWORD setting:
HKEY_CURRENT_USER\Software\BreezeSystems\DSLRRemotePro\100\PhotoboothPrintCounter
This setting can be displayed or edited in the event info dialog described in the next section. It can be
accessed using the token {localPrintCounter}.

Please note: this counter is not the same as the number of prints remaining on a roll of media in the
printer. Some printers can display the number of prints remaining via the printer driver or by running a
separate print monitoring utility.

Event Info

Event information can be defined and used in filenames, captions and the messages used when sharing
photos. The information is saved in the Windows registry so that it may be shared with other
applications and is read from the Windows registry before it is used so that it can use information
supplied by other applications. The "Photo Booth Event Info" dialog can be displayed by selecting
"Event info..." from the File menu or by pressing the "Event info..." photo booth shortcut button (if
defined):
 

The event info can be used in filenames (e.g. the filename and download folder of photos downloaded
from the camera), caption text in print layouts or in the message text used when sharing photos by
using the tokens below. The information is also saved in the Windows registry using the registry key:
HKEY_CURRENT_USER\Software\BreezeSystems\Event Info.
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Please note: Do not use the characters \ / : * ? " | < > in the event info if it is going to be used to
define filenames. Windows does not allow these characters to be used in filenames and this may
prevent the files from being saved.

Item Token Registry value

Event name {eventName} HKEY_CURRENT_USER\Software\BreezeSystems\Event
Info\EventName

Event date {eventDate} HKEY_CURRENT_USER\Software\BreezeSystems\Event
Info\EventDate

Event string 1 {eventString1} HKEY_CURRENT_USER\Software\BreezeSystems\Event
Info\EventString1

Event string 2 {eventString2} HKEY_CURRENT_USER\Software\BreezeSystems\Event
Info\EventString2

Event string 3 {eventString3} HKEY_CURRENT_USER\Software\BreezeSystems\Event
Info\EventString3

Event string 4 {eventString4} HKEY_CURRENT_USER\Software\BreezeSystems\Event
Info\EventString4

Event string 5 {eventString5} HKEY_CURRENT_USER\Software\BreezeSystems\Event
Info\EventString5

Print counter {eventPrintCou
nter}

HKEY_CURRENT_USER\Software\BreezeSystems\Event
Info\PrintCounter

Print total {eventPrintTot
al}

HKEY_CURRENT_USER\Software\BreezeSystems\Event
Info\PrintTotal

DSLR Remote Pro
print counter

{localPrintCou
nter}

HKEY_CURRENT_USER\Software\BreezeSystems\DSLRRem
otePro\100\PhotoboothPrintCounter

Print template name {printTemplate
Name}

HKEY_CURRENT_USER\Software\BreezeSystems\Event
Info\PrintTemplateName

The print template name is displayed in the "Photo Booth Event Info" dialog for information purposes
only and cannot be edited in the dialog. This setting is updated automatically when a print layout is
loaded in the print layout editor.

The event name and event date are used to generate an id to identify an event. The id is calculated by
taking the MD5 checksum of the event name + event date. The event id is stored in the XML summary
file and the email and text XML files. It is also available for including in email and text messages and
QR code using the token {eventId}.

The gallery id is used to help identify which gallery photos should be added to when using online gallery
systems such as Event Kite. The gallery id token, {eventKiteGalleryId}, can added to email messages
or used to define QR codes. You can also use the Event Kite session id token, {eventKiteSessionId}, to
identify a set of photos.

Three print counters are available:
1. "Print counter" - this is a print counter shared via the Windows registry with other apps (e.g. Breeze

Kiosk) and is decremented each time any app prints a photo
2. "Print total" - this is a print counter shared via the Windows registry with other apps (e.g. Breeze

Kiosk) and is incremented each time any app prints a photo
3. "DSLR Remote Pro print counter" - this is a private print counter only used by DSLR Remote Pro.

The counter is decremented each time a photo is printed

Use the action dropdown list to specify what action to take when the "Print counter" or "DSLR Remote

https://www.eventkite.co/
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Pro print counter" reaches zero. The options are:
"None": take no action and allow printing as normal
"Display error when print counter reaches 0": display an error message and disable printing when the
shared "Print counter" reaches zero
"Display error when DSLR Remote Pro print counter reaches 0": display an error message and disable
printing when the "DSLR Remote Pro print counter" reaches zero
The action dropdown also controls how the {printQuotaUsed} token works:
"None": {printQuotaUsed} always returns 0 (i.e. it is disabled and the print quota is never used up)
"Display error when print counter reaches 0": {printQuotaUsed} returns 1 when the print counter
reaches 0 else returns 0
"Display error when DSLR Remote Pro print counter reaches 0": {printQuotaUsed} returns 1 when the
DSLR Remote Pro print counter reaches 0 else returns 0

Click on the "Message..." button to edit the error message that is displayed to the user when the print
counter reaches zero.

Example: to limit an event to 200 prints first set the print counter to 200 then set the "Action:" dropdown
list to "Display error when printer counter reaches 0". Next click on the "Message..." button to edit the
message that is displayed to users when the print counter reaches zero.
Each time a print is output the counter is decremented and when in reaches zero the error message will
be displayed if users try to print additional photos.

Tip: To create a setup which uses a different profile when the DSLR Remote Pro print counter reaches
0 set the default profile to something like this:
C:\Profiles\{if,{localPrintCounter},print_and_share.xml,share_only.xml}
Alternatively you could use the {printQuota} token instead by setting the "Action" dropdown "Display
error when print counter reaches 0" or "Display error when  DSLR Remote Pro print counter reaches 0"
and setting the default profile to something like this:
C:\Profiles\{if,{printQuotaUsed},share_only.xml,print_and_share.xml}

The event info can also be manually added to the XML files used to setup a photo booth. Please see
the section on using profiles to setup a photo booth for details.

Timed Sessions

Select "Timed session" in the "Photo Booth Event Info Dialog" and click on the settings button to set up
a session which has a start time and an end time:

Set the start time to the time the photo booth session should start and the session end time to the time
the session should end.
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When the photo booth is running before the start time it will display the before_session.jpg screen.
When the time reaches the start time the photo booth will automatically switch to the ready screen.
When the session end time is reached the photo booth will automatically switch to the after_session.jpg
screen.

An optional message can be displayed in the before_session.jpg screen. This can be used to display
information such as when the photo booth opens or a countdown timer showing when it opens. Click on
the "..." button to the right of the "Font" text box to adjust the font type and size. Click on the "..." button
to the right of the "Font color" preview to change the color. Use the "Top offset (pixels)" setting to
position the message relative to the top of the screen. The message will be center justified.
The message can be made up of more than one line of text by adding \n to start a new line. The
following tokens can be used in the message:
{startTime} - this is replaced with the start time e.g. 19:00
{endTime} - this is replaced with the end time e.g. 22:30
{timeToStart} - this is replaced with the time until the photo booth opens e.g. 2:34:52
Example: to display the photo booth opening time with a countdown in you could set the message to:
Photo booth is open from {startTime} to {endTime}\nOpens in {timeToStart}...

An optional video can be displayed in the before_session.jpg and after_session.jpg screens. The video
should be given the same name as the screen e.g. before_session.mp4 or before_session.mov. Add
_loop to the end of the filename to play the video in a continuous loop e.g. before_session_loop.mp4.
Please see the section on screens displayed to the user for more information.
The optional message in the before_session.jpg screen will appear in front of the before session video.

Touchscreen actions can be defined to start a session early when the before_session.jpg screen is
displayed or to open the photo booth for another 10 minutes when the after_session.jpg screen is
displayed. The "Exit fullscreen photobooth" touchscreen action can also be used to exit photo booth
mode. All of these touchscreen actions can be password protected using the exit action password
which can be set in the "Touchscreen Settings" dialog.

Sharing Totals

The sharing totals shown at the bottom of the "Photo Booth Event Info" keep a count of the total
number of emails, texts and tweets sent by the photo booth. These counters are incremented each
time a photo is shared. The counters can be reset by entering new values and pressing "OK".
The counters are saved to the Windows registry when they are updated so that they can be monitored
by other applications if required.

Counter Registry value

Emails HKEY_CURRENT_USER\Software\BreezeSystems\DSLRRem
otePro\100\EmailCounter

Texts HKEY_CURRENT_USER\Software\BreezeSystems\DSLRRem
otePro\100\TextCounter

Tweets HKEY_CURRENT_USER\Software\BreezeSystems\DSLRRem
otePro\100\TweetCounter

10.19 Using external flash or studio strobes with live view

Due to the way Canon have designed live view on their cameras the triggering of flash guns and studio
strobes can cause problems.  Some options for lighting a photo booth are outlined below:
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Option 1: Use an E-TTL II compatible flash connected to the camera's hotshoe. This should work for
all mid to high end cameras. The camera's live view exposure simulation should disabled otherwise the
live view images may be too dark. This doesn't work very well with low end camera models because
they initially disable live view exposure simulation automatically but then turn it back on again after a
few seconds.

Option 2: Use a flash which is not E-TTL II compatible or studio strobes connected using a hotshoe to
PC cord adapter. This should work for mid to high end camera models if the camera's live view silent
shooting setting is disabled and live view exposure simulation is disabled. This also works with
mirrorless cameras (e.g. Canon EOS M50) if exposure simulation is disabled.  For low end camera
models the "external flash" option needs to be selected.

Option 3: Use the camera's built-in flash to trigger the main flash or strobe via a slave unit. This should
work for mid to high end camera models if the camera's built-in flash is set to manual flash not E-TTL
II. If the flash is set to E-TTL II the camera fires a pre-flash which will trigger the main lighting
prematurely. The flash mode on low end camera models cannot be changed and is set to E-TTL II
which means you will always get a pre-flash. However, this method should work with low end camera
models if you use a slave unit which has pre-flash cancellation so that it ignores the pre-flash and only
triggers off the main flash.

Option 4: Use the camera's built-in flash. This should work with all camera models but may result in
result in rather harsh, unflattering lighting.

Option 5: Use continuous lighting or available light to avoid the need for flash. This will work with all
camera models but may cause problems if the available light is too dim or keeps changing.

Mid to high end camera models: 40D, 50D, 60D, 70D, 80D, 6D Mark II, 6D, 7D, 7D Mark II, 5D Mark
IV, 5D Mark III, 5D Mark II, 1D Mark III, 1D Mark IV, 1Ds Mark III, 1D X, 1D X Mark II, 1D C

Low end camera models: 200D/Rebel SL2, 100D/Rebel SL1, 2000D/Rebel T7, 4000D, 1300D/Rebel
T6, 1200D/Rebel T5, 1100D/Rebel T3, 1000D/Rebel XS, 77D, 800D/Rebel T7i, 760D/Rebel T6s,
750D/Rebel T6i, 700D/Rebel T5i, 650D/Rebel T4i, 600D/Rebel T3i, 550D/Rebel T2i, 500D/Rebel T1i,
450D/Rebel XSi

Mirrorless camera models: Canon EOS M50

10.20 Green Screen Shooting

The photo booth mode in DSLR Remote Pro for Windows v2.0 introduces green screen shooting (also
known as chroma keying). Green screen photography works by taking photos of the subject in front of
a green background and then automatically replacing the background with a background image. The
background image can be anything you like such as an exotic location, a cityscape or even a photo of
the President of the United States.

DSLR Remote Pro for Windows also supports blue screen shooting. This works in exactly the same
way but uses a blue background instead of a green background. To enable blue screen shooting select
the "Blue screen mode" checkbox when the green screen settings dialog is displayed.

DSLR Remote Pro for Windows will automatically replace the green background with the chosen
background when using live view in photo booth mode and also when using the live view window. This
means that the users will see what the final picture will look like with the new background as opposed
to the green background that the cameras sees.

A basic green screen setup is shown below:
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Basic green screen setup with green screened live view images displayed on the monitor

When the images are printed out as a double strip they look like this:

For best results the green background should be evenly lit and the subject should be positioned to
minimize shadows falling on the background.

Green Screen Shooting in Photo Booth Mode

First copy the JPEG image to be used for the background to the photo booth images folder and name
it greenscreen_background.jpg.
Next connect a camera and select full screen photo booth and type Ctrl+G to display the green screen
settings:
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The left hand side of the screen shows the live view display and the right hand side shows a green
screened copy of the last photo taken by the camera. Press the "Take Test Photo" button to take a
test photo if no photo is displayed on the right.

If continuous lighting is being used the same settings can be used for the live view and the final photos
and the "Use same settings as live view" checkbox can be selected. When the "Use same settings as
live view" checkbox is selected any adjustments made to the green screen settings for live view will
also be applied to the photos.

If flash is being used it is likely that the lighting for live view is not the same as that for used for the
actual photos and the "Use same settings as live view" checkbox should be unchecked so that different
adjustments can be used for the live view images and the actual photos.

Select the "Enable green screen display" checkbox to enable green screen shooting. Then adjust the
sliders so that all of the green screen background is replaced with the background image but the
foreground subject is unaffected. Please see the section headed "Adjusting the green screen settings"
below for information on how to adjust the settings to get the best results.

Select the "Save copy of greenscreened photos in photo booth mode" option to save a of the photo
downloaded from the camera with the green background replaced with the background image. The
greenscreened copies are saved the "greenscreen" subfolder of the folder where the images from the
camera are saved. The greenscreened copy will be saved as a JPEG image unless the transparent
background option is selected in which case it will be saved as a PNG file.

Select the "Transparent background (print without overlay or background)" option to save the photos as
a PNG image with a transparent overlay. When this option is selected the images displayed in the live
view will be shown against the selected background image but the photos added to the print layout will
have a transparent background and the background will be the background defined in the print layout
(e.g. a background.jpg image). You can allow users to choose different backgrounds in the print
confirmation screen after the photos have been taken. Please see Swapping print backgrounds for
details.
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An outline or sticker effect can be applied to green screen or AI Background removal photos when the
transparent background option is used. To add the outline/sticker effect select the "Transparent
background (print without overlay or background" option and then select "Add outline/sticker effect":

The size of the outline is specified as a percentage of the width of the photo. Click on the "..." button to
the right of the outline color to select the color of the outline.

By default the photos taken by the camera will fill the green screen background. Select the "Adjust
position of photo within background" option if you want to place the photos in just one part of the
background.
Use the ""Rotate" slider to rotate and the "Crop" slider to the photo before placing it on the
background..
Use the "Scale factor" slider to adjust the size of the photo and the "X offset" and "Y offset" sliders to
adjust the position.

In full screen photo booth mode the green screen background and overlay images are loaded from the
photo booth images folder. The background image should be named greenscreen_background.jpg and
the overlay image should be named greenscreen_overlay.png. Different overlays and backgrounds can
be used for each shot by appending the shot number to the filenames e.g.
Shot 1: background filename: greenscreen_background_1.jpg, overlay filename:
greenscreen_overlay_1.png
Shot 2: background filename: greenscreen_background_2.jpg, overlay filename:
greenscreen_overlay_2.png
Shot 3: background filename: greenscreen_background_3.jpg, overlay filename:
greenscreen_overlay_3.png
Shot 4: background filename: greenscreen_background_4.jpg, overlay filename:
greenscreen_overlay_4.png

An different overlay and background file can be displayed in the live view by appending _live_view to
the filename. This is useful if the background or overlay contains text and the live view is mirrored
because it means versions of the background and overlay with no text can be used for live view instead
of displaying mirrored text. Example filenames:
Shot 1: live view background and overlay filenames: greenscreen_background_1_live_view.jpg,
greenscreen_overlay_1_live_view.png

background and overlay files applied to the prints: greenscreen_background_1.jpg, filename:
greenscreen_overlay_1.png
Shot 2: live view background and overlay filenames: greenscreen_background_2_live_view.jpg,
greenscreen_overlay_2_live_view.png

background and overlay files applied to the prints: greenscreen_background_2.jpg, filename:
greenscreen_overlay_2.png
Shot 3: live view background and overlay filenames: greenscreen_background_3_live_view.jpg,
greenscreen_overlay_3_live_view.png

background and overlay files applied to the prints: greenscreen_background_3.jpg, filename:
greenscreen_overlay_3.png
Shot 4: live view background and overlay filenames: greenscreen_background_4_live_view.jpg,
greenscreen_overlay_4_live_view.png

background and overlay files applied to the prints: greenscreen_background_4.jpg, filename:
greenscreen_overlay_4.png

Backgrounds and overlays can also be switched by saving a number of different profiles each using a
different photo booth images folder containing different greenscreen_background.jpg and
greenscreen_overlay.png images. The user can then select the different backgrounds using the profile
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shortcut keys. You can also switch green screen backgrounds and overlays by copying the new
greenscreen_background.jpg and greenscreen_overlay.png images into the photo booth images folder
while the booth is running.
Please note: Green screen should be enabled before saving the settings to file when using profiles to
switch backgrounds. If green screen is not enabled when the settings are saved green screen will be
disabled when the saved settings are loaded using a profile.

Green Screen Shooting in Normal Live View

To enable green screen shooting in normal live view mode first connect a camera and then select live
view from the Camera menu or by typing Ctrl+L. Then type Ctrl+G or right click on the live view display
and select "Green screen settings..." to display the green screen setup dialog:

Next select the background image by pressing on the "..." button then click on the "Enable green screen
display" checkbox to enable green screen display. Then adjust the sliders so that all of the green
screen background is replaced with the background image but the foreground subject is unaffected.
Please see the section headed "Adjusting the green screen settings" below for information on how to
adjust the settings to get the best results.

Select the "Save copy of greenscreened photos" option to save a greenscreened copy of each photo in
the greenscreen subfolder where the photos are downloaded. This option only works with JPEG
images and can't be used when shooting raw only (it can be used when shooting raw+JPEG).

Select the "Transparent background (print without overlay or background)" option to save the photos as
a PNG image with a transparent overlay. When this option is selected the images displayed in the live
view will be shown against the selected background image but the greenscreened copies of the photos
will be saved as PNG files with a transparent background.

Please note: The greenscreening is optimized for speed not quality in order to be able to display the
greenscreened images in the live view window in realtime. The quality should be good enough for small
photos and prints, but if you want large high quality results you may need to use specialist green screen
software such as FxHome PhotoKey.
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Adjusting the green screen settings

To get the best results you need a non-reflective background which is pure green. Try to keep the
lighting of the background as even as possible and avoid shadows cast by the people standing in front
of the background. If you are using a cloth background try to avoid creases as these will result in an
even green background.

Three different chroma keying methods are available:
1. Hue/Saturation - this method is suitable for for both green screen and blue screen shooting and gives

the best results under good lighting conditions
2. RGB Green screen - this method is only suitable for shooting green screen. It can give better results

than the hue/saturation method if the lighting is poor
3. RGB Blue screen - this method is only suitable for shooting blue screen.

Which method works best may depend on your lighting setup and background. Under most lighting
conditions the "hue/saturation" method should give the better results, particularly if the background isn't
pure green.
The "RGB Green screen" and "RGB Blue screen" methods are the same methods as used in versions
of DSLR Remote Pro for Windows up to version v3.2.

Adjusting the settings when using the "Hue/Saturation" method
First select "Hue/saturation" from the "Method:" dropdown list at the top of the green screen settings
dialog:

Then set the "Hue:" slider to 120 (or 240 if shooting against a blue background), the "Hue variation:"
slider to 5 and the "Saturation threshold:" slider to 45
Next adjust the "Hue:" slider until most of the background is replaced. The selected color is displayed to
the right of the slider.
Then adjust the "Hue variation" and "Saturation threshold" sliders until all of the green background is
replaced. Ask someone to stand in front of the green background to check the settings (or take a test
photo when using photo booth mode). If parts of their clothing are being replaced by the background it
may mean that the hue variation setting is too high and should be reduced.
The "Saturation threshold" slider sets the minimum saturation level that will be treated as background.
Normally the background will be pure green or pure blue and will be highly saturated and the
"Saturation threshold" slider can be set to 45 or more. Using a higher value will reduce the chances of
dark areas (e.g. black clothing) from being replaced with the green screen background.
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Adjusting the settings when using the "RGB Green screen" method
This method is only suitable for shooting against a green background. First select "RGB Green screen"
from the "Method:" dropdown list at the top of the green screen settings dialog:

Start by setting the green threshold to 30, the red level to 230 and the blue level to 222. Then move the
"Green threshold" slider to the left until most of the background is replaced. Fine tune the settings by
moving the "Red level" and "Blue level" sliders to the right. The best settings to use will depend on the
lighting conditions and the quality of the green background. If areas of the subject show the background
the settings are too strong and should be reduced by moving the red and blue sliders to the left or the
green slider to the right.

Adjusting the settings when using the "RGB Blue screen" method
This method is only suitable for shooting against a blue background. First select "RGB Blue screen"
from the "Method:" dropdown list at the top of the green screen settings dialog:

Start by setting the blue threshold to 30, the red level to 230 and the green level to 222. Then move the
"Blue threshold" slider to the left until most of the background is replaced. Fine tune the settings by
moving the "Red level" and "Green level" sliders to the right. The best settings to use will depend on the
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lighting conditions and the quality of the blue background. If areas of the subject show the background
the settings are too strong and should be reduced by moving the red and green sliders to the left or the
blue slider to the right.

Green Screen Backgrounds and Overlays in Video Booth Mode

Green screening of the live view images only is also available in video booth mode. This needs to be
enabled in the video booth settings dialog before it can be used.

In full screen video booth mode the green screen background and overlay images are loaded from the
photo booth images folder. The background image should be named video_greenscreen_background.
jpg or greenscreen_background.jpg and the overlay image should be named
video_greenscreen_overlay.png or greenscreen_overlay.png. The software will look for 
video_greenscreen_background.jpg and  video_greenscreen_overlay.png first and use these if
available. If they are not available it will look forgreenscreen_background and greenscreen_overlay.png
images.
Backgrounds and overlays can also be switched by saving a number of different profiles each using a
different photo booth images folder containing different greenscreen_background.jpg and
greenscreen_overlay.png images. The user can then select the different backgrounds using the profile
shortcut keys. You can also switch green screen backgrounds and overlays by copying the new
greenscreen_background.jpg and greenscreen_overlay.png images into the photo booth images folder
while the booth is running.

Please note: In video booth mode green screening is only applied to the live view images displayed to
the user. It is not applied to the movie files downloaded from the camera or during video playback. You
will need additional third party software to green screen the movie files after they have been
downloaded to the PC (DSLR Remote Pro automatically downloads the movie files to the PC).

Printing the Images

There are two methods to print out the green screened shots:

Method 1: DSLR Remote Pro for Windows takes the photos, performs the green screen removal and
prints the images. DSLR Remote Pro for Windows can perform simple green screen removal and print
the images without the need for any other software. This is simple to setup and is fine for small photo
booth prints under good lighting conditions. When green screen is enabled DSLR Remote Pro for
Windows will automatically replace the green background with the background image when printing out
the photo booth images unless the photo booth output option is set to "None".
This method doesn't require any software other than DSLR Remote Pro for Windows

Method 2: DSLR Remote Pro for Windows takes the photos and saves them in a folder where another
specialist green screen application replaces the background and passes the images to Hotfolder Prints
for formatting and printing. This is more complicated to setup than method 1 but by using a specialist
green screen application it will give superior results which are more suitable for larger prints.
This method requires DSLR Remote Pro for Windows v2.0 or later plus a green screen application
such as Green Screen Wizard Pro Batch and Hotfolder Prints.

When using method 2, green screen printing in DSLR Remote Pro for Windows can be disabled by
setting the output option to "None" in the photo booth settings page. DSLR Remote Pro for Windows
will run the full screen photo booth complete with green screened live view images and save the photos
to the folder specified in preferences e.g. to save the images in the folder C:\Photobooth the
preferences should be set to:

http://www.breezesys.com/Hotfolder
http://www.breezesys.com/Hotfolder
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DSLR Remote Pro for Windows preference settings to save the images in C:\Photobooth

The green screen app should be setup to monitor the folder where the photos are saved, automatically
replace the green background with the selected image and save them in a separate folder. The settings
for Green Screen Wizard Pro Batch to monitor photos in C:\Photobooth and save the green screened
images in C:\Photobooth\GreenScreen would be:

Green Screen Wizard Pro Settings (click on Tools in the main window to display the settings)

Please see the Green Screen Wizard website for information about Green Screen Wizard Pro Batch

http://www.greenscreenwizard.com/GreenScreenWizardPro.aspx
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and to purchase a copy. Please make sure you purchase the Green Screen Wizard Pro Batch version
as this is the only version which can monitor a folder for new photos and automatically replace the
green background.
Important: To ensure that what the user sees in DSLR Remote Pro for Windows' live view display and
the final printed output is the same the green screen background image should have an aspect ratio of
3:2. If a different aspect ratio is used the alignment of the background image may be different in the
live view display and the green screened prints. If the images are to printed on 6"x4" paper at 300 dpi
the background image should be a JPEG which is 1800 pixels wide by 1200 pixels high.
The green screen application will have its own settings for optimizing the green screen removal and will
need to be setup separately. The settings used in DSLR Remote Pro for Windows' live view display will
only affect what the user sees, not the final prints when using a separate app to perform the green
screen removal.

Hotfolder Prints should then be setup to monitor the folder where the green screened images are saved
so that it can automatically format and print them as required. The Hotfolder Prints preferences screen
to monitor C:\Photobooth\GreenScreen for four new images and then automatically format and print
them would be:

10.21 AI Background Removal

The AI background removal option uses subscription based online services which use AI (artificial
intelligence) to automatically remove the background from a photo (aka "green screen without the
green screen"). Currently three such services are available for DSLR Remote Pro: remove.bg, AI
Background Remove and gadbooth.com.

The example photo shown below was taken during Photo Booth Expo 2020 and shows how effective AI
background removal is at removing a distracting background:

https://remove.bg
https://www.photobooth-deluxe.de/en/ai-background-remove/
https://www.photobooth-deluxe.de/en/ai-background-remove/
https://gadbooth.com
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Note: This example was actually captured using Breeze Booth for iPad but similar results can be obtained using DSLR
Remote Pro

Please note: AI background removal services are provided by other companies who charge for their
services. These companies have no connection with Breeze Systems and Breeze Systems is not
responsible for the content of their websites. In order to these services you need set up an account
with them and copy your credentials to the Remove Background utility.
remove.bg,  AI Background Remove and gadbooth.com are all web based service and so you will need
a reliable internet connection in order to use them at an event.

After applying AI background removal the photos added to the print layout will have a transparent
background and the background will be the background defined in the print layout (e.g. a background.
jpg image). You can allow users to choose different backgrounds in the print confirmation screen after
the photo has been taken. Please see Swapping print backgrounds for details. 

In Operation

AI background removal works by using the image editor option to to run the Remove Background utility
which connects to the background removal service to create a PNG copy of the photo with transparent
areas where the background has been removed. This PNG image is then used in the print layout and
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slideshow GIFs. The background images defined for the print layout or slideshow GIF will be visible in
the transparent areas of the PNG image.

The easiest way to set this up is to run DSLR Remote Pro and select "Run AI Background Removal
tool..." from the File menu:

Click on "Account settings..." to select the AI background removal service you wish to use and to enter
your credentials for the service. The click on the "Setup DSLR Remote Pro..." button automatically
setup DSLR Remote Pro with the necessary settings. You can also disable background removal by
clicking on the "Set DSLR Remote Pro..." button.

The automatic setup makes the following changes:
1. The File->Setup image editor... is setup to run RemoveBackground.exe automatically when a photo

is taken and is downloaded to the PC
2. Greenscreen removal is enabled with the transparent background option selected
3. The "Delay before creating print layout" in the "Output Settings" dialog is set to 60 seconds to allow

time for the background to be removed before creating the print layout or slideshow GIF

Click on the "Account settings..." button in the Remove Background utility to select the background
removal service you wish to use and to enter you credentials:

Select the AI background removal service you wish to use from the "Service" dropdown list. Then enter
you credentials in the text areas below. For the remove.bg and Gadbooth services the credentials will
be in the form of an API key which can be obtained by logging into the services using a web browser.
For the AI Background Removal service the credentials will be in the form of a purchase id and license
code which are sent to you when you subscribe to the service.
Click on the "OK" button and then click on "Check credits..." to check the settings and to check the
number of credits you have remaining. The account information will be displayed in the status lines
under the "Only remove background when photo booth is running" checkbox:



Photo Booth Shooting 199

© 2024 We Fly Kites Inc.

Use the resizing checkbox to specify the size of image to be converted. It is best to set this to the
lowest setting needed for your prints or slideshow GIFs to reduce the amount of data that needs to be
transferred to the servers.
The special "Up to 0.25 megapixels" setting can be used to reduce the cost per image when using
remove.bg. At the time of writing remove.bg provide 50 free preview images (up to 0.25 megapixels in
size) each month and then only charge 1/4 of a credit once the preview credits have been used. The
services from AI Background Remove and Gadbooth use one credit for all image sizes.

You can check the service is running by clicking on the "Test image..." button and selecting a suitable
JPEG image to test.
Please note that testing an image may use up one of the credits purchased in your subscription.

At the time of writing remove.bg provides 50 free preview credits per month and options for buying
"Pay as you go" or subscription based credits. You can use the 50 free preview credits for testing
without having to enter any payment details.

Please see this post from our blog for information on how to create slideshow GIFs with animated
backgrounds.

Only performing AI background removal for some profile and not for others
You can use profiles to provide guests with a menu of options and set this up in such a way that some
profiles will use AI background removal and some won't. This can be setup by naming the photo booth
image folder used by each profile to indicate whether AI background removal should be used e.g. by
including the string 'aibg' in the folder name.
The RemoveBackground.exe utility used to perform the AI background removal is called using the 
image editor option. The image editor command can use tokens to only run the command if the photo
booth images folder used by the profile contains a certain string (e.g. aibg).
Please see the section on Editing images and editor setup for more information.

10.22 Swapping print backgrounds

This section describes how to allow users to choose different backgrounds and overlays in the print
confirmation screen displayed after taking the photos. This is useful when using AI background removal
or when shooting green screen with the transparent background options because it allows users to
choose different virtual backgrounds. It is also useful for normal photos because it allows users to
choose different print styles by switching backgrounds and overlays.

Different backgrounds and overlays can be chosen in the print confirmation screen (confirm_printing.
jpg) using touchscreen actions. The "Confirm printing (next background)" and "Confirm printing (previous
background)" touchscreen actions can be used to cycle through the available backgrounds or users can
select a background directly using the "Confirm printing (background 1)" through "Confirm printing
(background 6)" touchscreen actions. When the user chooses a different background the print preview
displayed in the print confirmation screen is updated automatically to show the new background and
overlay.

https://remove.bg
http://blog.breezesys.com/greenscreen-gifs-animated-backgrounds-overlays/
http://blog.breezesys.com/greenscreen-gifs-animated-backgrounds-overlays/
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Example print confirmation screen showing background 1

Example print confirmation screen showing background 2

Setup

First enable "Confirm before printing" in the "Photobooth Settings" dialog then edit the confirm_printing.
jpg screen in an image editor to add the graphics for the buttons used to select different backgrounds
(e.g. next background, previous background, background 1 etc.). Then add the touchscreen actions for
selecting the backgrounds using the touchscreen editor.

Next add the background images and optional overlay images to the photobooth images folder. The
background images should be JPEG images named background1.jpg, background2.jpg, background3.
jpg etc. The optional overlay images should be PNG images with transparency information in the alpha
channel and named overlay1.png, overlay2.png, overlay3.png etc. For the best results please ensure
the background and overlay images are the same size in pixels as the print layouts e.g. a 4" x 6" print
at 300 dpi is 1200 x 1800 pixels in size and so the background JPEG should also be 1200 x 1800 pixels
in size. If the background and overlay images are not the same size you may find that the print preview
shown in the print confirmation screen doesn't match the final print out.
 

Limitations

PNG logo images with transparent areas added using the print layout editor may not be displayed
correctly if the transparent areas are over the print background not the photos.
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10.23 Live View Overlay

Photo Booth Mode
An optional overlay image can be displayed over the live view images in full screen photo booth mode
to add fun effects such as superimposing a body builder's body with the user's head. It can also be
used to create fancy borders for the live view images to give the booth a more custom feel. It can also
be used to provide alignment guides if the photo booth is being used to take passport or id photos.

The overlay image should be a PNG file with transparency information in the alpha channel and saved in
the photo booth images folder.

Stills Photo Booth Mode Live View Overlay
In stills photo booth mode the overlay should be named live_view_overlay.png and have an aspect ratio
of 3:2 e.g. 960x640 pixels in size. If the aspect ratio of the overlay image isn't the same as the live view
images it will be stretched to fit and may appear distorted.
The live view size for most recent Canon cameras is 960x640 pixels when in photo mode.

Video Booth Mode Live View Overlay
In video photo booth mode the overlay should be named video_live_view_overlay.png and have an
aspect ratio that matches the currently selected video resolution. This is normally 16:9.
The live view size for most recent Canon cameras is 1024x576 pixels when in video mode.
If boomerang GIFs using the camera's photo mode are selected the live view will have an aspect ratio
of 3:2.

Ideally the live view overlay should be the same size as the live view images (typically 960x640 pixels in
photo mode or 1024x576 pixels in video mode). If the aspect ratio of the overlay image isn't the same
as the live view images it will be stretched to fit and may appear distorted. 

Please note: The live view overlay image only affects the live view images displayed to the user and
won't appear in the printed output or the video. To overlay the images in the printed output create a
copy of the live_view_overlay.png file called image_overlay.png and save it in the photo booth images
folder.

Overlays can also be used in conjunction with green screen shooting to provide effects such as
foregrounds or overlays to mock up a magazine cover.

Ready Screen Overlay
An additional overlay can also be displayed over the ready screen. Please see the section on Screens
displayed to the user for more information.

10.24 How to create PNG images using Photoshop

Photoshop
First create a new image with a transparent background. Then create a mask by clicking on the "Add
layer mask" in the layers palette.

Next add the graphics such as text overlays and picture frames to the image layer and use the layer
mask to control the transparency. In the layer mask white represents opaque, black represents fully
transparent and values between white and black represent increasing transparency.

Save a copy of the image as a PSD file for future reference and then save the image as a PNG file
named overlay.png.
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An existing PNG image containing transparency information in the alpha channel can be edited in
Photoshop by loading it into Photoshop. The layer mask containing the transparency information can be
recreated by selecting Layer->Layer Mask->From Transparency.

Note: PNG images used for overlays should be saved as 24-bit color images with an 8-bit alpha
channel containing transparency information. If the overlay only contains black, white and shades of
gray Photoshop will save it as an 8-bit PNG file not a 24-bit file. You can prevent this by placing a
colored pixel somewhere in the overlay (it can be in a full transparent area if you don't want it to appear
in the prints).

Photoshop Elements
First create a new image with a transparent background. Next add the graphics such as text overlays
and picture frames and use the opacity slider for the layers to control opacity. To get a simple fade
effect, you can also use the gradient tool. Once you’re happy with your image, save a copy as a PSD
file for future reference and then save the image as a PNG file named overlay.png.

10.25 Video Booth Shooting

Capturing a Video File
A video booth is similar to a photo booth except instead of taking one or more stills pictures it captures
a short video clip. Video booth shooting is available with all recent Canon cameras

The cameras can only capture video to the camera's memory card and so the camera must have a
memory card with sufficient space in order to use the video booth mode (video files are automatically
downloaded to the PC and deleted from the memory card after capture).
WARNING: If the camera's memory card is full the software will attempt to capture the video but will
stall when it tries to download it to the PC. To avoid this problem please make sure there is plenty of
free space on the memory card.

Please note: The camera must be set to photo mode not video mode.
Cameras with movie mode on the exposure mode dial should be set to P, Tv, Av or M.
Cameras that have a power switch with OFF, ON and MOVIE settings should be set to ON
Cameras with a photo/movie switch should be set to the photo setting

Capturing a Series of Still Photos to Create an Animated GIF
Video booth mode can also be used to capture a series of still photos which can be combined to create
a short animated GIF that plays back in a continuous loop. Please see this section for details.

Overview

The video booth mode works in a similar way to photo booth mode. Users are presented with a ready
screen with a live view display showing what the camera sees. When the user presses the start button
a countdown screen is displayed together with countdown message. At the end of the countdown the
capture screen is displayed together with a progress bar that shows how much time is remaining. After
the video clip has been captured the processing screen is displayed and the movie file is automatically
downloaded from the camera's memory card to the PC and then deleted from the memory card to
make space for the next clip. After downloading the ready screen is displayed ready for the next video
capture.

Video Booth Settings

The dialog below is displayed when "Video booth settings..." is selected from the File menu:
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In order to use the video booth mode it must be enabled by selecting "Enable video in photo booth
mode". Normally when you enter full screen photo booth mode (by typing Ctrl+F4) the photo booth
ready screen will be displayed. If you wish to startup in video booth mode select the "Startup in video
booth mode when selecting full screen photo booth" checkbox.

Select the "Hide live view during countdown and capture" to only display live view in the ready screen
and avoid guests being distracted by the live view during video capture. 

Select the "Display playback screen after capturing video" to allow users to play back the video and
decide whether to accept it or reject it. The playback screen will be displayed until the user either
accepts or rejects the video. When the video is rejected it is automatically deleted from the computer.
When the "Start playback automatically" option is selected video playback will start automatically when
the playback screen is displayed.
The playback screen will be displayed until either the user accepts or rejects the video or the timeout
occurs. Use the "Playback screen timeout" setting to specify the length of the timeout and the "Timeout
action:" dropdown to specify what happens when the timeout occurs.

Click on "Video postprocessing..." to configure the postprocessing applied to the video after it has been
captured. Postprocessing options include resizing the video, adding an overlay, changing the playback
speed or applying a custom edit list with speed ramping and jumpt cuts etc. Please see the section on 
Video Postprocessing for details.

The "Delay before playback" option allows time for additional processing of videos to be performed
outside of DSLR Remote Pro before it processes the video. The delay can be cut short by sending
Ctrl+Z to the photo booth. This allows the delay before playback to minimized by setting a long delay
and arranging for Ctrl+Z to be sent when the processed video is ready.
Please note: You do not need to set the "Delay before playback" when using the postprocessing built
into DSLR Remote Pro. You only need to use this setting if additional processing is to be applied
outside of DSLR Remote Pro before it processes the video.
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An optional video_confirmed.jpg screen can be displayed after the sharing screen (or after accepting
playback when not sharing) by setting the "Confirmed screen display time". Set this to the number of
seconds to display the video_confirmed.jpg screen or set it to 0 to disable the screen.

Use the "Duration of captured video clip" setting to specify the duration of the video clip in seconds.
This can be any value up to 1200 seconds (20 minutes). Please note that users can end the recording
before it reaches the preset duration by pressing the End key or "Stop video capture" touchscreen
action.

Use the "Countdown before capturing video" setting to specify the length of the countdown before video
capture starts. The countdown text is displayed during the countdown and is updated every second.
The following tokens can be used:
@videoClipLength@ - the duration of the video clip in seconds
@videoCountdown@ - the number of seconds remaining before video capture starts

Use the "..." buttons after the font and font color displays to change the font and color of the countdown
text.

The size and position of the video playback window can be set manually or set automatically by the
program. If the height is set to 0 the program will automatically display the video playback at the same
resolution as capture, or if this is to big to fit on the screen it will scale the size down to fit the screen.
The video playback window is normally displayed at the top of the screen but can be moved down
using the top offset setting if required. The video playback window left offset allows the horizontal
position of the window to be specified. The default setting of -1 will center the video playback window
on the screen.

Use the "..." buttons after the record/playback progress bar foreground and background color displays
to change the colors of the progress bar displayed during recording and playback.
Note: the progress bar can be hidden by setting the foreground and background colors to the same
values.

The size and position of the live view display uses the same settings as the stills photo booth and can
be specified using the photo booth settings dialog. The various screens used by the video booth should
be saved in the photo booth images folder which can also be specified using the photo booth settings
dialog. Click on the "Photobooth Settings..." button to save the current video booth settings and display
the photo booth settings dialog.

Video Post Processing

Click on the "Video postprocessing..." button to specify the postprocessing applied to videos:



Photo Booth Shooting 205

© 2024 We Fly Kites Inc.

Select "Enable video postprocessing" to enable the video post processing options. When
postprocessing is applied to a video the original video captured by the camera is replaced with the
processed video. Select "Copy original video to 'originals' subfolder" if you want to keep a copy of the
original video.

The processed video can be cropped and resized  using the "Cropping" and "Video height" settings.
Cropping is applied first and then the video is resized. Set the "Cropping" dropdown list to "square" to
crop the video to square e.g. crop a 1280x720 pixel video to 720x720 pixels. The "Video height" setting
resizes the video maintaining its aspect ratio e.g. setting the height to 360 pixels will resize a 1280x720
pixel video to 640x360 pixels.
Set the "Cropping" dropdown list to "custom" and specify the crop width to apply custom cropping e.g.
set the crop width to 960 to crop a 1280x720 pixel video with an aspect ration of 16:9 to 4:3 aspect
ratio (960x720 pixels).
Note: The live view display will show the whole video not just the square cropped area. You can mask
the live view to make it square by adding a video_live_view_overlay.png image to the photo booth
images folder. Please see the Live View Overlay section for more information.

Select "Mirror video (flip horizontally)" to mirror the video. This is useful for videos where a piece of
glass is placed between the camera and the guest and they write or draw on the glass.

Select the boomerang option to create a video that plays normally and then in reverse.
Specify the number of loops the video is played e.g. if you set the number of loops to 2 and select the
boomerang option the processed video will be: forward video + backward video + forward video +
backward video.
Set the playback speed to a value other than 1 to change the playback speed e.g. if the video was
captured at 60fps setting the playback speed to 0.5 will produce a smooth, slowed down video played
at half speed.

Select "Custom edit list" to create a video made of custom edits including speed ramping, jump cuts,
forwards and backwards video. This option disables the boomerang, loops and playback speed options
but allows you to apply more creative edits such as jump cuts and speed ramping.
Click on the "Edit..." button to edit the custom edit list:
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Each entry in the video edit list has a start time, end time, start speed and end speed.
The start and end times specify the start and end times of the clip taken from the original video, If the
start time is less than the end time the video will be played forward. If the start time is after the end
time the video will be played backward (from the end time to the start time). In the screenshot above
the first edit plays the video forwards from the start to 3 seconds into the video and then plays the
video backwards from 3 seconds back to the start:
1. start time=0, end time= 3, start speed=1, end speed=2
2. start time=3, end time= 0, start speed=2, end speed=1 

The start and end speeds specify the speed of playback of the clip. If the start and end speeds are set
to the same value the clip will be played at a constant speed. If the start and speeds are set to
different values the playback speed will change smoothly from the start speed to the end speed. In the
screenshot above the first clip will start at normal speed and will gradually speed up to 2x normal
speed by the end of the clip. The second clip will start a 2x speed and gradually ramp down to normal
speed at the end of the clip.

Jump cuts can be added by adding clips with different start and end times e.g. to play the first two
seconds of the video twice: once at normal speed and then again at double speed you could add two
clips:
3. start time=0, end time= 2, start speed=1, end speed=1
4. start time=0, end time= 2, start speed=2, end speed=2 

Right click on a clip in the edit list to edit, delete or change its position in the list or to insert a clip
before or after it. You can also double click on a clip to edit it.

New clips can be added to the edit list by clicking on the "Add clip..." button:

A video edit list can be saved to file for future reference or copying to another event by clicking on the
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"Export..." button. Click on the "Import..." to load a video edit list.

Note: Selecting the custom edit, boomerang option, setting the number of loops to 1 or changing the
playback speed will disable audio capture because it would sound strange if played backwards or at a
different speed.

A static overlay can be added to the video by placing a PNG file named video_overlay.png in the photo
booth images folder. The transparency of the overlay can be controlled using an alpha channel in the
PNG file. The overlay does not need to be the same size as the processed video and will be placed in
the top left corner of the video. If it is smaller than the video it won't cover the whole video. If it is larger
than the video it will be cropped to fit.
A video overlay can be added to the video by creating an Apple ProRes4444 video with transparency
information in the alpha channel and saving it with the name video_overlay.mov in the photo booth
images folder.

An optional introductory video can be added to the start of the processed video by placing an MP4
video named video_intro.mp4 in the photo booth images folder.
An optional closing or credits video can be appended to the end of the processed video by placing an
MP4 video named video_outro.mp4 in the photo booth images folder.
Note: The intro and outro videos must be the same size as the processed video. If they are different
sizes they will be discarded
Audio from the intro and outro videos will only be included if the original video has audio and is played
back once at normal speed. Audio from the intro or outro videos will be discarded if the video is edited
or does not contain audio.

Place an MP3 audio file named video_soundtrack.mp3 in the photo booth images folder to add an
soundtrack to the video. This will replace the audio captured with the original video and in the intro or
outro videos. The MP3 soundtrack must be at least as long as the processed video otherwise the final
video will be cut short to the length of the MP3 file. If the MP3 file is longer than processed video it will
be cut short to match the duration of the processed video.
The MP3 soundtrack will be added from the start of the intro video, if present, and will continue through
the playback of the processed video and then during the outro video, if present.

The time it takes to process the video depends upon a number of factors:
1. The camera video settings and the length of the captured video. This will affect the size of the

original video file and the time it takes to download it via USB to the PC after capture. A Canon EOS
M50 camera capturing 720p at 60fps takes approximately half the clip duration to download e.g. a 6
sec capture will take approximately 3 secs to download.

2. The processor speed of the computer and the number of edits and whether an intro or outro video is
added. The speed of the computer's storage will also affect the processing speed. SSD storage is
normally faster than conventional hard disks.
A typical video edit may take between half the duration of the final video to edit.

A fast, recent computer with an i5 or i7 processor and an SSD is recommended for the fast processing
of videos. The main factor is the speed of the processor and the computer's storage. Increasing the
amount of RAM above 4 or 8GB will have little or no effect on the processing speed.

Any errors or warnings generated during the postprocessing are automatically logged to a file named
DSLRRemotePro.log in your Documents folder. Please check this log file for errors if the video
postprocessing is not producing the expected results.

Sometimes antivirus software can interfere with the postprocessing by blocking a command line utility
called ffmpeg.exe. You can check whether ffmpeg.exe is working by opening a Windows PowerShell or
Command Prompt window and typing the following command line:
"C:\Program Files (x86)\BreezeSys\DSLR Remote Pro\ffmpeg.exe" -version
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If it is working you should get output similar to this:

 

Please check your antivirus settings if ffmpeg.exe isn't working.

Slow Motion Video

Slow motion video can be captured using the Canon EOS R6, Canon EOS R5, Canon EOS M50,
Canon EOS M6 Mark II, Canon EOS M200, Canon PowerShot G5X Mark II or Canon PowerShot G7
Mark III by selecting high frame rate 120fps video. When this setting is used the video will be captured
at 120fps without sound and is saved at 30fps giving playback at 1/4 normal speed.

To select 120 fps slow motion video capture disconnect the USB cable connecting the camera to the
computer and set the exposure mode dial on the camera to the movie setting. Then go to the tools
section of the camera settings and check that "Video system" is set to "For NTSC". Then go to the
camera menu and select "Movie rec quality" and enable "High Frame Rate". Set the exposure mode
dial back to its original setting (P, Av, Tv or M) and reconnect the USB cable. Unfortunately Canon don't
provide a way for selecting slow motion video remotely from a computer and you need to select it
manually using the camera's menus. 

Currently the Canon EOS R6, Canon EOS R5, Canon EOS M50, Canon EOS M6 Mark II, Canon EOS
M200, Canon PowerShot G5X Mark II and Canon PowerShot G7 Mark III are the only Canon cameras
that can be used to capture 120fps video. 
Other camera models can capture video at up to 60fps which can be played back at a slower rate (e.g.
1/4 normal speed by setting the video playback rate to 25), but this won't give as good quality as the
Canon EOS M50 capturing at 120fps. Also, the videos are saved at 60fps and need to be post
processed to create a slow motion copy without sound.

Green Screen
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Select the "Enable green screening of live view images" option to shoot green screen videos. Then type
Ctrl+G in full screen photo booth mode to adjust the green screen settings (please see the section on 
green screen shooting for more information). In full screen video booth mode the green screen
background and overlay images are loaded from the  photo boothimages folder. The background image
should be named video_greenscreen_background.jpg or greenscreen_background.jpg and the overlay
image should be named video_greenscreen_overlay.png or greenscreen_overlay.png. The software will
look for  video_greenscreen_background.jpg and  video_greenscreen_overlay.png first and use these if
available. If they are not available it will look forgreenscreen_background and greenscreen_overlay.png
images.
Backgrounds and overlays can also be switched by saving a number of different profiles each using a
different photo booth images folder containing different greenscreen_background.jpg and
greenscreen_overlay.png images. The user can then select the different backgrounds using the profile
shortcut keys. You can also switch green screen backgrounds and overlays by copying the new
greenscreen_background.jpg and greenscreen_overlay.png images into the photo booth images folder
while the booth is running.

Please note: In video booth mode green screening is only applied to the live view images displayed to
the user. It is not applied to the movie files downloaded from the camera or during video playback. You
will need additional third party software to green screen the movie files after they have been
downloaded to the PC (DSLR Remote Pro automatically downloads the movie files to the PC).

Capturing a Series of Still Photos to Create an Animated GIF

Video booth mode can also be used to capture a series of still photos which can be combined to create
an animated GIF which plays in a continuous loop. The animation can play the clip continuously,
repeating from the start (e.g. frames 1, 2, 3, 4, 5 then frames 1, 2, 3, 4, 5 again) or it can play the clip
forwards then backwards (e.g. frames 1, 2, 3, 4, 5, 4, 3, 2, 1, 2, 3, 4, 5 etc.).
The still frames are captured from the live view display and will be green screened if "Enable green
screening of live view images" is selected. The size of saved photos will depend on the resolution of the
live view images for the camera being used. Recent Canon DSLRs have a live view resolution of
960x640 pixels.

To enable this select the "Capture clip as a series of still frames (without sound)" option. Then select
the number of frames to capture in the sequence. Setting the number of frames to between 5 and 10
works well for a 1 sec or 2 sec clip. A higher value will give a smoother animation but will result in a
larger file size. A smaller value may cause the clip to appear as a series of jumps from frame to frame
rather than as an animation.

The "Capture rate (frames/capture)" setting specifies how often the live view frames should be saved.
The live view frame rate is approximately 12 frames/sec, but this may depend on the camera model
and the speed of the computer. Setting the capture rate to 5 frames/capture will capture a frame
approximately every 0.4 secs. The duration of the clip depends on the live view frame rate, the capture
rate and the number of frames to capture e.g. with a live view frame rate of 12fps, capturing a total of
6 frames at a rate of one frame every 5 live view frames the clip would take 6 * 5 / 12 = 2.5 secs.

Select the "Display playback screen after capturing video" option to play back the clip after capture.
The playback rate is specified as the time each frame is displayed in 1/100 sec e.g. setting this to 8 will
play the clip back at approximately normal speed (approx 12fps), 16 will play it back in approximately
half speed slow motion (approx 6 fps) etc.
Examples:
Number of frames to capture=10, capture rate=5, playback rate=40. This will capture a clip lasting
approximately 4 secs and play it back at normal speed
Number of frames to capture=10, capture rate=1, playback rate=40. This will capture a clip lasting
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approximately 1 sec and play it back in slow motion lasting about 4 secs
Number of frames to capture=10, capture rate=5, playback rate=10. This will capture a clip lasting
approximately 4 sec and play it back at high speed lasting about 1 sec

Normally the clip is played back in the forward direction in a loop e.g. frame 1, 2, 3, 4, 5, 6, 7, 8, 9, 10,
1, 2, 3, 4, 5, 6, 7, 8, 9, 10, 1, 2, 3 etc.
Select the 'Forward/reverse "ping-pong" playback' option to play the clip forwards then backwards
before repeating e.g. frame 1, 2, 3, 4, 5, 6, 7, 8, 9, 10, 9, 8, 7, 6, 5, 4, 3, 2, 1, 2, 3, 4, 5, 6, 7, 8, 9,
10, 9, 8, 7 etc.

If the user accepts the clip in the playback screen the captured live view images are saved as JPEG
files together with an XML video booth summary file. The XML summary file contains the following
information:

<?xml version="1.0" encoding="UTF-8"?>
<breeze_systems_photobooth version="3.5">
<video_information>
  <date>2016/05/04</date>
  <time>13:50:24</time>
  <photos>
    <photo image="1">FYQ65498_0001_01.JPG</photo>
    <photo image="2">FYQ65498_0001_02.JPG</photo>
    <photo image="3">FYQ65498_0001_03.JPG</photo>
    <photo image="4">FYQ65498_0001_04.JPG</photo>
    <photo image="5">FYQ65498_0001_05.JPG</photo>
    <photo image="6">FYQ65498_0001_06.JPG</photo>
    <photo image="7">FYQ65498_0001_07.JPG</photo>
    <photo image="8">FYQ65498_0001_08.JPG</photo>
  </photos>
  <evf_interval_ms>80</evf_interval_ms>
  <num_frames>10</num_frames>
  <capture_freq>5</capture_freq>
  <image_delay>10</image_delay>
  <ping_pong_playback>1</ping_pong_playback>
  <title_delay>100</title_delay>
  <title_at_end>100</title_at_end>
  <ping_pong_playback>1</ping_pong_playback>
  <gif_frame_width>500</gif_frame_width>
  <gif_frame_height>500</gif_frame_height>
  <gif_x_offset>50</gif_x_offset>
  <gif_y_offset>25</gif_y_offset>
  <gif_file>GIF\FYQ65498_0001_01.GIF</gif_file>
  <gif_frames_subfolder>GIF_frames</gif_frames_subfolder>
  <user_data></user_data>
  <photobooth_images_folder>C:\Users\Chris\Documents\PhotoboothImages\animated_gif_example</
photobooth_images_folder>
</video_information>
</breeze_systems_photobooth>

Animated GIFs

Select the "Create animated GIF" option and and click on the "Animated GIF settings..." button set the
animated GIF settings. Please see the Animated GIF section for details.
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Select the "Use camera's photo mode" option to set the camera to photo mode when capturing the still
images for the animated GIF. This will capture the images with the lens aperture set wide open with an
image size of 960x640 pixels for most recent Canon cameras. If "Use camera's photo mode" is not
selected the camera will be set to video mode with the lens aperture will be set to the current camera
setting (e.g. if the exposure mode dial on the camera is set to Av and the aperture to f11 the aperture
used during capture will be f11). The captured image size will be 1024x576 pixels for most recent
Canon cameras in video mode.

Images Displayed to the User

The following screen images are displayed to the user at different stages of the video capture:

video_ready.jpg - displayed when the video booth is ready to capture the next clip
video_countdown.jpg - displayed together with the countdown text during the countdown before
capturing the clip
video_capture.jpg - displayed together with a progress bar while the video clip is being captured
video_processing.jpg - displayed after video capture while the movie file is being transferred to the PC
video_playback.jpg - displayed when playing back the video that has just been captured
video_playback_finished.jpg - optional screen image displayed after playback or after downloading the
video if auto playback is not enabled
GIF_processing.jpg - optional screen displayed when creating animated GIFs in video mode

The images displayed to the user should be the same size or bigger than the computer's display. If the
images are too small they will be expanded to fit with a black border and a small warning message will
be displayed in the bottom left corner showing the image size and the display size.

Audio prompts can be added by placing a WAV sound file in the photo booth images folder and giving it
the same name as prompt screen. For example to play a sound when the video booth is ready copy a
WAV file named video_ready.wav into the photo booth images folder and it will be played when the
video_ready.jpg image is displayed.

In Operation

Once everything is setup simply run DSLR Remote Pro for Windows and press Ctrl+F4 to enter full
screen mode and display the ready screen. If the "Startup in video booth mode when selecting full
screen photo booth" is not set the window will start in photo booth mode. You can switch between
photo booth mode and video booth mode by using a touchscreen actions or typing Ctrl+V to select
video booth mode and Ctrl+P to select photo mode. In video booth mode the video capture sequence
can be started using a touchscreen action or by pressing  F7. The user can use a touchscreen action or
press the "End" key to stop the recording part way through or wait until it reaches the specified
duration setting and stops automatically.

When the video playback screen is displayed the user play the video again, accept the video or reject it
using touchscreen actions or keyboard shortcuts. Please see keyboard shortcuts for a complete list of
keyboard shortcuts.
The user must either accept or reject the video before the booth will return to the ready screen. When
the user rejects the video to movie file is deleted and is not saved on the camera's memory card or the
PC's hard disk. There is a default timeout of 300 secs after which time the video will be automatically
accepted. This timeout can be set in the video booth settings dialog.

If "auto reconnect" is selected from the "Camera" menu the camera can be turned off when not in use
and then turned it back on again to automatically restart photo booth operation. When the camera is
turned off the camera_not_connected.jpg screen is displayed and when it is turned back on again the
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ready screen is displayed.

To exit full screen photo booth mode either press the Esc key or hold down the SHIFT key and press
the left mouse button.

10.26 QR Codes and Contactless Operation

QR codes can be displayed on prints and in the sharing screen to provide a quick way for guests to
visit your website or online gallery simply by scanning the QR code with their phone. QR codes can
also be used for sending commands to the photo booth together with information such as email
addresses. This makes it possible to run a contactless photo booth where users can select the session
type (e.g. photos or boomerang GIFs) and send emails without having to touch the photo booth.

Contactless Operation

QR codes can be generated on a user's phone and used to run the photo booth and send emails
without the user having to touch the photo booth. Please see this video for a summary of what's
possible: https://vimeo.com/414822646

DSLR Remote Pro can read QR codes from the camera's live view or by using a webcam and the
Webcam QR Code Scanner utility. The QR codes can be used to trigger any touchscreen action
defined for the event and to enter email addresses for sending the output directly to the user.

The QR codes can be created using the QR code generator on the website contactlessbooth.com.
Please see this page for information customizing the QR code generator.
Alternatively you can create a QR code generator on your own website using Wordpress plug-ins or
scripts such as this sample PHP script.

Quickstart Guide

1. Select a suitable camera
For best results use a Canon camera which has dual pixel autofocus and set this to continuous AF
and face detect.
Suitable cameras include: Canon EOS M50, Canon REBEL SL2/EOS 200D, Canon Rebel SL3/EOS
250D, Canon EOS 77D, Canon Rebel T7i/EOS 800D
If you don't have a suitable camera you can use a webcam and the Webcam QR Code Scanner
utility instead

2. Setup the event
Please make sure your event has touchscreen actions defined for "Select photobooth+start" and
"Select video booth+start".
Enable "Scan QR codes for commands" in the "Photobooth Settings" dialog to enable the scanning of
QR codes to run photo booth commands.
Enable the email sharing option and setup the email server settings.

3. Run the photo booth and start scanning QR codes
Visit contactlessbooth.com using the web browser on your phone (or scan the QR code below using
your phone's camera), enter your email address and choose the session type and then hold your
phone in front of the photo booth's camera so that it can scan the QR code. If everything is setup
correctly the photo booth will start the countdown, take the photos and then automatically email them
when it displays the sharing screen.

https://vimeo.com/414822646
https://contactlessbooth.com/qr
https://contactlessbooth.com/qr/script.php
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https://contactlessbooth.com

Resources
· For more information please see the section on Scanning QR Codes below
· To use a webcam to scan the QR codes see Webcam QR Code Scanner
· For notes on customizing the QR code generator, hosting your own QR code generator etc. please

visit https://contactlessbooth.com/qr

Displaying QR Codes

QR codes can be provide a quick and convenient way for users to view their photos in an online gallery
or website simply by scanning the QR code with their phone. Dynamically generated QR codes can be
displayed on prints and in the sharing screen. If you use a microsite system that displays photos using
UIDs (e.g. Photobooth Gallery Plugin for Wordpress) the QR code can be used to jump straight to the
user's photos.

QR codes can be displayed on prints by adding a QR code in the print layout editor. A QR code can
also be displayed in the sharing screen by selecting the "Display QR code" option in the "Output
Settings" screen where the email and other sharing settings are specified. The size and position of the
QR code displayed in the sharing screen can be adjusted using the touchscreen editor.
The QR code text can be edited by selecting "Edit QR code..." from the File menu. The QR code text
can be dynamically generated to include a photo's filename or UID by using tokens. Please see the 
Editing QR Codes section in the Print Layout Editor for details.

Scanning QR Codes

DSLR Remote Pro is able to scan QR codes in photo booth mode when the camera's live view is
enabled. QR codes can be used to scan in information such as names, unique ids or email addresses.
QR codes can also be used to scan in commands to control the photo booth e.g. select a profile and
start the countdown.

QR codes should be defined as URLs with the commands and strings defined as percent encoded
parameters. The URL parameters can be made up of strings only, commands only or a mixture of both.

Scanning strings
Up to 10 strings can be defined in the URL by naming the parameters s1, s2, s3 etc. The URL below
gives and example with s1 set to "John" and s2 set to "Doe":
https://example.com?s1=John&s2=Doe
These strings can be accessed using tokens e.g. {qr1} for s1, {qr2} for s2 etc. One way to use these
tokens is in captions added to print layouts e.g. to print the name scanned from QR code on the print
the caption text could be set to "Name: {qr1} {qr2}".
The parameters should be percent encoded e.g. to define a single parameter that includes two words
separated by a space the space is encoded as %20 e.g.
https://example.com?s1=John%20Doe

https://contactlessbooth.com
https://contactlessbooth.com/qr
https://www.photobooth-deluxe.de/en/wordpress-photobooth-galerie-dokumentation/
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If you are using the photo booth as a data capture device which prints a QR code you can use the 
{urlencode,str} token to percent encode the responses e.g. if the user enters their name in survey
screen 1 in a text field with id "name" this can be percent encoded and included in the QR code text as:
https://example.com?s1={urlencode,{survey1_text1}}

The QR tokens are cleared after each shooting session.

Scanning commands
Up to 5 commands can be defined in the URL by naming the parameters c1, c2, c3 etc. The values of
the commands should be the same as the names of the touchscreen commands displayed in the 
touchscreen editor. 
e.g. selectPhotobooth+start or selectProfile1.

The URL below gives and example with c1 set to "selectProfile1" and c2 set to
"selectPhotobooth+start". This will tell the photo booth to select profile 1 and then switch to stills mode
and start the countdown:
https://example.com?c1=selectProfile1&c2=selectPhotobooth%2bstart

Please note: a command scanned in from a QR code will only be executed by the app if there is a
corresponding touchscreen keyboard action defined e.g. the command c1=selectProfile1 will only be
executed if there is a touchscreen action for selectProfile1.

The app ignores upper and lower case, spaces and punctuation when comparing the command string
with the touchscreen actions e.g. the following strings will all match the touchscreen action "Select
photobooth+start":
c1=Select%20photobooth%2dstart
c1=select%20photobooth%2dstart
c1=selectphotobooth%2dstart
c1=selectphotoboothstart

The %20 and %2d above are to represent the space and plus characters. This is because parameters
added to URLs need to be urlencoded. For simplicity you can omit spaces and punctuation from the
commands e.g.  use selectphotoboothstart instead of 
Select%20photobooth%2dstart.

Scanning email addresses
Email addresses can be scanned in from the sharing screen to send an email to a single email address
with one or more optional CC email addresses. The parameters for email addresses are:
email - only sends an email if the QR code is scanned when the sharing screen is displayed
autoemail -  automatically send the email when the sharing screen is displayed if the QR code is
scanned when the ready screen is displayed e.g. read the email address, start the countdown and
automatically send the email when the sharing screen is displayed.
cc - a CC email address

Scanning phone numbers for texting
Phone numbers can be scanned in from the sharing screen to send a text message. The parameters
for texting phone numbers are:
text - only sends a text if the QR code is scanned when the sharing screen is displayed
autotext -  automatically send the text when the sharing screen is displayed if the QR code is scanned
when the ready screen is displayed e.g. read the phone number, start the countdown and automatically
send the text when the sharing screen is displayed.

Scanning the event name and event strings
The event name and event strings can be scanned in from any screen that supports QR code scanning:
en - the event name
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es1 - event string 1
es2 - event string 2
es3 - event string 3
es4 - event string 4
es5 - event string 5
Please see the section headed Event Info for more information on event strings.

Examples
Example 1: Send an email to techsupport@breezesys.com and CC it to sales@breezesys.com when
the QR code is scanned when the sharing screen is displayed:
https://breezesys.com/qr.php?email=techsupport%40breezesys.com&cc=sales%40breezesys.com

Example 2: Switch to photo mode, start the countdown and automatically send an email to
sales@breezesys.com when the sharing screen is displayed:
https://breezesys.com/qr.php?c1=Select+photobooth%2Bstart&autoemail=sales%40breezesys.com

Example 3: Set the token {qr1} to string to identify the guest (e.g. ABCDE123) then switch to photo
mode, start the countdown and automatically send an email to sales@breezesys.com when the sharing
screen is displayed:
https://breezesys.com/qr.php?s1=ABCDE123&c1=Select+photobooth%2Bstart&autoemail=sales%40br
eezesys.com

Visual Confirmation
When a QR code that doesn't contain commands is scanned in the ready screen visual confirmation can
be provided by displaying the optional ready_overlay_qr.png screen (or video_ready_qr.png screen
when scanning a QR code in the video ready screen).

Repeating a QR Code
Sometimes it is useful to repeat the most recently scanned QR code using a touchscreen action. This
can be done by defining a qrRepeat touchscreen action in the ready or video ready screens. For
privacy reasons the most recently scanned QR code is only available to be repeated for 5 minutes after
which time it is discarded.

Scanning QR codes using the camera vs a webcam
QR codes can be scanned using the camera's live view or using the "Webcam QR Code Scanner" utility
with a webcam.
The scanning of strings from QR codes using the camera's live view display is enabled using the "Scan
QR codes for strings" setting in the Photobooth Settings dialog and the scanning of commands is
enabled using the "Scan QR codes for commands" setting.
Please note that when using the camera's live view display to scan QR codes the QR codes can only
be scanned when live view is active e.g. in the ready screens and the sharing screen but not in the
standby screen. When using the camera's live view display to scan QR codes a camera with dual pixel
AF set to continuous AF and face detect or wide area AF will give the best results.

Webcam QR Code Scanner

The Webcam QR Code Scanner which allows a webcam to be used to scan QR codes for the photo
booth. It can display a live feed from the webcam on the screen to help people position their phone
when scanning a QR code. You can specify the size and position of the live feed and when it is
displayed using the app's settings.
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Select the webcam from the "Camera:" dropdown list and then set the resolution and rotation as
required. The resolution does not need to be set to the highest setting to scan QR codes successfully.
A lower resolution setting should work well and may provide a faster live view refresh rate.

Click on the "Settings..." button to adjust the settings:

Use the left, top, width and height settings to specify the size and position of the live view window on
the screen.

Select "Display debug info" to display debug info in the live view window. This includes the size and
position of the live view window and the text scanned in from QR codes.
When debug info is selected you can adjust the position of the live view window by dragging it with the
mouse.

Select the "Auto run" option to start displaying the live view window automatically when the photo booth
runs in full screen mode.

Select the "Auto hide" option then use the "Screens displaying live view" options to specify when the live
view window should be displayed.
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Set "Link to:" to DSLR Remote Pro to use the Webcam QR Code Scanner utility with a photo booth run
by DSLR Remote Pro.

Sending Commands from other Apps

The Webcam QR Code Scanner utility passes the scanned URL to DSLR Remote Pro by sending a
WM_COPYDATA message with the data type (dwData) set to 200. Other apps can also use this
technique to send commands to control the photo booth. Please note that the command string must be
in the form of a URL and can only execute commands that correspond to touchscreen actions defined
for the event.
Please see "Controlling the Photo Booth" for more information.

10.27 Secure Single Use QR Codes

Secure single use QR codes provide an extension of the QR codes used for contactless operation. The
QR code is signed using a password to make it secure and difficult to forge and can only be used once
on a given computer. This means that it can be used for theme parks and attractions or for photo
booths where users can be issued with a QR code "coupon" to use the photo booth. It can also be
used to run a paid photo booth where the user makes a payment using an online payment service such
as PayPal and is sent an email or a text linking to a single use QR code that can be scanned by the
photo booth.

Enabling Secure Single Use QR Codes

Enable the scanning of QR commands and strings in the "Photobooth Settings"  for each event.

To only allow the use of secure QR codes and ignore all other QR codes select File->Single use QR
codes and then check the "Only accept single use QR codes" checkbox:
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Generating Single Use QR Codes

Select File->Single use QR codes to display the "Secure Single Use QR Codes" dialog (shown above).
The current QR code is displayed at the top of the dialog. This is updated automatically as the various
settings are changed. The QR code can be saved as a PNG image by pressing the "Save as PNG..."
button. The "QR Code quality" dropdown list controls the quality of the QR code. The higher quality
settings give denser QR codes with the QR text encoded multiple times to increase the chances of the
QR code being scanned even if areas are damaged or obscured. Choose a higher quality setting if you
plan to place a logo over part of the QR code.

The "Base URL" setting can be set to any URL. If the QR code is scanned using a mobile phone it will
normally open a web browser and load that URL. Change this URL to point to your web site or to the
web site for the event to direct users to that site if they scan the QR code using their phones.

Set "Command 1" to the touchscreen command to be executed when the QR code is scanned by the
photo booth. Any touchscreen command can be used, but normally this would be a command to start
the photo booth countdown e.g. "photoStart". A list of available touchscreen commands can be found in
the "Touchscreen editor". The touchscreen command does not need to be defined in the ready screen
for it to work - in fact it is best not to define it otherwise users could start the photo booth by tapping
the screen instead of scanning the QR code. When checking the scanned command spaces and
punctuation marks are ignored as upper or lower case e.g. the touchscreen command "Select profile 1
+ start" can called by setting "Command 1" to "selectProfile1Start" or "Select profile 1 + start".

To automatically send an email after taking the photos enter the email address in the "Auto email" field.
This option is included in the dialog for testing purposes only. Normally you would use an online QR
code generator to create a QR code with a user's email address if you want to automatically email the
photos.
The "Auto text" field works in a similar way but is used to send a text message after taking the photos.

The password field provides a way of making the QR code more secure. A scanned QR code will be
rejected if the password does not match the password entered in the the "Secure Single Use QR
Codes" dialog.

The "Computer name" field provides a way of limiting a QR code to a particular computer. A scanned
QR code will be rejected if the computer name in the QR code does not match the name of the
computer running the photo booth. Leave this fieid empty to disable this option.

Single use QR codes generated using the "Secure Single Use QR Codes" dialog have an expiry time
and date. A scanned QR code will be rejected if it is scanned after the expiry time. Click on the "Date/
time..." button to set the expiry time.

Providing Feedback When Scanning QR Codes

If a QR code is scanned and accepted the app will execute the commands (e.g. starting the
countdown) without displaying any additional information. If there is an error a simple error message
screen will be displayed for a few seconds. This can be customized by providing an optional PNG
screen image.
The error message will be displayed in English unless a PNG screen image is provided.

The following error screens filenames can be used:

qr_missing_parameters.png - the QR code is missing the auth or j parameters
qr_not_authorized.png - the auth parameter does not match the SHA1 hash of the JSON string plus
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password or the optional id in the JSON string does not match the computer's name
qr_invalid.png - the JSON string cannot be decoded
qr_used.png - the QR code has already been used on this computer
qr_expired.png - the QR code has expired

QR Code Text Technical Details

The QR code is in the form of a URL which has two parameters: a JSON string containing the
commands and a SHA1 signature.

The JSON string can contain up to 10 strings (s1 to s10) and up to 10 commands which correspond to
touchscreen actions (c1 to c10). It can also contain an email command (autoemail or email) and an
expiry date and time. Please see QR codes used for contactless operation for information about the
strings, commands and email options.
The expiry date/time is in the form of the number of seconds since the Unix epoch (00:00:00 UTC on 1
January 1970) stored in the JSON "expiry" value.
For additional security an optional id field can be added to the JSON string to specify the computer
name. The app will only process the QR code if the id in the JSON string matches the name of the
computer.

The signature is the SHA1 hash of the JSON string plus the password.

Example:
To create a QR code that starts a photo session with the touchscreen command "photoStart"and
automatically emails the output to sales@breezesys.com and is valid until 12:57 on Tuesday, May 19th,
2020 the JSON string would be:
{"c1":"startPhotobooth","autoemail":"sales@breezesys.co","expiry":1663430400}

The default password for the app is: <auth_password>
The string to sign is the JSON string + the password:
{"c1":"startPhotobooth","autoemail":"sales@breezesys.co","expiry":1663430400}<auth_password>
The SHA1 hash of the string to sign is: a48db8d2b2900cb38bf155d5c1c14925b2a43d4f

The text for the QR code needs to be in the form of a URL with a base URL which can be anything you
like e.g. https://breezesys.com
The signature is then added as the 'auth' parameter e.g. https://breezesys.com?
auth=a48db8d2b2900cb38bf155d5c1c14925b2a43d4f
Then URL encode the JSON string and add it to the URL as the "j" parameter e.g.
https://breezesys.com?auth=a48db8d2b2900cb38bf155d5c1c14925b2a43d4f&j=%7B%22c1%22%3A
%22startPhotobooth%22%2C%22autoemail%22%3A%22sales%40breezesys%2Ecom%22%2C%
22expiry%22%3A1663430400%7D

Additional parameters can also be added to the base URL if required. One use for this would be to
provide a link to the photos on an online gallery e.g. https://yoursite.com/gallery.php?id=1234&auth=...

Example PHP Script

The PHP code below will generate the QR code text to start a photo booth session using the
touchscreen command "photoStart" and automatically email the photos to sales@breezesys.com. The
QR code will be valid for 5 minutes (300 seconds) from when it was generated:

// add touchscreen command to switch to stills mode and start the countdown
$json['c1'] = "photoStart";
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// add a command to automatically email the photos to sales@breezesys.com
$json['autoemail'] = "sales@breezesys.com";

// set the expiry time to 300 seconds from now
$expires = time() + 300;
$json['expiry'] = $expires;

// generate the JSON string and SHA1 signature
$jsonStr = json_encode($json);
$authStr = $jsonStr . "<auth_password>";
$auth = sha1($authStr);

// construct the URL for the QR code text
$url = "https://breezesys.com?auth=$auth&j=" . urlencode($jsonStr);

10.28 File Uploader

The File Uploader is a tool to automatically upload photos, animated GIFs and MP4 movies from the
photo booth to online galleries. It can upload files using HTTPS POST to a website or an online gallery.

Files are automatically added to the upload queue after each photo booth shooting sequence and are
uploaded in the background allowing the photo booth to take the next set of photos without having to
wait. If there is no internet connection at the event the files will be held in the queue until an internet
connection is available.

General Settings

Select Tools->Uploader to display the settings dialog:

Check the "Upload files" checkbox to enable the uploading of files. When enabled files will be added to
the upload queue after each set of photos. The files will be uploaded in the background allowing the
photo booth to continue without interruption.

Set the "Upload URL" to call a script on the website where the files will be uploaded. The uploader will
use an HTTP POST to upload the files. Then set the password used by the web site to protect it from
unauthorized uploads. A sample PHP script to receive the uploaded files is listed below.

Select "Upload XML summary" to upload the photo booth XML summary. The XML summary file
contains detailed information, such as survey data, about the session which can be used by some
gallery software to provide statistics and analytics.
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Select "Upload JPEG copy of printed output" to upload the JPEG copy of the printed output. Please
note that the JPEG copy of the printed output is a copy of what is sent to the printer and may include
printer margins and both strips if printing double strips in 6x4 media to a printer that cuts the paper into
two 6x2 strips. If you want crop the output to remove the printer margins or to only upload a single strip
when printing double strips use the "Upload processed copy of the printed output" described below.

Select "Upload processed copy of the printed output" to upload the the processed copy of the printed
output. This is useful if you want to crop or resize the printed output before uploading. Please see this
section for details on how to create a processed copy of the printed output and to crop and resize it.

Select "Upload email and sharing XML files" to upload the XML files that are saved when sending an
email or text. The XML sharing files contain detailed information such as the email address and
responses to any input entered in the email or text keyboards.

Select "Upload original photos" to also upload the original photos taken by the camera.

Select "Upload processed photos" to also upload the original photos taken by the camera after they
have been processed e.g. resized and a logo added.

The uploader stores the upload queue in a database on the computer. Set the "Duration to keep
records" to the number of days the upload information should be held in the database. Click on the
"View uploads..." button to see a summary of the files uploaded, the files in the queue waiting to be
uploaded and any errors:

Click on "Clear queues..." to delete the entries from the database. Please note any pending uploads in
the upload queue will be discarded.

Sample PHP Script

The PHP script below shows how files sent by DSLR Remote Pro's File Uploader using the HTTPS
POST method can be received on a web site. This script is for illustrative purposes only and comes
with no warranty or support. You are free to use this script or modify it as required, but if you do so
you are responsible for checking that it is secure and meets your requirements.

The script handles two types of request:
1. "get_status" which checks whether a file has already been loaded to the server (and doesn't include
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the actual file in the upload). The script responds with the JSON string:
("exists": true, "filename": "<filename>"} if the file exists or ("exists": false, "filename": "<filename>"} if
it does not exist.

2. "upload" which uploads the file to the server. The script returns status code 200 if the upload is
successful or an error code and message if there is an error.

<?php

function logError($msg)
{

file_put_contents('../upload_log.txt', $msg . PHP_EOL, FILE_APPEND | LOCK_EX);
}

function fatalError($code, $msg)
{

// clear the old headers
header_remove();

// set the actual code
http_response_code($code);

// set the header to make sure cache is forced
header("Cache-Control: no-transform,public,max-age=300,s-maxage=900");

header('Content-Type: text/plain; charset=utf-8');
echo $msg;
logError($msg);
exit();

}

// replace this with a more secure password
$password = "photos";

// folder in which to store uploaded images
$destdir = "../gallery_uploads";

$id = $_POST["id"];
$request = $_POST["request"];
$filename = $_POST["filename"];
$chksum = $_POST["md5"];
$key = $_POST["key"];

// check client authentication string is correct
$localKey = "breeze" . $id . $password . $filename . $chksum;
if (sha1($localKey) != $key) {

fatalError(401, "Not authorized $key, " . sha1($localKey) . " id=$id, filename=$filename");
}

if ($request == "get_status")
{

// check whether file already exists on the server
$destFile = "$destdir/$filename";
$arr = array('exists' => file_exists($destFile), 'filename' => $filename);
fatalError(400, json_encode($arr));

}
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else if ($request != "upload")
{

// check whether it is an upload request
fatalError(400, "Invalid request: $request");

}

try {
// Undefined | Multiple Files | $_FILES Corruption Attack
// If this request falls under any of them, treat it invalid.
if (!isset($_FILES['fileToUpload']['error']) || is_array($_FILES['fileToUpload']['error'])) {

fatalError(400, "Invalid parameters");
}

// Check $_FILES['fileToUpload']['error'] value.
switch ($_FILES['fileToUpload']['error']) {
case UPLOAD_ERR_OK:

break;
case UPLOAD_ERR_NO_FILE:

fatalError(400, 'No file sent');
case UPLOAD_ERR_INI_SIZE:
case UPLOAD_ERR_FORM_SIZE:

fatalError(400, 'Exceeded form file size limit');
default:

fatalError(400, 'Unknown error');
}

// Check MIME type
$finfo = new finfo(FILEINFO_MIME_TYPE);
$mimeType = $finfo->file($_FILES['fileToUpload']['tmp_name']);
if (false === array_search(

$mimeType,
array(

'image/jpeg',
'image/gif',
'video/mp4',
'video/quicktime',
'text/xml',

)
)) {

fatalError(400, "Unexpected MIME type: " . $mimeType);
}

$srcFile = $_FILES["fileToUpload"]["tmp_name"];

// check file is JPEG, GIF, MP4 or XML
$fileType = strtolower(pathinfo($filename,PATHINFO_EXTENSION));
if ($fileType != "jpg" && $fileType != "gif"  && $fileType != "mp4" && $fileType != "xml" ) {

fatalError(400, "File type not allowed");
}

// check MD5 checksum matches uploaded file
if (strcasecmp(md5_file($_FILES["fileToUpload"]["tmp_name"]), $chksum) != 0) {

fatalError(400, "MD5 checksum incorrect");
}
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// read filename and dir from $filename and create dir if it doesn't already exist
[ 'basename' => $basename, 'dirname' => $dirname ] = pathinfo($filename);
$destFile = "$destdir/$basename";
if (strlen($dirname) > 0)
{

$dir = "$destdir/$dirname";
if (!file_exists($dir)) {

mkdir($dir, 0777, true);
}
if (file_exists($dir)) {

$destFile = "$dir/$basename";
}

}

// move the uploaded file to the upload folder
if (move_uploaded_file($srcFile, $destFile)) {

header('Content-Type: text/plain; charset=utf-8');
echo "File: $destFile";

} else {
logError("move_uploaded_file($srcFile, $destFile) failed");
fatalError(400, "Error copying file to upload folder: $destFile");

}
} catch (RuntimeException $e) {

fatalError(400, $e->getMessage());
}

?>

10.29 Sharing Photos

Emailing photos

Users can email photos directly from the photo booth if it has an internet connection and either a
touchscreen or a keyboard to enter their email address. If an internet connection is not available at an
event the email addresses can be saved and the emails sent later by selecting the offline email mode.
The simplest way to set this up is to use the photo booth setup wizard and then adjust the settings if
required. After running the photo booth setup wizard the email settings can editing using the dialog
below. This dialog can be opened by opening the "Photobooth Settings" dialog (File->Photobooth
Settings... or Ctrl+S) then opening the "Output Settings" dialog clicking on the "Settings..." button to the
right of the output options and then clicking on the email photo "Settings..." button.



Photo Booth Shooting 225

© 2024 We Fly Kites Inc.

The "Subject:" text box defines the text in the subject line of the email.

The body text of the message can be specified in plain text or in HTML format to provide more control
over its appearance. When using the HTML format the token {image} represents a link to the
attachment of the photo to be emailed and can be used with HTML <img> tag e.g. <img
src="{image}"> to display the photo in the email message. This can be combined with other tokens e.g.
the following line could be used to embed a photo in the HTML message or display a message saying
the video is attached to the email:
<p>{if,{isMovie},Your video is attached,<img src="{image}">}</p>
This evaluates to <p>Your video is attached</p> if the file is a movie file and to <p><img
src="{image}"></p> if it is a JPEG or an animated GIF.
Please note: for backwards compatibility with older versions of DSLR Remote Pro the token [image]
can be used instead of {image}. Please use one of the tokens listed in the Email Attachments section
for new events.

JPEG images and animated GIFs will be embedded in the HTML message if it contains the a token
referencing the image (e.g. {print_layout}) otherwise they will be attached to the email. Videos are
always sent as attachments because most email clients don't support HTML 5 and cannot display
embedded movie files.

Tokens for the date and time can be included in the email subject and message text fields and will be
replaced with the date or time the photos were taken when they are uploaded e.g.
%L will be replaced with the long date representation for your computer's locale e.g. Wednesday,
January 08, 2014
%l will be replaced with the long date and time representation for your computer's locale e.g.
Wednesday, January 08, 2014 20:23:56
{sharingMessage} is replaced with contents of the second text entry field (if defined) in the touchscreen
keyboard used for entering the user's email address. This allows the user to enter an optional message
when emailing photos.
Please see the tokens section for a list of available tokens.

Select the "Attach image to email" option to send the photo, GIF or MP4 with the email as an
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attachment (this is the default option). If this option is disabled the image won't be attached to the email
and you need to provide a link to a website where users can view their photos. For example you might
use an FTP client to automatically upload the photos to your website and then provide a link to the
photo in the email by replacing the line:
<p><img src="{image}"></p>
with something like this:
<p><img src="http://mywebsite.com/viewer.php?id={filename}"></p>

When sending photos the photo that is emailed is based on the JPEG copy of the printed output. You
can crop, resize and rotate the image before it is emailed to the user.
To crop the image first check the "Crop image:" checkbox and then specify the left offset and top offset
in pixels for the top left corner of the cropped image. Then specify the width and height of the image in
pixels. For example if the photo booth is setup to print a double strip of 4 images on 6"x4" paper you
may wish to crop the image so that only a single strip is emailed to the user. If the printer is set to a
resolution of 300 dpi the image will be 1200 pixels wide (4" x 300 dpi) by 1800 pixles high (6" x 300
DPI) and so to crop it into a single strip you need to set left=0, top=0, width=600 and height=1800.
You can also specify a maximum size for the image being uploaded using the "Max width (pixels):" and
"Max height (pixels):" settings. The JPEG copy of the printed output will be resized so that it is no
bigger than these settings before it is emailed. Keeping these values relatively small, e.g. 500 x 500
pixels, will reduce the time it takes to send the email.
Depending on you printer page settings the JPEG copy of the printed output may not be saved in the
correct orientation. If this is the case it can be rotated using the "Image rotation:" dropdown list. If you
are also using print preview (the "Confirm before printing" option in the "Photobooth Settings" dialog)
this can be set to "Same as print preview" and it will use the same rotation settings as the print
preview.
Please note that the image is cropped first, then resized and finally rotated before being emailed to the
user.

Select the "Use MP4 copy of animated GIF if available" option to enable the uploading of the MP4 copy
of animated GIFs. Please see the animated GIF section for details of how to create animated GIFs.
GIFs and MP4 files will be sent without being resized or cropped.

Select "Payment mode" to enable the payment screens when emailing from the sharing screen. When
payment mode is enabled and the user selects email from the sharing screen and enters a valid email
address a payment screen named email_payment.jpg is displayed. This is displayed until a timeout
occurs or a "payment accepted" or "payment cancelled" touchscreen command is received. If the
payment is accepted the photos are emailed and the email_success.jpg screen is displayed. If the
timeout occurs or the payment is cancelled the email_payment_cancelled.jpg screen is displayed for a
few seconds before returning to the share screen. Please see the Payment Options section for more
information.

Email Attachments

Click on the "Attachment settings..." button to display the "Email Attachment Settings" dialog to specify
additional email attachments:
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Select "Attach print layout with slideshow GIFs" to add an attachment for the JPEG copy of the print
layout when emailing slideshow GIFs (or their MP4 copies). The size and cropping information in the
email settings dialog is saved with the attachment information.
Select "Attach original photos" to add attachment information for the individual photos taken in stills
photo booth mode. Select "Attach processed photos (if available)" to also include copies of the photos
after they have been processed. Use the "Max size of photos (pixels)" settings to specify the maximum
width and height of the photos.
Select "Attach thumbnails of photos" to add attachment information for thumbnails of the individual
photos taken in stills photo booth mode. Use the "Max size of thumbnails (pixels)" settings to specify
the maximum width and height of the thumbnails.
Select the types of attachments to be included when emailing MP4 videos. The options are: "MP4 only"
which attaches the MP4 file to the email,  "JPEG preview only" which extracts a preview image from
the MP4 movie and attaches it to the email, "MP4 and JPEG preview" which attaches both the MP4 file
and the JPEG preview to the email. Use the "Max size of MP4 preview (pixels)" settings to specify the
maximum width and height of the JPEG preview extracted from the MP4 file.

Attachments for JPEG images (including preview created from MP4 videos) and GIF images can be
embedded in HTML emails using the following tokens:
{print_layout} - the JPEG copy of the print layout
{photo<n>} - original individual photos e.g. {photo1}, {photo2} etc.
{thumbnail<n>} - individual thumbnails e.g. {thumbnail1}, {thumbnail2} etc.
{gif} - slideshow GIF or boomerang GIF
{video_preview} - JPEG preview of the video

When "Attach processed photos (if available)" is selected the token used for embedding the photos in
the HTML email text will depend on whether "Attach original photos" is also selected. If "Attach original
photos" is selected the token for the processed photos is {processed<n>} otherwise it is {photo<n>}.

To embed the print layout in the email message body you need to add something like this to the HTML
message text:
<img src="{print_layout}">

To embed the first photo in the email message body you need select "Attach original photos" and to
add something like this to the HTML message text:
<img src="{photo1}">

To embed the first processed photo in the email message body you need select "Attach processed
photos (if available)" and to add something like this to the HTML message text:
<img src="{photo1}">
or <img src="{processed1}"> if "Attach original photos2 is also selected.

To embed a thumbnail of the first photo in the email message body you need select "Attach thumbnails
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of photos" and to add something like this to the HTML message text:
<img src="{thumbnail1}">

You can also the the {image} token followed by the attachment number e.g. {image} or {image1} for the
first attachment, {image2} for the second attachment e.g.
<p>Attachment 1: <img src="{image1}"></p>
<p>Attachment 2: <img src="{image2}"></p>

If there is no corresponding token for the attachment in the HTML email text or if the attachment is a
MP4 movie file it will be attached to the email and won't be embedded in the email text.

Email Server Settings

The email server settings also need to be setup so that the program can email the photos. The "Email
Server Settings" dialog can be opened by selecting "Email Server Settings..." from the File menu or by
clicking on the "Email server settings..." button in the "Output Settings" dialog. The "Email Server
Settings" dialog shown below will be displayed:

To send an email you need to specify the host name and port number of your email server. Most email
servers also require a username and a password to prevent unauthorized users from sending spam
emails. For additional security select the "Use SSL for secure email" option to send the email using
SSL. The port number should normally be set to 465 or 587 when using SSL secure email or 25
otherwise (please check the port numbers used by your ISP). 
Set the "Email addr:" to the sender's email address. To include the name of the sender with the email
address enter it as the name followed by the email address enclosed in angle brackets e.g. "Acme
Photo Booth <photobooth@acme.com>". Most free email services require the sender's email address
to the be the same as that of the email account specified by the username and password.

The settings can be verified by sending a test email by entering the destination email address and then
clicking on the "Send test email to:" button. The email status and any error messages will be displayed
in the status area at the bottom of the dialog.

Select the "Log email addresses to file:" checkbox to log the email addresses to a CSV file. Then either
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type in the filename of the log file in the editbox or click on the "..." to open a file browser. The log file
contains a line for each email containing the following comma separated values: the date in the format
YYYYMMDD, the time in the format HHMMSS, the email address, the status (1=success, 0=failure)
and the filename of the image file e.g.
20140114,174842,test@gmail.com,1,C:\Users\Chris\Documents\PhotoboothImages\2014-01-14
\prints\140114_174826.jpg

Using GMail to send emails
In spring 2020 Google withdrew support for standard SMTP emails and replaced it with a more secure
service linked to your Google account. DSLR Remote Pro v3.15 has received app approval from
Google which allows it to send emails using this new secure method. To use GMail to send emails you
need to authorize it with your Google account. To do this first set the "Host" to GMail and then click on
the "GMail authenticate..." button. This will open a web browser window guiding you through the
acceptance process. If the PC has already been authenticated pressing the "GmaiL authenticate..."
button will refresh the GMail access token and display its status.
If you decide to stop allowing DSLR Remote Pro to send emails using GMail you can revoke its access
by logging in to your Google account and going to the Security settings and "Third-party apps with
account access". You should see an entry for Breeze Booth which you can click on to review its
access. If you decide to remove access this will prevent all copies of DSLR Remote Pro from sending
emails using GMail and you will need to re-authenticate them if you to use GMail on them again.
DSLR Remote Pro only has permission to send emails on your behalf using GMail. It is not able to
read, modify or delete your emails and does not have access to any other Google services you may
use.

Switching to a different GMail account: The GMail email account used to send the emails can be
changed by signing into the Google account settings for the current account using a web browser and
removing access for Breeze Booth in the security settings. Then re-authenticate in DSLR Remote Pro
and select the new account.

Please note: Google limit the number of emails that can be sent from a GMail account to 500 emails in
a 24 hour period which may not be enough if you are running several photo booths. If this is a problem
please consider using a dedicated email service such as sendgrid.com.
 

In Operation

Breeze Hub is free and is included included with the Breeze Booth for iPad Event Editor which can be
downloaded from https://www.breezesys.com/support

When the photo booth is run and the photos have been taken the print preview screen will be displayed
first (if "Confirm before printing" is selected) and then when the user selects "Print" the sharing screen
(share.jpg) will be displayed. If the user selects "Cancel" in the print preview screen the sharing screen
won't be displayed and the booth will return to the ready screen (ready.jpg). If the "Confirm before
printing" option is not selected the sharing screen will be displayed after taking the photos.

When the sharing screen (share.jpg) the user has the option to email  the photo by touching the email
button on the touchscreen or by typing E if they are using a normal keyboard. The sharing screen can
be exited by touching the "Cancel" button on the touchscreen or by typing X or Esc on a normal
keyboard. The sharing screen will also exit automatically if the user does nothing and the screen
timeout occurs. The sharing screen timeout can be specified in the "Output Settings" dialog.

When the user selects email photo the touchscreen keyboard will be displayed allowing them to enter
the email address. The user can enter the email address by tapping on the touchscreen keyboard or by
typing it in using a normal keyboard. The user can then either tap on the "Cancel" button (or type Esc)
to cancel the email or tap on the "Send email" button (or press the keyboard Enter key) to start the
upload. The touchscreen keyboard will cancel automatically if the user doesn't tap the touchscreen or

https://www.breezesys.com/support
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type anything and the keyboard timeout occurs. The keyboard timeout can be specified in the
"Touchscreen Settings" dialog which can be displayed from the "Photobooth Settings" dialog.

The "To" email address is read from the first email text field defined in the touchscreen keyboard. If
additional email text fields are found they are added as CC addresses. Please see touchscreen
keyboard page for more information and an example of how to add a CC text field to the email
keyboard.

When the user has entered their email address and selected "Send email" the email upload screen
(email_photo.jpg) will be displayed and the photo will be placed in the email queue and  the email
success screen (email_success.jpg) will be displayed for a few seconds and then the screen will return
to the sharing screen.

The sharing screen can also be displayed from the ready screen using the keyboard shortcut
Shift+Ctrl+S or the "Display sharing screen" touchscreen action.

From DSLR Remote Pro v3.16 onwards emails are sent in the background and users do not need to
wait in the sharing screen for each email to be sent. When the users enters their email address an XML
copy of the email is saved and is added to the email queue to be sent in the background. The XML
copy of the email is saved in the same folder as the photos being emailed and is given a filename prefix
of email_YYYMMDD_hhmmss_. When an email is sent the status is saved to the XML email file.

Email "Offline Mode" and sending emails after an event

If no internet connection is available at an event you can disable the sending of emails and send them
later when an internet connection is available. To do this you select the email "Offline email mode"
option in the "Output Settings" dialog.
The emails can be sent when an internet connection is available by selecting "Send emails and MMS/
SMS messages..." from the "File" menu in the main window:

The first two lines in the "Sharing Status" dialog show the status of the email and text message queues.
This will display all emails and texts queued since the app was run. If you exit DSLR Remote Pro and
restart it the queues will be empty.

Enter the base folder where the photos are stored (e.g. {documents}\PhotoboothImages) and press
the "Scan" button to add unsent email and text messages to the sharing queue. This will scan the base
folder and all its subfolders looking for email and text XML files that have not been sent. If it finds
messages that have not been sent it will ask whether you would like to add them to the sharing queue.
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You can limit the age of the messages included in the scan by setting the "Max age (days)" setting.
This is useful if you have old events in your photo booth images folder and don't want old messages to
be sent.

Select the "Scan at startup" option to automatically scan for unsent messages each time DSLR Remote
Pro is run. 

The offline mode setting is not saved in the XML settings files when using profiles, but the setting can
be changed when loading profiles by adding one of the following lines to the XML settings file:
Enable offline mode:
<photoboothEmailOfflineModeSetting>1</photoboothEmailOfflineModeSetting>

Disable offline mode:
<photoboothEmailOfflineModeSetting>0</photoboothEmailOfflineModeSetting>

Sending an MMS (or SMS)

MMS messages can be sent in the US and Canada using a web-based service called Twilio (www.
twilio.com). In other countries the message can be sent as an SMS message with a link to the photo.
Most cellphones should recognize the link as a link to a web server and open a web browser on the
user's cellphone to view the photo. Please note that the image link in an SMS will only be valid for 7
days.

To use this service you need an account with Twilio and enter your Twilio account details in the MMS
setting dialog. Twilio charge for each MMS or SMS message sent using their service. Please see their
website for pricing information.
The maximum image file size that can be sent is 1 MB, but Twilio may resize the image file to conform
to the cellphone service provider's size requirements.

When the user taps the MMS icon in the sharing screen a touchscreen keyboard will displayed to allow
the user to enter their cellphone number. Please see the touchscreen keyboard section for information
on how to customize its layout and appearance.

The MMS settings need to be setup so that the program can send the texts via Twilio. The "MMS
Settings" dialog can be opened by clicking on the "SMS/MMS settings..." button in the "Output Settings"
dialog. The "MMS Settings" dialog shown below will be displayed:

http://www.twilio.com)
http://www.twilio.com)
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Enter your Twilio message phone number, AccountSID and AuthToken in the "MMS Settings" dialog.
You can find your Twilio message phone number, AccountSID and AuthToken by logging into your
Twilio account.

Set the country prefix to your country prefix e.g. +1 for the US and Canada, +44 for the UK, +49 for
Germany etc. When users enter their cellphone numbers they can either enter the number with their
country prefix e.g. +1234567890 or without it e.g. 23456789 and the country prefix will be added
automatically before sending the text.

Select the message type from the "Message type:" dropdown list. The available options are:
1. MMS - send the message as an MMS with the image attached to the message. Currently Twilio only

supports MMS messaging in the US and Canada. If this option is used in a country which doesn't
support MMS messaging through Twilio the message will be sent as an SMS + image. 

2. SMS - send the message as an SMS. You will need to include a link to a website in the message
text so that the user can view their photos e.g. http://mywebsite.com/photos/{fullFilename}

3. SMS + image - send the message as an SMS with a link to the photo. The photo will only be
available for viewing for 7 days. Use the {url} token to include the URL to the image in the text
message. If the {url} token is not included in the message the URL will be appended to the end of the
message.

Photos sent using the "MMS" and "SMS + image" options must be no more than 1MB in size after
resizing and cropping. An error message will be displayed if the 1MB file size limited is exceeded.
Twilio may resize the photo to conform with the cellphone service operator's MMS size limits.
Photos sent using the "SMS + image" option will be hosted on the Breeze Systems' website for 7 days.

You can specify a maximum message length to ensure the 160 character SMS message length is not
exceeded. In some countries SMS messages of more than 160 characters may be sent as multiple
SMS messages and will cost more. In other countries the SMS message will be truncated to 160
characters.

You can crop, resize and rotate the photos before they are sent to the user. 
To crop the image first check the "Crop image:" checkbox and then specify the left offset and top offset
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in pixels for the top left corner of the cropped image. Then specify the width and height of the image in
pixels. For example if the photos are from a photo booth which is setup to print a double strip of 4
images on 6"x4" paper you may wish to crop the image so that only a single strip is emailed to the
user. If the printer is set to a resolution of 300 dpi the image will be 1200 pixels wide (4" x 300 dpi) by
1800 pixels high (6" x 300 DPI) and so to crop it into a single strip you need to set left=0, top=0,
width=600 and height=1800.
You can also specify a maximum size for the image being uploaded using the "Max width (pixels):" and
"Max height (pixels):" settings. The JPEG copy of the printed output will be resized so that it is no
bigger than these settings before it is emailed. Keeping these values relatively small, e.g. 500 x 500
pixels, will reduce the time it takes to send the email.
If required, the photo can be rotated using the "Image rotation:" dropdown list.
Please note that the image is cropped first, then resized and finally rotated before being sent to the
user.

Select the "Use MP4 copy of animated GIF if available" option to enable the uploading of the MP4 copy
of animated GIFs. Please see the animated GIF section for details of how to create animated GIFs.
GIFs and MP4 files will be sent without being resized or cropped.

You can specify a timeout for uploading the photo to prevent a slow or broken internet connection from
jamming the photo booth.
From DSLR Remote Pro v3.16 onwards texts are sent in the background and users do not need to wait
in the sharing screen for each text to be sent. When the users enters their phone number an XML copy
of the text is saved and is added to the text sharing queue to be sent in the background. The XML copy
of the text is saved in the same folder as the photos being texted and is given a filename prefix of
text_YYYMMDD_hhmmss_. When a text is sent the status is saved to the text XML file.

Select "Payment mode" to enable the payment screens when texting from the sharing screen. When
payment mode is enabled and the user selects text from the sharing screen and enters a valid phone
number a payment screen named mms_payment.jpg is displayed. This is displayed until a timeout
occurs or a "payment accepted" or "payment cancelled" touchscreen command is received. If the
payment is accepted the photos are texted and the mms_success.jpg screen is displayed. If the
timeout occurs or the payment is cancelled the mms_payment_cancelled.jpg screen is displayed for a
few seconds before returning to the share screen. Please see the Payment Options section for more
information.

By default the screens displayed when sending an MMS or SMS will have a simple status message
shown on a black background. This can be overridden by placing the following JPEG screen images in
the screen images folder:
mms.jpg - screen displayed when sending an MMS
mms_success.jpg - screen displayed after an MMS has been sent successfully
mms_as_sms.jpg - screen displayed in if MMS isn't supported and SMS is being used instead
mms_error.jpg - screen displayed if there is an error when sending an MMS

MMS/SMS "Offline Mode" and sending texts after an event

If no internet connection is available at an event you can disable the sending of texts and send them
later when an internet connection is available. To do this you select the email "MMS/SMS Offline mode"
option in the "Output Settings" dialog.
The texts can be sent when an internet connection is available by selecting "Send emails and MMS/
SMS messages..." from the "File" menu in the main window:

Please see the section on sending offline emails for details.
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Posting photos to the user's Twitter account (tweeting)

Users can post photos to their personal Twitter account directly from the photo booth if it has an
internet connection and either a touchscreen or a keyboard to enter their Twitter login information. The
simplest way to set this up is to use the photo booth setup wizard and then adjust the settings if
required. After running the photo booth setup wizard the Twitter settings can editing using the dialog
below. This dialog can be opened by opening the "Photobooth Settings" dialog (File->Photobooth
Settings... or Ctrl+S) then opening the "Output Settings" dialog clicking on the "Settings..." button to the
right of the output options and then clicking on the Twitter "Settings..." button.

The comment setting specifies text that will be used in the tweet. Twitter limits messages to 140
characters but approximately 20 characters are required for the URL when posting photos and so the
maximum usable message size is 120 characters. Tokens for the date and time can be included in text
and will be replaced with the date or time the photos were taken when they are uploaded e.g.
%L will be replaced with the long date representation for your computer's locale e.g. Wednesday, June
08, 2015
%l will be replaced with the long date and time representation for your computer's locale e.g.
Wednesday, June 08, 2015 20:23:56
Please see the tokens section for a list of available tokens.

The photo that is tweeted is based on the JPEG copy of the printed output. You can crop, resize and
rotate the image before it is tweeted.
To crop the image first check the "Crop image:" checkbox and then specify the left offset and top offset
in pixels for the top left corner of the cropped image. Then specify the width and height of the image in
pixels. For example if the photo booth is setup to print a double strip of 4 images on 6"x4" paper you
may wish to crop the image uploaded to Twitter so that only a single strip is sent. If the printer is set to
a resolution of 300 dpi the image will be 1200 pixels wide (4" x 300 dpi) by 1800 pixles high (6" x 300
DPI) and so to crop it into a single strip you need to set left=0, top=0, width=600 and height=1800.
You can also specify a maximum size for the image being uploaded using the "Max width (pixels):" and
"Max height (pixels):" settings. The JPEG copy of the printed output will be resized so that it is no
bigger than these settings before it is tweeted. Keeping these values relatively small, e.g. 500 x 500
pixels, will reduce the time it takes to upload the file.
Depending on you printer page settings the JPEG copy of the printed output may not be saved in the
correct orientation. If this is the case it can be rotated using the "Image rotation:" dropdown list. If you
are also using print preview (the "Confirm before printing" option in the "Photobooth Settings" dialog)
this can be set to "Same as print preview" and it will use the same rotation settings as the print
preview.
Please note that the image is cropped first, then resized and finally rotated before being tweeted.
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Select the "Log uploads to file:" checkbox to log tweets to a CSV file. Then either type in the filename
of the log file in the editbox or click on the "..." to open a file browser. The log file contains a line for
each tweet attempt containing the following comma separated values: the date in the format
YYYYMMDD, the time in the format HHMMSS, the Twitter username prefixed with
TWITTER_USERNAME: and with @ characters replaced by _ , the status (1=success, 0=failure) and
the filename of the image file e.g.
20151214,174842,TWITTER_USERNAME:test_gmail.com,1,C:
\Users\Chris\Documents\PhotoboothImages\2015-12-14\prints\151214_174826.jpg
Please note: The log file only contains the date/time, username, filename and whether the upload was
successful. The user's password is NOT recorded and therefore the log file cannot be used to tweet
the photos after the event.

In Operation
When the photo booth is run and the photos have been taken the print preview screen will be displayed
first (if "Confirm before printing" is selected) and then when the user selects "Print" the sharing screen
(share.jpg) will be displayed. If the user selects "Cancel" in the print preview screen the sharing screen
won't be displayed and the booth will return to the ready screen (ready.jpg). If the "Confirm before
printing" option is not selected the sharing screen will be displayed after taking the photos.

When the sharing screen (share.jpg) the user has the option to tweet the photo by touching the Twitter
button on the touchscreen or by typing T if they are using a normal keyboard. The sharing screen can
be exited by touching the "Cancel" button on the touchscreen or by typing X or Esc on a normal
keyboard. The sharing screen will also exit automatically if the user does nothing and the screen
timeout occurs. The sharing screen timeout can be specified in the "Output Settings" dialog.

When the user selects the Twitter option the touchscreen keyboard will be displayed allowing them to
enter their Twitter user name and password. The user can enter their user name and password by
tapping on the touchscreen keyboard or by typing them in using a normal keyboard. The user can then
either tap on the "Cancel" button (or type Esc) to cancel the upload or tap on the "Upload photo" button
(or press the keyboard Enter key) to start the upload. The touchscreen keyboard will cancel
automatically if the user doesn't tap the touchscreen or type anything and the keyboard timeout occurs.
The keyboard timeout can be specified in the "Touchscreen Settings" dialog which can be displayed
from the "Photobooth Settings" dialog.

When the user has entered their Twitter user name and password and selected "Upload photo" the
Twitter login screen (twitter_login.jpg) will be displayed together with a small web browser window
showing the Twitter login page. The user must tap the "Ok" button or press the Enter key on the
keyboard to login to Twitter and give the application to tweet the photo.

After the user has logged in and authorized the PhotoboothUploader app the upload will start and the
Twitter upload screen (twitter_upload.jpg) will be displayed. If the upload is successful the Twitter
success screen (twitter_success.jpg) will be displayed for a few seconds and then the screen will
return to the sharing screen. If there is an error (e.g. the internet connection was lost) the Twitter error
screen (twitter_error.jpg) will be displayed for a few seconds and then the screen will return to the
sharing screen.

If there is a timeout waiting for the user to login and authorize the PhotoBoothUploader app the upload
will be aborted and the timeout screen (fb_timeout.jpg) will be displayed for a few seconds and then
the screen will return to the sharing screen.

The sharing screen can also be displayed from the ready screen using the keyboard shortcut
Shift+Ctrl+S or the "Display sharing screen" touchscreen action.

If you have problems with the Windows Taskbar appearing when uploading photos to Twitter you can
run the HideWindowsTaskbar.exe utility to hide the Windows taskbar. HideWindowsTaskbar.exe will
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automatically hide the Windows taskbar when DSLR Remote Pro is running in full screen photo booth
mode. HideWindowsTaskbar.exe can be found in the DSLR Remote Pro installation folder (usually C:
\Program Files (x86)\BreezeSys\DSLR Remote Pro on 64-bit Windows).

Please note: The user's Twitter username and password are private and are not saved by the photo
booth software.  There is no offline option for Twitter tweets because users need to enter both their
username and password to allow  posting to their Twitter account and no system should ever keep a
record of users' passwords.

Notes on using a normal keyboard for Twitter tweets, sending texts
and emailing photos

The Twitter tweet, texting and email photo options are designed to be used with a touchscreen, but can
also be operated using a normal keyboard. Please note that if you give users access to a keyboard
you need to prevent them from causing problems by exiting out of the photo booth program (e.g. by
typing Ctrl+Alt+Delete, Ctrl+tab or pressing the Windows key). One way to do this is to take a basic
USB keyboard and either wedge or glue the Ctrl, Alt, Win etc. keys so that they can't be pressed.

The following keys can be used to navigate the print preview, sharing screens:

Print preview:
Type A to print the photos
Type X or Esc to cancel printing

Sharing screen:
Type E to email the photos
Type M enter user message
Type P to print the photos
Type S to send an SMS or MMS text message
Type T to tweet the photos on Twitter
Type X or Esc to exit the sharing screen and return to the ready screen

Touchscreen keyboard:
Type in the user name and password using the normal keyboard keys
Type Tab to switch between the username and password input
Type Enter to start logging in to Twitter after entering the username and password
Type Esc to exit and return to the sharing screen

Twitter login and PhotoBoothUploader app authorization screens:
Type Enter to login to Twitter and Enter again to authorize the PhotoBoothUploader app

Privacy

It is the responsibility of the photo booth operator to ensure the third-party services you use are
appropriate for your events and the jurisdiction you are working in. 
In the notes below "image" refers to JPEG photos, animated GIFs or movie files.

Email
No guest data captured by Breeze Systems
Emails are sent using the email service setup by the photo booth operator.
If you choose to save the email details (i.e. date, time, guest's email address, image filename and any
other inputs defined on the touchscreen keyboard) they are recorded on the photo booth PC.
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Twitter
No guest data captured by Breeze Systems
If you choose to save the Twitter upload details (i.e. date, time, guest's Twitter login id, image filename
and any other inputs defined on the touchscreen keyboard) they are recorded on the photo booth PC.
The guest's password is not recorded.

Text
MMS and SMS+image options: the image is hosted on the Breeze Systems' website for 7 days and is
then deleted automatically. The URLs of the images are anonymous and secure making it extremely
difficult for unauthorized viewing of images. These images are stored on the Breeze Systems web site
solely to allow MMS messages to be sent via Twilio or guests to view their individual images upon
receipt of an SMS text message. They are not used for any other purpose and are deleted
automatically after 7 days.
If you choose to save the text details (i.e. date, time, guest's phone number, image filename and any
other inputs defined on the touchscreen keyboard) they are recorded on the photo booth PC.

Uploading photos to your personal or business Facebook page

There are a number of free tools for automatically uploading photos to your personal or business
Facebook page or to other social networking or photo sharing sites:

1. Dropbox - Dropbox is a free service for synchronizing files across multiple computers and devices.
When a file is copied into the Dropbox folder on your computer it is automatically uploaded to online
storage in the Cloud. If a photo is copied to a subfolder in the Photos Dropbox folder it will
automatically create an online gallery which can be viewed using a web browser.
Dropbox comes with 2 GB of free online storage which can be increased for a monthly fee. Please
visit the Dropbox website for more details.

2. IFTTT + Dropbox/Box/Google Drive- IFTTT (If This Then That) is a free web based automation
tool that works in conjunction with free online storage services such as Dropbox, Box and Google
Drive. It uses "recipes" to perform actions when files are added to your online storage. It can link to
many services including Facebook (to access your personal Facebook page), Facebook pages (to
access a business Facebook page), Flickr, YouTube and Twitter. The recipes are run every 15
minutes and can upload a maximum of 15 photos each update.
Please visit the IFTTT website for more details

All of the above services work by monitoring a folder on you PC and automatically uploading the photos
to the Cloud or directly to a Facebook album. The output options in DSLR Remote Pro can be used to
automatically crop and resize the prints from the photo booth and copy the image to the folder being
monitored for uploading to the Cloud and/or Facebook. The output settings dialog can be displayed by
setting the output option in the photo booth settings to "Print and save JPEG copy" or "JPEG copy
only" and pressing the "Settings..." button:

https://www.dropbox.com
http://ifttt.com
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Select the "Copy JPEG to folder:" option and enter the name of the folder where the JPEG copy of the
printed output should be copied to. This should be the folder that is being monitored by your the online
storage service. The JPEG copy of the printed output is formatted for sending to a printer and may be
larger than you want for uploading to Facebook. For example a typical double strip of 4 images printed
at 300 DPI on 4"x6" paper will be 1200 x 1800 pixels in size and will show two strips of 4 photos side
by side. You may want to limit the size for faster uploading and viewing on guests' cell phones etc. and
to crop the image so that it only shows a single strip of 4 photos. You can do this by clicking on the
"Settings..." button to the right of the "Copy JPEG copy of printed output" button to display the "Copy
JPEG Settings" dialog and using the "Crop image before copying" and "Resize image before copying"
options as shown below:

If you need more control over the layout...

Please take a look at our Hotfolder Prints software if you need more control over how the photos are

http://www.breezesys.com/Hotfolder/index.htm
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formatted before being uploaded to Twitter and other social networking sites. Hotfolder Prints allows
you to create a completely new layout optimized for uploading and to add logos or other information
that doesn't appear in the printed strips. Hotfolder Prints can also email photos to users (using the
email address entered using the touchscreen keyboard) and run a slideshow which is automatically
updated as new photos are taken.

Summary Online Storage Services

The free IFTTT web automation tools can be used in conjunction with the following free Cloud based
online storage services:
· Dropbox: 2 GB of free online storage, more available for a monthly fee
· Box: 5 GB of free online storage, more available for a monthly fee
· Google Drive: 5 GB of free online storage, more available for a monthly fee

Please note the information above was correct at the time of writing but may have changed since.
Please check the relevant websites for the latest information about the various services described on
this page.

10.30 Reports

Email and Texting Reporting Tool

The email and texting reporting tool can be used to create a report showing the number of emails and
texts sent using the output from DSLR Remote Pro and our other Windows based photo booth apps or
from Breeze Booth for iPad.
Select "Photo booth sharing report..." from the Reports menu to run the email and texting reporting tool:

The email and text reporting tool works by scanning folder where the photo booth photos are saved
looking for XML email and text files and reading this information to create a summary of the emails and
texts. Enter the base folder in the edit box or press the "..." button to open a browser to select the
folder. Then press the "Run" button to scan the folder and all its subfolders:

http://www.breezesys.com/Hotfolder/index.htm
http://www.breezesys.com/Hotfolder/index.htm
https://www.dropbox.com
https://www.box.com
http://drive.google.com
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The results will show a summary of the total number of sessions and the breakdown between photos,
GIFs and video sessions. It also shows the number of shares by email and by text.

This is followed by two tables: one showing email shares and one showing text shares. These tables
use tab delimited fields which can be copied and pasted into a spreadsheet such as Microsoft Excel
where the data can be displayed as a graph. A portion of the results can be selected by holding the left
mouse button down and selected the required text or the whole report can be selected by clicking on
the "Copy to clipboard" button. Then copy and paste the data into a spreadsheet for analysis. 

Statistics Tool

The statistics tool can be used to create a report using the output from DSLR Remote Pro and our
other Windows based photo booth apps or from Breeze Booth for iPad.
Select "Photo booth session stats report..." from the Reports menu to run the statistics tool:

The statistics tool works by scanning folder where the photo booth photos are saved for XML summary
files and reading this information to create a summary of the number of sessions and shares. Enter the
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base folder in the edit box or press the "..." button to open a browser to select the folder. Then press
the "Run" button to scan the folder and all its subfolders:

The results will show a summary of the total number of sessions and the breakdown between photos,
GIFs and video sessions. It also shows the number of shares by email and by text.

The next session shows the busiest day and busiest hour for the period for all devices together with the
busiest day and hour for a single device.

The busiest day is then shown as a table giving a hour by hour summary of the number and type of
sessions and the shares.

Lastly, a table giving a day by day summary for the last 30 days is displayed showing the number and
type of sessions and the shares.

These tables use tab delimited fields which can be copied and pasted into a spreadsheet such as
Microsoft Excel where the data can be displayed as a graph. A portion of the results can be selected
by holding the left mouse button down and selected the required text or the whole report can be
selected by clicking the "Copy to clipboard" button. Then copy and paste the data into a spreadsheet
for analysis. 

Survey Data

The survey data tool can be used to create a report showing survey responses using the output from
DSLR Remote Pro and our other Windows based photo booth apps or from Breeze Booth for iPad.
Select "Photo booth survey data report..." from the Reports menu to run the survey data tool:
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The survey data tool works by scanning folder where the photo booth photos are saved for XML
summary files and reading this information to create a report showing responses to surveys. Enter the
base folder in the edit box or press the "..." button to open a browser to select the folder. Select
"Include QR code strings" to include data such as users' email addresses when using QR codes to run
a contactless photo booth.
Then press the "Run" button to scan the folder and all its subfolders:

The results a table of each session that gathered survey data.

The first row of the table gives the headings for each column: 'path' for the path of the XML summary
file followed by one or more headings for each of the survey results in the form: survey screen number
(e.g. survey1), response type (e.g. chkbox, text or radio), response identifier.  

The remaining rows show the responses to each session and start with the path of the XML summary
file followed by a list of responses to each question in the survey. 

The table uses tab delimited fields which can be copied and pasted into a spreadsheet such as
Microsoft Excel where the data can be displayed as a graph or analysed. A portion of the results can
be selected by holding the left mouse button down and selected the required text or the whole report
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can be selected by clicking the "Copy to clipboard" button. Then copy and paste the data into a
spreadsheet for analysis. 

10.31 The Configure.exe Utility

BThe Configure.exe utility provides a way to modify some of the less commonly used settings in DSLR
Remote Pro. It can be found in the installation folder (usually C:\Program Files (x86)\Breezesys\DSLR
Remote Pro) and can be run by opening the installation folder in Windows File Explorer and then double
clicking on Configure.exe.
Important: Please exit DSLR Remote Pro before running the Configure.exe utility otherwise any
changes you make may not be saved properly.

EVF Settings

EvfIntervalInMs - Specifies the refresh interval of the live view display in milliseconds (default value
80). A smaller value will give a faster refresh rate. The maximum live view refresh rate will depend on
the camera model and the speed of the computer. Please note that changing this setting may affect the
timing of animated GIFs captured in video booth mode.
EvfFocusPeakingThreshold - Sets the threshold used for focus peaking in live view (default value
200). Please see the section on live view for details.

Photobooth Settings

PhotoboothJpegSaveQuality - The JPEG quality setting used when saving the JPEG copy of the
printed output (default 90). Higher value give improved quality but will also increase the size of the files.
PhotoboothFasrResize - Uses a faster resizing algorithm when resizing images to create the print
layout. The faster resizing algorithm may reduce the time it takes to prepare the photos for printing
when running on slower computers but also reduce the quality slightly.
PhotoboothSuppressXML - Select this option to disable the saving of the XML summary file that is
normally written after each photo booth shooting sequence.
PhotoboothSaveLayoutEvenIfRejected - Save the JPEG copy of the printed output even if the user
rejects the photos in the print confirmation screen.
PhotoboothAfErrorMsg - Error message to display to users if the camera is set to AF and is unable
to lock focus when taking photos.
PhotoboothTakingHideLiveView - Hide the live view display when the taking.jpg screen is displayed
approximately 1 second before the camera takes each photo
PhotoboothTakingTimeBeforeRelease - Specifies when the taking.jpg screen should be displayed in
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milliseconds before the camera takes the photo. Setting this to 0 will use the default value which is to
display the taking.jpg screen approximately 1 second before taking the photo.
PhotoboothCountdownDelayInMS - Adds an offset when calculating the time until the photo
displayed in the countdown text. This can be used to compensate for the delay between the command
to take a photo being sent to the camera and the time the photo is captured (see also
PhotoboothShutterLag).
PhotoboothDisableLiveViewInReadyScreen - Select this to disable live view in the ready screen and
only enable it when the countdown starts
PhotoboothAbortIfNoInput - Abort the shooting sequence and return to the ready.jpg screen if the
"Email input at start of sequence" touchscreen keyboard option is used and the user does not enter
anything
AllowOverlappingTouchscreenAreas - Allow touchscreen areas to overlap so that one touch can
activate multiple actions. Please take care when using this options as overlapping some combinations
of touchscreen actions may produce unexpected effects or could cause the software to crash.
PhotoboothShutterLag - Compensate for the camera's shutter lag (the delay from when the
command to take a photo is sent to when the camera actually captures the photo). The delay is in
milliseconds e.g. setting it to 500 will tell the software to send the command to take the photo half a
second before the countdown timer reaches zero (see also PhotoboothCountdownDelayInMS)
PhotoboothPrintCounter - Sets the start value for the print counter that is decremented each time
photos are printed (more details).
AllowEvfBrightnessAdjustment - Allow cursor up/down keys to adjust live view brightness using the
shutter speed when using manual exposure mode and bank 1 or bank 2 camera settings
PromptToSavePrintLayoutInDefaultProfile - Prompt to save print layout in the default profile or most
recently loaded profile after selecting the print layout editor from the main window
PhotoboothTapCountdown3Sec - Set the stills photo booth countdown timer to 3 secs if user taps
the screen during the countdown. The countdown text is hidden if countdown is set to more than 15
secs e.g. you can set the delay before taking remaining photos to 30 secs to allow users time to
change props and get ready for the next photo and then ask them to tap the screen for a 3 sec
countdown or wait for the full 30 seconds to elapse (the countdown text will only be displayed for the
final 15 secs of the countdown).
PhotoboothPhotoPreviewX - Left offset (in pixels) of preview photos displayed in the preview.jpg
screen
PhotoboothPhotoPreviewY - Top offset (in pixels) of preview photos displayed in the preview.jpg
screen
PhotoboothPhotoPreviewW - Width (in pixels) of preview photos displayed in the preview.jpg screen.
Set this to 0 to automatically size the photo to fill the screen and center it.
PhotoboothPhotoPreviewH - Height (in pixels) of preview photos displayed in the preview.jpg screen.
Set this to 0 to automatically size the photo to fill the screen and center it.
EnablePrintCopiesStatusText - Enable the print copies status display shown briefly at the bottom of
the ready.jpg screen when selecting different numbers of copies
ShowPreviewWhenUploading - Display a preview of the photos or animated GIF when uploading to
Twitter or when sending emails
InfoInactivityTimeout - Timeout in seconds for displaying the optional information screens

Photobooth Setup Wizard Defaults

WizardDownloadFolder - Download folder where photos and videos are saved. Default setting:
{documents}\\PhotoboothImages\\{dateLess8h}
WizardFirstPhotoInterval - Countdown duration for first photo in secs (default 5 secs)
WizardPhotoInterval - Countdown duration for remaining photos in secs (default 3 secs)
WizardGifPhotoMode - Capture GIFs using camera's photo mode
WizardGifNumFramesToCapture - Number of frames to capture for boomerang GIFs (default 15
frames)
WizardGifCaptureFreq - GIF capture frequency (default=2)
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WizardGifPlaybackImageDelay - GIF playback speed in 1/100 sec (default=8)
WizardGifPingPongPlayback - Capture boomerang GIF (aka ping-pong)
WizardVideoCountdownLengthInSecs - Countdown duration for videos or boomerang GIFs (default
5 secs)), Number, 1, 120 },
WizardGifWidth - Size of photos in animated GIFs
WizardGifFrameWidth - Width of animated GIFs (0=use photo width)
WizardGifXOffset - Left offset of photo within GIF frame (default=10 pixels)
WizardGifYOffset - Top offset of photo within GIF frame (default=10 pixels)), Number, 0, 1000 },
WizardVideoClipLengthInSecs - Length of video to capture in video booth mode (default 10 secs)

Twitter

TwitterLoginWindowWidth - The width in pixels of the Twitter login window
TwitterLoginWindowHeght - The height in pixels of the Twitter login window

Sharing

SharingSuccessScreenDuration - Time (in secs) to display the success screen when sharing
SharingOfflineScreenDuration - Time (in secs) to display the offline screen when sharing
SharingErrorScreenDuration - Time (in secs) to display the error screen when sharing

Status Command

PhotoboothStatusCmdEnable - Enable the running of status commands when the photo booth status
changes
PhotoboothStatusCmd - Command to run when the photo booth status changes
PhotoboothStatusCmdXML - Command to run when the photo booth XML summary file is written
Please see the section headed "Running External Commands" for information about these settings.

Photobooth Text Tokens

The following values are read from the Windows registry and can be used in the caption text added to
photos before printing: {PhotoboothText1}, {PhotoboothText2}, {PhotoboothText3}, {PhotoboothText4},
{PhotoboothText5}
Example application: Print delegate information read from RFID enabled id cards on photo booth prints
(requires a separate utility to read the RFID information and copy it into the Windows registry)

Video

VideoboothKeyboard - Display optional touchscreen keyboard in video booth mode. Set this to 1 to
show the keyboard at the start or 2 to show the keyboard after capture. The information entered is
saved in the XML summary file.

11 Automatic Printing of Photos

Photo booth mode can also be used for automatically printing out photographs as they are taken. When
this is setup you can take a picture with the camera using the normal camera controls and it will be
automatically downloaded to the PC and printed out using the current photo booth layout settings. An
optional confirmation screen can also be displayed allowing the photographer to decide whether to print
each photo. Applications include school and portrait photography, Santa's Grotto shots and id
photographs.
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To use this mode set the number of photos in photo booth mode to 1, design the print layout (e.g. set
the number of rows and columns to 1, add headers, footers, captions and overlays as required) and
then select full screen photo booth mode. Then simply take each photo and it will be downloaded to the
PC and printed automatically. If the option to ask for confirmation before printing is selected the display
will show a print preview and ask for confirmation before printing each shot. Reprints of the last shot
can be made by typing Ctrl+R.

12 Running DSLR Remote Pro from other apps

Overview
DSLR Remote Pro for Windows includes an interface library called DSLRRemoteLib.dll which can be
used by other applications to control DSLR Remote Pro for Windows. Also included is a simple
command line application called DSLRRemoteTest.exe which can be used to control DSLR Remote Pro
for Windows from a command prompt or a batch file. For example a batch file could be written to take
a series of photos using different apertures and shutter speeds to bracket the exposure.

DSLRRemoteLib.dll
DSLRRemoteLib.dll is a library that can be used by other programs to control DSLR Remote Pro for
Windows. It can be found in the main folder where DSLR Remote Pro for Windows is installed (usually
C:\Program Files\BreezeSys\DSLR Remote Pro). Please see the DSLRRemoteTest\ReadMe.txt and
DSLRRemoteLib.h files for details.

Files included:
DSLRRemoteTest.exe - compiled console application

DSLRRemoteLib.dll - DLL used by DSLRRemoteTest.exe to interface with DSLR Remote Pro for
Windows
DSLRRemoteLib.lib - lib for C++ apps to link to the DLL
DSLRRemoteLib.h - header file for C++ applications using the DLL

DSLRRemoteTest - directory containing a VC++ project and source code for DSLRRemoteTest.exe

DSLRRemoteTest.exe
DSLRRemoteTest.exe is a simple command line application that communicates with DSLR Remote Pro
for Windows and allows the shutter to be released and some of the camera settings to be changed.
DSLRRemoteTest.exe and complete source code to build it using Visual C++ .Net can be found in the
DSLRRemoteTest folder where DSLR Remote Pro for Windows is installed (usually C:\Program
Files\BreezeSys\DSLR Remote Pro).

To run DSLRRemoteTest.exe first run DSLR Remote Pro and then open a command prompt window
and change directory to the DSLR Remote Pro for Windows installation folder. The run
DSLRRemoteTest.exe -h to get a list of the available commands.
Here is the output from a simple session where the output directory is set and the shutter is released
(commands typed in by the user are shown in bold):

Microsoft Windows [Version 6.1.7601]
Copyright (c) 2009 Microsoft Corporation.  All rights reserved.

C:\>cd C:\Program Files\BreezeSys\DSLR Remote Pro

C:\Program Files\BreezeSys\DSLR Remote Pro>DSLRRemoteTest.exe -h
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Usage: DSLRRemoteTest <options>
        -h              print this usage information
        -w <shots>      run camera as a webcam for <shots> shots
                        images are saved as webcam.jpg in the current
directory
        -t <interval>   specify the number of seconds between shots when
                        used as a webcam
        -S <camera#>    select camera (multi-camera versions of DSLR Remote
Pro only)
        -C <connect>    connect or disconnect from the camera
        -a <aperture>   set the aperture, 0 = widest aperture
        -b <WB>         set the white balance or kelvin color temp
        -e <mode>       set the exposure mode (1D series cameras only)
        -s <shutter>    set the shutter speed, 0 = longest shutter speed
        -x <comp>       set the exposure compensation
        -i <quality>    set the image size and quality
        -I <ISO>        set the ISO
        -L <enable>     display/hide live view window
        -E <pathname>   capture live view frame to JPEG file
        -f <step>       focus lens: 1=near3, 2=near2, 3=near1, 4=far1,
5=far2, 6=far3
        -c <comment>    set comment to be added to images (max 255 chars)
        -p <prefix>     set the filename prefix (max 255 chars)
        -o <directory>  set the output directory
        -B <duration>   press shutter button for <duration> tenths of a sec
        -q              query output directory
        -n              don't release shutter
        -X              exit DSLR Remote Pro

C:\Program Files\BreezeSys\DSLR Remote Pro>DSLRRemoteTest.exe -n -o C:
\Photos -q
Output directory: C:\Photos\2007-01-15\

C:\Program Files\BreezeSys\DSLR Remote Pro>DSLRRemoteTest.exe
Success, image saved as: C:\Photos\2007-01-15\IMG_0001.JPG

C:\Program Files\BreezeSys\DSLR Remote Pro>
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13 Preferences

Click on "File->Preferences" to display the preferences dialog.

Mouse Button Actions
The middle and right mouse buttons can be assigned to release the shutter or take pictures in preview
mode. This allows you to use the mouse like a simple cable release.
Note: This only works if the mouse pointer is over the main window and is not over one of the controls.

Only Download JPEG Images to PC
Normally when the camera is set to raw+JPEG both the raw files and the JPEGs are downloaded to
the PC. Select the "Only download JPEGs to PC when shooting raw+JPEG" option to save the raw
and JPEG files to the camera's memory card and only download the JPEG file to the PC when
shooting raw+JPEG and using the save to camera and PC option. This is reduces the time it takes to
download images to the PC which can be useful if there is a slow link between the camera and PC (e.
g. a wifi connection with a Canon EOS 6D or when using a Cat 5 USB 1.1 extender cable) and you
need to see previews of each shot on the PC.
Important: Please make sure there is a memory card with plenty of space in the camera otherwise the
raw files may not be saved. Also, don't forget to copy the raw files to the PC after the shoot.

Preview Images
The default setting when taking preview shots is to switch to small JPEG images to reduce the file size
and speed up the download time. Recent cameras have much faster USB 2.0 interfaces and can
download images much faster making download speed less of an issue. When "Use small JPEGs for
preview shots" is not selected DSLR Remote Pro for Windows will use the current image size and
quality when takinh preview shots.
(This option is ignored when using  the original EOS-1D or EOS-1Ds cameras).

Delete Movie Files
Movies files are stored on the camera's memory card and have to be separately downloaded to the
PC. When the "Delete movie files from memory card after downloading to PC" option is selected movie
files will be automatically deleted from the camera's memory card after they have been successfully
downloaded to the PC to free up space on the memory card. Please see the section on video capture
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for more information.

High DPI Awareness

Some tablets and laptops have very high resolution screens and the way Windows displays applications
will depend on whether they are "DPI aware" or not. Older applications which are not high DPI aware
are scaled up to avoid the text being too small to read. This means that the resolution of the screen
available to the application is less than the actual screen resolution. The amount of display scaling
depends on the "size of text, apps and other items" setting in the Windows display settings.

Newer applications that are high DPI aware automatically scale the text so that it can be read and can
use the full resolution of the screen.

DSLR Remote Pro has the option to operate as a "DPI aware" application and use the full screen
resolution or to behave like a legacy application with a display that is scaled by Windows.

Example: Microsoft Surface Pro 4 tablet has a screen resolution of 2736x1824 pixels
If DSLR Remote Pro is run with the "Set DPI awareness" option set the screen images used in photo
booth mode will need to be 2736x1824 pixels in size to fill the screen.
If the "Set DPI awareness" option is not set the size of the screen images will depend on the "size of
text, apps and other items" selected in the Windows display settings:
If it is set to 150% the screen images need to be 1824x1216 pixels
If it is set to 200% the screen images need to be 1368x912 pixels

Recommendation: select the "DPI aware" setting for all new photo booth screen designs and only
disable it if you have old designs which don't fill the screen (you may also need to adjust the "size of
text, apps and other items" Windows display setting)

Specifying the download folder
These settings control where images are stored on the computer's hard disk. The edit box displays the
base folder for images and can be changed by typing directly into the edit box or by clicking on the "..."
button and using the folder browser. If the Year, Month and Day checkboxes are not checked this will
be the folder in which all images and videos are stored.
Note: If the folder does not already exist it will be created when the photo or video is saved.

The Year, Month and Day checkbox control the automatic generation of subfolders according to the
computer's date. The example image name shown at the bottom of the dialog shows how the various
settings are combined. Select the "Flatten date" checkbox to combine the year, month and day into a
single subfolder e.g. in the example above:
June 6, 2017 with "Flatten date" unchecked gives "C:\Photos\2017\06\06"

With "Flatten date" checked it gives "C:\Photos\2017-06-06"
You can also use tokens when specifying the download folder e.g. "C:\%Y\%T" would give the year
followed by the camera model.

Image Filenames
When "Use camera filenames" is selected DSLR Remote Pro for Windows uses the same filenames for
images saved to the PC as the camera uses for images saved to its memory card (when the option to
save images to camera and PC is used). If the option to save images to the PC only is used the
filenames from the camera will start from 0001 each time the camera is connected e.g. IMG_0001.
CR2, IMG_0002.CR2 etc. To avoid overwriting existing files DSLR Remote Pro for windows will
automatically add a number to the end of the filename e.g. IMG_0001_1.CR2. The sequential file
numbering and append sequence letter to filenames when auto-bracketing options are ignored when
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camera filenames are used.
Note: Camera filenames are not available with older cameras (i.e. camera which don't use the CR2
raw file format).

By default image filenames are in upper case e.g. IMG_0001.JPG or IMG_0001.CR2. If the "Lower
case file extensions" checkbox is selected images will be saved with lower case file extensions e.g.
IMG_0001.jpg or IMG_0001.cr2.

When the "Sequential file numbering" checkbox is set DSLR Remote Pro for Windows stores images
using a numeric sequence number when they are saved to the PC's hard disk. It scans the output
directory for existing images and uses the lowest available sequence number e.g. if the output directory
already contains the image 0123.JPG DSLR Remote Pro for Windows will save the next image as
0124.JPG. DSLR Remote Pro for Windows will then continue numbering from that point even if the
images are removed from the directory while it is running. This is to prevent duplicate filenames when
images captured by DSLR Remote Pro for Windows are immediately removed from the output
directory e.g. when using a program to automatically send the images to a picture desk using FTP.
When the "Sequential file numbering" checkbox is not set DSLR Remote Pro for Windows scans the
output directory for existing images and uses the lowest available number to give a unique filename e.g.
if the output directory already contains the image 0123.JPG DSLR Remote Pro for Windows will save
the next image as 0124.JPG.

You can also use tokens when specifying the download folder e.g. "C:\%Y\%T" would give the year
followed by the camera model.

When "Append sequence letter to end of filenames when auto-bracketing" is selected auto-bracketed
filenames have the same image number and a sequence letter added to each shot for easy
identification. e.g. a 3-shot sequence might give filenames 0001a.JPG, 0001b.JPG and 0001c.JPG as
opposed to 0001.JPG, 0002.JPG and 0003.JPG when this option is switched off.

Select the "use camera filenames" option if you want DSLR Remote Pro for Windows to use the same
names for images saved to the PC as those saved to the camera's memory card. Please note that
camera filenames may not be available with older camera models.

JPEG images are saved with a .JPG file extension e.g. 0001.JPG, 0002.JPG etc.

Raw images from current EOS cameras are saved with a .CR2 file extension. If raw+JPEG mode is
selected the JPEG image will be saved as the same filename as the raw file but with a .JPG file
extension e.g. 0001.CR2 and 0001.JPG.

Raw files from older EOS cameras (e.g. Canon EOS 10D) are saved as two files: the CRW file
containing the raw image data and the THM file containing a small JPEG thumbnail image. Raw images
are saved as: 0001.CRW and 0001.THM, 0002.CRW and 0002.THM, 0003.CRW and 0003.THM etc.

Raw images from the EOS-1D and EOS-1DS are saved with a .TIF file extension. If raw+JPEG mode
is selected the JPEG image will be saved as the same filename as the raw file but with a .JPG file
extension e.g. 0001.TIF and 0001.JPG.

You can specify an optional prefix to be added at the start of each image's filename e.g. the prefix
"studio shoot " would result filenames like "studio shoot 0001.JPG", "studio shoot 0002.CR2" etc.

The number of digits used in the filenames can be specified from 0 to 10. When this is set to 1 or more
the filenames will always contain a number and this will be padded with leading zeroes if required. If it
is set to 0 and a filename prefix is defined the filename will use the prefix unless the file already exists
in which case it will add _ followed by the lowest available number to make the filename unique. Please
note that setting the number of digits to 0 may not number raw and JPEG images correctly when
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shooting RAW+JPEG.

Example 1: Filename prefix: IMG, number of digits: 0
Images will be saved with the following names: IMG.JPG, IMG_1.JPG, IMG_2.JPG... IMG_10.JPG

Example 2: Filename prefix: IMG, number of digits: 1
Images will be saved with the following names: IMG1.JPG, IMG2.JPG, IMG3.JPG... IMG10.JPG

Example 3: Filename prefix: IMG_, number of digits: 4
Images will be saved with the following names: IMG_0001.JPG, IMG_0002.JPG, IMG_0003.JPG...
IMG_0010.JPG

14 Tokens

Date and time tokens

%a Abbreviated weekday name e.g. Fri

%A Full weekday name e.g. Friday

%b Abbreviated month name e.g. Jun

%B Full month name e.g. June

%d
Date in the form YYMMDD (equivalent to %y%m
%D)

e.g. 110617 for June 11,
2017

%D Day of the month (01 to 31)  

%H Hour (00 to 23)  

%I Hour (01 to 12)  

%j Day of the year (001 to 366)  

%l Long date/time representation of locale
e.g. Monday, January
17, 2017 19:03:47

%L Long date representation for locale
e.g. Monday, January
17, 2017

%m Month (01 to 12) e.g. 06 for June

%M Minutes (00 to 59)  

%p am/pm indicator e.g. PM

%S Seconds (00 to 59)  

%t
Time in the form HHMMSS (equivalent to %H%M
%S)

 

%W Week number (00 to 53)  

%x Date representation for locale
e.g. 06_14_17 for June
14, 2017

%X Time representation for locale e.g. 14_39_29

%y Year without century e.g. 17

%Y Year with century e.g. 2017

%z Time zone name
e.g. GMT Standard
Time

%Z Time zone offset wrt UTC
e.g. +0100 for GMT
during DST

{timeNow} Time 'now' in the form HHMMSS



 252

© 2024 We Fly Kites Inc.

{yearNow} Year 'now' in the form YYYY e.g. 2017

{monthNow} Month 'now' (01 to 12) e.g. 06 

{dayNow} Day 'now' (01 to 31) e.g. 17 

{yearLess8h}
Year with century 8 hours ago - useful when
shooting events which continue after midnight

e.g. 2017

{monthLess8h}
Month (01 to 12) 8 hours ago - useful when
shooting events which continue after midnight

e.g. 01

{dayLess8h}
Day of the month (01 to 31) 8 hours ago - useful
when shooting events which continue after
midnight

e.g. 19

{dateLess8h}
Year, month, day less 8 hours in the form YYYY-
MM-DD

e.g. 2018-01-21

Folders

{documents} The current user's documents folder
e.g. C:
\users\chris\Documents

{desktop} The current user's desktop folder
e.g. C:
\users\chris\Desktop

{profile} The current user's profile folder e.g. C:\users\chris

Shooting data tokens

%c Camera serial number (Canon EOS cameras only)  

%C Canon EOS-1D/1DS style camera serial number  

%e File extension (without the '.')
e.g. JPG for IMG_4567.
JPG

%i ISO value read from the shooting data  

{iso}
ISO value read from the shooting data (same as
%i)

{tv}
Shutter speed with the leading 1/ removed e.g. a
shutter speed 1/125 sec gives a value of 125

{av} Aperture setting

{orientation} Image orientation: L for landscape or P for portrait

{orientationAngle} Image orientation angle in degrees: 0, 90 or 270

%o Image filename without extension e.g. IMG_4567

%O Owner string (Canon cameras only)  

%T
Camera model name starting from the first word
containing digits

e.g. 80D for Canon EOS
80D

%T1 Same as %T, but '-' are treated as spaces
e.g. 1DX for Canon
EOS-1DX

%T2 Full camera model name e.g. Canon EOS 80D

%T3 First word of camera model name containing digits
e.g. 80D for Canon EOS
80D

%T4 Same as %T3, but '-' are treated as spaces  

%T5 Last word of camera model name containing digits
e.g. 80D for Canon EOS
80D
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%T6 Same as %T5, but '-' are treated as spaces
e.g. 1DX for Canon
EOS-1DX

%v
Camera model name starting from the first word
containing digits
(same as %T)

 

%V Full camera model name (same as %T2)  

Tokens for modifying strings

The tokens below can be used to modify tokens or strings:

Token Description Example

{left,n,str} Extracts the first n characters from str
(which can be a string or token). 

{left,4,{filename}} for D:\Photos\image1.jpg
will give: image

{mid,n,m,str
}

Extracts m characters starting from the n'th
character from str (which can be a string or
token). 

{mid,1,3,{filename}} for D:\Photos\image1.jpg
will give: mag
{mid,3,,{filename}} for D:\Photos\image1.jpg
will give: ge1

{right,n,str} Extracts the last n characters from str
(which can be a string or token). 

{right,2,{filename}} for D:\Photos\image1.jpg
will give: e1

{field,n,str} Extracts the nth field from str. Fields are
separated by space, period, hyphen, slash,
backslash or underscore characters

{field,2,{filename}} for D:\Photos\IMG_0001.
jpg will give: IMG

{field2,n,ch,
str}

Extracts the nth field from str using the
character ch as the field separator

{field2,2,-,one-two-three} will give: two

{first,str} Extracts the first word from str (which can
be a string or token).

{first,%L} for an image taken Monday,
January 17, 2015 will give: Monday

{last,str} Extracts the last word from str (which can
be a string or token).

{last,%L} for an image taken Monday,
January 17, 2015 will give: 2015

{upper,str} Converts str to upper case {upper,%B} for a photo taken in June gives:
JUNE

{lower,str} Converts str to lower case {lower,%B} for a photo taken in June gives:
june

{capitalize,s
tr}

Converts str to lower case and capitalizes
the first letter

{capitalize,john} gives John

{default,str1
,str2}

Returns str1 unless it is an empty string in
which case it returns str2 (str1 and str2 can
be strings or tokens

{default,1,2} returns 1
{default,,2} returns 2

{if,test,str1,
str2}

Returns str1 if test contains any text except
0 else returns str2 (test, str1 and str2 can
be strings or tokens)

{if,1,2,3} returns 2
{if,0,2,3} returns 3
{if,,2,3} returns 3

{compare,st
r1,str2}

Returns 1 if str1 is the same as str2 else
returns an empty string

{compare,photo,photo} returns 1,
{compare,photo,image} returns empty string

{lessThan,st
r1,str2}

Returns 1 if str1 less than str2 else returns
an empty string. If both str1 and str2 are
integers it performs a numerical comparison
otherwise it performs an alphabetical string
comparison

{lessThan,1984,2023} returns 1,
{lessThan,dogs,cats} returns empty string

{contains,st
r1,str2}

Returns 1 if str1 contains str2 else returns
an empty string

{contains,photo,to} returns 1,
{contains,photo,camera} returns empty string

{random,n, Returns a random number in the range n to {random,1,10} returns a random number



 254

© 2024 We Fly Kites Inc.

m} m. A new random number is generated
each time the ready screen is displayed in
photo booth mode

between 1 and 10

{urlencode,
str}

Encodes str so that it can be used as a
parameter in a URL e.g. when providing a
URL for a microsite

https://yoursite.com/viewer.php?id={urlencod
e,my name} gives
https://yoursite.com/viewer.php?id=my%20n
ame

{tinyUrl,url} Converts a URL to a shortened version
using tinyurl.com

https://www.breezesys.com/solutions/booth/
is shortened to https://tinyurl.com/3ns9dvwc

Other tokens

{comment} The value of comment entered in the main window  

{artist}
Artist string stored in the camera (not available on
very old camera models)

{author} Same as {artist}

{copyright}
Copyright string stored in the camera (not
available on very old camera models)

{copy} Same as {copyright}

{photoboothNumImages} Number of shots defined in photo booth mode e.g. 4

{photoboothImage} Shot number in photo booth shooting sequence e.g. first photo returns 1

{photoboothDateTime}
Date and time at the start of the current photo
booth shooting sequence

e.g. 20110126_190509

{photoboothDate}
Date at the start of the current photo booth
shooting sequence

e.g. Jan 26, 2011
returns 20110126

{photoboothTime}
Time at the start of the current photo booth
shooting sequence

e.g. 7:05:09 pm returns
190509

{photoboothDir}
The value of the full pathname of the photo booth
images folder

e.g. C:
\Photobooth\Profile1

{photoboothSubdir} The value of the photo booth images subfolder
e.g. C:
\Photobooth\Profile1
gives Profile1

{photo1}, {photo2} etc.
Filename (without file extension or directory path)
of each photo in photo booth mode

{imageCounter}
Shutter activation count (the total number of
pictures that have been taken with the camera)

e.g. 1234

{imageCounter5}
Same as {imageCounter} but padded with leading
zeroes to give a 5 digit number

e.g. 01234

{imageCounter6}
Same as {imageCounter} but padded with leading
zeroes to give a 6 digit number

e.g. 001234

{filename}
Filename of the saved print layout in photo booth
mode (only available for captions used in photo
booth prints and in email text)

e.g. 20161028_193423.
JPG

{filenameNoExt}
Same as {filename} but returns the filename
without a file extension

e.g. 20161028_193423

{isGif}
Returns 1 if the file is an animated GIF else
returns 0 (only available when sharing)
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{isJpeg}
Returns 1 if the file is a JPEG image else returns
0 (only available when sharing)

{isMovie}
Returns 1 if the file is a movie file else returns 0
(only available when sharing)

{uid}

Unique id in the form ABC12345 updated at the
start of each photo booth shooting sequence. Can
be used in captions and the filename prefix. The id
is guaranteed not to repeat within 72 hours and is
very unlikely to repeat within 10 years.

{uid2}

Alternative unique id in the form ABCDE123
updated at the start of each photo booth shooting
sequence. Can be used in captions and the
filename prefix. The id is guaranteed not to repeat
within 776 days and two photo booths running at
exactly the same time have a 1 in 216,000,000
chance of generating the same id.

{uid3}

Alternative unique id in the form ABC123DEF
updated at the start of each photo booth shooting
sequence. Can be used in captions and the
filename prefix.

{guid}
128-bit integer which is globally unique to a high
degree of certainty. It is updated at the start of
each photo booth shooting sequence.

e.g. d8de5c08-a9b0-
4043-9bd9-
07fe1fa33b6a

{message}
Message entered by the user when using the
"Message input at end of sequence" touchscreen
keyboard option

{sharingMessage}
Optional message entered by the user when
sending emails

{user1_data}

The text entered by the user in prompt 1 of the
touchscreen keyboard. This token can be used in
caption text in print layouts when the "Email input
at start of sequence" or "Email input after taking
photos" touchscreen keyboard options are
selected. Use {user2_data} for the text in prompt
2 etc. 

{survey1_text1}

Text entered by the user in prompt 1 of survey
screen 1. Use {survey1_text2} for the text in
prompt 2 etc. Use {survey2_text1} for the text in
survey screen 2 etc.

{survey1_chkbox1}

Value of checkbox 1 set in survey screen 1. Use
{survey1_chkbox2} for the checkbox 2 2 etc. Use
{survey2_chkbox1} for checkbox 1 in survey
screen 2 etc

1 if the checkbox was
selected
0 if the checkbox was
not selected

{printTemplateName}
Filename part of the last print template to be
loaded (can also be shared with other applications
via the Windows registry)

e.g. John & Jane for C:
\PrintTemplates\John &
Jane.pblt

{eventName}
Event name that can be shared with other
applications via the Windows registry

e.g. John & Jane

{eventDate}
Event date in the form YYYY-MM-DD that can be
shared with other applications via the Windows
registry

e.g. 2022-11-02
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{eventId}
Event id that is calculated using the MD5
checksum of the event name + event date

e.g.
1e73da35a8362d03b49
6fa30d901d0d0

{eventKiteGalleryId}
Id identifying a gallery when using Event Kite for
online galleries and micro-sites

{eventKiteSessionId}

A unique id when using Event Kite in the form
ABC123DEF. This is updated at the start of each
photo booth shooting sequence and be used in
captions, QR codes and the filename prefix.

{eventString1} to
{eventString5}

Additional event information that can be shared
with other applications via the Windows registry

{printQuotaUsed}

Returns 0 if the remaining prints counter is more
than 0 else returns 1.
Please note:the print counter to use depends on
the event settings

{eventPrintCounter}
The current value of the event print counter i.e. the
prints remaining

{localPrintCounter}
The current value of the DSLR Remote Pro print
counter i.e. the prints remaining

{qr1} to {qr10}
Strings scanned in using the QR code reader
options

{to}

The 'to' email address when sending emails or the
'to' phone number when sending texts. This token
is only available in the message body when
sending emails or texts

{print_layout} The JPEG copy of the print layout used when 
embedding images in emails

e.g. <img
src="{print_layout}">

{photo<n>}
Individual photos used when embedding images in
emails

e.g. <img
src="{photo1}"><br>
<img src="{photo2}">

{thumbnail<n>}
Individual thumbnails used when embedding
images in emails

e.g. <img
src="{thumbnail1}"><br>
<img
src="{thumbnail2}">

{gif}
Slideshow GIF or boomerang GIF when 
embedding images in emails

e.g. <img src="{gif}">

{video_preview}
JPEG preview of the video when embedding
images in emails

e.g. <img
src="{video_preview}">

15 Release History

26 February 2024: v3.20.1
· Maintenance release to fix a problem with the touchscreen editor crashing when an event does not

have a ready overlay screen.

20 February 2024: v3.20
· Added the option to postprocess photos by sending an HTTP POST to a web server or running a

local command 
· Print compositing now supports the cropping of images and the option to display the original

unmodified photo
· Added an optional ready_overlay_qr.png screen to provide visual feedback when scanning a QR
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code
· New qrRepeat touchscreen action to repeat the most recently scanned QR code
· Added Event Kite gallery and session ids to make it easier to integrate with Event Kite online

galleries and micro-sites

20 November 2023: v3.19.2
· "Miami" and "Pop-o-Matic" themes now included in the setup wizard

28 June 2023: v3.19.1
· Added support for the Canon EOS R100
· Video post processing now supports vertical videos from the Canon EOS M50 Mark II and Canon

EOS R100
· Added {lessThan,str1,str2} token for comparing two integer or two string values
· Fixed an issue loading settings from the "Photobooth Settings" dialog when print layouts contain

rotated photos

17 May 2023: v3.19
· Added support for the Canon EOS R8 and Canon EOS R50
· Added print compositing with support for opacity, blur, motion blur, colorizing, blend modes, contrast

and saturation
· Added outline/sticker effect when shooting green screen or using AI background removal
· Added support for timed sessions
· Added an option to create user surveys.

9 March 2023: v3.18.2.1
· Fixed issues in v3.18.2 with touchscreen keyboards converting all input to upper case and crashing

when using Shift+Ctrl+left click to save the keyboard settings

· 14 February 2023: v3.18.2
· Added support for the Canon EOS R6 Mark II
· Added the ability to retry failed uploads
· Added optional watermark when displaying prints in the print confirmation or sharing screens

8 November 2022: v3.18.1.1
· Fixed an issue in v3.18.1 where loading a profile could cause the app to crash

1 November 2022: v3.18.1
· Added options to upload the JPEG copy of the printed output and the processed copy of the printed

output to the uploader
· Added the option to make user survey responses available to other apps by writing them to the

Windows registry
· Added event date and event id to provide a way to identify events
· Fixed an issue with the ready overlay screen images being cropped when using profiles and

animated GIFs
· Fixed an issue with email attachments for processed photos and thumbnails not being sent unless

original photos were also selected

4 October 2022: v3.18
· Added support for the Canon EOS R7 and Canon EOS R10
· Added support for secure, single use QR codes
· Added the ability to add a video with transparency to a video captured in video booth mode
· Added file uploader to automatically upload photos, videos and GIFs to a website as they are taken
· Added payment modes when sharing by email or text
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· Added export settings option to the Tools menu
· Added vertical positioning for default keyboards to make it easier to display email and other

keyboards at the top of the screen
· Fixed an issue sending emails with cc addresses

23 March 2022: v3.17.1
· Simplified the cropping of videos to square in the video post processing settings
· Improvements to error checking and validation of video post processing settings
· Added the ability to load and save video edit lists to file

16 February 2022: v3.17
· Added support for post processing videos.including creative effects such as jump cuts, speed

ramping and boomerang playback. Videos can be cropped and resized and an overlay  can be added
together with an intro and outro video and a soundtrack.

· Fixed an issue with the taking.jpg screen not being displayed when an animation is being used for the
countdown

12 January 2022: v3.16.1
· Fixed an issue adding attachments to emails as file attachments
· Fixed an issue with UIDs not being updated in stills photo booth mode when the keyboard shortcut F5

is used to start the shooting sequence

15 December 2021: v3.16
· Now sends emails and texts in the background without requiring Breeze Hub and provides full control

over attachments for emails
· Added the ability to select different print backgrounds/overlays in the confirm printing screen 
· Added payment mode for printing from the sharing screen and support for the new MDB Payment

utility
· Added options for digital only and for creating slideshow GIFs when running the photo booth setup

wizard
· Added reports for photo booth session, survey data and sharing
· Added the option to disable line drawing on prints so that users can only add emojis or stickers to

prints
· Added the option to create events with slideshow GIFs or MP4s and for "digital only" events when

running the photo booth setup wizard
· Updated URL shortening for SMS+image text messages due to changes made by TinyUrl.com
· The processed image now supports a background image named processed_photo_background.jpg.

When using the transparent background option when shooting green screen or using AI background
removal the optional greenscreen_background.jpg image is added to the photo's background before
it is added to the processed image

· The time the reprinting.jpg/processing.jpg screen is displayed when reprinting from the reprint
selection screen is now configurable

· Added the ability to scan in the event name and event strings when scanning QR codes.
· Fixed an issue with the live view 4:3 aspect ratio option not cropping the live view
· Fixed an issue with the sizing of preview images in photo booth mode with some screen sizes and

orientations
· Removed support for legacy auto print layout which was replaced by the print layout editor in DSLR

Remote Pro v3.0

16 March 2021: v3.15.5
· Fixed an issue connecting to the Canon EOS M50 Mark II in markets where the camera is identified

as Canon EOS M50M2
· Now saves the event name and event strings to the photo booth summary file
· Fixed an issue with the green screen overlay not being applied to preview photos
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· Fixed an issue with the green screen background not being added when using the "save copy of
processed photos" option with the transparent green screen background option

9 December 2020: v3.15.4
· Added support for the Canon EOS R5 and Canon EOS R6 
· Added support for the Canon EOS 850D/Rebel T8i/Kiss X10i
· Added support for the Canon EOS M50 Mark II/Kiss M2
· Added {field2,n,ch,str} token for extracting a field from a string using ch as the separator character
· Fixed an issue with AI background removal not working when the mirror output images option is

selected
· Fixed an issue setting the owner string, artist and copyright information on recent camera models

24 August 2020: v3.15.3
· Fixed an issue with multiple texts being sent when scanning a QR code in the sharing screen

3 July 2020: v3.15.2
· Contactless operation now has the ability to send texts
· Improved the ability to read QR codes in bright, high contrast lighting conditions e.g. outside
· Fixed an issue with the live view display for QR code input in the sharing screen not being rotated

when the camera is in portrait orientation
· Added {contains,str1,str2} token for testing whether str1 contains str2

13 May 2020: v3.15.1
· Fixed an issue with scanning QR codes in the sharing screen after a boomerang GIF or video

session
· Fixed an issue with the {uid} and {uid2} tokens not being expanded in QR codes displayed in the

sharing screen

7 May 2020: v3.15
· Added support for contactless operation for running the photo booth and sending emails using QR

codes
· Added support for AI background removal services aka "green screen without the green screen"
· Added an optional background/overlay filename suffix in "Output Settings" to allow the backgrounds

and overlays for prints, slideshow GIFs and boomerang GIFs to be selected using random numbers
or in response to user input in surveys

· Added an option to display a dynamically generated QR code in the sharing screen
· Now supports the latest secure method for sending emails via GMail
· Added the ability to use tokens to define the initial value of text fields in touchscreen keyboards
· Added the option to save a copy of the zoom area of the live view display when shooting JPEGs

which are saved to the PC
· Fixed an issue with positioning MP4 animations in screens with live view enabled
· Removed references to sharing via Facebook because it is no longer supported due to the

Cambridge Analytica scandal 

30 October 2019: v3.14.3
· Added support for the Canon EOS M6 Mark II and Canon EOS M200
· Added support for the Canon EOS 90D
· Fixed an issue with sharing slideshow MP4s that affected v3.14.2

22 October 2019: v3.14.2
· Added support for the Canon PowerShot G5 X Mark II and Canon PowerShot G7 X Mark III
· Photo booth printing now automatically bleeds the background.jpg and overlay.png to fill the printable

area
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· Added the option of a gray background for the emoji and frame menus in the drawing and signing
screen

· Now hides the video playback window until the video starts playing to avoid a blank window
appearing when loading a screen animation

· Fixed an issue with "load profile X + start" touchscreen actions not starting the shooting sequence if
the ready screen has a ready_loop.mp4 animation

· Fixed an issue with using filenames to position GIF and MP4 screen animations that affected v3.14
and v3.14.1

31 July 2019: v3.14.1
· Fixed issues with playing back videos captured in video booth mode that affected some computers
· Fixed an issue which could cause logos not to be displayed in the print layout editor

24 July 2019: v3.14
· Added support for the Canon EOS 250D/Rebel SL3/EOS 200D II/EOS Kiss X10
· Logos in prints are now placed over overlays
· Added counters for the total number of emails, texts and tweets
· Added the option to let users select different frames for the print layout in the drawing/signing screen
· Fixed a reliability issue with playing videos in photo booth mode that was caused by recent Windows

updates

15 April 2019: v3.13
· Added support for the Canon EOS RP and Canon PowerShot SX70 HS
· Logos in print layouts are now saved in the PBLT print template file
· Added mirror options to creative filters in photo booth mode
· Added total number of prints counter

26 November 2018: v3.12
· Added support for the Canon EOS R
· PNG logos and JPEG images can now be added to print layouts
· Emails can now include CC email addresses
· Screens can now display a video in the background and an animated GIF overlay
· Live view display in video booth mode now supports optional video_live_view_overlay.png overlay
· Much faster uploading of images when sharing by text or Twitter
· Fixed an issue with sharing boomerang GIFs when share videos is selected

11 September 2018: v3.11.4
· Added emojis/stickers/virtual props to the signing and drawing on prints
· The icons in the reprint selection screen can now be placed at the top of the screen to make it easier

to use on magic mirror booths
· Improved support for the Canon EOS M50 mirrorless camera in photo booth mode
· Added a "Reprint screen from video ready" touchscreen action to allow the reprint selection screen

to be selected from the video ready screen
· Fixed an issue with previously shared prints appearing in the background of the video sharing screen 
· Fixed an issue that caused a black background to appear in print layouts containing rotated photos

(this issue only affected v3.11.3)

15 August 2018: v3.11.3
· Added cropping, rotation and improved placement of photos within the background when shooting

green screen in photo booth mode
· Added the ability to share videos captured in video booth mode
· Added an optional delay before playback to allow time for post processing after capturing a video in

video booth mode
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· Fixed an issue with the sizing of live view overlays that affected v3.11.2 
· Fixed an issue with the Canon EOS 1500D being incorrectly identified as a Canon EOS 500D

9 July 2018: v3.11.2
· Added support for the Canon EOS 1500D aka Canon EOS 2000D/Rebel T7/EOS Kiss X90
· Added support for the Canon EOS 3000D aka Canon EOS 4000D
· Added {isGif}, {isJpeg}, {isMovie} tokens which are available when sharing images
· Added an error message if the log file cannot be written when using the email and texting offline

options

7 June 2018: v3.11.1
· Maintenance release to fix a problem with email offline mode being selected when loading profiles
· Added optional information screens that can be displayed from the ready screens

28 May 2018: v3.11
· live_view_overlay.png is now updated with the color, B&W and filters e.g. live_view_overlay_c.png

for color, live_view_overlay_b.png for B&W
· Added {printQuotaUsed}, {printCounterEvent} and {printCounterLocal} tokens
· Added 4:3 aspect ratio option for live view, print layouts and the photo booth setup wizard
· Added the option to delete the photos if they are rejected in the confirm printing screen
· Added optional info screen when displaying touchscreen keyboards
· Timeouts for the success, offline and error screens when sharing are now configurable using the

Configure utility
· Fixed an issue with prints still being output when the printer counter reaches 0
· Fixed an issue in photo booth mode when shooting raw+JPEG with the Canon EOS M50

2 May 2018: v3.10
· Added support for the Canon EOS M50/EOS Kiss M
· Added support for the Canon EOS 2000D/Rebel T7/EOS Kiss X90
· Added support for the Canon EOS 4000D
· The photo preview, print preview and share preview areas can now be edited using the touchscreen

editor
· Added the ability to resize, sharpen and add an overlay to the saved copy of the processed photos
· Added the option to display an error message and disable printing when the print counters reach zero
· Added the following keyboard shortcuts: Ctrl+A for "Preview: accept", Ctrl+R for "Preview: retake",

Ctrl+X for "Preview: abort"
· Added the option to save XML copies of emails and texts
· Privacy information added to the "Sharing Photos" section
· Fixed an issue when using transparent green screen backgrounds with Instagram style filters or B&W

styles
· Fixed an issue with the full screen live view setting when the camera and screen are in portrait

orientation.

19 February 2018: v3.9.1
· Maintenance release to fix a problem with the MIME type of emails sent with MP4 attachments
· Fixed an error with the positioning of previews in the share screen when using the "sides" button

placement option in the photo booth setup wizard

14 February 2018: v3.9
· Photo booth setup wizard enhanced to support square or full screen live view and screens with

animated GIFs, filters and manual control over the size and placement of PNG button images
· MP4 copies of animated GIFs can now have an optional soundtrack
· Animated GIFs can now have an additional overlay for adding logos or branding
· Faster and better quality green screen processing
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· Fixed a possible performance issue when sending complex HTML emails

11 December 2017: v3.8.1
· Maintenance release to fix a problem running Photoshop droplets in photo booth mode
· Updated the HideWindowsTaskbar utility to work with the latest version of Photoshop

28 November 2017: v3.8
· Added support for the Canon EOS 6D Mark II
· Enhanced the photo booth setup wizard to support themes with different button styles, screen

backgrounds and caption text
· Boomerang GIFs can now be created with animated animated backgrounds when shooting green

screen 
· Added a print counter to the event info shared via the Windows registry
· Added the option to send emails without including the image as an attachment
· Added {urlencode,str} token to allow arbitrary strings to be passed as parameters in a URL e.g.

when providing a link to a microsite
· Added optional "tap for 3 sec countdown" in countdown screen if remaining countdown is 15 seconds

or more 
· Now supports GIF animations in the screens used for sharing photos by email, text, Facebook and

Twitter
· Fixed a problem with double the number of reprints being made when the number of copies is set to

2
· Fixed a problem with camera settings in photo booth mode when switching from a photo booth profile

with live view enabled to one without
· Fixed errors in filenames of animated GIFs captured in video booth mode
· Fixed a problem with thumbnails not being displayed in the reprint selection screen when pathnames

of the images are long

5 September 2017: v3.7.3
· Added support for the Canon PZ-E1 power zoom adapter
· User survey data can now be used to specify the download folder
· Added the option to disable or enable user survey data (in the "Touchscreen Settings" dialog)
· Added {random,x,y} token
· Added touchscreen actions to run a script with or without password protection
· Fixed a problem identifying the Kiss X9 (aka Rebel SL2/EOS 200D)
· Fixed a problem with animated GIFs not being saved in video booth mode if the P

hotoboothSuppressXml option is selected

7 August 2017: v3.7.2
· Added support for the Canon EOS 200D/Rebel SL2
· Added event info shared via the Windows registry
· Add touchscreen actions to load randomly selected profiles
· Animated GIFs can now be displayed in the confirm_printing.jpg and share.jpg screens
· Fixed a problem cropping copies of processed photos
· Fixed a problem saving copies of green screen images when the transparent option is selected and

B&W tinted mode is selected
· Fixed a problem with the touchscreen keyboard timeout not working in the sharing screens

28 June 2017: v3.7.1.2
· Added the option to save a copy of processed photos (e.g. after being rotated, cropped, digitally

zoomed, converted to B&W etc.)
· Fixed a problem with animated GIFs hanging in video booth mode if the GIF is rejected too soon

after capture
· Fixed a problem with the last frame of an animated GIF captured in stills photo booth mode being
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displayed for only 1/25 sec
· Fixed a problem with the playback speed of MP4 copies of animated GIFs captured in photo booth

mode when the number of backgrounds/overlays is set to more than 1

15 June 2017: v3.7.1.1
· Maintenance release to remove a debug message which was accidentally left in v3.7.1

12 June 2017: v3.7.1
· Added support for the Canon EOS 77D and Canon EOS 800D/Rebel T7i
· Added a user survey option to capture text and checkbox responses from users in photo booth mode
· Speeded up MP4 and animated GIF processing when creating animated GIFs in video booth mode
· {filename} and {filenameNoExt} tokens can now be used in email, text and Twitter messages
· Improved handling of display scaling on high DPI screens (see Preferences)
· Added "Save Photobooth Settings" option to the File menu to save all the photo booth related

settings to file
· Animated GIF capture in video booth mode now supports "stop video capture" to create shorter clips
· Updated Facebook uploader to fix problems caused by the way Facebook handles cookies that

affected Facebook uploads on some computers
· Fixed a problem when using PNG overlay images that are too small which could cause the software

to crash
· Fixed a problem with the optional ready overlay appearing in the reprint selection screen

21 February 2017: v3.7
· Added support for displaying an animated GIF in photo booth screens
· Animated countdowns can now use an animated GIF which can be displayed over the live view

display
· Ready screen can now display an optional overlay (ready_overlay.png)
· Added new Instagram style filters in photo booth mode
· Camera settings dialog now has the option to take test photos using the current settings for each

bank and can be displayed using a photo booth shortcut button
· Photo booth setup wizard enhanced to support choosing the number of copies to print in the print

confirmation screen and the creation of 'boomerang' animated GIFs
· Optional tags added to the XML settings format to allow advanced users to create location

independent settings files to make it easier to share settings on different photo booths
· Capturing animated GIFs in video booth mode now has the option to use the camera in photo mode

or video mode and to crop the live view display and display a live_view_overlay.png overlay
· Added the option whether to mirror the preview images displayed after each photo is taken
· Added the option to mirror photos before printing or adding to animated GIFs
· The default profile now has the option to randomly select a profile
· Fixed a problem with Facebook users not being logged out after uploading photos
· Fixed a problem with animating the GIF_processing.jpg screen

10 November 2016: v3.6.1
· Added support for the Canon EOS 5D Mark IV
· Improved control over camera settings in video booth and photo booth modes
· Added support for drawing on or signing the print layout before printing or sharing
· Improved support for modifying photos before printing e.g. using Adobe Photoshop droplets
· Live view cropping now supports vertical "letter box" style cropping in addition to horizontal cropping
· Now prints photos before displaying the sharing screen
· New touchscreen actions added for increasing or decreasing the number of copies to print in the print

confirmation screen. The print confirmation screen now uses different backgrounds according to the
number of copies .e.g confirm_printing_1.jpg, confirm_printing_2.jpg etc.

· Added the option to send the MP4 copy of animated GIFs when sending SMS or MMS texts
· Fixed a problem with the "Use MP4 copy of animated GIF if available" setting when emailing photos
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· Fixed a problem with the playback timeout option when capturing animated GIFs in video booth mode

10 October 2016: v3.6
· Improved green screen setup in photo booth mode
· Added photo booth shortcut buttons for loading and saving the default profile. The "print layout"

shortcut now asks whether to save the settings to the default profile, if defined, after editing the print
layout

· Added the option to automatically load the default profile when DSLR Remote Pro is run and the
ability to specify a profile file to load in the command line

· Added the ability to share animated GIFs by email, text, Facebook and Twitter. Animated GIFs
shared on Facebook are hosted on giphy.com

· Animated GIFs captured in video mode can now be placed within a frame
· Animated GIFs can be created using indexed color (to give more detail) or dithered color (to give

better colors)
· MP4 copies of animated GIFs can be created automatically and shared via Facebook or email
· Added {uid2} token which generates a unique id in the form ABCDE123 and is guaranteed not to

repeat for 776 days
· Added the option to crop the print preview display in photo booth mode
· Optional live view version of green screen overlay and background in photo booth mode
· Added simulated camera option to allow testing photo booth mode without a camera
· Reprint selection screen now allows multiple files to be selected and the number of copies to be

printed to be specified
· Added lockdown mode to limit access to advanced photo booth settings
· Added timeout in video playback screen with the option to automatically accept or reject the video
· Added an option to show the mouse cursor to give full control of the photo booth when using a mouse
· The camera's preset white balance settings can now be used for live view to give more consistent

results when capturing animated GIFs in video booth mode
· Fixed a problem with timeouts when uploading to Facebook or Twitter
· Please note: this release and all future releases will not run on Windows XP

13 July 2016: v3.5.3.1
· Maintenance release to fix a problem with uploading to Facebook and Twitter which affected v3.5.3

11 July 2016: v3.5.3
· Enhanced the animated GIF support in stills photo booth mode and video booth mode to allow

multiple title pages so that short animations can be displayed in addition to the photos
· Fixed a problem which caused video playback to break up on some computers

22 June 2016: v3.5.2
· Enhanced the animated GIF support in stills photo booth mode to work when the camera is in portrait

orientation and added the ability to position photos within the GIF and to have different overlays for
each photo

· Fixed a problem with external flash mode which affected v3.5.1
· Added a workaround for a camera firmware issue which causes occasional AF errors when the

camera is set to manual focus

15 June 2016: v3.5.1
· Added the option to create an animated GIF slideshow of the stills photo booth shooting sequence
· Added the option to create an animated GIF of the video clip when using the "Capture clip as a

series of still frames" in video booth mode
· Added the option to only display live view in the ready screen and to hide it during the countdown
· Added the ability to overlap touchscreen actions to allow one touch to perform multiple actions
· Fixed a problem with the playback breaking up when animating photo booth screens using some

http://giphy.com/
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types of MP4 video file

10 May 2016: v3.5
· Added support for Canon EOS 1300D/Rebel T6, Canon EOS 80D and Canon EOS-1D X Mark II
· Added additional photo booth shortcut buttons for taking a test photo and loading profiles
· Added the option to hide the camera controls normally displayed on the left side of the main window

to provide a simplified interface for photo booth operators
· Simplified the method of specifying the playback speed when using the fast stills capture option for

creating animated GIFs 
· Now supports MP4 or MOV files for animated screens and countdowns in photo booth mode
· Movie file display no longer uses Apple's QuickTime libraries
· Minor changes to the way checkboxes are displayed in touchscreen keyboards
· Added a "Close" action for touchscreen keyboards to allow a terms and conditions page to be

displayed at the start of the shooting sequence
· Fixed problems uploading to Facebook caused by changes to Facebook's login requirements
· Fixed problems uploading to Twitter caused by changes to Twitter's login requirements

12 January 2016: v3.4
· Added fast stills capture option in video booth mode for creating fun animated GIFs
· Added support for posting photos to Twitter
· Added support for sending photos by MMS (US and Canada only) or SMS via Twilio.com
· Now supports up to 12 captions in the print layout, options to change the caption display order and

the option to right justify the caption text
· The printing option in the sharing screen now has the option to limit the number of prints
· Fixed a problem with the alpha channel being lost when saving a transparent PNG copy of

greenscreened photos when the camera orientation is set to portrait
· Replaced %1, %2, %3, %4, %5, %6 tokens with {yearNow}, {monthNow}, {dayNow}, {yearLess8h},

{monthLess8h}, {dayLess8h} to avoid problems with unwanted substitutions in emails
· Fixed a typo in the default text for HTML emails: correcting <image src="{image}"> to <img

src="{image}">
· Fixed a problem with image attachments not displaying in emails sent to Outlook.com
· Changed the keyboard shortcuts for digital zoom in photo booth mode from cursor left/right to 

Ctrl+Alt+cursor left/right to reduce the chances of selecting this accidentally

9 September 2015: v3.3.3
· Maintenance release fixing a problem when photos overlap the left or top borders of the print layout

which could cause the software to crash
· Adjusted the green screen processing algorithm to give better results and added the option to chose

which green screen algorithm to use
· Added keyboard shortcuts for selecting a profile and starting the shooting sequence (profiles 1 to 8

only)
· Added the option to log Facebook uploads to file  
· Fixed a problem with non-ASCII characters in the email subject and with email log files when the

image pathname contains non-ASCII characters

15 July 2015: v3.3.2
· Added support for the Canon EOS 5DS R and Canon EOS 5DS
· Fixed a problem overriding the email_address attribute when using the touchscreen keyboard "email

input at start" option

24 June 2015: v3.3.1
· Maintenance release fixing a problem with File->Send emails not reading information from the email

log file.
· Added mandatory option to <prompt> tag in touchscreen keyboard XML definition to indicate that an



 266

© 2024 We Fly Kites Inc.

input field must contain text
· Fixed a problem with the green screen zoom/position settings not being saved to file for use with

profiles

16 June 2015: v3.3
· Added support for the Canon EOS 750D/Rebel T6i and Canon EOS 760D/Rebel T6s
· Added unicode support for handling characters in most languages
· Added the ability to shoot raw+JPEG in photo booth mode
· Improved green screen processing
· Added the ability to position the photo within the background when shooting greenscreen in photo

booth mode
· Added optional password to protect "exit photo booth mode" touchscreen action
· Added touchscreen actions to select a profile and start the shooting sequence (profiles 1 to 8 only)
· Added new touchscreen action editor
· Added "Message input at end of sequence" touchscreen keyboard option to allow users to enter a

message which can be added to the printed output (using the {message} token)
· Added an option to print photos from the sharing screen (this can also be selected when running the

photo booth setup wizard)
· The default touchscreen keyboard for entering the user's Facebook login name and password now

displays punctuation characters when the shift key is pressed (US keyboard layout)
· Email message text can now be specified in HTML format and plain text format
· Inactivity timer now loads default profile, if defined, before switching to standby mode

25 November 2014: v3.2
· Added support for Canon EOS 7D Mark II
· Now supports hashtags when uploading photos to Facebook
· Added offline email mode and the ability to send unsent emails later
· Added reprint selection screen available from the photo booth ready screen
· Added auto standby option in photo booth mode

9 October 2014: v3.1
· Added the option to crop the photo before uploading to Facebook or sending by email
· Added "Single strip of 2" preset layout option
· Fixed a possible problem where uninstalling a printer driver could cause the program to crash
· The body text for emails now allows return characters

18 July 2014: v3.0.1
· Added support for sharing 300 DPI photo booth templates when using HiTi printers
· Fixed a problem with lines appearing on the last screen created by the photo booth setup wizard
· Added additional photo booth shortcut buttons and the ability to choose which ones are displayed

22 June 2014: v3.0
· Added support for Canon EOS 1200D/Rebel T5
· Added interactive editor for photo booth print layouts
· Added the importing and exporting of photo booth print layouts
· Added the ability to print QR codes on photo booth prints
· Added "Pop art" creative filter in photo booth mode
· Added optional thumbnail display in photo booth mode
· Added new photo booth dashboard to provide quick access to the main photo booth settings
· Increased the number of photo booth profiles from 8 to 18
· Increased the number of photo booth captions from 2 to 8
· Improved error reporting when testing and sending emails and improved support for services such as

free email services such as yahoo.com
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20 February 2014: v2.7.2
· Added "From" email address setting when sending emails
· Fixed a problem with the touchscreen handling which could result in the touchscreen keyboard

detecting an unwanted key press at startup

6 February 2014: v2.7.1.1
· Maintenance release to fix a problem with the software crashing on some systems when sending

emails

28 January 2014: v2.7.1
· Added "Confirm printing (no JPEG copy)" print option in photo booth mode
· Improved Facebook upload option to support different Facebook login screens and disable

touchscreen edge gestures on Windows 8 and Windows 8.1
· Fixed a problem with video booth touchscreen actions
· Fixed a problem with screen flicker in video booth mode
· Fixed a problem with the share screen being displayed when selecting reprint in photo booth mode

21 January 2014: v2.7
· Added the ability to upload photos to a user's Facebook page in photo booth mode
· Added the ability to email photos in photo booth mode
· Added auto white balance option for live view in photo booth mode

6 December 2013: v2.6.2
· Added support for Canon EOS-1D C
· Added a single photo layout option in the photo booth setup wizard and preset layouts tool
· Improved the performance of printing custom layouts in photo booth mode when images are printed

multiple times e.g. the double strip of four layout
· Now disables touchscreen edge gestures when running in full screen photo booth mode on Windows

8 and Windows 8.1 systems
· Save green screen copy of photos now rotates the photos to match the orientation setting

12 September 2013: v2.6.1
· Added support for the Canon EOS 70D (including WiFi operation)
· Added inactivity timer option in the photo booth settings dialog and photo booth setup wizard

30 August 2013: v2.6
· Added new photo booth creative filter option which can apply a variety of different effects to both the

live view and the final photos.
· Added the option to rotate as well as crop and resize the additional JPEG copy of the printed output
· Added optional validation of email addresses entered using the touchscreen keyboard
· Added focus point display in live view with status display during live view auto focus.
· Fixed a problem displaying green screen overlay in video booth mode
· Lighter/darker exposure keyboard shortcuts in photo booth mode (PageUp/PageDn) now require Ctrl

to be pressed to reduce problems with accidental adjustments due to touchscreen gestures

21 May 2013: v2.5.3
· Added support for Canon EOS 100D/Rebel SL1 and Canon EOS 700D/Rebel T5i
· Improved support for angled multi-line captions in photo booth mode
· Adding focus peaking option in live view display
· Fixed a problem with selecting the option to save pictures to the camera's memory card when using

a Canon EOS 30D
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15 February 2013: v2.5.2.2
· Fixed a problem in v2.5.2.1 which caused an error when selecting cancel from the print confirmation

screen in photo booth mode

12 February 2013: v2.5.2.1
· Fixed a problem with cropping and resizing the JPEG copy of the printed output in photo booth mode
· Added Ctrl+A keyboard shortcut and touchscreen action to auto focus in photo booth mode. Also

added the ability to adjust focus by pressing the Ctrl key and using the mouse wheel.

3 January 2013: v2.5.2
· Added support for the Canon EOS 6D (including WiFi operation)
· Added electronic level display in live view for the Canon EOS 6D, Canon EOS 5D Mark III and Canon

EOS-1D X
· Added controls for adjusting the sound recording settings in live view video mode for the Canon EOS-

1D X, 5D Mark III, 6D and 650D/Rebel T4i
· Added optional keyboard.wav sound when displaying the touchscreen keyboard in photo booth mode
· Added the ability to specify the position of the movies in animated photo booth screens

26 November 2012: v2.5.1
· Fixed a problem with the ready.mov animated photo booth screen overlapping the live view display

when switching from standby mode
· Fixed a problem starting the photo booth shooting sequence when a ready.mov animated screen is

defined and the delay before taking the first photo is set to 0
· Added optional manual positioning and looping of the video played in the animated photo booth

screens
· Added double strip of three and single strip of three layout options to the photo booth preset layouts

and setup wizard

25 October 2012: v2.5
· Added support for the Canon EOS-1D X
· Added the ability to use movies to animate photo booth screens
· Added post processing options in photo booth mode for easier website and social networking site

uploads
· Added fast resize option in photo booth mode - provides faster print processing with minimal

reduction in image quality
· Added options to reprint photo booth photos after an event

27 August 2012: v2.4.2.1
· Fixed a problem shooting video in normal live view and in photo booth mode
· Added the option to display the touchscreen keyboard immediately after taking the photos in photo

booth mode

6 July 2012: v2.4.2
· Added support for the Canon EOS Rebel T4i/EOS 650D/Kiss X6i
· Added digital zoom option to stills photo booth shooting
· Fixed a problem which affected the display of histogram data in live view in v2.4.1
· Fixed a problem using multiple green screen backgrounds in photo booth mode in v2.4.1

31 May 2012: v2.4.1
· Added support for the Canon EOS 5D Mark III
· Added the option to green screen live view images in video booth mode (video playback and movies

downloaded from the camera are not green screened)
· Minor changes and bug fixes to the photo booth setup wizard
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16 April 2012: v2.4
· Added Photo Booth Setup Wizard which automatically creates all the screens and the print layout for

common photo booth configurations
· Added "clicker mode" where the photographer or users choose when to take the photos in photo

booth mode
· Added an option to include the current printer settings when saving the photo booth settings to file
· Added a quick reprint option (keyboard shortcut: Ctrl+Shift+R) when the output option is set to "Print

and save JPEG copy"
· Fixed problems using a default profile to switch from video to stills photo booth mode when rejecting

a video
· Added {uid} token which generates a unique id for filenames and captions when shooting in photo

booth mode
· Added a timed shutter release option to the remote interface

3 February 2012: v2.3.2
· Added <caption1> and <caption2> tags to the XML photo booth summary file
· Added an option to the touchscreen keyboard to hide text when entering a password
· Fixed problems using a default profile to switch from video to stills photo booth mode
· Fixed a problem with selecting photo booth profiles 7 and 8

12 January 2012: v2.3.1.1
· Fixed a crash in v2.3.1 when not shooting in photo booth mode

11 January 2012: v2.3.1
· Added timeouts in photo booth mode for print confirmation, touchscreen keyboard input and video

confirmation
· Displays optional reprinting,jpg screen image and skips the print confirmation screen when reprinting

photo booth images
· Added optional checkboxes to the touchscreen keyboard in photo booth mode
· Added monochrome tint/toning option to support printing in sepia and other tints in photo booth mode
· Improved noise reduction in photo booth live preview when displaying black and white images

30 September 2011: v2.3
· Added the ability to specify the size and position of the playback window in video booth mode
· Now displays the video_playback_finished.jpg screen image, if defined, after video playback
· Added the ability to specify a horizontal offset for the live view display in photo booth mode
· Added the option to use {photoboothSubDir} or {photoboothDir} tokens when specifying the profile

pathname to allow the use of more than 8 photo booth profiles
· Added a separate delay for the first photo in the stills photo booth shooting sequence
· Added optional color management of printed images
· Fixed a problem with photo booth shooting using external flash mode when "Only display live view

images for the first shot" is selected
· Fixed a problem with incomplete screen refreshes when switching photo booth profiles

3 August 2011: v2.2.3.1
· Increased the number of photo booth profiles that can be loaded via keyboard shortcuts/touchscreen

actions from 6 to 8
· Fixed a problem selecting B&W mode in DSLR Remote Pro for Windows v2.2.3

26 July 2011: v2.2.3
· Added preset layouts when using the custom layout option to help design popular layouts using four

photos
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· Added the ability to set the exposure mode from the PC with the following camera models: EOS
500D/Rebel T1i, EOS 550D/Rebel T2i, EOS 1000D/Rebel XS, EOS 40D, EOS 50D, EOS 7D, EOS
5D Mark II

· Fixed a problem with the default photo booth profile not being applied when shooting in video booth
mode

23 May 2011: v2.2.2.1
· Fixed a problem caused by the latest Canon SDK which resulted in some cameras getting stuck in

manual focus mode
· Fixed an error when auto-bracketing with Canon EOS 400D and saving images to the camera only
· In full screen photo booth mode preview images will now show the image_overlay.png overlay image

(if defined) not live_view_overlay.png
· Added extra checks for touchscreen actions to make sure they are not applied at the wrong time in

photo booth mode

4 May 2011: v2.2.2
· Added blue screen shooting
· Added default profile option to reset the photo booth to a known state after each shooting sequence
· Enhanced touchscreen keyboard in photo booth mode to allow multiple input fields and the use of a

normal keyboard

31 March 2011: v2.2.1
· Added support for the Canon Rebel T3i (aka Canon EOS 600D) and Canon Rebel T3 (aka Canon

EOS 1100D)
· "External flash mode" option in photo booth mode now adjusts live view brightness automatically

when used with Rebel series cameras
· Video booth record/playback progress bar now has user definable foreground and background colors
· Users can now stop the video recording by pressing the 'End' key instead of waiting for the preset

time
· Now displays a warning instead of an error if touchscreen areas overlap e.g. to allow video booth

related touchscreen buttons to be put in the same place as stills related buttons
· Added the ability to run external commands when the photo booth screen changes and when the

XML summary file is written at the end of the photo booth shooting sequence

8 February 2011: v2.2
· Added confirm_printing.jpg and printing_confirmed.jpg screens when using the print confirmation

option in photo booth mode
· Added an "external flash" mode when photo booth shooting to allow the studio strobes and external

flash guns that are not E-TTL compatible to be used with Rebel series cameras
· Added optional touchscreen keyboard in photo booth mode
· Green screen shooting in full screen photo booth mode now has the ability to use different

backgrounds and overlays for each shot and to save a green screened copy of each photo
· Fixed a problem with time lapse shooting using raw+JPEG mode and the latest camera models

1 December 2010: v2.1.1
· Fixed a problem with keyboard input focus in video booth mode
· Fixed a problem switching between video booth mode and photo booth mode with the Canon EOS

60D
· Added photo booth keyboard shortcuts and touchscreen actions for selecting camera PictureStyles

10 November 2010: v2.1
· Added support for the Canon EOS 60D
· Added video booth mode
· Photo booth mode now has the option to specify the vertical positioning of the live view display and
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countdown text 
· Photo booth mode now has the option to disable live view during printing
· Photo booth previews are now green screened and look like the final output when green screen

shooting
· The camera battery status is now displayed in the main window title bar
· Added an option in preferences to use lower case file extensions for images saved to the PC

27 August 2010: v2.0
· Live view is now automatically restarted if it is canceled by the camera
· Added support for motion detection using Webcam Zone Trigger (available separately from http://

www.zonetrigger.com)
· Added green screen shooting overlay in main live view window and in photo booth mode
· Added optional overlay image for live view display in photo booth mode
· Photo booth timings changed so that countdown text now counts down to 1 instead of stopping at 2

24 May 2010: v1.9.1
· Fixed a problem with B&W images being printed in color in the custom photo booth layout
· Improved handling of external button presses in photo booth mode to prevent a new shooting

sequence from being started before the current one has finished printing
· Added the ability to turn off the AF area rectangle in live view (by typing Ctrl+TAB)

11 May 2010: v1.9
Added the following enhancements to photo booth shooting:
· New, more flexible custom layout of prints including image rotation. Please note that custom layouts

from previous versions of DSLR Remote Pro for Windows will need to be updated if they use the
"Copy left half of page to right to create a double strip" option

· Captions can now be rotated
· Live view is hidden when displaying the release.jpg image to avoid confusion caused by the live view

freezing just before the picture is taken
· Added an optional minimum duration before closing the processing.jpg screen to allow a 'Please

leave the booth now' message to be displayed for several seconds at the end of the sequence
· The default behavior of the live view inactivity timer now disables and immediately re-enables live

view after 25 minutes to avoid the camera cancelling live view after 30 minutes 

31 March 2010: v1.8.3
· Added preliminary support for video capture with the Canon EOS 5D Mark II, Canon EOS 7D, Canon

EOS 1D Mark IV, Canon EOS 500D/Rebel T1i and Canon EOS 550D/Rebel T2i
· Fixed a problem which caused live view images to be displayed on top of preview images in full

screen photo booth mode.
· Fixed a problem shooting to the camera's memory card only when using the Canon EOS 550D/Rebel

T2i and Canon EOS 5D Mark II

5 March 2010: v1.8.2
· Added support for Canon EOS 550D/Rebel T2i
· Full +/-5 EV exposure compensation range now available with cameras that support it
· Added "Remote Manual" AF option for taking photos from the PC without using auto-focus
· Added an inactivity timer for live view in full screen photo booth mode
· The camera's LCD can now be turned on and off remotely from the PC when live view is active

(recent cameras with HDMI outputs only)
· Fixed a problem selecting 30 sec shutter speed when auto-bracketing with cameras that have a

separate bulb setting on the exposure mode dial

27 January 2010: v1.8.1
· Added support for the Canon EOS-1D Mark IV

http://www.zonetrigger.com
http://www.zonetrigger.com
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· Added workaround for Canon EOS 50D firmware bug which causes camera controls to be locked
with "busy" displayed on the camera LCD after using live view

· Added the ability to specify the number of digits in filenames
· Added optional live view overlay image
· Fixed problems with bulb shooting from the PC when using the Canon EOS 7D
· Fixed a reliability problem when shooting long continuous sequences at high frame rates

11 December 2009: v1.8
· Added support for the Canon EOS 7D
· Added an option to automatically edit JPEGs and raw files, raw files only or JPEGs only in the editor

setup dialog
· Added "Use camera filenames" option so that images saved to the camera's memory card and to the

PC have the same filenames
· Added more flexible touchscreen options to photo booth mode and the ability to switch between

different sets of photo booth settings
· Added optional release.jpg screen which is displayed immediately before taking a picture in full

screen photo booth mode
· Added support for the Kensington Wireless Presenter in full screen photo booth mode
· Fixed problems with saving images to the camera only when using recent cameras

5 August 2009: v1.7.6
· Improved the responsiveness of live view controls on low spec PCs or  when using slow USB

connections
· Added custom layout option for photo booth prints and the ability to load and save photo booth

settings
· Minor improvements to the focus_stacking script to show progress on screen and extra checks to

detect the camera connection being lost or the live view window being closed.

12 May 2009: v1.7.5
· Added support for Canon EOS 500D/Rebel T1i
· Added an option to only display live view images for the first photo in the photo booth sequence in full

screen photo booth mode
· Live view images can now be rotated by selecting the orientation from the View menu in the main

window

11 March 2009: v1.7.4
· Fixed a problem shooting sRaw with the Canon EOS 40D
· Added the ability to play .wav sound files when displaying photo booth prompt screens
· Added the ability to specify the number of copies of photo booth prints
· Added additional start options for full screen photo booth mode to facilitate the use of touchscreens
· Added support for the StealthSwitch in full screen photo booth mode

9 December 2008: v1.7.3
· Fixed a problem connecting to the Canon EOS Rebel XS
· Now includes information on how to use external buttons in photo booth mode
· Camera can now be turned off when not in use during full screen photo booth shooting
· Fullscreen photo booth shooting now includes an option to use the mouse for triggering the photo

booth sequence and for switching between B&W or color photos

21 November 2008: v1.7.2
· Added support for the Canon EOS 50D and Canon EOS 5D Mark II
· Added left.jpg, middle.jpg and right.jpg options for more flexible layout of images in photo booth

mode.
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5 August 2008: v1.7.1
· Added support for the Canon EOS 1000D/Rebel XS/Kiss Digital F
· Now supports portrait orientation live view images in photo booth mode
· Added preview display option to photo booth mode and optional captions on printed images.
· Live view images now optionally upscaled to fill live view window 

24 April 2008: v1.7
· Added support for the Canon EOS 450D/Rebel XSi/Kiss Digital X2
· Added live view, the saving of printed images and optional overlay image to photo booth shooting

mode
· Added camera settings dialog which allows the camera's clock to be synchronized with the PC's

clock and the camera owner string to be set
· Error and warning messages now cancel automatically after 10 secs when camera auto-reconnect is

selected

6 February 2008: v1.6.1
· Fixed a problem downloading and saving large raw files from the Canon EOS-1Ds Mark III

4 December 2007: v1.6
· Added support for the Canon EOS-1Ds Mark III
· New photo booth mode added
· Live view now supports horizontal and vertical flipping and 180 degree rotation

2 October 2007: v1.5
· Added support for the Canon EOS-1D Mark III and Canon EOS 40D.
· Added live view display for Canon EOS-1D Mark III and Canon EOS 40D. Live view supports manual

focus and contrast detection autofocus and also has optional onion skinning and grid overlay.
· Long bulb exposures can now be controlled from the PC when using the Canon EOS-1D Mark III or

Canon EOS 40D
· Added "Arrange windows" option (Ctrl+A) to help arrange the live view and main windows

25 June 2007: v1.4
· Full support Windows Vista support for Canon EOS 350D/Rebel XT, 400D/Rebel XTi, 20D, 30D, 5D,

1D Mark II, 1D Mark IIN and 1Ds Mark II
· Fixed problems with Av and Tv dropdown menus following recent Windows updates

16 April 2007: v1.3.2
· Added test and notes for running on Windows Vista
· Updated DSLRRemoteLib.dll interface library

22 December 2006: v1.3.1
· Improved reliability with Canon EOS 20D, 350D, 1D Mark II, 1D Mark IIN and 1Ds Mark II cameras.
· Fixed LP5 error at startup on some systems

20 October 2006: v1.3
· Added support for the Canon EOS 400D/Rebel XTi/Kiss Digital X
· Added an option to name auto-bracketed sequences with a letter suffix to make it easier to identify

sets of bracketed images e.g. IMG_0123a.JPG, IMG_0123b.JPG, IMG_0123c.JPG
· Added option to execute a command after completing an auto bracket sequence
· Added BBProDirDisplay.exe utility to allow DSLR Remote Pro for Windows to display images in

BreezeBrowser Pro
· Improved warning message display when PC's disk is full
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· Spacebar can now be used to release the shutter (unless keyboard focus is in the comment edit
window)

19 May 2006: v1.2
· Added support for the new Canon EOS 30D
· Added the option to use the new or old Canon libraries to control the Canon EOS 20D, 350D, 5D,

1D2 and 1DS2
· Fixed autobracketing of images when saving images to the camera's memory card only
· Spot metering mode and picture style can now be selected from the PC when using the Canon EOS

5D

29 December 2005: v1.1.1
· Fixed problem with "H/W error 0x000002" when taking long exposures
· Extended auto bracket interval to 2 stops
· Added "Ignore camera update events" option to Camera menu for more reliable operation when

taking pictures using the camera's controls
· Fixed memory leak when using auto reconnect
· Fixed problem when shooting auto bracket sequences and saving raw+JPEG images to the PC
· Fixed a problem with Canon EOS 350D/Digital Rebel XT only downloading thumbnails when shooting

raw images

20 October 2005: v1.1
· Added support for Canon EOS 20D, 350D/Digital Rebel XT, 5D, 1D Mark II and 1Ds Mark II
· Added HQ display option
· Added color management
· Added auto-bracketing
· Added image renaming plus the ability to name the image using the image comment
· Improved reliability when shooting continuous sequences

26 January 2004: v1.0
· First public release with support for Canon EOS D30, D60, 10D, 300D/Digital Rebel, 1D and 1DS
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